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Preface

This core Microsoft® Excel® text provides students with the skills needed to execute
many personal and professional activities. It also prepares them to go on to more
advanced skills using the Excel software. The text takes the approach of making
decisions using Excel. Personal decisions introduced include important purchases,
such as homes and automobiles, savings for retirement, and personal budgets.
Professional decisions include budgets for managing expenses, merchandise items
to mark down or discontinue, and inventory management. Students are given clear,
easy-to-follow instructions for each skill presented and are also provided with
opportunities to learn additional skills related to the personal or professional
objectives presented. For example, students learn the key terms with respect to
home mortgages and understand the impact interest rates have on monthly
mortgage payments. This text also places an emphasis on “what-if” scenarios so
students gain an appreciation for the computational power of the Excel application.
In addition, students learn how Excel is used with Microsoft® Word® and Microsoft®
PowerPoint® to accomplish a variety of personal and professional objectives.

All screenshots that appear throughout this text are copyright of Microsoft
Corporation. All Rights Reserved. They have been used with permission from
Microsoft Corporation. How to Use Microsoft® Excel®: The Careers in Practice Series is an
independent publication and is not affiliated with, nor has it been authorized,
sponsored, or otherwise approved by Microsoft Corporation.



Chapter 1

Fundamental Skills

Microsoft® Excel® is a tool that can be used in virtually all careers and is valuable in
both professional and personal settings. Whether you need to keep track of
medications in inventory for a hospital or create a financial plan for your
retirement, Excel enables you to do these activities efficiently and accurately. This
chapter introduces the fundamental skills necessary to get you started in using
Excel. You will find that just a few skills can make you very productive in a short
period of time.
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1.1 An Overview of Microsoft® Excel®

LEARNING OBJECTIVES

Examine the value of using Excel to make decisions.
Learn how to start Excel.

Become familiar with the Excel workbook.
Understand how to navigate worksheets.

Examine the Excel Ribbon.

Become familiar with the Quick Access Toolbar.
Examine the right-click menu options.

Become familiar with the commands in the File tab.
Learn how to save workbooks.

Save workbooks in the Excel 97-2003 file type.

. Examine the Status Bar.

. Become familiar with the features in the Excel Help window.
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Microsoft® Office contains a variety of tools that help people accomplish many
personal and professional objectives. Microsoft Excel is perhaps the most versatile
and widely used of all the Office applications. No matter which career path you
choose, you will likely need to use Excel to accomplish your professional objectives,
some of which may occur daily. This chapter provides an overview of the Excel
application along with an orientation for accessing the commands and features of
an Excel workbook.

Making Decisions with Excel

Follow-along file: Not needed for this skill

Taking a very simple view, Excel is a tool that allows you to enter quantitative data
into an electronic spreadsheet to apply one or many mathematical computations.
These computations ultimately convert that quantitative data into information. The
information produced in Excel can be used to make decisions in both professional
and personal contexts. For example, employees can use Excel to determine how
much inventory to buy for a clothing retailer, how much medication to administer
to a patient, or how much money to spend to stay within a budget. With respect to
personal decisions, you can use Excel to determine how much money you can spend
on a house, how much you can spend on car lease payments, or how much you need
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to save to reach your retirement goals. We will demonstrate how you can use Excel
to make these decisions and many more throughout this text.

Figure 1.1 "Example of an Excel Worksheet with Embedded Chart" shows a
completed Excel worksheet that will be constructed in this chapter. The

information shown in this worksheet is top-line sales data for a hypothetical
merchandise retail company. The worksheet data can help this retailer determine
the number of salespeople needed for each month, how much inventory is needed
to satisfy sales, and what types of products should be purchased. Notice that the
embedded chart makes it very easy to see which months have the highest unit sales.

Figure 1.1
x] =R g ‘ i Merchandise Sales by Month - Microsoft Excel
Home  Insert  Pagelayout Formulas Data  Review  View =]
Q.
& il 10 AA ==_| =; | el [m} S=mset~ = v A
4 g A ==(=® S |cenerl - e L I/ ?
B2~ E| :Uiﬁ — S pelete v | [F]~ Z
B 7 U~ it ,Ra, | 5= ad v v B 9 | <0 .00 Conditional Formatas Cell o = ~, Sort& Finc
7 U-|B- A== =8 8% 00 20 cormatting v Table v Styles~ | HEFOMat ™ | CAY Eirerv sele
Clipboard Font Alignment Number Styles Cells Editing
o1 ad b
A B C D E F G H | J K L M

General Merchandise World ]
BB 2071 Retail Sales (in millions) Unit Sales

Unit | Average | Sales
2 Month Sales Price Dollars
3 January 2670 | $ 9.99| $ 26,685
4 |February 2160 | $ 1249 $ 26,937
5 March 515 | % 1499|% 7,701
6 |April 590 | $ 17.49| $ 10,269
7 May 1,030 | $§ 14.99| $ 15,405
8 |June 2875| % 1249 $ 35916
9 |July 2700 | $ 999| % 26937
10 August 900 | $ 19.99| $ 17,958
11 September 775 |$ 19.99 | $ 15,708
12 | October 1,180 | $ 19.99 | $ 23,562
13 November 1,800 |$ 1749 |$ 31416
14 December 3560 [$ 14.99 | $ 53,370 This embedded chart was created
Total Sales| 20,755 $291,864 with data listed in columns A and B.

» o,

Starting Excel

Follow-along file: Not needed for this skill

The following steps will guide you in starting the Excel application. Note that these
steps along with Figure 1.2 "Start Menu" relate to the Windows 7 operating system,
which is very similar to the Windows Vista operating system.

1. Click the Start button on the lower left corner of your computer
screen.
2. Click the All Programs arrow at the bottom left of the Start menu.

1.1 An Overview of Microsoft® Excel® 8
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Figure 1.2

Click the Microsoft Office folder on the Start menu. This will open the
list of Microsoft Office applications.

Click the Microsoft Excel 2010 option. This will start the Excel
application.

. |

Click here to see alist of all
Microsoft Office applications

on your computer.

Microsoft Mouse /
Microsoft Office
Microsoft Access 2010
[&] Microsoft Excel 2010
@ Microsoft InfoPath Designer 2010
@ Microsoft InfoPath Filler 2010
@ Microsoft OneMote 2010
0] Microsoft Outlook 2010
\E Microsoft PowerPoint 2010 ul
(2] Microsoft Publisher 2010 Music
@ Microsoft SharePoint Workspace 201
(V] Microsoft Visio 2010
(W] Microsoft Word 2010 -
1 Microsoft Office 2010 Tools
a Digital Certificate for VBA Projec|
(8] Microsoft Clip Organizer
Wi Microsoft Office 2010 Language —
2 Microsoft Office 2010 Upload Ce
@ Microsoft Office Picture Manage
Microsoft Rich Tools
. RichCopy4.0

Joseph M. Manzo

Documents l
ft

Pictures 0 If this shortcut appears on your
desktop, you can double click
it to open Excel.

Computer
Control Panel
Devices and Printers

Default Programs

Help and Support

| Microsoft Sitverlight

The All Programs arrow
becomes the Back arrow
once tis clicked.

Start Button

The Excel Workbook

Follow-along file: Not needed for this skill

Once Excel is started, a blank workbook will open on your screen. A workbook is
an Excel file that contains one or more worksheets? (sometimes referred to as
spreadsheets). Excel will assign a file name to the workbook, such as Book1, Book2,

1. An Excel file that contains one
or more worksheets.

Book3, and so on, depending on how many new workbooks are opened. Figure 1.3
"Blank Workbook" shows a blank workbook after starting Excel.

2. May also be referred to as a
spreadsheet and contains
rectangles called cells for
entering numeric and
nonnumeric data.

1.1 An Overview of Microsoft® Excel®
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Figure 1.3 Blank Workbook
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Click here to close
this workbook.

J |

Click here to
close Excel.

View buttons; currently
set to Normal View.

Zoom slider
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Files that are currently
open will appear here.

Your workbook should already be maximized (or shown at full size) once Excel is

started, as shown in Figure 1.3 "Blank Workbook". However, if your screen looks

like Figure 1.4 "Restored Worksheet" after starting Excel, you should click the

Maximize button, as shown in the figure.

Figure 1.4 Restored Worksheet
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3 Workbook file name appears
4 here instead of the top center.
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7
8

1.1 An Overview of Microsoft® Excel®

Restored workbook
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3. A specific location on a
worksheet where data are
entered and stored.

. A column letter followed by a
row number used to identify
specific cells on a worksheet.

. When cell locations are used in
formulas, Excel will reference
the data that is entered into
the cell. The cell reference is
the cell location address.

. Any group of contiguous cell
locations; a cell range is noted
as two cell locations separated
by a colon.

Navigating Worksheets

Follow-along file: Not needed for this skill

Data are entered and managed in an Excel worksheet. The worksheet contains
several rectangles called cells for entering numeric and nonnumeric data. Each cell®
in an Excel worksheet contains an address, which is defined by a column letter
followed by a row number. For example, the cell that is currently activated in
Figure 1.4 "Restored Worksheet" is A1. This would be referred to as cell location*
A1 or cell reference’ Al. The following steps explain how you can navigate in an
Excel worksheet:

1. Place your mouse pointer over cell D5 and left click.

2. Check to make sure column letter D and row number 5 are highlighted
in orange, as shown in Figure 1.5 "Activating a Cell Location".

Figure 1.5 Activating a Cell Location

@| H Wy - (- | < Bookl - Micros
Home Insert Page Layout Formulas Data Review View
] & [caibri i AN = = v S | General
- Sp === [
Paste o R (A vy === iEsE - v B
i f B 7 U~ | A é === == @ $ o 9
Clipboard Font | Alignment Numbel
D5 - Jx
A B £ F G H | ]

Column letter D and row
number 5 are highlighted in
orange, indicating cell D5

is activated.
Pz g -

w

1k
2
2
1
5]

6

7 | | The bold outline indicates Mouse pointer changes to a
8 that this cell location is block plus sign when dragged
9 activated. over the cells of a worksheet.

3. Move the mouse pointer to cell Al.
Click and hold the left mouse button and drag the mouse pointer back
to cell D5.

5. Release the left mouse button. You should see several cells highlighted,
as shown in Figure 1.6 "Highlighting a Range of Cells". This is referred
to as a cell range® and is documented as follows: A1:D5. Any two cell
locations separated by a colon are known as a cell range. The first cell

1.1 An Overview of Microsoft® Excel® 11
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1.1 An Overview of Microsoft® Excel®

is the top left corner of the range, and the second cell is the lower right

corner of the range.

Figure 1.6 Highlighting a Range of Cells
| - -

¥

“ Home  Insert  Page Layout  Formulas  Data

Book1l - Mic

Review View

e
j % caibri SR N EE v S | |General
Paste A B 7 U Sy A o — ES g
= f ur- o Tan'| = = i~ | $ * %
Clipboard I Font Alignment I~ Nun

Al v ke

E T — Gl ) E F G H I J

=

2

T

l-— is highlighted.

L4

5

6

7

8

)

10

phl

12
13
14
15
16
17
18
19
20
21
22
23
24

Click the tab to
open the worksheet

Click here to add a new
worksheet to the workbook

M 4> )

Sheet1 /Sheet2 /Sheet3 /%3

Ready |

[Insert Worksheet (Shift+F11)}

6. Click the Sheet3 worksheet tab at the bottom of the worksheet. This is
how you open a worksheet within a workbook.

7. Click the Sheet1 worksheet tab at the bottom of the worksheet to
return to the worksheet shown in Figure 1.6 "Highlighting a Range of

Cells".

12



Chapter 1 Fundamental Skills

7. The upper area of the Excel
screen that contains several
tabs running across the top.
Each tab provides access to a
different set of Excel
commands.

Mouseless Commands

Basic Worksheet Navigation

+ Use the arrow keys on your keyboard to activate cells on the
worksheet.

« Hold the SHIFT key and press the arrow keys on your keyboard to
highlight a range of cells in a worksheet.

+ Hold the CTRL key while pressing the PAGE DOWN or PAGE UP keys
to open other worksheets in a workbook.

The Excel Ribbon

Follow-along file: Not needed for this skill

Excel’s features and commands are found in the Ribbon’, which is the upper area of
the Excel screen that contains several tabs running across the top. Each tab
provides access to a different set of Excel commands. Figure 1.7 "Ribbon for Excel"
shows the commands available in the Home tab of the Ribbon. Table 1.1 "Command
Overview for Each Tab of the Ribbon" provides an overview of the commands that
are found in each tab of the Ribbon.

Figure 1.7 Ribbon for Excel

1| | - @ Book1 - Microsoft Excel SRt
Home | Insert  Pagelayout Formulas  Data  Review  View a@o@ =
= X [cabn u A = ) (i E=eet  E-
i S General - =| (W = 7
=) S £ ! axodae- g L
Past B 7 U By A | v o 5 | =0 .00 Conditional Formatas fell | pu. . Sort& Find&
e B 3-% 00 30| cormatting v Table v Stfles ~ FdFormat v | B+ Fiterv selectr

_Number Styles Cells Editing

The Home tab of the | 1 1 J K L
Ribbon is activated.

the Ribbon (Ctrl+F1)

ini
B ames on the
Click here to ibbon.
minimize the Ribbon.

The Ribbon

Table 1.1 Command Overview for Each Tab of the Ribbon

Tab .-
Description of Commands
Name
File Also known as the Backstage view of the Excel workbook. Contains all
commands for opening, closing, saving, and creating new Excel workbooks.

1.1 An Overview of Microsoft® Excel® 13
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Includes print commands, document properties, e-mailing options, and help
features. The default settings and options are also found in this tab.

Home

Contains the most frequently used Excel commands. Formatting commands are
found in this tab along with commands for cutting, copying, pasting, and for
inserting and deleting rows and columns.

Insert

Used to insert objects such as charts, pictures, shapes, PivotTables, Internet
links, symbols, or text boxes.

Page
Layout

Contains commands used to prepare a worksheet for printing. Also includes
commands used to show and print the gridlines on a worksheet.

Formulas

Includes commands for adding mathematical functions to a worksheet. Also
contains tools for auditing mathematical formulas.

Data

Used when working with external data sources such as Microsoft® Access®, text
files, or the Internet. Also contains sorting commands and access to scenario
tools.

Review

Includes Spelling and Track Changes features. Also contains protection
features to password protect worksheets or workbooks.

View

Used to adjust the visual appearance of a workbook. Common commands
include the Zoom and Page Layout view.

The Ribbon shown in Figure 1.7 "Ribbon for Excel" is full, or maximized. The benefit
of having a full Ribbon is that the commands are always visible while you are
developing a worksheet. However, depending on the screen dimensions of your
computer, you may find that the Ribbon takes up too much vertical space on your

worksheet.

If this is the case, you can minimize the Ribbon by clicking the button

shown in Figure 1.7 "Ribbon for Excel". When minimized, the Ribbon will show only

the tabs and not the command buttons. When you click on a tab, the command
buttons will appear until you select a command or click anywhere on your

worksheet.

1.1 An Overview of Microsoft® Excel®
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8. Located at the upper-left side
of the Excel screen above the
Ribbon, this toolbar provides
access to the most frequently
used commands, such as Save
and Undo.

Mouseless Commands
Minimizing or Maximizing the Ribbon

+ Hold down the CTRL key and press the F1 key.
+ Hold down the CTRL key and press the F1 key again to maximize
the Ribbon.

Quick Access Toolbar and Right-Click Menu

Follow-along file: Not needed for this skill

The Quick Access Toolbar® is found at the upper left side of the Excel screen above
the Ribbon, as shown in Figure 1.3 "Blank Workbook". This area provides access to
the most frequently used commands, such as Save and Undo. You also can
customize the Quick Access Toolbar by adding commands that you use on a regular
basis. By placing these commands in the Quick Access Toolbar, you do not have to
navigate through the Ribbon to find them. To customize the Quick Access Toolbar,
click the down arrow as shown in Figure 1.8 "Customizing the Quick Access
Toolbar". This will open a menu of commands that you can add to the Quick Access
Toolbar. If you do not see the command you are looking for on the list, select the
More Commands option.

1.1 An Overview of Microsoft® Excel® 15
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Figure 1.8 Customizing the Quick Access Toolbar
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In addition to the Ribbon and Quick Access Toolbar, you can also access commands
by right clicking anywhere on the worksheet. Figure 1.9 "Right-Click Menu" shows
an example of the commands available in the right-click menu.

1.1 An Overview of Microsoft® Excel®

16
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9. This view, which is opened
through the File tab on the
Ribbon, contains a variety of
features and commands related
to the workbook that is
currently open.

Figure 1.9 Right-Click Menu
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The File Tab

Follow-along file: Not needed for this skill

If you have used Office 2007, you may have noticed that the Office button has

disappeared in the 2010 version. It has been replaced with the File tab on the far left

side of the Ribbon. The File tab is also known as the Backstage view’ of the

workbook. It contains a variety of features and commands related to the workbook

that is currently open, new workbooks, or workbooks stored in other locations on

your computer or network. Figure 1.10 "File Tab or Backstage View of a Workbook"
shows the options available in the File tab or Backstage view. To leave the Backstage
view and return to the worksheet, click any tab on the Ribbon or click the image of

the worksheet on the right side of the window. You must click the Info button

(highlighted in green in Figure 1.10 "File Tab or Backstage View of a Workbook") to
see the image of your worksheet on the right side of the window.

1.1 An Overview of Microsoft® Excel®

17



Chapter 1 Fundamental Skills

Figure 1.10 File Tab or Backstage View of a Workbook
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Save & Send
Hel — Versions
el 5 o . = . o
P «L(ja &) There are no previous versions of this file.
] options Manage Click here to leave the backstage
E = Versions ~ view and return to your worksheet.

Click here to open the
Save As dialog box.

Protect

Prepare for Sharing

Click here to view all the
default settings for Excel.

Properties v
Size

Title

Tags
Categories
Related Dates
Last Modified Today, 8:32 PM
Created Today, 10:09 AM

Last Printed

Related People

Author Joseph

Last Modified By

show All Properties

The document properties
are listed here.

Included in the File tab are the default settings for the Excel application that can be
accessed and modified by clicking the Options button. Figure 1.11 "Excel Options
Window" shows the Excel Options window, which gives you access to settings such
as the default font style, font size, and the number of worksheets that appear in
new workbooks.

1.1 An Overview of Microsoft® Excel®
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Figure 1.11 Excel Options Window

Excel Options
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listed here. of worksheets that appear in a
new workbook.

Saving Workbooks (Save As)

Follow-along file: Not needed for this skill

Once you create a new workbook, you will need to change the file name and choose
a location on your computer or network to save it. The following steps explain how
to save a new workbook and assign it a file name. It is important to remember
where you save this workbook on your computer or network as you will be using
this file in the Section 1.2 "Entering, Editing, and Managing Data" to construct the
workbook shown in Figure 1.1 "Example of an Excel Worksheet with Embedded
Chart".

1.1 An Overview of Microsoft® Excel®

If you have not done so already, start Excel. A blank workbook should
appear on your screen. Check to make sure the workbook is maximized
(see Figure 1.4 "Restored Worksheet").

Click the File tab.

Click the Save As button in the upper left side of the Backstage view
window, as shown in Figure 1.10 "File Tab or Backstage View of a
Workbook". This will open the Save As dialog box.

Click in the File Name box at the bottom of the Save As dialog box.
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5. Use the BACKSPACE key to remove the current file name of the

workbook.

6. Type the file name: Excel Objective 1.0.
7. Click the Desktop button on the left side of the Save As dialog box if

you wish to save this file on your desktop. If you want to save this
workbook in a different location on your computer or network, double
click the Computer option, as shown in Figure 1.12 "Save As Dialog

Box", and select your preferred location.
8. Click the Save button on the lower right side of the Save As dialog box.

Figure 1.12 Save As Dialog Box

Save As
@@v ‘- Desktop » v‘ g | | Search Desktop bl |
Organize ¥ New folder = - 2]
»
& Name Size Item type Date modified
4 .| Favorites b (it

« Libraries
| B Desktop ‘ Y
e i et D R Joseph M. Manzo _

Js Downloads E Double click here to select a new

& Computer 4

location on your computer or

«» Recent Places

@ Network

[Shows the disk drives and hardware connected to this computer. ]

network.

~J Libraries

> ., Documents
b & Music

Click here to type a new
file name for the workbook.

> & Pictures
> |

/ 111 | »

. B oveaoo o
File name: Excel Objecitve 1.0 A/

Save as type: [Excel Workbook (*xlIsx)

l—

Authors: Joseph M. Manzo
Click here to save a

workbook on your
desktop.

[] Save Thumbnail

#' Hide Folders

1.1 An Overview of Microsoft® Excel®

Tags: Add a tag

Click here to select and save the
workbook as a different file type

Tools v \such as an older version of Office.

—
Click here to save |
your workbook.
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Mouseless Commands

Save As

+ Press the F12 key and use the tab and arrow keys to navigate

around the Save As dialog box. Use the ENTER key to make a
selection.

Or press the ALT key on your keyboard. You will see letters and
numbers, called Key Tips, appear on the Ribbon. Press the F key on
your keyboard for the File tab and then the A key. This will open
the Save As dialog box.

Skill Refresher: Saving Workbooks (Save As)

(click to see video)

Qe = W N =

Click the File tab on the Ribbon.

Click the Save As option.

Select a location on your PC or network.

Click in the File name box and type a new file name if needed.
Click the down arrow next to the “Save as type” box and select the
appropriate file type if needed.

Click the Save button.

Excel 97-2003 File Type

Follow-along file: Open a blank workbook.

If you are working with someone who is using a version of Microsoft Office that is
older than Office 2007, you will have to save your workbook under the Excel 97-2003
Workbook format. A person who is running Office 2003 will not be able to open
workbooks that are saved under the Office 2010 or Office 2007 file types. You can
save a workbook as an Excel 97-2003 file type by clicking the down arrow next to
the “Save as type” box in the Save As dialog box (see Figure 1.12 "Save As Dialog

Box").

1.1 An Overview of Microsoft® Excel®
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You can also change the file type of your workbook by using the File tab on the

Ribbon. The

G e e

following steps explain this method:

Open the workbook you wish to convert to the Excel 97-2003 file type.
Click the File tab on the Ribbon.

Click the Save & Send button on the left side of the Backstage view.
Click the Change File Type button.

Double click the Excel 97-2003 Workbook option on the right side of
the Backstage view. This will open up the Save As dialog box and set
the file type box to Excel 97-2003 Workbook (see Figure 1.13 "Changing
the File Type of a Workbook").

Check to make sure the Save As dialog box is set to the location where
you want to save your workbook.

Click the Save button at the bottom of the Save As dialog box.

Figure 1.13 Changing the File Type of a Workbook

@]

Book1 - Microsoft Excel

Insert Page Layout Formulas Data Review  View

H Save
Save As
[£5 Open
|_‘j Close

Info
Recent
New

Print

Save & Send

Help

[7_-1 Options

E Exit

Save & Send
L[-]:v'. Send Using E-mail
0 Save to Web

Change File Type

Workbook File Types
@ I Workbook

E0l | Uses the Excel Spreadsheet format

Excel 97-2003 Workbook ‘

an Soues s BbsreB ik Uses the Excel 97-2003 Spreadsheet —
s format k
i OpenDocument Spreadsheet
File Types L‘Fb P =0 P
=| Uses the OpenDocument Spreadsheet

} format

‘ i l
@ Macro-Enabled Workbook
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the file type of your workbook
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Binary Workbool
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Click here to view
a list of file types.

Save and e-mail options

Other File Types
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Text (Tab delimited)
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1.1 An Overview of Microsoft® Excel®

CSV (Comma delimited)
Text format separated by commas

‘E_a,j

Use these options

to save a worksheet
as a text file.
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10. Located below the worksheet
tabs on the Excel screen, it
displays a variety of
information, such as the status
of certain keys on your
keyboard (e.g., CAPS LOCK), the
available views for a workbook,
the magnification of the
screen, or mathematical
functions that can be
performed when data are
highlighted on a worksheet.

1.1 An Overview of Microsoft® Excel®

Why?
No Office 2007 File Type

Workbooks that are created in Office 2010 are automatically compatible with
Office 2007. A person who is running Office 2007 will be able to open, edit, and
save workbooks created in Office 2010.

When you convert an existing workbook created in Office 2010 to the Excel 97-2003
file type, you may not notice any changes on the workbook itself. If you are using a
feature or format that is not compatible with Office 97-2003, a warning will appear
upon saving the file. You may want to remove these features and formats before
sending the workbook to a person who is running an older version of Office. When
you open a file that is saved in the Excel 97-2003 format, you will see the
Compatibility Mode indicator next to the workbook name, as shown in Figure 1.14
"Workbook That Has Been Saved in Excel 97-2003 Format".

Figure 1.14 Workbook That Has Been Saved in Excel 97-2003 Format

izl] [ s R e ] = Bookl [Compatibility Mode] - Microsoft Excel
“ Home Insert Page Layout Formulas Data Review View
= ‘

. Calibri vl v A AT = =] B =i GeNeral v :F:‘ F
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Paste B 7 U~ e & A === =55 |- o, o | =0 .00 Conditional Format

B =2 £ -— | = = = T 53 $ fo 00 30 £ormatting > Table
Clipboard . Font Alignment Number - Styles
Al - b \

This indicates that the L M

workbook has been saved
as an Excel 97-2003 file type.

N |
>

N w

(e}

o

.

Dl

@

The Status Bar

Follow-along file: Continue with a blank workbook or open a new one.

The Status Bar' is located below the worksheet tabs on the Excel screen (see

Figure 1.15 "Customizing the Status Bar"). It displays a variety of information, such
as the status of certain keys on your keyboard (e.g., CAPS LOCK), the available views

for a workbook, the magnification of the screen, and mathematical functions that
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can be performed when data are highlighted on a worksheet. You can customize the

Status Bar as follows:

1. Place the mouse pointer over any area of the Status Bar and right click

(see Figure 1.15 "Customizing the Status Bar").

2. Select the Caps Lock option from the menu (see Figure 1.15

'Customizing the Status Bar").

3. Press the CAPS LOCK key on your keyboard. You will see the Caps Lock
indicator on the lower right side of the Status Bar.
4. Press the CAPS LOCK key again. The indicator on the Status Bar goes

away.

Figure 1.15 Customizing the Status Bar
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Follow-along file: Continue with a blank workbook or open a new one.

The Help feature provides extensive information about the Excel application.

Although some of this information may be stored on your computer, the Help
window will automatically connect to the Internet, if you have a live connection, to
provide you with resources that can answer most of your questions. You can open
the Excel Help window by clicking the question mark in the upper right corner of
the screen (see Figure 1.3 "Blank Workbook"). Here you can search for specific

topics or type a question in the upper-left side of the window, as shown in Figure
1.16 "Excel Help Window".

1.1 An Overview of Microsoft® Excel®
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Figure 1.16 Excel Help Window
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+ Press the F1 key on your keyboard.
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KEY TAKEAWAYS

1.1 An Overview of Microsoft® Excel®

Excel is a powerful tool for processing data for the purposes of making
decisions.

You can find Excel commands throughout the tabs in the Ribbon.

You can customize the Quick Access Toolbar by adding commands you
frequently use.

You must save your workbook in the Excel 97-2003 file format when
sharing workbooks with people who are running Microsoft Office 2003
and older versions.

Office 2007 can open files created in Office 2010.

You can add or remove the information that is displayed on the Status
Bar.

The Help window provides you with extensive information about Excel.
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EXERCISES

1. Which of the following responses best defines the notation
A1:B157

1.1 An Overview of Microsoft® Excel®

The contents in cell A1l are identical to the contents in cell
B15.

b. The cells between A1 and B15 are hidden.

A cell range or contiguous group of cells that begins with cell
A1 and include all cells up to and including cell B15.
A cell link that connects cell A1 to B15.

2. The Spell Check feature is in which tab of the Excel Ribbon?

fo op

Home
Review
Data
Formulas

3. Holding down the CTRL key and pressing the F1 key on your
keyboard is used to

o op

minimize the Ribbon

open the Excel Help window
save a workbook

switch between open workbooks

4. If you are sending an Excel workbook created in Office 2010 to a
person who is running Office 2007, you should do the following:

Use the Save As command to save the workbook in the Office
2007 file format.

Use the Save As command to save the workbook in the Excel
97-2003 file format.

Use the Save As command to save the workbook in the
Universal Compatibility format.

Nothing. Office 2007 can open files created in Office 2010.
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1.2 Entering, Editing, and Managing Data

LEARNING OBJECTIVES

Understand how to enter data into a worksheet.

Examine how to edit data in a worksheet.

Examine how Auto Fill is used when entering data.

Understand how to delete data from a worksheet and use the Undo
command.

Examine how to adjust column widths and row heights in a worksheet.
Understand how to hide columns and rows in a worksheet.

Examine how to insert columns and rows into a worksheet.
Understand how to delete columns and rows from a worksheet.

Learn how to move data to different locations in a worksheet.

B W N =

© g N ey &

In this section, we will begin the development of the workbook shown in Figure 1.1
"Example of an Excel Worksheet with Embedded Chart". The skills covered in this
section are typically used in the early stages of developing one or more worksheets
in a workbook.

Entering Data

Follow-along file: Excel Objective 1.0 (This is a blank workbook that was named in
the previous section. If you skipped the previous section, open a new workbook and
save it with the file name “Excel Objective 1.0.”)

We will begin building the workbook shown in Figure 1.1 "Example of an Excel
Worksheet with Embedded Chart" by manually entering data into the worksheet.
There are other ways in which you can bring data into an Excel worksheet, such as
importing data from a website or a Microsoft Access database. However, we will
demonstrate these other methods later. The following steps explain how the
column headings in Row 2 are typed into the worksheet:

1. Activate cell location A2 on the worksheet.

2. Type the word Month.

3. Press the RIGHT ARROW key. This will enter the word into cell A2 and
activate the next cell to the right.

4. Type Unit Sales and press the RIGHT ARROW key.
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1.2 Entering, Editing, and Managing Data

5. Repeat step 4 for the words Average Price and Sales Dollars.

Figure 1.17 "Entering Column Headings into a Worksheet" shows how
your worksheet should appear after you have typed the column
headings into Row 2. Notice that the word Price in cell location C2 is not
visible. This is because the column is too narrow to fit the entry you
typed. We will examine formatting techniques to correct this problem
in the next section.

Figure 1.17 Entering Column Headings into a Worksheet

(¥]

d - = Excel Objective 1.(
Home Insert Page Layout Formulas Data Review View
j & calibri =L = A‘ L= — E‘ @,- Eﬁ General
2L B 7 U- - A EESEEH §$-%
Clipboard Font Alignment 5 MNut
c2 - fx | Average Price

A B C D E E G

Content in the activated

1

. cell appears here in the formula.
2 |Month Unit SaleslAverage PISaIes Dollars
3

The word Price is cut off
4 -
because the column is too narrow.

Integrity Check

Column Headings

It is critical to include column headings that accurately describe
the data in each column of a worksheet. In professional
environments, you will likely be sharing Excel workbooks with
coworkers. Good column headings reduce the chance of someone
misinterpreting the data contained in a worksheet, which could
lead to costly errors depending on your career.

. Activate cell location B3.
. Type the number 2670 and press the ENTER key. After you press the

ENTER key, cell B4 will be activated. Using the ENTER key is an efficient
way to enter data vertically down a column.
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8. Repeat step 7 by entering the following numbers in cells B4 through
B14: 2160, 515, 590, 1030, 2875, 2700, 900, 775, 1180, 1800, and 3560.

Why?

Avoid Formatting Symbols When Entering Numbers

When typing numbers into an Excel worksheet, it is best to avoid
adding any formatting symbols such as dollar signs and commas.
Although Excel allows you to add these symbols while typing
numbers, it slows down the process of entering data. It is more
efficient to use Excel’s formatting features to add these symbols to
numbers after you type them into a worksheet.

9. Activate cell location C3.

10. Type the number 9.99 and press the ENTER key.

11. Repeat step 10 by entering the following numbers in cells C4 through
C14:12.49,14.99, 17.49, 14.99, 12.49, 9.99, 19.99, 19.99, 19.99, 17.49,
and 14.99.

12. Activate cell location D3.

13. Type the number 26685 and press the ENTER key.

14. Repeat step 13 by entering the following numbers in cells D4 through
D14: 26937, 7701, 10269, 15405, 35916, 26937, 17958, 15708, 23562,
31416, and 53370.

Integrity Check

Data Entry

It is very important to proofread your worksheet carefully, especially when you
have entered numbers. Transposing numbers when entering data manually into
a worksheet is a common error. For example, the number 563 could be
transposed to 536. Such errors can seriously compromise the integrity of your
workbook.

1.2 Entering, Editing, and Managing Data 30
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Figure 1.18 "Completed Data Entry for Columns B, C, and D" shows how your

worksheet should appear after entering the data. Check your numbers carefully to
make sure they are accurately entered into the worksheet.

Figure 1.18 Completed Data Entry for Columns B, C, and D
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Editing Data

Follow-along file: Excel Objective 1.0 (Use file Excel Objective 1.01 if you are starting
with this skill.)

Data that has been entered in a cell can be changed by double clicking the cell

location or using the Formula Bar''. You may have noticed that as you were typing

data into a cell location, the data you typed appeared in the Formula Bar. The

Formula Bar can be used for entering data into cells as well as for editing data that
already exists in a cell. The following steps provide an example of entering and then

11. The area just above the column
letters on a worksheet. It can
be used for entering data into
cells as well as for editing data
that already exists in cells.

1.2 Entering, Editing, and Managing Data

editing data that has been entered into a cell location:

1. Activate cell A15 in the Sheet1 worksheet.
2. Type the abbreviation Tot and press the ENTER key.
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3. Click cell A15.
Move the mouse pointer up to the Formula Bar. You will see the
pointer turn into a cursor. Move the cursor to the end of the
abbreviation Tot and left click.

5. Type the letters al to complete the word Total.

6. Click the checkmark to the left of the Formula Bar (see Figure 1.19
"Using the Formula Bar to Edit and Enter Data"). This will enter the
change into the cell.

Figure 1.19 Using the Formula Bar to Edit and Enter Data
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9 2700 9.99 26937

10 900 19.99 17958

11 775 19.99 15708

12 1180 19.99 23562

13 1800 17.49 31416

14 3560 14.99 5337
15 |Total | < Active cell

1A

7. Double click cell A15.
8. Add a space after the word Total and type the word Sales.
9. Press the ENTER key.

1.2 Entering, Editing, and Managing Data
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12.

13.

An Excel feature used to
complete data in either a
quantitative or qualitative
sequence. It can also be used to
copy and paste data in a
worksheet.

A small square in lower right
corner of an activated cell.
When the mouse pointer gets
close to the Fill Handle, the
white block plus sign turns into
a black plus sign.

Mouseless Command

Editing Data in a Cell

« Activate the cell that is to be edited and press the F2 key on your
keyboard.
Auto Fill

Follow-along file: Excel Objective 1.0 (Use file Excel Objective 1.02 if you are starting
with this skill.)

The Auto Fill'* feature is a valuable tool when manually entering data into a
worksheet. This feature has many uses, but it is most beneficial when you are
entering data in a defined sequence, such as the numbers 2, 4, 6, 8, and so on, or
nonnumeric data such as the days of the week or months of the year. The following
steps demonstrate how Auto Fill can be used to enter the months of the year in
Column A:

Activate cell A3 in the Sheet1 worksheet.
Type the word January and press the ENTER key.
Activate cell A3 again.

=W N =

Move the mouse pointer to the lower right corner of cell A3. You will
see a small square in this corner of the cell; this is called the Fill
Handle" (see Figure 1.20 "Fill Handle"). When the mouse pointer gets
close to the Fill Handle, the white block plus sign will turn into a black
plus sign.
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1.2 Entering, Editing, and Managing Data

Figure 1.20 Fill Handle
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5. Left click and drag the Fill Handle to cell A14. Notice that the Auto Fill
tip box indicates what month will be placed into each cell (see Figure

1.21 "Using Auto Fill to Enter the Months of the Year"). Release the left

mouse button when the tip box reads “December.”
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Figure 1.21 Using Auto Fill to Enter the Months of the Year

2|

Home Insert Page Layout Formulas D
j ®  [aibri vl A AT ==
- »

Besls BIU- B 3 A =3
Clipboard T | Font M

‘ A3 - Jx | January

A B C D

1
2 |Month Unit Sales Average PiSales Dollars
3 January 2670 9.99 26685
4 2160 12.49 26937
5 515 14.99 7701
6 590 17 .
The mouse pointer

7 1030 ‘| changes to a black plus
8 2875 sign when it is placed
9 2700 over the Fill Handle.
10 19.99 I7958
1l | 19.99 15708
12 19.99 23562
13 17.49 31416
14 14. canza

o This tip box indicates that
15 Total Sales the word December will be
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Once you release the left mouse button, all twelve months of the year
should appear in the cell range A3:A14, as shown in Figure 1.22 "Auto
Fill Options Button". You will also see the Auto Fill Options button. By
clicking this button, you have several options for inserting data into a
group of cells.
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Figure 1.22 Auto Fill Options Button
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Fill Months

6. Left click the Auto Fill Options button.

7. Left click the Copy Cells option. This will change the months in the
range A4:A14 to January.

8. Left click the Auto Fill Options button again.

9. Left click the Fill Months option to return the months of the year to the
cell range A4:A14. The Fill Series option will provide the same result.

Deleting Data and the Undo Command

Follow-along file: Excel Objective 1.0 (Use file Excel Objective 1.03 if you are starting
with this skill.)

There are several methods for removing data from a worksheet, a few of which are
demonstrated here. With each method, you use the Undo command. This is a
helpful command in the event you mistakenly remove data from your worksheet.
The following steps demonstrate how you can delete data from a cell or range of
cells:
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. Activate cell C2 by placing the mouse pointer over the cell and clicking

the left mouse button.
Press the DELETE key on your keyboard. This removes the contents of

the cell.

Highlight the range C3:C14 by placing the mouse pointer over cell C3.

Then left click and drag the mouse pointer down to cell C14.
4. Place the mouse pointer over the Fill Handle. You will see the white
block plus sign change to a black plus sign.

5. Left click and drag the mouse pointer up to cell C3 (see Figure 1.23
"Using Auto Fill to Delete Contents of Cell"). Release the mouse button.

The contents in the range C3:C14 will be removed.

Figure 1.23 Using Auto Fill to Delete Contents of Cell
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3370 The Fill Handle was
dragged up the column.

6. Click the Undo button in the Quick Access Toolbar (see Figure 1.3

"Blank Workbook"). This should replace the data in the range C3:C14.

7. Click the Undo button again. This should replace the data in cell C2.
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Mouseless Command

Undo Command

> Hold down the CTRL key while pressing the letter Z on your
keyboard.

8. Highlight the range C2:C14 by placing the mouse pointer over cell C2.
Then left click and drag the mouse pointer down to cell C14.

9. Click the Clear button in the Home tab of the Ribbon, which is next to
the Cells group of commands (see Figure 1.24 "Clear Command Drop-
Down Menu"). This opens a drop-down menu that contains several
options for removing or clearing data from a cell. Notice that you also
have options for clearing just the formats in a cell or the hyperlinks in
a cell.

10. Click the Clear All option. This removes the data in the cell range.
11. Click the Undo button. This replaces the data in the range C2:C14.

Figure 1.24 Clear Command Drop-Down Menu
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14. A box that appears when the
width of a column is being
adjusted using the click-and-
drag method. It displays the
number of characters that will
fit into the column using
Calibri 11-point font.

Adjusting Columns and Rows

Follow-along file: Excel Objective 1.0 (Use file Excel Objective 1.03 if you are starting
with this skill.)

In Figure 1.22 "Auto Fill Options Button", there are a few entries that appear cut off.
For example, the last letter of the word September cannot be seen in cell A11. This is
because the column is too narrow for this word. The columns and rows on an Excel
worksheet can be adjusted to accommodate the data that is being entered into a
cell. The following steps explain how to adjust the column widths and row heights
in a worksheet:

1. Bring the mouse pointer between Column A and Column B in the
Sheet1 worksheet, as shown in Figure 1.25 "Adjusting Column Widths".
You will see the white block plus sign turn into double arrows.

2. Left click and drag the column to the right so the entire word
September in cell A11 can be seen. As you drag the column, you will see
the column width tip box'*. This box displays the number of
characters that will fit into the column using the Calibri 11-point font.

3. Release the left mouse button.
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Figure 1.25 Adjusting Column Widths
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You may find that using the click-and-drag method is inefficient if you
need to set a specific character width for one or more columns. Steps 4
through 7 illustrate a second method for adjusting column widths
when using a specific number of characters:

4. Activate any cell location in Column A by moving the mouse pointer
over a cell location and clicking the left mouse button. You can
highlight cell locations in multiple columns if you are setting the same
character width for more than one column.

5. Inthe Home tab of the Ribbon, left click the Format button in the Cells
group (see Figure 1.26 "Cells Group in the Home Tab").

6. Click the Column Width option from the drop-down menu (see Figure
1.27 "Format Drop-Down Menu"). This will open the Column Width
dialog box.

7. Type the number 13 and click the OK button on the Column Width
dialog box. This will set Column A to this character width (see Figure

1.28 "Column Width Dialog Box").
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Figure 1.26 Cells Group in the Home Tab
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Figure 1.27 Format Drop-Down Menu
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Figure 1.28 Column Width Dialog Box
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Mou

Mouseless Command

Column Width

o Press the ALT key on your keyboard, then press the letters H,
0, and W one at a time.

Steps 8 through 10 demonstrate how to adjust row height, which is
similar to adjusting column width:

8. Activate cell A15 by placing the mouse pointer over the cell and
clicking the left mouse button.
9. In the Home tab of the Ribbon, left click the Format button in the Cells
group (see Figure 1.26 "Cells Group in the Home Tab").
10. Click the Row Height option from the drop-down menu (see Figure 1.27
"Format Drop-Down Menu"). This will open the Row Height dialog box.
11. Type the number 24 and click the OK button on the Row Height dialog
box. This will set Row 15 to a height of 24 points. A point" is
equivalent to approximately 1/72 of an inch. This adjustment in row
height was made to create space between the totals for this worksheet
and the rest of the data.

seless Command

Row Height

Figure 1

« Press the ALT key on your keyboard, then press the letters H, O,
and H one at a time.

.29 "Excel Objective 1.0 with Column A and Row 15 Adjusted" shows the

appearance of the worksheet after Column A and Row 15 are adjusted.

15. Metric used when measuring
the height of a row; equivalent
to approximately 1/72 of an
inch.

1.2 Entering, Editing, and Managing Data
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Figure 1.29 Excel Objective 1.0 with Column A and Row 15 Adjusted
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1
17

Row heights can be adjusted by
placing the mouse pointer between
two row numbers and clicking and

dragging to the desired height.

Skill Refresher: Adjusting Columns and Rows

(click to see video)

Activate at least one cell in the row or column you are adjusting.

Click the Home tab of the Ribbon.

Click the Format button in the Cells group.

Click either Row Height or Column Width from the drop-down

menu.

5. Enter the Row Height in points or Column Width in characters in
the dialog box.

6. Click the OK button.

=W N =
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Hiding Columns and Rows

Follow-along file: Excel Objective 1.0 (Use file Excel Objective 1.04 if you are starting

with this skill.)

In addition to adjusting the columns and rows on a worksheet, you can also hide
columns and rows. This is a useful technique for enhancing the visual appearance of
a worksheet that contains data that is not necessary to display. These features will
be demonstrated using the Excel Objective 1.0 workbook. However, there is no need
to have hidden columns or rows for this worksheet. The use of these skills here will

be for demonstration purposes only.

1. Activate cell C1 in the Sheet1 worksheet by placing the mouse pointer
over the cell location and clicking the left mouse button.

2. Click the Format button in the Home tab of the Ribbon.

3. Place the mouse pointer over the Hide & Unhide option in the drop-
down menu (see Figure 1.27 "Format Drop-Down Menu"). This will

open a submenu of options.

4. Click the Hide Columns option in the submenu of options (see Figure
1.30 "Hide & Unhide Submenu"). This will hide Column C.

Figure 1.30 Hide & Unhide Submenu
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Protection
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AL LAk rall

o Hold down the CTRL key while pressing the number 0 on your

keyboard.
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Figure 1.31 "Hidden Column" shows the workbook with Column C

hidden in the Sheet1 worksheet. You can tell a column is hidden by the

missing letter C.

Figure 1.31 Hidden Column
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To unhide a column,

follow these steps:

dragging over to cell D1.

. Highlight the range B1:D1 by activating cell B1 and clicking and

. Click the Format button in the Home tab of the Ribbon.
. Place the mouse pointer over the Hide & Unhide option in the drop-

down menu (see Figure 1.27 "Format Drop-Down Menu").

. Click the Unhide Columns option in the submenu of options (see Figure

1.30 "Hide & Unhide Submenu"). Column C will now be visible on the

worksheet.
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10.
11.

12.

13.

14.
15.

16.

Mouseless Command

Unhiding Columns

o Highlight cells on either side of the hidden column(s), then
hold down the CTRL key and the SHIFT key while pressing the
close parenthesis key ()) on your keyboard.

The following steps demonstrate how to hide rows, which is similar to
hiding columns:

Activate cell A3 in the Sheet1 worksheet by placing the mouse pointer
over the cell location and clicking the left mouse button.

Click the Format button in the Home tab of the Ribbon.

Place the mouse pointer over the Hide & Unhide option in the drop-
down menu (see Figure 1.27 "Format Drop-Down Menu"). This will
open a submenu of options.

Click the Hide Rows option in the submenu of options (see Figure 1.30
"Hide & Unhide Submenu"). This will hide Row 3.

Mouseless Command

Hiding Rows

o Hold down the CTRL key while pressing the number 9 key on
your keyboard.

To unhide a row, follow these steps:

Highlight the range A2:A4 by activating cell A2 and clicking and
dragging over to cell A4.

Click the Format button in the Home tab of the Ribbon.

Place the mouse pointer over the Hide & Unhide option in the drop-
down menu (see Figure 1.27 "Format Drop-Down Menu").

Click the Unhide Rows option in the submenu of options (see Figure
1.30 "Hide & Unhide Submenu"). Row 3 will now be visible on the
worksheet.
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Mouseless Command
Unhiding Rows

+ Highlight cells above and below the hidden row(s), then hold down
the CTRL key and the SHIFT key while pressing the open
parenthesis key (() on your keyboard.

Integrity Check
Hidden Rows and Columns

In most careers, it is common for professionals to use Excel workbooks that
have been designed by a coworker. Before you use a workbook developed by
someone else, always check for hidden rows and columns. You can quickly see
whether a row or column is hidden if a row number or column letter is missing.

Skill Refresher: Hiding Columns and Rows

(click to see video)

Activate at least one cell in the row(s) or column(s) you are hiding.
Click the Home tab of the Ribbon.

Click the Format button in the Cells group.

Place the mouse pointer over the Hide & Unhide option.

Click either the Hide Rows or Hide Columns option.

G v W N =
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Skill Refresher: Unhiding Columns and Rows

(click to see video)

1. Highlight the cells above and below the hidden row(s) or to the left
and right of the hidden column(s).

Click the Home tab of the Ribbon.

Click the Format button in the Cells group.

Place the mouse pointer over the Hide & Unhide option.

Click either the Unhide Rows or Unhide Columns option.

Qg b W DN

Inserting Columns and Rows

Follow-along file: Excel Objective 1.0 (Use file Excel Objective 1.04 if you are starting
with this skill.)

Using Excel workbooks that have been created by others is a very efficient way to
work because it eliminates the need to create data worksheets from scratch.
However, you may find that to accomplish your goals, you need to add additional
columns or rows of data. In this case, you can insert blank columns or rows into a
worksheet. The following steps demonstrate how to do this:

1. Activate cell C1 in the Sheet1 worksheet by placing the mouse pointer
over the cell location and clicking the left mouse button.

2. Click the down arrow on the Insert button in the Home tab of the
Ribbon (see Figure 1.32 "Insert Button (Down Arrow)").
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Figure 1.32 Insert Button (Down Arrow)
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3. Click the Insert Sheet Columns option from the drop-down menu (see
Figure 1.33 "Insert Drop-Down Menu"). A blank column will be inserted
to the left of Column C. The contents that were previously in Column C
now appear in Column D. Note that columns are always inserted to the
left of the activated cell.

Mouseless Command

Inserting Columns

o Press the ALT key and then the letters H, I, and C one at a time.
A column will be inserted to the left of the activated cell.
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Figure 1.33 Insert Drop-Down Menu
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4. Activate cell A3 in the Sheet1 worksheet by placing the mouse pointer
over the cell location and clicking the left mouse button.

5. Click the down arrow on the Insert button in the Home tab of the
Ribbon (see Figure 1.32 "Insert Button (Down Arrow)").

6. Click the Insert Sheet Rows option from the drop-down menu (see
Figure 1.33 "Insert Drop-Down Menu"). A blank row will be inserted
above Row 3. The contents that were previously in Row 3 now appear
in Row 4. Note that rows are always inserted above the activated cell.

Mouseless Command

Inserting Rows

¢ Press the ALT key and then the letters H, I, and R one at a time. A
row will be inserted above the activated cell.
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Skill Refresher: Inserting Columns and Rows

(click to see video)

1. Activate the cell to the right of the desired blank column or below
the desired blank row.

2. Click the Home tab of the Ribbon.

3. Click the down arrow on the Insert button in the Cells group.

4, Click either the Insert Sheet Columns or Insert Sheet Rows option.

Moving Data

Follow-along file: Excel Objective 1.0 (Use file Excel Objective 1.05 if you skipped the
previous skill and are starting with this skill.)

Once data are entered into a worksheet, you have the ability to move it to different
locations. The following steps demonstrate how to move data to different locations
on a worksheet:

1. Highlight the range D2:D15 by activating cell D2 and clicking and
dragging down to cell D15.

2. Bring the mouse pointer to the left edge of cell D2. You will see the
white block plus sign change to cross arrows (see Figure 1.34 "Moving
Data"). This indicates that you can left click and drag the data to a new
location.
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Figure 1.34 Moving Data
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3. Left click and drag the mouse pointer to cell C2.

indicate that this data
is ready to be moved.

4. Release the left mouse button. The data now appears in Column C.
5. Click the Undo button in the Quick Access Toolbar. This moves the data

back to Column D.

Integrity Check

Moving Data

Before moving data on a worksheet, make sure you identify all the components
that belong with the series you are moving. For example, if you are moving a
column of data, make sure the column heading is included. Also, make sure all

values are highlighted in the column before moving it.

Deleting Columns and Rows

Follow-along file: Excel Objective 1.0 (Use file Excel Objective 1.05 if you are starting

with this skill.)

You may need to delete entire columns or rows of data from a worksheet. This need
may arise if you need to remove either blank columns or rows from a worksheet or
columns and rows that contain data. The methods for removing cell contents were
covered earlier and can be used to delete unwanted data. However, if you do not

1.2 Entering, Editing, and Managing Data
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want a blank row or column in your workbook, you can delete it using the following
steps:

1. Activate cell A3 by placing the mouse pointer over the cell location and
clicking the left mouse button.

2. Click the down arrow on the Delete button in the Cells group in the
Home tab of the Ribbon.

3. Click the Delete Sheet Rows option from the drop-down menu (see
Figure 1.35 "Delete Drop-Down Menu"). This removes Row 3 and shifts
all the data (below Row 2) in the worksheet up one row.

Mouseless Command

Deleting Rows

o Press the ALT key and then the letters H, D, and R one at a
time. The row with the activated cell will be deleted.

Figure 1.35 Delete Drop-Down Menu
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4. Activate cell C1 by placing the mouse pointer over the cell location and
clicking the left mouse button.

5. Click the down arrow on the Delete button in the Cells group in the
Home tab of the Ribbon.
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6. Click the Delete Sheet Columns option from the drop-down menu (see
Figure 1.35 "Delete Drop-Down Menu"). This removes Column C and
shifts all the data in the worksheet (to the right of Column B) over one
column to the left.

Mouseless Command
Deleting Columns

« Press the ALT key and then the letters H, D, and C one at a time.
The column with the activated cell will be deleted.

Skill Refresher: Deleting Columns and Rows

(click to see video)

Activate any cell in the row or column that is to be deleted.
Click the Home tab of the Ribbon.

Click the down arrow on the Delete button in the Cells group.
Click either the Delete Sheet Columns or the Delete Sheet Rows
option.

KEY TAKEAWAYS

¢ Column headings should be used in a worksheet and should accurately
describe the data contained in each column.

+ Using symbols such as dollar signs when entering numbers into a
worksheet can slow down the data entry process.

« Worksheets must be carefully proofread when data has been manually
entered.

« The Undo command is a valuable tool for recovering data that was
deleted from a worksheet.

« When using a worksheet that was developed by someone else, look
carefully for hidden column or rows.

=W N =
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EXERCISES

1. When entering numeric data into an Excel worksheet, you should
omit symbols such as commas or dollar signs because:

a. These numbers will not be usable in mathematical functions
or formulas.

b. Excel will convert this to text data.

Excel will not accept these entries into a cell location.

d. It slows down the data entry process.

@

2. Which of the following statements is true with respect to editing
the content in a cell location?

a. Activate the cell location and press the F2 key on your
keyboard to edit the data in the cell.

b. Double click the cell location to edit the data in a cell
location.

c. Activate the cell location, click the Formula Bar, and make
any edits for the cell location in the Formula Bar.

d. All of the above are true.

3. Which of the following will enable you to identify hidden
columns in a worksheet?

a. The column letter appears in a tip box when the mouse
pointer is moved over a hidden column.

b. Clicking the Page Layout View button in the View tab of the
Ribbon shows all columns in the worksheet and shades
hidden columns.

c. The column letters that appear above the columns in a
worksheet will be missing for hidden columns.

d. Click the Hidden Columns indicator in the Status Bar.

4. Which of the following is true with respect to inserting blank
rows into a worksheet?

a. Blank rows are inserted above the activated cell or cell range
in a worksheet.
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b. Blank rows are always inserted in the center of a cell range.
At least two or more cells in a worksheet must be highlighted
before a row can be inserted.

c. The command for inserting blank rows and columns can be
found by clicking the Format button in the Home tab of the
Ribbon.

d. When inserting blank rows into a worksheet, the Undo
button is disabled. You must use the Delete button in the
Home tab of the Ribbon to remove unwanted blank rows.
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LEARNING OBJECTIVES

Use formatting techniques to enhance the appearance of a worksheet.
Understand how to align data in cell locations.

Examine how to enter multiple lines of text in a cell location.
Understand how to add borders to a worksheet.

Examine how to use the AutoSum feature to calculate totals.
Understand how to insert a chart into a worksheet.

Use the Cut, Copy, and Paste commands to manipulate the data on a
worksheet.

8. Examine how to use the Sort command to rank data on a worksheet.
9. Understand how to move, rename, insert, and delete worksheet tabs.

ooy @ 9

This section addresses formatting commands that can be used to enhance the visual
appearance of a worksheet. It also provides an introduction to mathematical
calculations and charts. The skills introduced in this section will give you powerful
tools for analyzing the data that we have been working with in this workbook and
will highlight how Excel is used to make key decisions in virtually any career.

Formatting Data and Cells

Follow-along file: Excel Objective 1.0 (Use file Excel Objective 1.04 if you are starting
with this skill.)

Enhancing the visual appearance of a worksheet is a critical step in creating a
valuable tool for you or your coworkers when making key decisions. The following
steps demonstrate several fundamental formatting skills that will be applied to the
workbook that we are developing for this chapter. Several of these formatting skills
are identical to ones that you may have already used in other Microsoft applications
such as Microsoft® Word® or Microsoft® PowerPoint®.

1. Highlight the range A2:D2 in the Sheet1 worksheet by placing the
mouse pointer over cell A2 and left clicking and dragging to cell D2.

2. Click the Bold button in the Font group of commands in the Home tab
of the Ribbon (see Figure 1.36 "Font Group of Commands").
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Figure 1.36 Font Group of Commands

Click here to open the
font style drop-down
menu.

T \g Lo R I /[ Commands for J

changing the font size
Home Insert Page Layout A Formula

B & | [calibri 11 v A AT
- By A/[ Font color button ]
Paste 4 B JF U~|iliv| &av A~

[

/ f A Click here to view the
il | / — color palate for changing

lipb
= the cell fill color.

[ Bold button ] [Italics button]
Click here to select the
double underline format.

L 4

Mouseless Command

Bold Format

> Hold the CTRL key while pressing the letter B on your
keyboard.

3. Highlight the range A15:D15 by placing the mouse pointer over cell A15
and left clicking and dragging to cell D15.

4. Click the Bold button in the Font group of commands in the Home tab
of the Ribbon.

5. Click the Italics button in the Font group of commands in the Home tab
n

of the Ribbon (see Figure 1.36 "Font Group of Commands").

6. Click the Underline button in the Font group of commands in the Home
tab of the Ribbon (see Figure 1.36 "Font Group of Commands"). Notice
that there is a drop-down arrow next to the Underline button. This is
for selecting a double underline format, which is common in careers
that deal with accounting or budgeting activities.
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Mouseless Command

Italics Format

> Hold the CTRL key while pressing the letter I on your
keyboard.

Mouseless Command

Underline Format

o Hold the CTRL key while pressing the letter U on your
keyboard.

Why?

Format Column Headings and Totals

Applying formatting enhancements to the column headings and
column totals in a worksheet is a very important technique,
especially if you are sharing a workbook with other people. These
formatting techniques allow users of the worksheet to clearly see
the column headings that define the data. In addition, the column
totals usually contain the most important data on a worksheet
with respect to making decisions, and formatting techniques allow
users to quickly see this information.

7. Highlight the range B3:B14 by placing the mouse pointer over cell B3

and left clicking and dragging down to cell B14.

8. Click the Comma Style button in the Number group of commands in

the Home tab of the Ribbon (see Figure 1.37 "Number Group of

Commands").
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10.
11.

12.

13.

14.

15.

16.

17.

18.

Figure 1.37 Number Group of Commands
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Decimal button
Accounting -
Comma ]
[ Style Format J l
$ - % * | %G00

A

Accounting )
Number FormatJ { Decrease

MNumber

Decimal button

Click the Decrease Decimal button in the Number group of commands
in the Home tab of the Ribbon (see Figure 1.37 "Number Group of
Commands").

The numbers will also be reduced to zero decimal places.

Highlight the range C3:C14 by placing the mouse pointer over cell C3
and left clicking and dragging down to cell C14.

Click the Accounting Number Format button in the Number group of
commands in the Home tab of the Ribbon (see Figure 1.37 "Number
Group of Commands"). This will add the US currency symbol and two
decimal places to the values. This format is common when working
with pricing data.

Highlight the range D3:D14 by placing the mouse pointer over cell D3
and left clicking and dragging down to cell D14.

Again, this will add the US currency symbol to the values as well as two
decimal places.

Click the Decrease Decimal button in the Number group of commands
in the Home tab of the Ribbon.

This will add the US currency symbol to the values and reduce the
decimal places to zero.

Highlight the range A1:D1 by placing the mouse pointer over cell A1
and left clicking and dragging over to cell D1.

Click the down arrow next to the Fill Color button in the Font group of
commands in the Home tab of the Ribbon (see Figure 1.38 "Fill Color
Palette").
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Figure 1.38 Fill Color Palette

®| WY - Excel Objective 1.0

Home  Insert  Page Layout i View Increase Font
= Size button
j & [calbri Ylu C A L= g‘;‘ B S | General

Click this down arrow to
open the Fill Color Palette.

Paste = B 7 U
J u

Theme Colors

Clipboard T Font — — Numt
et - '  p pEE EE ———— "
Al M f | |
B | F G
il 5 |
2 Month Unit Sales Avi
3 January 2,670 S | Standard Colors Aquf‘ Accent 5, Darker 25%]
4 February 2,160 ¢ |HME L L L
5 |March 515 § Dojll
Al o Colors... |
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Z will change color as the S 124799 7515405 Fill Color Palette
mouse pointer is dragged

over the color palette.

19. Click the Aqua, Accent 5, Darker 25% color from the palette (see Figure
1.38 "Fill Color Palette"). Notice that as you move the mouse pointer
over the color palette, you will see a preview of how the color will
appear in the highlighted cells.

20. Click the down arrow next to the Font Color button in the Font group
of commands in the Home tab of the Ribbon (see Figure 1.36 "Font
Group of Commands").

21. This change will be visible once text is typed into the highlighted cells.

22. Click the Increase Font Size button in the Font group of commands in
the Home tab of the Ribbon (see Figure 1.38 "Fill Color Palette").

23. Highlight the range A1:D15 by placing the mouse pointer over cell A1
and left clicking and dragging down to cell D15.

24. Click the drop-down arrow on the right side of the Font button in the
Home tab of the Ribbon (see Figure 1.36 "Font Group of Commands").

25. Notice that as you move the mouse pointer over the font style options,
you can see the font change in the highlighted cells.

26. Expand the row width of Column D to 10 characters.
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Figure 1.39 "Formatting Techniques Applied" shows how the Sheet1 worksheet

Why?

Pound Signs (####) Appear in Columns

When a column is too narrow for a long number, Excel will automatically
convert the number to a series of pound signs (####). In the case of words or

text data, Excel will only show the characters that fit in the column. However,

this is not the case with numeric data because it can give the appearance of a
number that is much smaller than what is actually in the cell. To remove the

pound signs, increase the width of the column.

should appear after the formatting techniques are applied.

1.3 Formatting and Data Analysis

Figure 1.39 Formatting Techniques Applied
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Data Alignment (Wrap Text, Merge Cells, and Center)

Follow-along file: Excel Objective 1.0 (Use file Excel Objective 1.06 if you are starting
with this skill.)

The skills presented in this segment show how data are aligned within cell
locations. For example, text and numbers can be centered in a cell location, left
justified, right justified, and so on. In some cases you may want to stack multiword
text entries vertically in a cell instead of expanding the width of a column. This is
referred to as wrapping text'®. These skills are demonstrated in the following

steps:

1. Highlight the range B2:D2 by placing the mouse pointer over cell B2
and left clicking and dragging over to cell D2.

2. Click the Center button in the Alignment group of commands in the

Home tab of the Ribbon (see Figure 1.40 "Alignment Group in Home
Tab"). This will center the column headings in each cell location.

Figure 1.40 Alignment Group in Home Tab

Vertical
Alignment buttons

AL
‘4 )
= =| B~ =- Wrap
= = ¥ =l Text button
e e 7 Merge &
= = = — == %"' ‘Centerbutton
\ —/ \ |
~

Horizontal nent

Alignment buttons Click here to

J Increase Indent.

Click here to
Decrease Indent.

-

3. Click the Wrap Text button in the Alignment group (see Figure 1.40

"Alignment Group in Home Tab"). The height of Row 2 automatically

16. Stacking multiword text expands, and the words that were cut off because the columns were too
entries vertically in a cell.
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narrow are now stacked vertically (see Figure 1.42 "Sheet1 with Data
Alignment Features Added").

Mouseless Command

Wrap Text

o Press the ALT key and then the letters H and W one at a time.

Why?

Wrap Text

The benefit of using the Wrap Text command is that it significantly
reduces the need to expand the column width to accommodate
multiword column headings. The problem with increasing the
column width is that you may reduce the amount of data that can
fit on a piece of paper or one screen. This makes it cumbersome to
analyze the data in the worksheet and could increase the time it
takes to make a decision.

4. Highlight the range A1:D1 by placing the mouse pointer over cell A1
and left clicking and dragging over to cell D1.

5. Click the down arrow on the right side of the Merge & Center button in
the Alignment group of commands in the Home tab of the Ribbon.

6. Left click the Merge & Center option (see Figure 1.41 "Merge Cell Drop-
Down Menu"). This will create one large cell location running across
the top of the data set.
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Mouseless Commands

Merge Commands

+ Merge & Center: Press the ALT key and then the letters H, M, and C
one at a time.

« Merge Cells: Press the ALT key and then the letters H, M, and M one
at a time.

 Unmerge Cells: Press the ALT key and then the letters H, M, and U
one at a time.

Figure 1.41 Merge Cell Drop-Down Menu

;‘ @)v é General

— = e Click here to open
—— mm = -
= = = @»y | the drop-down menu

Alignment é‘g Merge & Center
. —

B Merge across

Click here to merge cells
Dy E —
Merge Cells : :

Click hiere'to ﬂj without centering data.

break a merged ,ﬁ Unmerge Cells

cell into separate cells.

Why?
Merge & Center

One of the most common reasons the Merge & Center command is used is to
center the title of a worksheet directly above the columns of data. Once the
cells above the column headings are merged, a title can be centered above the
columns of data. It is very difficult to center the title over the columns of data if
the cells are not merged.
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Figure 1.42 "Sheet1 with Data Alignment Features Added" shows the Sheet1
worksheet with the data alignment commands applied. The reason for merging the

cells in the range A1:D1 will become apparent in the next segment.

Figure 1.42 Sheet1 with Data Alignment Features Added
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Unit Average Sales merged into one cell.
2 Month Sales Price Dollars
3 January 2670 $ 9.99 $ 26685
4 February 2,160 $12.49 $ 26,937
5 March 515 $1499 $ 7,701
6 Apri =l | T80 | < 10,269 TheWrapTextfeature was
7 May 1030 $1499 $ 15405 applledtothe range B2:D2. J
8 |June 2875 $1249 $ 35916
9 |July 2700 $ 999 $ 26,937
10 August 900 $ 1999 $ 17,958
11 September 775 $1999 $ 15,708
12 October 1,180 $ 19.99 § 23,562
13 November 1,800 $17.49 $ 31416
14 December 3,560 %1499 $ 53,370
15 Total Sales

i
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Skill Refresher: Wrap Text

(click to see video)

1. Activate the cell or range of cells that contain text data.
2. Click the Home tab of the Ribbon.
3. Click the Wrap Text button.

1.3 Formatting and Data Analysis
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Skill Refresher: Merge Cells

(click to see video)

B W N =

Highlight a range of cells that will be merged.

Click the Home tab of the Ribbon.

Click the down arrow next to the Merge & Center button.
Select an option from the Merge & Center list.

Entering Multiple Lines of Text

Follow-along file: Excel Objective 1.0 (Use file Excel Objective 1.07 if you are starting
with this skill.)

1.3 Formatting and Data Analysis

In the Sheet1 worksheet, the cells in the range A1:D1 were merged for the purposes
of adding a title to the worksheet. This title will require that two lines of text be
entered into a cell. The following steps explain how you can enter text into a cell
and determine where you want the second line of text to begin:

Activate cell A1 in the Sheet1 worksheet by placing the mouse pointer
over cell A1 and clicking the left mouse button. Since the cells were
merged, clicking cell A1 will automatically activate the range A1:D1.

2. Type the text General Merchandise World.

Hold down the ALT key and press the ENTER key. This will start a new
line of text in this cell location.

Type the text 2011 Retail Sales (in millions) and press the ENTER key.
Select cell A1. Then click the Italics button in the Font group of
commands in the Home tab of the Ribbon.

Increase the height of Row 1 to 30 points. Once the row height is
increased, all the text typed into the cell will be visible (see Figure 1.43
"Title Added to the Sheet1 Worksheet").
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Figure 1.43 Title Added to the Sheet1 Worksheet

®| -+ Excel Objective 1.0
Home Insert Page Layout Formulas Data Review View

‘—3 * calibri i LA A= g%\ v 5i | General

PajteHj Bru- O A EESEEE $-%
Clipboard 5 | Font I \ Alignment - Num

K1 v b
A B C D E = G
General Merchandise World
il 2011 Retail Sales (in millions)
Unit Average Sales

2 Month Sales Price Dollars

3 January 2670 $ 9.99 $ 26685

4 February 2,160 $ 1249 $ 26,937

5 March 515 $14.99 $ 7,701

6 |April 590 $17.49 $ 10,269

7 May 1,030 $1499 $ 15405

8 June 2875 $1249 $ 35916

9 |July 2,700 $ 9.99 $ 26,937
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Skill Refresher: Entering Multiple Lines of Text

(click to see video)

Activate a cell location.

Type the first line of text.

Hold down the ALT key and press the ENTER key.
Type the second line of text and press the ENTER key.

=W N =

Borders (Adding Lines to a Worksheet)

Follow-along file: Excel Objective 1.0 (Use file Excel Objective 1.08 if you are starting
with this skill.)
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In Excel, adding custom lines to a worksheet is known as adding borders. Borders'’
are different from the grid lines that appear on a worksheet and that define the
perimeter of the cell locations. The Borders command lets you add a variety of line
styles to a worksheet that can make reading the worksheet much easier. The
following steps illustrate methods for adding preset borders and custom borders to

a worksheet:

17. Lines that are added to a
worksheet to separate the data
in columns and rows.

1.3 Formatting and Data Analysis

1. Note that when you click on cell A1, cells B1:D1 will also activate since

they are merged.

Click the down arrow to the right of the Borders button in the Font
group of commands in the Home page of the Ribbon (see Figure 1.44
"Borders Drop-Down Menu").

Figure 1.44 Borders Drop-Down Menu
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Cells dialog box.

Left click the All Borders option from the Borders drop-down menu
(see Figure 1.44 "Borders Drop-Down Menu"). This will add vertical and

horizontal lines to the range A1:D15.

Highlight the range A2:D2 by placing the mouse pointer over cell A2
and left clicking and dragging over to cell D2.

Click the down arrow to the right of the Borders button.
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10.

11.

12.

Left click the Thick Bottom Border option from the Borders drop-down
menu.

Highlight the range A1:D15.

Click the down arrow to the right of the Borders button.

This will open the Format Cells dialog box (see Figure 1.45 "Borders
Tab of the Format Cells Dialog Box"). You can access all formatting
commands in Excel through this dialog box.

In the Style section of the Borders tab, left click the thickest line style
(see Figure 1.45 "Borders Tab of the Format Cells Dialog Box").

Left click the Outline button in the Presets section (see Figure 1.45
"Borders Tab of the Format Cells Dialog Box").

Click the OK button at the bottom of the dialog box (see Figure 1.45
"Borders Tab of the Format Cells Dialog Box").

Figure 1.45 Borders Tab of the Format Cells Dialog Box
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Figure 1.46 Borders Added to the Sheetl Worksheet
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Skill Refresher: Preset Borders

(click to see video)

Highlight a range of cells that require borders.
Click the Home tab of the Ribbon.

Click the down arrow next to the Borders button.
Select an option from the preset borders list.

=W N =
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Skill Refresher: Custom Borders

(click to see video)

Highlight a range of cells that require borders.

Click the Home tab of the Ribbon.

Click the down arrow next to the Borders button.

Select the More Borders option at the bottom of the options list.
Select a line style and line color.

Select a placement option.

Click the OK button on the dialog box.

N O Ok LN =

AutoSum

Follow-along file: Excel Objective 1.0 (Use file Excel Objective 1.09 if you are starting
with this skill.)

You will see at the bottom of Figure 1.46 "Borders Added to the Sheet1 Worksheet"
that Row 15 is intended to show the totals for the data in this worksheet. Applying
mathematical computations to a range of cells is accomplished through functions'®
in Excel. Chapter 2 "Mathematical Computations" will review mathematical
formulas and functions in detail. However, the following steps will demonstrate
how you can quickly sum the values in a column of data using the AutoSum
command:

1. Activate cell B15 in the Sheet1 worksheet.
2. Click the Formulas tab of the Ribbon.

3. Click the down arrow below the AutoSum button in the Function
Library group of commands (see Figure 1.47 "AutoSum Drop-Down
List"). Note that the AutoSum button can also be found in the Editing
group of commands in the Home tab of the Ribbon.

18. Mathematical computations
that are applied to a range of
cells or specific cells on a
worksheet.
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N oo

Figure 1.47 AutoSum Drop-Down List
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Click the Sum option from the AutoSum drop-down menu.

Excel will provide a total for the values in the Unit Sales column.
Activate cell D15.

Repeat steps 3 through 5 to sum the values in the Sales Dollars column
(see Figure 1.48 "Totals Added to the Sheet1 Worksheet").

This will remove the pound signs (####) and show the total.
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Figure 1.48 Totals Added to the Sheet1 Worksheet
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14 |December 3,560 | $1499 % 53,370
15 |Total Sales | 20,755 $ 291,864
y Totals were added to
15 T [ these columns using ]

L the AutoSum command.

Skill Refresher: AutoSum

(click to see video)

1. Highlight a cell location below or to the right of a range of cells
that contain numeric values.
Click the Formulas tab of the Ribbon.

3. Click the down arrow below the AutoSum button.

4. Select a mathematical function from the list.

Inserting a Column Chart

Follow-along file: Excel Objective 1.0 (Use file Excel Objective 1.10 if you are starting
with this skill.)
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19. Tools used to graphically
display the datain a
worksheet.

1.3 Formatting and Data Analysis

As mentioned at the beginning of this chapter, Excel serves as a critical tool for
making decisions in both personal and professional contexts. Charts' are a
powerful tool in Excel that allow you to graphically display the data in a worksheet.
Graphical displays allow the reader to immediately identify key trends and
behaviors in the data that is being analyzed. For the workbook that we are using for
this chapter, understanding the trends in monthly sales data is critical for making
decisions such as how many staff members to assign to the store for each month as
well as supplying the store with enough inventory to accommodate expected sales.
To assist the reader in analyzing this data, a column chart will be created to
graphically display the data. It is important for you to plan which type of chart will
best display the data so your readers can quickly see key trends. More details on
creating charts and on chart types will be presented in a later chapter. The
following steps are an introduction to creating the column chart required for this
chapter’s objective:

1. Highlight the range A2:B14.
Click the Insert tab of the Ribbon.

3. Click the Column button (see Figure 1.49 "Column Chart Drop-Down
Menu"). This will open the column chart drop-down menu of options.

Figure 1.49 Column Chart Drop-Down Menu
@“g-q-pvy; Excel Objpast:

= Column button
Home Insert Page Layout Formulas Data Review
J_'l E\E @Shapes 2l P Line v |l Area v ELine
P__[ Smartart

&b ric v |.'-_'_~Scatter - ECOW
PivotTable Table Picture CIIp T
v Art  laghScreenshot - } Bar v o Other Charts + | J1Win/!

Tables | Tlustrations 2-D Column n
4

A2 v(*  f[month M”ﬂﬂ]”ﬂﬂj‘

A B
2011 Retail Sales (in millionfdsal oo

General Merchandlse Wor

-

Un't Average Compare values across categories
2 |Month Sales Price [ [ by using vertical rectangles.
3 January 2,670 $ 9.99 $ Cylind Use it when the order of categories
4 |February 2160 [ $ 1249 (3% yiinclen is not important or for displaying
m - '515 $ 14'99 $ l{ | item counts such as a histogram.
5 arc . :ﬂl'
6 |April 590 | $1749| % | - —h'
7 |May 1,030 | $ 14.99 | $| cone
8 |June 875 (31249 | % ] |
9 | July 2,700 9% Jﬂﬂ LA}A | M A IM
10 August B 5 10.99 [Siee— L& L850 I
11 |September 775 (%1999 | $ b
12 |October 1,180 | $ 19.99 | $ g
13 |November 1,800 | $ 17.49 | $ M_“ Excel will use the
14 |December 3,560 | $ 1499 % highlighted data to
il A ChartTy create a chart.
15 |Total Sales | 20,755 3 291,864 |

\
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4. Select the Clustered Column option from the list of column chart

options (see Figure 1.49 "Column Chart Drop-Down Menu"). This will
create an embedded chart in the Sheet1 worksheet (see Figure 1.50
"Embedded Column Chart in Sheet1").

Figure 1.50 "Embedded Column Chart in Sheet1" shows the column
chart that is created once a selection is made from the column chart
drop-down menu. Notice that there are three new tabs added to the
Ribbon. These tabs contain features for enhancing the appearance and
construction of Excel charts. These commands will be covered in more
detail in a later chapter. For now, you will see that Excel places the
chart over the data in the worksheet. The following steps explain how
to move and resize the chart:

Figure 1.50 Embedded Column Chart in Sheet1

Click and drag the dots

erimeter of th
ing Handles, to
ize of the char

@ HY-- = Excel Objective 1.0 - Microsoft Excel
Home Insert  Pagelayout Formulas Data  Review  Vie Design | Layout  Format
il o, 9T =
L 1 all 3 = T .
Change  Save As Switch  Select hﬂl&u ﬂi_ﬂi ‘UL‘M' I .
Chart Type Template Row/Column Data —| =
Type Data Chart Layouts Chart Styles
Chart1 v 5
A B © D F G H I J K
General Merchandise World
1 2011 Retail Sales (in millions) ¢
Unit |Average| - Sales 1 ==
2 [Month Sales | Price .
Unit Sales
3 [January 2670 % 9.99
4 |February 2,160 | $ 12.49
5 |March 515 | $ 14.99
6 |April 590 | $ 17.49
7 |May 1,030 | $ 14.99
8 |June 2875 |$1249 |8 ar:ur:d "‘Se.’?
chart, or Sizi
9 [July 2700 |$ 999 |9S W Unit Sales change the s
10 |August 900 |$19.99 | S |
11 [September 7751$19.99 | §
12 October 1,180 | $19.99 |
& A N S
13 |[November 1,800 [ $17.49 | S R & v9° RO \o\@@’?é‘s@b"&é&& é&&
14 [December 3,560 [ $14.99 |5 ¥ & & T
15 |Total Sales | 20.755
- The cross arrows indicate ?
you can left click and drag
the chart.

The block white plus sign will become black cross arrows (see Figure
1.50 "Embedded Column Chart in Sheet1").

Left click and drag the chart so the upper left corner is placed in the
middle of cell F1 (see Figure 1.51 "Moving an Embedded Chart").
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20. Dots that appear around the
perimeter of an embedded
chart in a worksheet. They can
be clicked and dragged to
desired dimensions to change
the size of a chart.

1.3 Formatting and Data Analysis

10.

11.
12.

13.
14.

Figure 1.51 Moving an Embedded Chart

~

Releasing the left mouse button

e ' == e il here will place the upper left

Clipboard = Font I Alignment | Number corner in the middle of cell F1.

Chart 1 v I ~

A B % D E F G H |
General Merchandise World v
1 2011 Retail Sales (in millions) -
Unit |Average| - Sales ! 2

2 |Month Sales Price . Unit Sales
3 |January 2670|% 999 |%
2 FEbruary 2160 | § 1249 | § icinn [This outline appears as the
5 [March 515 |$ 1499 | § 3500 < chartis beiF:\Z moved.
6 [April 590 | $ 17.49 | $ 3.000 l
7 [May 1,030 [ $ 1499 | 2500 f—

Place the mouse pointer over the top center sizing handle® (see
Figure 1.50 "Embedded Column Chart in Sheet1"). You will see the
mouse pointer change from a white block plus sign to a vertical double
arrow. Make sure the mouse pointer is not in the cross arrow mode as
shown in Figure 1.50 "Embedded Column Chart in Sheet1" as this will
move the chart instead of resizing it.

While holding down the ALT key on your keyboard, left click and drag
the mouse pointer slightly up. The chart will automatically adjust up to
the top of Row 1.

Place the mouse pointer over the left center sizing handle.

While holding down the ALT key on your keyboard, left click and drag
the mouse slightly toward the left. The chart will automatically adjust
to the left side of Column F.

Place the mouse pointer over the lower center sizing handle.

While holding down the ALT key on your keyboard, left click and drag
the mouse slightly down. The chart will automatically adjust to the
bottom of Row 14.

Place the mouse pointer over the right center sizing handle.

While holding down the ALT key on your keyboard, left click and drag
the mouse slightly to the right. The chart will automatically adjust to
the right side of Column M.
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Why?

There Are No Sizing Handles on a Chart

If you do not see the dots or sizing handles around the perimeter
of a chart, it could be that the chart is not activated. To activate a
chart, left click anywhere on the chart.

Figure 1.52 "Embedded Chart Moved and Resized" shows the column

chart moved and resized. Notice that the sizing handles are not visible
around the perimeter of the chart. This is because the chart is not
activated. Once you click anywhere on the worksheet outside the chart
area, the chart is automatically deactivated.

Figure 1.52 Embedded Chart Moved and Resized
TR S S EEE (T Y% TS g Tabe syles v | Bdfomat~ | B FieT Sl

Alignment - Number - Styles Cells Editing

© D E F G H | J K L M N

ise World .
in millions) Unit Sales

‘erag Sales
>rice | Dollars
9.99 26,685
12.49 26,937
14.99 7,701
17.49 10,269
14.99 15,405
12.49 35,916
9.99 26,937
19.99 17,958
19.99 15,708
19.99 23,562
17.49 31,416
14.99 53,370

The missing sizing handle
indicate that this chart is
not active.

M Unit Sales

@ o oo oo lololololoo

£291. 864

Why?

Use the ALT Key When Resizing a Chart

Using the ALT key while resizing an embedded chart locks the
perimeter of the chart to the columns and rows of the worksheet.
This gives you the ability to adjust the chart to precise sizes as you
adjust the width and height of the worksheet rows and columns.
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As shown in Figure 1.50 "Embedded Column Chart in Sheet1", when a
chart is created, three tabs are added to the Ribbon. The following
steps explain how to use a few of the formatting and design features in
these tabs:

15. Check to make sure the column chart in Sheet1 is activated. To activate
the chart, left click anywhere on the chart.
16. Click the Design tab under the Chart Tools set of tabs on the Ribbon.
17. Click the down arrow on the right side of the Chart Styles section (see
Figure 1.53 "Chart Styles in the Design Tab").
Figure 1.53
Excel Objective 1.0 - Microsoft Excel Chart Tools
age Layout Formulas Data Review View Design \‘Layout Format Design Tab
=
el 1
SR L[ [ [
Data
Chart Layouts Chart Styles Chart Styles
5 St le 44 down arrow
D E | F G H I ] K L M | N
d -
s) Unit Sales
Sales 4,000 -
Dollars
—_— 3,500
26,685
26,937 3.000 I
7701 2500 i} I i
18. Click Style 44 in the Chart Styles section. This style has a black
background with red columns (see Figure 1.53 "Chart Styles in the
Design Tab").
19. Click the Format tab under the Chart Tools set of tabs on the Ribbon.
20. Click the down arrow on the right side of the WordArt Styles section
(see Figure 1.54 "WordArt Styles in the Format Tab").
Figure 1.54
x o9 - |= Excel Objective 1.0 - Microsoft Excel Chart Tools |
“ Home Insert Page Layout Formulas Data Review View Design Layout ‘ Format
Chart Area Jshape Fill v = A v |
\9! Format Selection . . . E)Shape Outline v .
7o\ down arrow
&H Reset to Match style =il Shape Effects v k = N q‘:i}-
Current Selection Shape Styles WordArt Styles
Chart1 v £ Fill - Blue, Accent 1, Inner Shad———
B C D E F G H | J K
al Merchandise World .
W <tzil Sales (in millions) Unit Sales MRS
Unit [Average| Sales
2 Sales Price Dollars
3 2670|% 999|% 26685
4 2160 |%12.49 |3 26937
5 515|$ 1499 | $ 7,701
6 590 | $ 17.49 | $ 10,269

1.3 Formatting and Data Analysis
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Click the Blue, Accent 1, Inner Shadow option (see Figure 1.54 "WordArt Styles in
the Format Tab"). Notice that as you move the mouse pointer over the WordArt

Styles options, the format of the chart title as well as the X and Y axis titles
changes.

Figure 1.55 "Formatting Features Applied to the Column Chart" shows the
embedded column chart with the formatting features applied. This chart is very

effective in displaying the Unit Sales trends for this company. You can see very
quickly that the tallest bar in the chart is the month of December, followed by the
months of June, July, January, and February.

1.3 Formatting and Data Analysis

Figure 1.55
) H ) - s ‘ 7 Excel Objective 1.0 - Microsoft Excel
m Home  Insert  Pagelayout Formulas  Data  Review  View =@
i . _ ) bl e <
B & [caion i s ==l (S ([ z :r% _l: g e Z .%F A
B3~ = o = o Delete ~  [§]v &4
Paste B I U~ v B AL = . . 9 4 | %0 .00 Conditional Formatas Cell |y ~_ Sort& Find&
P = H -l = B $-% 00 30| comatting v Tablew Styles~ | EEIFOrMat Y CAY girer select~
Clipboard Font Alignment Number Styles Cells Editing
P15 - 5
A B & D E

General Merchandise World
2011 Retail Sales (in millions)

Unit Sales

-

Unit |Average| Sales
2 [Month Sales Price Dollars
3 [January 2670 |$ 999|% 26,685
4 |February 2160 | $ 1249 | $ 26,937
5 |March 515($1499 |8 7,701
6 |April 590 [ $17.49|$ 10,269
7 |May 1,030 [$1499|3$ 15405 L
8 |June 2875|%$1249|% 35916
9 |July 2,700 ([$ 999 |$% 26,937
10 |August 900 | $19.99 | $ 17,958
11 |September 7751 $19.99 | $ 15708
12 |October 1,180 | $ 19.99 | § 23,562
13 |[November 1,800 | $ 17.49 | $ 31,416
14 |December 3,560 | $ 1499 | $ 53,370
15 |Total Sales | 20,755 $ 291,864
16
4 4 » ¥ Sheetl /Sheet2 /Sheet3 /%3 / T W

Skill Refresher: Creating a Column Chart

(click to see video)

1. Highlight a range of cells that contain data that will be used to
create the chart.

2. Click the Insert tab of the Ribbon.

3. Click the Column button in the Charts group.

4, Select an option from the Column drop-down menu.

E
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Cut, Copy, and Paste

Follow-along file: Excel Objective 1.0 (Use file Excel Objective 1.11 if you are starting
with this skill.)

The Cut, Copy, and Paste commands are perhaps the most widely used commands in
Microsoft Office. With regard to Excel, the Copy and Paste commands are often used
to make copies of worksheets for developing different scenarios or versions for the
data being analyzed. The following steps demonstrate how these commands are
used for the objective in this chapter:

1. Click the Select All button in the upper left corner of the Sheet1

worksheet (see Figure 1.56 "Clipboard Group of Commands").

Cut button

Figure 1.56 Clipboard Group of Commands

X9~

-

Paste BIE"E"&'é' ===
Clipboard T | Font E¥ Alignn
.8 -~ & 0000
A B C D

1 Select All button:
Y Click here to highlight
the entire worksheet. Sales
2 |Month —Sares | ce Dollars

2. Click the Copy button in the Clipboard group of commands in the
Home tab of the Ribbon (see Figure 1.56 "Clipboard Group of

Commands").
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Mouseless Command

Copy
o Press the CTRL key and then the letter C key on your keyboard.

3. Open the Sheet2 worksheet by left clicking on the Sheet2 worksheet
tab at the bottom of the workbook.
4, Activate cell location Al.

5. Click the Paste button in the Clipboard group of commands in the
Home tab of the Ribbon. Be sure to click the upper area of the Paste
button and not the down arrow at the bottom of the button. A copy of
Sheet1 will now appear in Sheet2.

Mouseless Command

Paste

o Press the CTRL key and then the letter V key on your
keyboard.

6. Click anywhere on the chart in the Sheet2 worksheet.

7. Click the Cut button in the Clipboard group on the Home tab of the
Ribbon. This will remove the chart from the Sheet2 worksheet.

Mouseless Command

Cut

o Press the CTRL key and then the letter X key on your keyboard.

8. Open the Sheet3 worksheet by left clicking on the Sheet3 worksheet
tab at the bottom of the workbook.
9. Activate cell location A1l.
10. Click the Paste button in the Home tab of the Ribbon. This will paste
the chart from the Sheet2 worksheet into the Sheet3 worksheet.
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Sorting Data (One Level)

Follow-along file: Excel Objective 1.0 (Use file Excel Objective 1.12 if you are starting
with this skill.)

As mentioned earlier in this section, a chart is a tool that enables worksheet readers
to analyze data quickly to spot key trends or patterns. Another powerful tool that
provides similar benefits is the Sort”* command. This feature ranks the rows of data
in a worksheet based on designated criteria. The following steps demonstrate how
the Sort command is used to rank the data in the Sheet2 worksheet:

1. In the Sheet2 worksheet, highlight the range A2:D14.
Click the Data tab of the Ribbon.

3. Click the Sort button in the Sort & Filter group of commands. This will
open the Sort dialog box (see Figure 1.57 "Sort & Filter Group of

Commands").

Figure 1.57 Sort & Filter Group of Commands

[x] Lo IR O Excel Objective 1.0 - Microsc
e Data tab !
Home Insert FEge Tay0on ormulas Data Review View

L@From Access - iﬁ % - IEIConnections A AlZ \ 1; Clear
3| b @E— uf T
Iia From Web I -3] Properties | y Reapph

N 4

From Other Existing Refresh Zl Sart Fiter Tex
Lﬁ From Text  Sources ¥ | Connections | All¥ =2 Edit Links A l’f,’ Advanced | Colu
Get External Data \ Connections / [% Sort & Filter \
A2 ~@® | Month " lsont

“ Show the Sort dialog box to sort
General Merchandise | Sort button data based on several criteria at
2011 Retail Sales (in millions)

= WWW g Press Fl for more h.EIP.
2 Month Sales Price Dollars
3 January 2670|% 999|% 26685

4. Click the down arrow next to the “Sort by” drop-down box in the Sort
dialog box (see Figure 1.58 "Sort Dialog Box").

21. An Excel command used to
rank the data in a worksheet
based on designated criteria.
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Figure 1.58 Sort Dialog Box

If you highlighted the column
headings in your data, this
option must be checked.

o ¢ R

- [ Options... I E My data has headers

%] Add Level “ X Delete Level “ =3 Copy Level ‘

Column Sort On Order
Sort by Values El AtoZ

Sales Dollars

Click here to set the sort criteria
to ascending or descending order

( ] ist |
LSort by drop-down IlstJ

Click the Unit Sales option from the drop-down list.

Click the down arrow next to the Order drop-down box.

Click Largest to Smallest from the drop-down list.

Click the OK button at the bottom of the Sort dialog box. The data in
the range A2:D14 will now be sorted in descending order based on the
values in the Unit Sales column.

R N

Integrity Check
Sorting Data

Carefully check the highlighted range of the data you are sorting. It is critical
that all columns in a contiguous range of data are highlighted before sorting. If
you do not sort all the columns in a data set, the data could become corrupted
in such a way that it may not be corrected. If Excel detects that you are trying
to sort only part of a contiguous range of data, it will give you a warning dialog
box.

Figure 1.59 "Data Sorted Based on Unit Sales" shows the data in the Sheet2
worksheet sorted based on the values in the Unit Sales column. Similar to the chart,
the Sort command makes it easy to identify the months of the year with the highest
unit sales.
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Figure 1.59 Data Sorted Based on Unit Sales

®| HY- o= Excel Objective 1.0
Home Insert Page Layout Farmulas Data Review View
rom Access pE onnections [ “ i Clear

g T | | @S 4 EE W oo
u}From Web | - Z2' Properties [ - i Reap

"y From Other Exlstmvg Refresh o et il Sort Filter

[Z]From Text  Sources v | Connections | All v == Edit Links U2 Advar

Get External Data Connections Sort & Filter
1 - £
A B C D E F
General Merchandise World

1 2011 Retail Sales (in millions)

] Unit [Average| Sales

2 [Month Sales Price Dollars

3 |December 3,560 | $ 1499 | $ 53,370 W

4 |June 2875|%$1249 | % 35916

5 |July 2700 | % 999 |3 26937

6 |January 2670(% 999 |3% 26685

7 |February 2160 | $ 1249 |$ 26,937 ]

8 [November 1,800 | $ 17.49 | $ 31,416 Datais sorted based
9 [October 1180 | $ 19.99 | $ 23,562 i el Sl
10 |May 1,030 | $ 1499 | $ 15,405 UniSalescolmb:
11 [August 900 | $ 1999 | $ 17,958

12 (September 775| %1999 | $ 15708

13 |April 590 | $17.49 | % 10,269

14 (March 515|%$1499 | % 7,701 J

15 |Toral Sales | 20,755 $ 291,864

16

4 4 » M| Sheetl | Sheet2 /~Sheet3 %

Skill Refresher: Sorting Data (One Level)

(click to see video)

A U WN =

Moving, Renaming, Inserting, and Deleting Worksheets

Highlight a range of cells to be sorted.
Click the Data tab of the Ribbon.
Click the Sort button in the Sort & Filter group.
Select a column from the “Sort by” drop-down list.
Select a sort order from the Order drop-down list.
Click the OK button on the Sort dialog box.

Follow-along file: Excel Objective 1.0 (Use file Excel Objective 1.13 if you are starting

with this skill.)

1.3 Formatting and Data Analysis
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The default names for the worksheet tabs at the bottom of workbook are Sheet1,
Sheet2, and so on. However, you can change the worksheet tab names to identify
the data you are using in a workbook. Additionally, you can change the order in
which the worksheet tabs appear in the workbook. The following steps explain how
to rename and move the worksheets in a workbook:

With the left mouse button, double click the Sheet1 worksheet tab at
the bottom of the workbook (see Figure 1.60 "Renaming a Worksheet

Tab").

2. Type the name Sales by Month.

Press the ENTER key on your keyboard.

4, With the left mouse button, double click the Sheet2 worksheet tab at

10.

11.

12.
13.

1.3 Formatting and Data Analysis

the bottom of the workbook.
Type the name Unit Sales Rank.

Press the ENTER key on your keyboard.

Figure 1.60 Renaming a Worksheet Tab

12 |October 1,180 | $ 1992 | 3% 23,562

13 |[November 1,800 ($1749 | 3% 31416

14 |December 3,560 | $14.99 | $ 53,370

15 |Toral Sales | 20,755 $ 291,864 | ,

16 Click here to add

4 > M _;"Sheetzt;'SheetB %1 ~4— ablank worksheet
to the workbook.

Double click here to
change the name
of the worksheet tab.

Click and drag the
worksheet tab to
change the order.

Left click and drag the Unit Sales Rank worksheet tab to the left of the
Sales by Month worksheet tab.

Click the Sheet3 worksheet tab.

Click the Home tab of the Ribbon.

Click the down arrow on the Delete button in the Cells group of
commands.

Click the Delete Sheet option from the drop-down list (see Figure 1.35
"Delete Drop-Down Menu").

Click the Delete button on the Delete warning box.

Click the Insert Worksheet tab at the bottom of the workbook (see

Figure 1.60 "Renaming a Worksheet Tab").
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Integrity Check
Deleting Worksheets

Be very cautious when deleting worksheets that contain data. Once a worksheet
is deleted, you cannot use the Undo command to bring the sheet back. Deleting
a worksheet is a permanent command.

Mouseless Command

Inserting New Worksheets

« Press the SHIFT key and then the F11 key on your keyboard.

Figure 1.61 "Final Appearance of the Excel Objective 1.0 Workbook" shows the final

appearance of the Excel Objective 1.0 workbook after the worksheet tabs have been
renamed and moved.

1.3 Formatting and Data Analysis
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Figure 1.61 Final Appearance of the Excel Objective 1.0 Workbook

X - - |= Excel Objective 1.0 -
Home Insert Page Layout Formulas Data Review View

‘2] % calibri vlu <A A= g;‘ v S General

Dafte 'qj B 7 U-~- {‘_av‘q%vA' EE=EE=EEE %
Clipboard I | Font M Alignment Numb:

K1 - 5
A B C D E E
General Merchandise World
1 2011 Retail Sales (in millions)
Unit Average Sales

2 |Month Sales Price Dollars

3 [December 3,560 | $14.99 | $ 53,370

4 |June 2875|%1249|% 350916

5 [July 2700 (% 999 |% 26937

6 [January 2670 | % 999 |% 26,685

7 |February 2160 | $ 1249 | $ 26,937

8 [November 1,800 | $17.49 | $ 31416

9 |October 1,180 | $ 19.99 | $ 23,562

10 |May 1,030 | $1499 | $ 15405

11 [August 900 | $19.99 | % 17,958

12 (September 775|%$ 1999 | $ 15708

13 [April 590 | $ 1749 | % 10,269

14 |March 515|%$ 1499 |8 7,701

R 5 Worksheet tabs

12 RESER '—“"w . =;’_294-864-—‘[ have been renamed.

44 » | Unit Sales Rank / Sales by Month Sheetl /%3 /

Skill Refresher: Renaming Worksheets

(click to see video)

1. Double click the worksheet tab.
2. Type the new name.
3. Press the ENTER key.
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Skill Refresher: Moving Worksheets

(click to see video)

1. Left click the worksheet tab.
2. Drag it to the desired position.

Skill Refresher: Deleting Worksheets

(click to see video)

Open the worksheet to be deleted.
Click the Home tab of the Ribbon.

Select the Delete Sheet option.
Click Delete on the warning box.

G v W N =

Click the down arrow on the Delete button.
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KEY TAKEAWAYS

1.3 Formatting and Data Analysis

Formatting skills are critical for creating worksheets that are easy to
read and have a professional appearance.

A series of pound signs (####) in a cell location indicates that the column
is too narrow to display the number entered.

Using the Wrap Text command allows you to stack multiword column
headings vertically in a cell location, reducing the need to expand
column widths.

Use the Merge & Center command to center the title of a worksheet
directly over the columns that contain data.

Adding borders or lines will make your worksheet easier to read and
helps to separate the data in each column and row.

Effective charts enable readers to immediately identify key trends in the
data you are displaying.

Check to make sure all the data in a contiguous range of cells is
highlighted before using the Sort command. Highlighting and sorting
only part of a contiguous data set could corrupt your data in such a way
that its integrity may not be restored.

You cannot use the Undo command to bring back a worksheet that has
been deleted.
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EXERCISES

1. The pound signs (####) that appear in a cell location indicate
that:

a. A computational error has occurred.

b. The AutoSum feature was applied to text data instead of
numeric data.

c. A number is too long for the current width of a column.

d. You must click the Calculate Sheet command in the Formulas
tab of the Ribbon.

2. Which of the following is most accurate with respect to the Wrap
Text command?

a. It allows you to designate which words are placed on a
second line in a cell.

b. It reduces the need to expand the width of the columns in a
worksheet.

c. It converts any numeric data to text data.

d. It can be accessed only through the right-click menu of
options.

3. What is the quickest way to center a title over six columns of
data?

a. Type the title into the cell location over the left-most column
and use the space bar to try and place the title over the
center of the six columns.

b. Type the title into the cell location over the left-most column
and click the Center alignment button in the Home tab of the
Ribbon.

c. Type the title into the cell location over the third column
and use the BACKSPACE key to place the title over the center
of the six columns.

d. Highlight the six cell locations over each of the columns and
click the Merge & Center button in the Home tab of the
Ribbon.

4. Which of the following is true with respect to deleting
worksheets?
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. You cannot use the Undo button to bring back a worksheet

once it has been deleted.

. Click the Select All button and press the DELETE key on your

keyboard to delete a worksheet from a workbook.

. Holding down the SHIFT key while pressing the F11 key on

your keyboard will delete a worksheet from your workbook.

. Excel will not let you delete a worksheet that contains data.

All data must be removed from the worksheet before the
worksheet can be deleted.
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1.4 Printing

LEARNING OBJECTIVES

1. Use the Page Layout tab to prepare a worksheet for printing.
2. Add headers and footers to a printed worksheet.
3. Examine how to print worksheets and workbooks.

Once you have completed a workbook, it is good practice to select the appropriate
settings for printing. These settings are in the Page Layout tab of the Ribbon and
discussed in this section of the chapter.

Page Setup

Follow-along file: Excel Objective 1.0 (Use file Excel Objective 1.14 if you are starting
with this skill.)

Before you can properly print the worksheets in a workbook, you must establish
appropriate settings. The following steps explain several of the commands in the
Page Layout tab of the Ribbon used to prepare a worksheet for printing:

Open the Unit Sales Rank worksheet by left clicking on the worksheet
tab.

2. Click the Page Layout tab of the Ribbon.

10.
11.

12.

Click the Margins button in the Page Setup group of commands. This
will open a drop-down list of options for setting the margins of your
printed document.

Click the Wide option from the Margins drop-down list.

Open the Sales by Month worksheet by left clicking on the worksheet
tab.

Click the Page Layout tab of the Ribbon (see Figure 1.62 "Page Layout
Commands for Printing").

Click the Margins button in the Page Setup group of commands.
Click the Narrow option from the Margins drop-down list.

Click the Orientation button in the Page Setup group of commands.
Click the Landscape option.

Click the down arrow to the right of the Width button in the Scale to
Fit group of commands.

Click the 1 Page option from the drop-down list.
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13. Click the down arrow to the right of the Height button in the Scale to
Fit group of commands.

14. Click the 1 Page option from the drop-down list. This step along with
step 12 will automatically reduce the worksheet so that it fits on one
piece of paper. It is very common for professionals to create
worksheets that fit within the width of the paper being used. However,
for long data sets, you may need to set the height to more than one
page. Table 1.2 "Printing Resources: Purpose and Use for Page Setup
Commands" provides a list of commands found in the Page Layout tab
of the Ribbon

Why?
Use Print Settings

Because professionals often share Excel workbooks, it is a good practice to
select the appropriate print settings in the Page Layout tab even if you do not
intend to print the worksheets in a workbook. It can be extremely frustrating
for recipients of a workbook who wish to print your worksheets to find that the
necessary print settings have not been selected. This may reflect poorly on your
attention to detail, especially if the recipient of the workbook is your boss.

Figure 1.62 Page Layout Commands for Printing

\E| e & - - \ = Excel Objective 1.0 - M
: < - - Page Layout tab
File Home Insert Page Layout Formulas Data Review View
ncomrs ’ I @ ! = | :%I of- Width: |Automatic = Gridlines = Headings
I | - 1 ul 1< -
.Fonts * ‘;'IJ Height: Automatic = \ || view | [V View
Themes Margins Orientation  Size Print  Breaks Background Print -
v [O]effects~ |~ - v Areav - Titles o [ Scale: [100% 3 print | [ print
Themes Page Setup g Scale to Fit I heet Options “ |
Use these commands z
Click the down
to fit a worksheet onto 0
one page for printing e e
pag ) lists of scaling options.
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Table 1.2 Printing Resources: Purpose and Use for Page Setup Commands

Margins

Sets the top, bottom, right, and left
margin space for the printed
document

1. Click the Page Layout tab of the
Ribbon.

2. Click the Margin button.

3. Click one of the preset margin
options or click Custom Margins.

Orientation

Sets the orientation of the printed
document to either portrait or
landscape

1. Click the Page Layout tab of the
Ribbon.

2. Click the Orientation button.

3. Click one of the preset
orientation options.

Size

Sets the paper size for the printed
document

1. Click the Page Layout tab of the
Ribbon.

2. Click the Size button.

3. Click one of the preset paper size
options or click More Paper Sizes.

Print Area

Used for printing only a specific area
or range of cells on a worksheet

1. Highlight the range of cells on a
worksheet that you wish to print.

2. Click the Page Layout tab of the
Ribbon.

3. Click the Print Area button.

4, Click the Set Print Area option
from the drop-down list.

Breaks

Allows you to manually set the page
breaks on a worksheet

1. Activate a cell on the worksheet
where the page break should be
placed. Breaks are created above
and to the left of the activated cell.

2. Click the Page Layout tab of the
Ribbon.

3. Click the Breaks button.

4, Click the Insert Page Break
option from the drop-down list.

Background

Adds a picture behind the cell
locations in a worksheet

1. Click the Page Layout tab of the
Ribbon.
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22. Space at the top of a printed
worksheet that contains
information such as the date,
page number, file name,
company name, and so on.

23. Space at the bottom of a
printed worksheet that
contains information such as
the date, page number, file
name, company name, and so
on.

1.4 Printing

2. Click the Background button.

3. Select a picture stored on your
computer or network.

Print Titles

Used when printing large data sets
that are several pages long. This
command will repeat the column
headings at the top of each printed

page.

1. Click the Page Layout tab of the
Ribbon.

2. Click the Print Titles button.

3. Click in the Rows to Repeat at
Top input box in the Page Setup
dialog box.

4. Click any cell in the row that

contains the column headings for
your worksheet.

5. Click the OK button at the bottom
of the Page Setup dialog box.

Headers and Footers

Follow-along file: Excel Objective 1.0 (Use file Excel Objective 1.15 if you are starting
with this skill.)

When printing worksheets from Excel, it is common to add headers®” and footers™
to the printed document. Information in the header or footer could include the
date, page number, file name, company name, and so on. The following steps
explain how to add headers and footers to the Excel Objective 1.0 workbook:

1. Open the Unit Sales Rank worksheet by left clicking on the worksheet
tab.
2. Click the Insert tab of the Ribbon.

3. Click the Header & Footer button in the Text group of commands. You
will see the Design tab added to the Ribbon; this is used for creating the
headers and footers for the printed worksheet. Also, this will convert
the view of the worksheet from Normal to Page Layout (see Figure 1.63
"Design Tab for Creating Headers and Footers").
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Figure 1.63 Design Tab for Creating Headers and Footers
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— . (- V) |y & | aa - Different First Page | Scale with Document
= = |z uu 7 &Y A Ea O] | P = = < !
Header Footer Page Number Current Current  File File Sheet  Picture Format Goto Goto Different Odd & Even Pages [V Align with Page Margins
v v Number of Pages Date Time Path  Name Name Picture | Header Footer
Header & Footer k Header & Footer Elements Navigation k Options

The upper left
section of the
header is
activated.

Click here to activate
the footer section.

| | Click to add

\&[Date]

Joseph M. Manzo

l Header

General Merchaadise World
2011 Retail Sales in millions)

Unit  [Aderage Sales
2 Month Sales Pyice Dollars
3 December 3560 (S \4 99 |8 53370
"l a June 2875[S 1949]8 35916

Click here to add the
current date to the activated
section of the header or footer.

4. Type your name in the center section of the Header.

5. Place the mouse pointer over the left section of the Header and left
click (see Figure 1.63 "Design Tab for Creating Headers and Footers").

6. Click the Current Date button in the Header & Footer Elements group
of commands in the Design tab of the Ribbon.

7. Click the Go to Footer button in the Navigation group of commands in
the Design tab of the Ribbon.

8. Place the mouse pointer over the far right section of the footer and left
click.

9. Click the Page Number button in the Header & Footer Elements group
of commands in the Design tab of the Ribbon.

10. Click any cell location outside the header or footer area. The Design tab

for creating headers and footers will disappear.

11. Click the Normal view button in the lower right side of the Status Bar
(see Figure 1.64 "Worksheet in Page Layout View").
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Figure 1.64 Worksheet in Page Layout View
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12. Open the Sales by Month worksheet by left clicking the worksheet tab.
13. Repeat steps 2 through 11 to create the same header and footer for this
worksheet.

Printing Worksheets and Workbooks

Follow-along file: Excel Objective 1.0 (Use file Excel Objective 1.16 if you are starting

with this skill.)

Once you have established the print settings for the worksheets in a workbook and

have added headers and footers, you are ready to print your worksheets. The
following steps explain how to print the worksheets in the Excel Objective 1.0
workbook:

1. Open the Unit Sales Rank worksheet by left clicking on the worksheet

tab.
2. Click the File tab on the Ribbon.

3. Click the Print option on the left side of the Backstage view (see Figure
1.65 "Print Preview"). On the right side of the Backstage view, you will

be able to see a preview of your printed worksheet.
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Figure 1.65 Print Preview
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4. Click the Print Active Sheets button in the Print section of the
Backstage view (see Figure 1.65 "Print Preview").

5. Click the Print Entire Workbook option from the drop-down list. This

will print all worksheets in a workbook when the Print button is

clicked.

Click the Next Page arrow at the bottom of the preview window.

Click the Print button.

Click the Home tab of the Ribbon.

Save and close the Excel Objective 1.0 workbook.

KEY TAKEAWAYS

¢« The commands in the Page Layout tab of the Ribbon are used to prepare
a worksheet for printing.

* You can add headers and footers to a worksheet to show key
information such as page numbers, the date, the file name, your name,
and so on.

¢ The Print commands are in the File tab of the Ribbon.

© ® N
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EXERCISES

1. Which of the following commands is used to print the column
headings in a worksheet at the top of each printed page for a
worksheet that contains 100 rows of data?

a. the Header & Footer command in the Insert tab of the Ribbon

b. the Print Titles command in the Page Layout tab of the
Ribbon

c. theInsert command in the Home tab of the Ribbon

d. the Conditional Formatting command in the Home tab of the
Ribbon

2. Which of the following is true with respect to printing Excel
worksheets?

a. Setting the Width and Height drop-down lists to 1 Page will
ensure that all the worksheets in a workbook are printed on
one page.

b. The page layout settings must be set for each worksheet in a
workbook.

c. You can print only one worksheet at a time in a workbook
that contains multiple worksheets.

d. All of the above are true.
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1.5 Chapter Assignments and Tests

To assess your understanding of the material covered in the chapter, please
complete the following assignments.
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1.5 Chapter Assignments and Tests

Careers in Practice (Skills Review)

Basic Monthly Budget for Medical Office (Comprehensive Review)

Starter File: Chapter 1 CiP Exercise 1

Difficulty: Level 1

Creating and maintaining budgets are common practices in many careers.
Budgets play a critical role in helping a business or household control
expenditures. In this exercise you will create a budget for a hypothetical
medical office while reviewing the skills covered in this chapter. Begin the
exercise by opening the file named Chapter 1 CiP Exercise 1.

Entering, Editing, and Managing Data

1. Activate all the cell locations in the Sheet1 worksheet by left
clicking the Select All button in the upper left corner of the
worksheet.

2. In the Home tab of the Ribbon, set the font style to Arial and the
font size to 12 points.

3. Increase the width of Column A so all the entries in the range
A3:A8 are visible. Place the mouse pointer between the letter A and
letter B of Column A and Column B. When the mouse pointer
changes to a double arrow, left click and drag it to the right until
the character width is 18.00.

4. Enter Quarter 1 in cell B2.

5. Use AutoFill to complete the headings in the range C2:E2. Activate
cell B2 and place the mouse pointer over the Fill Handle. When the
mouse pointer changes to a black plus sign, left click and drag it to
cell E2.

6. Increase the width of Columns B, C, D, and E to 10.14 characters.
Highlight the range B2:E2 and click the Format button in the Home
tab of the Ribbon. Click the Column Width option, type 10.14 in
the Column Width dialog box, and then click the OK button in the
Column Width dialog box.

7. Enter the words Medical Office Budget in cell A1.

103


http://www.gone.2012books.lardbucket.org/sites/all/files/ManzoExcel_1.0_Chapter_1_CiP_Exercise_1.xlsx

Chapter 1 Fundamental Skills

8. Insert a blank column between Columns A and B. Activate any cell
location in Column B. Then, click the drop-down arrow of the
Insert button in the Home tab of the Ribbon. Click the Insert Sheet
Columns option.

9. Enter the words Budget Cost in cell B2.

10. Adjust the width of Column B to 13.29 characters.

Formatting and Basic Charts

11. Merge the cells in the range A1:F1. Highlight the range and click
the Merge & Center button in the Home tab of the Ribbon.

12. Make the following format adjustments to the range A1:F1: bold;
italics; change the font size to 14 points; change the cell fill color to
Aqua, Accent 5, Darker 50%; and change the font color to white.

13. Increase the height of Row 1 to 24.75 points.

14. Center the title of the worksheet in the range A1:F1 vertically.
Activate the range and then click the Middle Align button in the
Home tab of the Ribbon.

15. Make the following format adjustment to the range A2:F2: bold;
and change the cell fill color to Tan, Background 2, Darker 10%.

16. Set the alignment in cell B2 to Wrap Text. Activate the cell location
and click the Wrap Text button in the Home tab of the Ribbon.

17. Copy cell C3 and paste the contents into the range D3:F3.

18. Copy the contents in the range C6:C8 by highlighting the range and
clicking the Copy button in the Home tab of the Ribbon. Then,
highlight the range D6:F8 and click the Paste button in the Home
tab of the Ribbon.

19. Calculate the total budget for all four quarters for the salaries.
Activate cell B3 and click the down arrow on the AutoSum button
in the Formulas tab of the Ribbon. Click the Sum option from the
drop-down list. Then, highlight the range C3:F3 and press the
ENTER key on your keyboard.

20. Copy the contents of cell B3 and paste them into the range B4:B8.

21. Format the range B3:F8 with a US dollar sign and zero decimal
places.

22. Sort the data in the range A2:F8 based on the values in the Quarter
4 column in ascending order. Highlight the range A2:F8 and click
the Sort button in the Data tab of the Ribbon. Select Quarter 4 in
the “Sort by” drop-down box and select Smallest to Largest in the
Order drop-down box. Click the OK button.

23. Add vertical and horizontal lines to the range A1:F8. Highlight the
range and click the down arrow next to the Borders button in the
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Home tab of the Ribbon. Select the All Borders option from the
drop-down list.

24. Change the name of the Sheet1 worksheet tab to “Budget.” Double
click the worksheet tab, type the word Budget, and press the
ENTER key.

25. Insert a pie chart using the data in the range A2:B8. Highlight the
range and click the Pie button in the Insert tab of the Ribbon. Click
the first option on the list (the Pie option).

26. Click and drag the chart so the upper left corner is in the center of
cell H2.

27. Add labels to the chart by clicking the Layout 1 option from the
Chart Layouts list in the Design tab of the Ribbon. Make sure the
chart is activated by clicking it once before you look for the Layout
1 Chart Layout option.

Printing

28. Change the orientation of the Budget worksheet so it prints
landscape instead of portrait.

29. Adjust the appropriate settings so the Budget worksheet prints on
one piece of paper.

30. Add a header to the Budget worksheet that shows the date in the
upper left corner and your name in the center.

31. Add a footer to the Budget worksheet that shows the page number
in the lower right corner.

32. Use the Save As command in the File tab of the Ribbon to save the
workbook by adding your name in front of the current workbook
name (i.e., “your name Chapter 1 CiP Exercise 1”).

33. Close the workbook and Excel.
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Figure 1.66
Completed Medical Budget Exercise

1.5 Chapter Assignments and Tests
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Marketing for Specialty Women’s Apparel

Starter File: Chapter 1 CiP Exercise 2

Difficulty: Level 2

A key activity for marketing professionals is to analyze how population
demographics change in certain regions. This is especially important for
specialty retail stores that target a specific age group within a population. This
exercise utilizes the skills covered in this chapter to analyze hypothetical
population trends. The decisions that can be made with such information

include where to open new stores, whether existing stores should be closed and

reopened in other communities, or whether the product assortment should be
adjusted. The purpose of this exercise is to use the skills presented in this
chapter to analyze hypothetical population trends for a fashion retailer.

1. In the Sheet1 worksheet, enter the year 2008 into cell B3.
. Use AutoFill to fill the years 2009 to 2012 in the range C3:F3.
3. Change the font style to Arial and the font size to 12 points for all
cell locations in the Sheet1 worksheet.
4. Merge and center the cells in the range A1:F1.
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5. Make the following formatting adjustments to the range A1:F1:
bold; italics; change the cell fill color to Olive Green, Accent 3,
Lighter 60%; change the font size to 14 points.

6. Enter the title for this worksheet into the range A1:F1 on two lines.
The first line should read Population Trends by Age Group. The
second line should read for Region 5.

7. Increase the height of Row 1 so the title is visible.

8. Delete Row 2.

9. Increase the height of Row 2 to 21 points.

10. Format the values in the range B3:F6 so a comma separates each
thousands place with zero decimal places.

11. Make the necessary adjustments to remove any pound signs (####)
that may have appeared after formatting the values.

12. Sort the data in the range A2:F6 based on the values in the year
2008 from largest to smallest.

13. Enter the word Totals in cell A7.

14. Increase the height of Row 7 to 22.50 points.

15. Format the range A7:F7 so entries are bold and italic.

16. In cell B7, add a total that sums the values in the range B3:Bé.
Format the value with zero decimal places and a comma for each
thousands place.

17. Copy the contents of cell B7 and paste them into the range C7:F7.

18. Add vertical and horizontal lines to the range A1:F7.

19. Add a very bold orange border around the perimeter of the range
AL:F7.

20. Insert a column chart using the data in the range A2:F6. Select the
2-D Stacked Column format.

21. Move the column chart so the upper left corner is in the middle of
cell A8.

22. Rename the Sheet1 worksheet tab to Population Trends.

23. Adjust the appropriate settings so the Population Trends
worksheet prints on one piece of paper.

24. Add a header to the Population Trends worksheet that shows the
date in the upper left corner and your name in the center.

25. Save the workbook by adding your name in front of the current
workbook name (i.e., “your name Chapter 1 CiP Exercise 2”). (Hint:
you will need to Save As.)

26. Close the workbook and Excel.
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Figure 1.67

Completed Population Trends Exercise
T A A \ B \ c \ D | E | F
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Integrity Check

Starter File: Chapter 1 IC Exercise 1

Difficulty: Level 3

The purpose of this exercise is to analyze a worksheet to determine whether

there are any integrity flaws. First, read the scenario below. Then, open the file

that is related to this exercise and analyze the worksheets contained in the
workbook. You will find a worksheet in the workbook named AnswerSheet.
This worksheet is to be used for any written responses required for this

exercise.

Scenario

Your coworker provides you with sales data in an Excel workbook, which you
intend to use for a sales strategy meeting with your boss. The workbook was
attached to an e-mail with the following points stated in the message.

+ The data represents the top-selling items for the company last
year with respect to sales dollars.

+ Ireceived the data from an analyst in my department who insisted

the cost data for each item was included. However, I don’t see it.

You might have to manually enter this yourself. I included the cost

for each item below.
« The original data I received is in Sheet1. I copied this data and
pasted it into Sheet2. I thought you might like to see this sorted.

¢ Cost per item data:

Item Cost
Black Flat $35.00
Bracelet $30.00
Brown Pump | $25.00
Daisy Print $40.00
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Item Cost
Grey Stripe $110.00
Jersey Knit $80.00
Navy Pinstripe | $125.00
Navy Wool $135.00
Quartz Watch | $80.00
Sandal $45.00
Tan Trench $115.00
Topaz Ring $50.00

Assignment

1. Analyze the data in this workbook carefully. Would you be
comfortable using this data in a meeting with your boss? Use the
AnswerSheet in this workbook to briefly list any concerns you

have with this data.

2. If it is necessary to enter the cost information, enter it in the
Sheet1 worksheet. If not, state why in the AnswerSheet.

3. Correct any problems and make any adjustments you think are
appropriate to this workbook.

4, Save the workbook by adding your name in front of the current

workbook name.
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Applying Excel Skills

The assignment in this section requires that you apply the skills presented in
this chapter to achieve the stated objective. Read the assignment first and then
open the file and complete the stated requirements. When you complete an
assignment, save the file by adding your name in front of the current name of
the workbook.

Starter File: Chapter 1 AES Assignment 1
Difficulty: Level 3

The workbook for this assignment contains sales plan data by month for
merchandise categories sold by a hypothetical clothing retailer. Use the skills
covered in this chapter to accomplish the points listed below.

. Show the total sales plan dollars next to each category in Column

B.

. Instead of showing the sales plan dollars by month, calculate the

plan dollars for each quarter (see the following figure, “Layout for
Sales by Quarter”). The months assigned to each quarter are as
follows:

° Quarter 1: February, March, and April

° Quarter 2: May, June, and July

o Quarter 3: August, September, and October

° Quarter 4: November, December, and January

. Show the total plan for each quarter.
. Sort the merchandise categories based on the total sales plan

dollars.

. Add any additional formatting enhancements that will make the

worksheet easier to read.
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Figure 1.68

Category Total Sales Plan Quarter1 Quarter2 Quarter3 Quarter 4
Shoes

Casual Pants

Casual Shirts

Dress Shirts

Dress Pants

Suits

Accessories
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CHAPTER SKILLS TEST

Starter File: Chapter 1 Skills Test

Difficulty: Level 2

Answer the following questions by executing the skills on the starter file
required for this test. Answer each question in the order in which it appears.
If you do not know the answer, skip to the next question. Open the starter
file listed above before you begin this test.

In the Sheet1 worksheet, enter the word Totals in cell C14.

Format all the cells in Sheet1 to Arial font style and a 12-point font size.

Set the character width for Columns A through G to 12.71.

Edit the entry in cell B2 to read “Item Number.”

Use AutoFill to fill the contents of cell B3 into the range B4:B13.

Copy the contents of cell A3 and paste them into the range A4:A8.

Delete Column F.

Format the range A1:F2 so the text is Bold.

Set the alignment in the range A2:F2 to Wrap Text.

Change the fill color of the cells in the range A1:F1 to Red, Accent 2,

Darker 25%.

. Make the following font changes to the range A1:F1: set the font color to

white, add italics, and set the font size to 14.

12. Merge and center the cells in the range A1:F1.

13. Enter the title for this worksheet in the range A1:F1. The title should
appear on two lines. The first line should read Status Report. The
second line should read Sales and Inventory by Item.

14. Increase the height of Row 1 so the entire title is visible.

15. Insert a blank row above Row 14.

16. Format the values in the range €3:C13 with a US dollar sign and two
decimal places.

17. Format the values in the range E3:F13 with zero decimal places and a
comma at each thousands place.

18. In cell E15, use AutoSum to calculate the sum of the values in the range
E3:E14.

19. Add vertical and horizontal lines to the range A1:F15.

20. Add abold line border around the perimeter of the range A1:F15.

21. Insert a column chart using the data in the range D2:E13.

22. Move the chart so the upper left corner is in the middle of cell H2.

23. Sort the data in the range A2:F13 based on the values in the Sales in

Units column. Sort the values in descending order or largest to smallest.

© e B P
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24.
25.
26.

27/,
28.

29.

30.

31.

32.

33.

Insert a new blank worksheet in the workbook.

Delete Sheet3.

Move Sheet4 ahead of Sheet2 so the order of the worksheets is Sheet1,
Sheet4, and Sheet2.

Rename the Sheet1 worksheet tab to “Status Report.”

Change the orientation of the Status Report worksheet so it prints
landscape instead of portrait.

Adjust the appropriate settings so the Status Report worksheet prints on
one piece of paper.

Add a header to the Status Report worksheet that shows the date in the
upper left corner and your name in the center.

Add a footer to the Status Report worksheet that shows the page
number in the lower right corner.

Save the workbook by adding your name in front of the current
workbook name (i.e., “your name Chapter 1 Skills Test”). (Hint: you will
use Save As.)

Close the workbook and Excel.
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Mathematical Computations

Perhaps the most valuable feature of Excel is its ability to produce mathematical
outputs using the data in a workbook. This chapter reviews several mathematical
outputs that you can produce in Excel through the construction of formulas and
functions. The chapter begins with the construction of formulas for basic and
complex mathematical computations. The second section reviews statistical
functions, such as SUM, AVERAGE, MIN, and MAX, which can be applied to a range
of cells. The last section of the chapter addresses functions used to calculate
mortgage and lease payments as well as the valuation of investments. This chapter
also shows how you can use data from multiple worksheets to construct formulas
and functions. These skills will be demonstrated in the context of a personal cash
budget, which is a vital tool for managing your money for long-term financial
security. The personal budget objective will also provide you with several
opportunities to demonstrate Excel’s what-if scenario capabilities, which highlight
how formulas and functions automatically produce new outputs when one or more
inputs are changed.
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2.1 Formulas

LEARNING OBJECTIVES

1. Learn how to create basic formulas.

2. Understand relative referencing when copying and pasting formulas.

3. Work with complex formulas by controlling the order of mathematical
operations.

4. Understand formula auditing tools.

This section reviews the fundamental skills for entering formulas into an Excel
worksheet. The objective used for this chapter is the construction of a personal cash
budget. Most financial advisors recommend that all households construct and
maintain a personal budget to achieve and maintain strong financial health.
Organizing and maintaining a personal budget is a skill you can practice at any
point in your life. Whether you are managing your expenses during college or
maintaining the finances of a family of four, a personal budget can be a vital tool
when making financial decisions. Excel can make managing your money a fun and
rewarding exercise.

Figure 2.1 "Completed Personal Cash Budget Workbook" shows the completed
workbook that will be demonstrated in this chapter. Notice that this workbook
contains four worksheets. The first worksheet, Budget Summary, contains
formulas that utilize or reference the data in the other three worksheets. As a
result, the Budget Summary worksheet serves as an overview of the data that was
entered and calculated in the other three worksheets of the workbook.
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1. Used to calculate a variety of
mathematical outputs in Excel
and can be used to create
virtually any custom
calculation required for your
objective.

2. Cell addresses used in
formulas. Excel references the
values entered into the cell
locations used in formulas to
produce outputs. When the
values are changed in a cell
referenced by a formula, Excel
automatically produces new
outputs. When a cell reference
is used by itself in a cell
location (cell address preceded
by an equal sign [=]), Excel
displays the value entered into
that cell location.

2.1 Formulas

Figure 2.1 Completed Personal Cash Budget Workbook

‘E‘ - & 5 Personal Budget - Microsoft Excel o & R
“ Home  Insert  Pagelayout  Formulas  Data  Review  View o@ o @ =
5 T &S S B S o N et 4
Ba-|—— — = = E| = S pelete ~ | (3]~ Z Ea
v | Iy Ay, v | B == - — «.0 .00 Conditional Formatas Cell - - Sort & Find &
7 B[Z|u- - S-A- EEEEEE] % 0 Wl Formatting = Table - Styles + | EEAFOrmat | (2~ fiter+ select~
Clipboard Font Alignment Number . Styles Cells Editing
AL - fx | Personal Cash Budget v
A 8 C D E F G H ] J K LB
q Personal Cash Budget |
2 NetIncome $ 33,000
3 Expenses $ 17,950
4 Mortgage Payments $ 10,629
5 Car Lease Payments $ 2479
6 Total Plan Spend $ 31,058 94.1% =
7 Net Change in Cash $ 1,942 5.9%
8
9 Savings Plan| $ 25,000
10 Savings Projection| $ 25,606
11 Plan vs Projeclion $ 606 The outputs in this worksheet are
created by formulas and functions L]
f . that reference the data entered in
12 Years of Saving 10 these worksheets.
13 Rate of Return 3.5%|
14 Current Balance| $ 2,000
15 ) o~
4« » | Budget Summary 'Budget Detail Mortgage Payments Car Lease Payments /%[ 4 [ w ] »

Creating a Basic Formula

Follow-along file: Excel Objective 2.00

Lesson Video: Basic Formulas

(click to see video)

Formulas' are used to calculate a variety of mathematical outputs in Excel and can
be used to create virtually any custom calculation required for your objective.
Furthermore, when constructing a formula in Excel, you use cell locations that,
when added to a formula, become cell references?. This means that Excel uses, or
references, the number entered into the cell location when calculating a
mathematical output. As a result, when the numbers in the cell references are
changed, Excel automatically produces a new output. This is what gives Excel the
ability to create a variety of what-if scenarios, which will be explained later in the
chapter.

To demonstrate the construction of a basic formula, we will begin working on the
Budget Detail worksheet in the Personal Budget workbook, which is shown in
Figure 2.2 "Budget Detail Worksheet". To complete this worksheet, we will add
several formulas and functions. Table 2.1 "Spend Category Definitions" provides
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2.1 Formulas

definitions for each of the spend categories listed in the range A3:A11. When you
develop a personal budget, these categories are defined on the basis of how you
spend your money. It is likely that every person could have different categories or
define the same categories differently. Therefore, it is important to review the
definitions in Table 2.1 "Spend Category Definitions" to understand how we are

defining these categories before proceeding.

Figure 2.2
A B C D E F (
Expense Plan
1 (Does not include mortgage and car) | @
Percentof [Monthly |Annual * Percent
2 Category Total Spend Spend LY Spend |Change
3 Household Utilities $ 3,000 (% 3,000 M
4 Food $ 2,500|3% 2,250
5 Gasoline $ 1,500|$ 1,200
6 Clothes $ 1200]$ 1,000
7 Insurance $ 1,500 (% 1,500
8 Taxes $ 3,500 3% 3,500
9 Entertainment $ 2000|% 2250 Formulas and functions will be
10 Vacation $ 1,500 (% 2,000 added in the blank cells to
11 Miscellaneous $ 1250|$ 1558 [P e (T
- - for this worksheet.
12 Totals
13 Number of Categories
14 Average Spend
15 Min Spend
16 Max Spend -

17
18
19

4 4 » »| Budget Summary | Budget Detail ~ Mortgage Payments Car Lease Payments %3/ 4

Table 2.1 Spend Category Definitions

Household Money spent on electricity, heat, and water and on cable, phone, and

Utilities Internet access

Food Money spent on groceries, toiletries, and related items

Gasoline Money spent on fuel for automobiles

Clothes Money spent on clothes, shoes, and accessories

Insurance Money spent on homeowner’s or automobile insurance

Taxes Money spent on school and property taxes (this example of the personal
budget assumes that we own property).

Entertainment Money spent on entertainment, including dining out, movie and theater

tickets, parties, and so on
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3. Numerical value used in the
construction of formulas.
Constants should have some
universal quality that does not
change, such as days in a week
or minutes in an hour.

2.1 Formulas

Category Definition

Vacation Money spent on vacations

Miscellaneous

Includes any other spending categories, such as textbooks, software,
journals, school or work supplies, and so on

The first formula that we will add to the Budget Detail worksheet will calculate the
Monthly Spend values. The formula will be constructed so that it takes the values in
the Annual Spend column and divides them by 12. This will show how much money

will be spent per month for each of the categories listed in Column A. The following
explains how this formula is created:

1. Click the Budget Detail worksheet tab to open the worksheet.

2. Click cell C3.

3. Type an equal sign (=). When the first character entered into a cell
location is an equal sign, it signals Excel to perform a calculation or
produce a logical output.

4. Type D3. This adds D3 to the formula, which is now a cell reference.
Excel will use whatever value is entered into cell D3 to produce an
output.

5. Type the slash symbol (/). This is the symbol for division in Excel. As
shown in Table 2.2 "Excel Mathematical Operators", the mathematical
operators in Excel are slightly different from those found on a typical
calculator.

6. Type the number 12. This divides the value in cell D3 by 12. In this
formula, a number, or constant’, is used instead of a cell reference
because it will not change. In other words, there will always be 12
months in a year.

7. Press the ENTER key.

Table 2.2 Excel Mathematical Operators

Symbol Operation

+

Addition

Subtraction

Division

Multiplication

Power/Exponent
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Why?
Use Cell References

Cell references enable Excel to dynamically produce new outputs when one or
more inputs in the referenced cells are changed. Cell references also allow you
to trace how outputs are being calculated in a formula. As a result, you should
never use a calculator to determine a mathematical output and type it into
the cell location of a worksheet. Doing so eliminates Excel’s cell-referencing
benefits as well as your ability to trace a formula to determine how outputs are
being produced.

Figure 2.3 "Adding a Formula to a Worksheet" shows how the formula appears in
cell C3 before you press the ENTER key. Figure 2.4 "Formula Output for Monthly

Spend" shows the output of the formula after you press the ENTER key. The
monthly spend for Household Utilities is $250 because the formula is taking the
Annual Spend in cell D3 and dividing it by 12. If the value in cell D3 is changed, the
formula automatically produces a new output. We are calculating the spend per
month for each category because people often get paid and are billed for these
items on a monthly basis. This formula allows you to compare your monthly income
to your monthly bills to determine whether you have enough income to pay these

expenses.

Figure 2.3 Adding a Formula to a Worksheet

X - -

13

Home Insert Page Layout Formulas Data Review View

Excel Objective 2.00 - Microsoft Excel

& 2 AN == S -
La- :
o B u AT EEEIEE | $ ’
7 -
Clipboard Font Alignment Number
IF X v & | =D3/12
A B (G D E F C
EXP ense Plan The blue border
1 (Does not include mortgage and car) indicates that this cell is
Percent of |Monthly [Annual / Percent referenced in a formula.
2 Category Total Spend Spend K LY Spend |Change
3 Household Utilities =D3/12] |$ 3,000]$ 3.000
4 Food $ 2500 |3% 2,250
5 Gasoline $ 1,500 % 1,200
6 |Clothes $ 1,200 |$ 1,000
7 lnaiirancra * 1EBNN & 1 ANN
N (Cell D3 is the cell reference
The formula begins ey —
with an equal sign. L .

2.1 Formulas
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Figure 2.4
(5 K R
- | The formula in the activated
= M £| 03124 L cellis displayed here. ]
A B | ¢ ] D E F T
Expense Plan
1 (Does not include mortgage and car)
Percent of [Monthly |Annual Percent

2 Category Total Spend Spend LY Spend [Change

3 |Household Utilities $§ 250|$ 3,000 |$ 3,000

4 Food $ 2500[% 2250

5 Gasoline $ 1,500|% 1,200

6 Clothes $ 1,200]|$ 1,000

7 lneniranca Q 1 ENN 1 &« 1 BNnN

After pressing the Enter key, the
formula displays the output.

Why?

Use Universal Constants

If you are using constants, or numerical values, in an Excel formula, they
should be universal constants that do not change, such as the number of days in
a week, weeks in a year, and so on. Do not type the values that exist in cell
locations into an Excel formula. This will eliminate Excel’s cell-referencing
benefits, which means if the value in the cell location you are using in a formula
is changed, Excel will not be able to produce a new output.

Relative References (Copying and Pasting Formulas)

Follow-along file: Continue with Excel Objective 2.00. (Use file Excel Objective 2.01 if
starting here.)

Lesson Video: Relative References

(click to see video)
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4. Excel automatically adjusts a
cell reference used in a formula
or function relative to its
original location when it is
pasted into new cell locations.

2.1 Formulas

Once a formula is typed into a worksheet, it can be copied and pasted to other cell
locations. For example, Figure 2.4 "Formula Output for Monthly Spend" shows the
output of the formula that was entered into cell C3. However, this calculation needs
to be performed for the rest of the cell locations in Column C. Since we used the D3
cell reference in the formula, Excel automatically adjusts that cell reference when
the formula is copied and pasted into the rest of the cell locations in the column.
This is called relative referencing” and is demonstrated as follows:

Click cell C3.

Click the Copy button in the Home tab of the Ribbon.

Highlight the range C4:C11.

Click the Paste button in the Home tab of the Ribbon.

Double click cell C6. Notice that the cell reference in the formula is
automatically changed to Dé.

6. Pressthe ENTER key.

A

Figure 2.5 "Relative Reference Example" shows the outputs added to the rest of the
cell locations in the Monthly Spend column. For each row, the formula takes the
value in the Annual Spend column and divides it by 12. You will also see that cell D6
has been double clicked to show the formula. Notice that Excel automatically
changed the original cell reference of D3 to D6. This is the result of relative
referencing, which means Excel automatically adjusts a cell reference relative to its
original location when it is pasted into new cell locations. In this example, the
formula was pasted into eight cell locations below the original cell location. As a
result, Excel increased the row number of the original cell reference by a value of
one for each row it was pasted into.

Figure 2.5 Relative Reference Example

A B C D E - (
Expense Plan

1 (Does not include mortgage and car)

Percent of |Monthly |Annual Percent
2 Category Total Spend Spend LY Spend |Change
3 Household Utilities 3 250 | % 3,000(% 3,000
4 Food 3 208 |% 2500(|% 2250
5 Gasoline 3 1251% 1,500 % 1,200
6 Clothes =D6/12 [$ 1,200]$ 1,000
7 Insurance 125|$% 1,500 | $ 1,500 -
8 Taxes $| 202 1% 3500 |3 3.500 || automatically changed when the
9 Entertainment $ 167 |$ 2000|3% 2250 f°fmU'§WfSPastefdhe'e,because
10 Vacation $ 125|$ 1,500|S 2,000 ofrelativereferencing.
11 Miscellaneous $ 104|% 1250|% 1,558
12 Totals
13 Number of Categories
1 Aviarana @nand
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Why?
Use Relative Referencing

Relative referencing is a convenient feature in Excel. When you use cell
references in a formula, Excel automatically adjusts the cell references when
the formula is pasted into new cell locations. If this feature were not available,
you would have to manually retype the formula when you want the same
calculation applied to other cell locations in a column or row.

Creating Complex Formulas (Controlling the Order of Operations)

Follow-along file: Continue with Excel Objective 2.00. (Use file Excel Objective 2.02 if
starting here.)

Lesson Video: Complex Formulas

(click to see video)

The next formula to be added to the Personal Budget workbook is the percent
change over last year. This formula determines the difference between the values in
the LY (Last Year) Spend column and shows the difference in terms of a percentage.
This requires that the order of mathematical operations be controlled to get an
accurate result. Table 2.3 "Standard Order of Mathematical Operations" shows the
standard order of operations for a typical formula. To change the order of
operations shown in the table, we use parentheses to process certain mathematical
calculations first. This formula is added to the worksheet as follows:

Click cell F3 in the Budget Detail worksheet.

Type an equal sign (=).

Type an open parenthesis (().

Click cell D3. This will add a cell reference to cell D3 to the formula.
When building formulas, you can click cell locations instead of typing
them.

5. Type a minus sign (-).

6. Click cell E3 to add this cell reference to the formula.

e

123


http://www.gone.2012books.lardbucket.org/sites/all/files/ManzoExcel_1.0_Excel_Objective_2.02.xlsx
http://www.youtube.com/v/Ysl2vFE-dBo?rel=0

Chapter 2 Mathematical Computations

2.1 Formulas

7. Type a closing parenthesis ().

8. Type the slash (/) symbol for division.

9. Click cell E3. This completes the formula that will calculate the percent
change of last year’s actual spent dollars vs. this year’s budgeted spend
dollars (see Figure 2.6 "Adding the Percent Change Formula").

10. Press the ENTER key.

11. Click cell F3 to activate it.

12. Place the mouse pointer over the Auto Fill Handle.

13. When the mouse pointer turns from a white block plus sign to a black
plus sign, click and drag down to cell F11. This pastes the formula into
the range F4:F11.

Table 2.3 Standard Order of Mathematical Operations

First: Excel executes any exponential computations first.

Second: Excel performs any multiplication or division computations second. When
or / | there are multiple instances of these computations in a formula, they are
executed in order from left to right.

Third: Excel performs any addition or subtraction computations third. When
+or- | there are multiple instances of these computations in a formula, they are
executed in order from left to right.

Override Standard Order: Any mathematical computations placed in parentheses
are performed first and override the standard order of operations. If there are
layers of parentheses used in a formula, Excel computes the innermost
parentheses first and the outermost parentheses last.

0

Figure 2.6 "Adding the Percent Change Formula" shows the formula that was added
to the Budget Detail worksheet to calculate the percent change in spending. The
parentheses were added to this formula to control the order of operations. Any
mathematical computations placed in parentheses are executed first before the
standard order of mathematical operations (see Table 2.3 "Standard Order of
Mathematical Operations"). In this case, if parentheses were not used, Excel would
produce an erroneous result for this worksheet.
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Figure 2.6 Adding the Percent Change Formula

- v (" X ¥ | =(D3-E3)/E3
A B C D E [ F | ¢

Expense Plan

1 (Does not include mortgage and car)

Percent of |Monthly [Annual Percent
2 Category Total Spend Spend LY Spend |Change
3 |Household Utilities $ 250 |%$ 3,000,$ 3,000 =(D3-E3)/E3|
4 Food $ 208 |$ 2,500 |$ 2,250 1M 1%
5 Gasoline $ 125|$ 1,500 |$ 1,200 2%.0% rMathematicalcomputationsin ]
6 Clothes 3 100 | $ 1,200 | $ 1,000 20.0% L parentheses are performed first.
7 Insurance $ 125|1% 1,500 $ 1,500 0.0%
8 Taxes $ 292 (% 3,500 |$ 3,500 0.0%
9 Entertainment 3 167 |$ 2,000 (% 2,250 -11.1%
10 Vacation $ 125|%$ 1,500 | $ 2,000 -25.0%
11 Miscellaneous $ 104 |$ 1250 |$ 1,558 -19.8%
12 Totals
13 Number of Categories
a4 Aviarama CnAand

Figure 2.7 "Removing the Parentheses from the Percent Change Formula" shows the
result of the percent change formula if the parentheses are removed. The formula
produces a result of a 299900% increase. Since there is no change between the LY
spend and the budget Annual Spend, the result should be 0%. However, without the
parentheses, Excel is following the standard order of operations. This means the
value in cell E3 will be divided by E3 first (3,000/3,000), which is 1. Then, the value
of 1 will be subtracted from the value in cell D3 (3,000-1), which is 2,999. Since cell
F3 is formatted as a percentage, Excel expresses the output as an increase of
299900%.

Figure 2.7 Removing the Parentheses from the Percent Change Formula

p
Without the use of parentheses, J

Excel will perform the calculation
F3 - %| oa3fes ) of E3/E3 first.
A C D E N <
Expense Plan
1 (Does not include mortgage and car)
Percent of |Monthly |Annual Percent
2 Category Total Spend Spend LY Spend |Change
3 \Household Utilities 3 250 ($ 3,000 % 3,000 | 299900%
4 Food 3 208 |% 2500|% 2250 11.1% —
c [Raenline &« 41285l 1&0n & 1900 pYyery)| B bEn s
result because of a poorly
constructed formula.

2.1 Formulas 125



Chapter 2 Mathematical Computations

2.1 Formulas

Integrity Check

Does the Output of Your Formula Make Sense?

It is important to note that the accuracy of the output produced by a formula
depends on how it is constructed. Therefore, always check the result of your
formula to see whether it makes sense with data in your worksheet. As shown
in Figure 2.7 "Removing the Parentheses from the Percent Change Formula", a
poorly constructed formula can give you an inaccurate result. In other words,
you can see that there is no change between the Annual Spend and LY Spend
for Household Utilities. Therefore, the result of the formula should be 0%.
However, since the parentheses were removed in this case, the formula is
clearly producing an erroneous result.

Skill Refresher: Formulas

(click to see video)

Type an equal sign (=).

Click or type a cell location. If using constants, type a number.
Type a mathematical operator.

Click or type a cell location. If using constants, type a number.
Use parentheses where necessary to control the order of
operations.

6. Press the ENTER key.

g &= W N =

Auditing Formulas

Lesson Video: Auditing Formulas

(click to see video)

Follow-along file: Continue with Excel Objective 2.00. (Use file Excel Objective 2.03 if
starting here.)
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Excel provides a few tools that you can use to review the formulas entered into a
worksheet. For example, instead of showing the outputs for the formulas used in a
worksheet, you can have Excel show the formula as it was entered in the cell
locations. This is demonstrated as follows:

1. With the Budget Detail worksheet open, click the Formulas tab of the
Ribbon.

2. Click the Show Formulas button in the Formula Auditing group of
commands. This displays the formulas in the worksheet instead of
showing the mathematical outputs.

3. Click the Show Formulas button again. The worksheet returns to
showing the output of the formulas.

Figure 2.8 "Show Formulas Command" shows the Budget Detail worksheet after
activating the Show Values command in the Formulas tab of the Ribbon. As shown
in the figure, this command allows you to view and check all the formulas in a
worksheet without having to click each cell individually. After activating this
command, the column widths in your worksheet increase significantly. The column
widths were adjusted for the worksheet shown in Figure 2.8 "Show Formulas
Command" so all columns can be seen. The column widths return to their previous
width when the Show Formulas command is deactivated.

Figure 2.8 Show Formulas Command

Lﬂ‘ bd - - G} 5 Excel Objective 2.00 - Microsoft Excel 1
Home Insert Pagelayout Formulas  Data  Review  View @ c

- - > p a =]

ﬁ 2 @ @ ‘ ;AJ ﬁ ﬁ @ mm § 5 Define Name ~ SlaTrace precedents |l show Fogmulas Fw
o a &5 — ]

— Fa (3 Trace Dependents ¥} Error che\pg ~ | & —

Insert | AutoSum Recently Financial Logical Text Date& Lookup& Math& More | Name - Watch | Calculat
Function | v Usedv v - ~  Time~ Reference » Trig~ Functions v | Manager EE Create from Selection | i Remove Arrows v (&) Evaluate Form\fa | Window | Option:
Function Library Defined Names Formula Auditing Calcu

115 A 5 The Show Formulas
A B (€ D E F G command is activated.

Expense Plan
1 (Does not include mortgage and car)
Monthly
2 Category |Percent of Total |Spend Annual Spend [LY Spend |Percent Change
3 Household Utilities =D3/12 3000 3000 =(D3-E3)/E3
4 Food =D4/12 2500 2250 =(D4-E4)/E4
5 Gasoline =D5/12 1500 1200 =(D5-E5)/E5
6 Clothes =D6/12 1200 1000 =(D6-E6)/E6 The formulas are displayed
7 Insurance =D7/12 1500 1500 =(D7-E7)E7 ‘"Sﬁgi;’;;z:’:g:‘;‘:'"":’;:e
8 Taxes =D8/12 3500 3500 =(D8-E8)/E8 BeaiaEl
9 Entertainment =D9/12 2000 2250 =(D9-E9)/EQ
10 Vacation =D10/12 1500 2000 =(D10-E10)/E10
11 Miscellaneous =D11/12 1250 15584 |=(D11-E11)/E11
12 Totals \
13 Number of Categories /
14| Average Spend| i feamres’are removed when the
15 Min Spend L Show Formulas command is activated. J

< » [ Budget Summary | Budget Detail /~ Mortgage Payments  Car Lease Payments |4 w
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Skill Refresher: Show Formulas

(click to see video)

. Click the Formulas tab on the Ribbon.

2. Click the Show Formulas button in the Formula Auditing group of

commands.
. Click the Show Formulas button again to show formula outputs.

Mouseless Commands

Show Formulas

+ Hold down the CTRL key while pressing the accent symbol ().

Two other tools in the Formula Auditing group of commands are the Trace
Precedents and Trace Dependents commands. These commands are used to trace
the cell references used in a formula. The Trace Dependents command shows where
any given cell is referenced in a formula. The Trace Precedents command shows
what cells have been referenced in a formula that exists in an activated cell. The
following is a demonstration of these commands:

2.1 Formulas

. Click cell D3 in the Budget Detail worksheet.
. Click the Trace Dependents button in the Formula Auditing group of

commands in the Formulas tab of the Ribbon. A double blue arrow
appears, pointing to cell locations C3 and F3 (see Figure 2.9 "Trace
Dependents Example"). This indicates that cell D3 is referenced in
formulas that are entered in cells C3 and F3.

. Click the Remove Arrows command in the Formula Auditing group of

commands in the Formulas tab of the Ribbon. This removes the Trace
Dependents arrow.

. Click cell F3 in the Budget Detail worksheet.
. Click the Trace Precedents button in the Formula Auditing group of

commands in the Formulas tab of the Ribbon. A blue arrow running
through cells D3 and E3 and pointing to cell F3 appears (see Figure 2.10
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2.1 Formulas

"Trace Precedents Example"). This indicates that cells D3 and E3 are
references in a formula entered in cell F3.
6. Click the Remove Arrows command in the Formula Auditing group of

commands in the Formulas tab of the Ribbon. This removes the Trace
Precedents arrow.

Figure 2.9 "Trace Dependents Example" shows the Trace Dependents arrow on the

Budget Detail worksheet. The blue dot represents the activated cell. The arrows
indicate where the cell is referenced in formulas.

Figure 2.9 Trace Dependents Example

[/ Epr=T

Click here to activate the
Home Insert  Pagelayout Formulas  Data Trace Dependents command.
= = a < 7 - 2 2 5 Define Name ~ S Trace proddents B show Formulas | =7
e vy A F
UL fPuseinF a

{3 Trace Dependents ¥ Error checking + | &
Insert AutoSum Recently Financial Logical Text Date & Lookup & Math & More Name N Wat
Function v Usedv - ~  Time~ Reference~ Trig~ Functions v  Manager ES Create from Selection | i, Remove Arrows ~ (£) Evaluate Formula | Winc

Excel Objective 2.00 - Microsoft Excel

Review View

Function Library Defined Names

Formula Auditing

D3 v J | 3000
A B C D [ E F G I J
1 (Does not include mortgage and car) Trace Dependents arrow.
Percentof [Monthly |Annual Percent Trabiue dot i placed
2 Category Total |spend  [spend lLy-Spend |Chang
3 |Household Utilities $ <5250 A 0.0%
4 Food S 288[S 2500($% 2,% i 11.1%
5 Gasoline $ 125 \3\1,500 ,200 25.0%
P al PN

3 4nn e I™qnpte 41 nnn ~n nor
The arrows point to cell locations
that contain formulas where the
active cell is referenced.

Figure 2.10 "Trace Precedents Example" shows the Trace Precedents arrow on the
Budget Detail worksheet. The blue dots on this arrow indicate the cells that are
referenced in the formula contained in the activated cell. The arrow is pointing to
the activated cell location that contains the formula.

Figure 2.10 Trace Precedents Example

Click here to activate the
@\ H L TS & = Excel Objective 2.00 - Microsoft Excel Trace Precedents command.
Home  Insert  Pagelayout  Formulas  Data  Review  View

- - T— . - - " B} & . -
fr 2 ﬁj @ ﬁ JAJ ﬁ ﬁ @ m § ,;?Dfﬁnerﬂ'amer FtaTrace Precedents B3 show Formulas "

-] =1
v =3 Trace Dependents ¥ Error Checking ~

Insert | AutoSum Recently Financial Logical ~Text Date & Lookup& Math& More Name ,

Function v Usedv v - v  Time~ Reference Trig~ Functions~  Manager B Create from Selection i, Remove Arrows v @ Evaluate Formula

Defined Names

Function Library

F3 - | =(D3-E3)/€3
A B C D E F G H |
Expense Plan

Formula Auditing

J

1 (Does not include mortgage and car) The arrow-is pointing to
Percentof |Monthly |Annual Percent { the activated cell ]

2 Category Total Spend Spend LY Spend [Ch:

3 \Household Utilities $ 250 | $%3:066 3:060 0.0%

4 Food $ 208 | $ 00 2,250 11.1%

5 Gasoline S  125]S$ 1.50Q 1,200 25.0%

| AlAthAn e 4nn | & 4 anaNe 4 nnn AN no’

The blue dots indicate the cells
that are referenced in the formula
contained in cell F3.
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Skill Refresher: Trace Dependents

(click to see video)

1. Click a cell location that contains a number or formula.

2. Click the Formulas tab on the Ribbon.

3. Click the Trace Dependents button in the Formula Auditing group
of commands.

4. Use the arrow(s) to determine where the cell is referenced in
formulas and functions.

5. Click the Remove Arrows button to remove the arrows from the
worksheet.

Skill Refresher: Trace Precedents

(click to see video)

1. Click a cell location that contains a formula or function.

2. Click the Formulas tab on the Ribbon.

3. Click the Trace Precedents button in the Formula Auditing group
of commands.

4, Use the dot(s) along the line to determine what cells are
referenced in the formula or function.

5. Click the Remove Arrows button to remove the line with the dots.
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Chapter 2 Mathematical Computations

KEY TAKEAWAYS

+ Mathematical computations are conducted through formulas and
functions.

¢ An equal sign (=) precedes all formulas and functions.

« Formulas and functions must be created with cell references to conduct
what-if scenarios where mathematical outputs are recalculated when
one or more inputs are changed.

« Mathematical operators on a typical calculator are different from those
used in Excel. Table 2.2 "Excel Mathematical Operators" lists Excel
mathematical operators.

« When using numerical values in formulas and functions, only use
universal constants that do not change, such as days in a week, months
in a year, and so on.

« Relative referencing automatically adjusts the cell references in
formulas and functions when they are pasted into new locations on a
worksheet. This eliminates the need to retype formulas and functions
when they are needed in multiple rows or columns on a worksheet.

« Parentheses must be used to control the order of operations when
necessary for complex formulas.

« Formula auditing tools such as Trace Dependents, Trace Precedents, and
Show Formulas should be used to check the integrity of formulas that
have been entered into a worksheet.
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EXERCISES

2.1 Formulas

. Which of the following terms best describes how Excel is able to

change the outputs of formulas and functions when one or more
inputs are changed?

absolute references

cell references

relative references

dynamic output referencing

o op

. Which of the following best describes the proper use of numbers

when constructing formulas in Excel?

a. Numbers cannot be used in the construction of formulas. You
can use only cell locations.

b. You cannot combine numbers and cell locations in a formula.
This will produce an error.

c. Numbers should always be used when creating formulas in
Excel.

d. Numbers should be used when constructing formulas with
constants that do not change, such as the days in a week,
months in a year, and so on.

. Which of the following will be calculated first in the formula

=((C10-D2)*A9)+B5*C5?

D2*A9

B5*C5

C10-D2

A9 * the result of (C10-D2)

o op

. Which of the following formula auditing features would you use

if you wanted to see where a specific cell location was referenced
in formulas entered into a worksheet?

Show Formulas

Trace Precedents

Trace Dependents

Show Cell Reference Mapping

o op
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2.2 Statistical Functions

LEARNING OBJECTIVES

Use the SUM function to calculate totals.

Use absolute references to calculate percent of totals.

Use the COUNT function to count cell locations with numerical values.

Use the AVERAGE function to calculate the arithmetic mean.

Use the MAX and MIN functions to find the highest and lowest values

in a range of cells.

6. Learn how to copy and paste formulas without formats applied to a cell
location.

7. Learn how to set a multiple level sort sequence for data sets that have

duplicate values or outputs.

QO = W N =

In addition to formulas, another way to conduct mathematical computations in
Excel is through functions. Statistical functions apply a mathematical process to a
group of cells in a worksheet. For example, the SUM function is used to add the
values contained in a range of cells. A list of commonly used statistical functions is
shown in Table 2.4 "Commonly Used Statistical Functions". Functions are more
efficient than formulas when you are applying a mathematical process to a group of
cells. If you use a formula to add the values in a range of cells, you would have to
add each cell location to the formula one at a time. This can be very time-
consuming if you have to add the values in a few hundred cell locations. However,
when you use a function, you can highlight all the cells that contain values you wish
to sum in just one step. This section demonstrates a variety of statistical functions
that we will add to the Personal Budget workbook. In addition to demonstrating
functions, this section also reviews percent of total calculations and the use of
absolute references.

Table 2.4 Commonly Used Statistical Functions

Function Output

ABS The absolute value of a number

AVERAGE | The average or arithmetic mean for a group of numbers

COUNT The number of cell locations in a range that contain a numeric character
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2.2 Statistical Functions

The number of cell locations in a range that contain a text or numeric
COUNTA
character
MAX The highest numeric value in a group of numbers
The middle number in a group of numbers (half the numbers in the group are
MEDIAN | higher than the median and half the numbers in the group are lower than the
median)
MIN The lowest numeric value in a group of numbers
MODE The number that appears most frequently in a group of numbers
PRODUCT | The result of multiplying all the values in a range of cell locations
SQRT The positive square root of a number
STDEV.S | The standard deviation for a group of numbers based on a sample
SUM The total of all numeric values in a group

The SUM Function

Follow-along file: Continue with Excel Objective 2.00. (Use file Excel Objective 2.03 if
starting here.)

Lesson Video: SUM Function

(click to see video)

The SUM function is used when you need to calculate totals for a range of cells or a
group of selected cells on a worksheet. With regard to the Budget Detail
worksheet, we will use the SUM function to calculate the totals in row 12. It is
important to note that there are several methods for adding a function to a
worksheet, which will be demonstrated throughout the remainder of this chapter.
The following illustrates how a function can be added to a worksheet by typing it
into a cell location:

A o S .

Click the Budget Detail worksheet tab to open the worksheet.
Click cell C12.

Type an equal sign (=).

Type the function name SUM.

Type an open parenthesis (().
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2.2 Statistical Functions

Click cell C3 and drag down to cell C11. This places the range C3:C11
into the function.

Type a closing parenthesis ().

Press the ENTER key. The function calculates the total for the Monthly
Spend column, which is $1,496.

Figure 2.11 "Adding the SUM Function to the Budget Detail Worksheet" shows the

appearance of the SUM function added to the Budget Detail worksheet before
pressing the ENTER key.

Figure 2.11 Adding the SUM Function to the Budget Detail Worksheet

- X v f| =SUM(C3:C11)

A B | ¢ ] D E F L«
Expense Plan /(The blue outline shows the range]

1 (Does not include mortgage and car) of cells included in the function.

Percent of |Monthly |Annual Percent
2 Category Total Spend Spe@/ LY Spend |Change
3 Household Utilities $ 250 45~ 3,000 [$ 3,000 0.0%
4 Food $ 208 |$ 2,500 | $ 2,250 11.1%
5 Gasoline $ 125|$ 1,500 | $ 1,200 25.0%
6 Clothes $ 100 |$ 1,200 |$ 1,000 20.0%
7 |Insurance $ 125|% 1,500 % 1,500 0.0%
8 Taxes $ 292 |$ 3,500 | $ 3,500 0.0%
9 Entertainment $ 167 |$ 2,000|% 2250 -11.1%
10 Vacation $ 125|$ 1,500 | $ 2,000 -25.0%
11 Miscellaneous $ 104]% 1250|% 1,558 -19.8%
12 Totals |=sum(c3:c11) .
13 Number of Categories \f This function will calculate the }
14 Average Spend L totalffthevaluesin this range.
15 Min Spend

4 4 » M| Budget Summary | Budget Detail ~~ Mortgage Payments . Car Lease Payments /2[4

As shown in Figure 2.11 "Adding the SUM Function to the Budget Detail
Worksheet", the SUM function was added to cell C12. However, this function is also

needed to calculate the totals in the Annual Spend and LY Spend columns. The
function can be copied and pasted into these cell locations because of relative
referencing. Relative referencing serves the same purpose for functions as it does
for formulas. The following demonstrates how the total row is completed:

e

Click cell C12 in the Budget Detail worksheet.

Click the Copy button in the Home tab of the Ribbon.

Highlight cells D12 and E12.

Click the Paste button in the Home tab of the Ribbon. This pastes the
SUM function into cells D12 and E12 and calculates the totals for these
columns.

Click cell F11.
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2.2 Statistical Functions

6. Click the Copy button in the Home tab of the Ribbon.

7. Click cell F12, then click the Paste button in the Home tab of the
Ribbon. Since we now have totals in row 12, we can paste the percent
change formula into this row.

Figure 2.12 "Results of the SUM Function in the Budget Detail Worksheet" shows the
output of the SUM function that was added to cells C12, D12, and E12. In addition,
the percent change formula was copied and pasted into cell F12. Notice that this
version of the budget is planning a 1.7% decrease in spending compared to last year.

Figure 2.12
K1 - £
A B C D E F G
T Expense Plan
1 (Does not include mortgage and car)
Percentof |Monthly |Annual Percent
2 Category Total Spend Spend LY Spend |Change
3 Household Utilities $ 250 |$ 3,000 $ 3,000 0.0%
4 Food $ 208 |$ 2500 |% 2250 11.1%
5 Gasoline 3 125|/% 1,500 | $ 1,200 25.0%
6 Clothes $ 100 |$ 1,200 | $ 1,000 20.0%
7 Insurance 3 125|/% 1,500 | $ 1,500 0.0%
8 Taxes $ 292 |$ 3,500 |$ 3,500 0.0%
9 Entertainment $ 167 |$ 2,000 |$ 2250 -11.1%
10 Vacation $ 125|% 1,500 | % 2,000 -25.0%
11 Miscellaneous 3 104 |$ 1250 |% 1,558 -19.8%
12 Totals 1,496 17,950 18,258 -1.7%
2 ‘$\V\ : \ v\
13 Number of Categories The percent change formula
~—)\ was pasted here since totals
14 Average Spend Outputs created by [have been added to row 12.]
15 Min Spend SUM functions.

4 4 » M| Budget Summary | Budget Detail /~ Mortgage Payments . Car Lease Payments 3[4
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Integrity Check

Cell Ranges in Statistical Functions

When you intend to use a statistical function on a range of cells in a worksheet,
make sure there are two cell locations separated by a colon and not a comma. If
you enter two cell locations separated by a comma, the function will produce an
output but it will be applied to only two cell locations instead of a range of cells.
For example, the SUM function shown in Figure 2.13 "SUM Function Adding
Two Cell Locations" will add only the values in cells C3 and C11, not the range
C3:C11.

Figure 2.13

C D
Monthly |Annual
2 Spend Spend
3 $ 202/$ 3
4 9 250 1% 3
5% 20818 2,
6 9 167 |$ 2,
7 9 125§ 1.
g8 $ 125§ 1.
9 $ 12518 1,
10 $ 1048 1.
1175100 |5t Tresenmaindiate v rcion il

12 =sum(c3Yc11)

Absolute References (Calculating Percent of Totals)

Follow-along file: Continue with Excel Objective 2.00. (Use file Excel Objective 2.04 if
starting here.)
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Lesson Video: Absolute References

(click to see video)

Since totals were added to row 12 of the Budget Detail worksheet, a percent of total
calculation can be added to Column B beginning in cell B3. The percent of total
calculation shows the percentage for each value in the Annual Spend column with
respect to the total in cell D12. However, after the formula is created, it will be
necessary to turn off Excel’s relative referencing feature before copying and pasting
the formula to the rest of the cell locations in the column. Turning off Excel’s
relative referencing feature is accomplished through an absolute reference. The
following steps explain how this is done:

1. Click cell B3 in the Budget Detail worksheet.
2. Type an equal sign (=).

3. Click cell D3.

4. Type a forward slash (/).

5. Click cell D12.

6.

Press the ENTER key. You will see that Household Utilities represents
16.7% of the Annual Spend budget (see Figure 2.14 "Adding a Formula
to Calculate the Percent of Total").
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5. Error code displayed in a cell
containing a formula or
function that is trying to divide
by zero.

2.2 Statistical Functions

Figure 2.14 Adding a Formula to Calculate the Percent of Total

83 A fe | =D3/D12 Formula entered
u into B3
A M D E :

Expense Plan

1 (Does not include mortgage and car)

Percent of (Monthly |Annual Percent
2 Category Total Spend Spend LY Spend |Change
3 |Household Utilities 16.7%)| $ 250|% 3,000|% 3,000 0.0%
4 Food f $ 208 |% 2500|% 2250 11.1%
5 Gasoline / 3 1251% 1,500|% 1,200 25.0%
6 Clothes / $ 100]$ 1,200|% 1,000 20.0%
7 Insurance / % 1251% 1,500 | % 1,500 0.0%
8 |Taxes [ $ 292|% 3,500[$ 3,500 0.0%
9 |Entertainment / 3 167 |$ 20003 2250 -11.1%
10 Vacation / $ 12513 1500($ 2,000 -25.0%
11 Miscellaneous I $ 104 |3 1250|% 1,558 -19.8%
12 Totals / $ 1,496 | % 11950 $ 18,258 -1.7%
13 /\Ium ber of Categories
14 / Average Spend
15 Min Spend
i« 4 » [ Budget Summary || Budget Detail /~ Mortgage Paymeifts .~ Car Lease Payments /%J <E

Household Utilities

represents 16.7% of the total
Annual Spend in cell D12. J

Figure 2.14 "Adding a Formula to Calculate the Percent of Total" shows the
completed formula that is calculating the percentage that Household Utilities
Annual Spend represents to the total Annual Spend for the budget (see cell B3).
Normally, we would copy this formula and paste it into the range B4:B11. However,
because of relative referencing, both cell references will increase by one row as the
formula is pasted into the cells below B3. This is fine for the first cell reference in
the formula (D3) but not for the second cell reference (D12). Figure 2.15 "#DIV/0
Error from Relative Referencing" illustrates what happens if we paste the formula
into the range B4:B12 in its current state. Notice that Excel produces the #DIV/0’
error code. This means that Excel is trying to divide a number by zero, which is
impossible. Looking at the formula in cell B4, you see that the first cell reference
was changed from D3 to D4. This is fine because we now want to divide the Annual
Spend for Insurance by the total Annual Spend in cell D12. However, Excel has also
changed the D12 cell reference to D13. Because cell location D13 is blank, the
formula produces the #DIV/0 error code.
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6. Prevents Excel from using
relative referencing to change
a cell reference used in a
formula or function; an
absolute reference is applied to
a cell reference by typing a
dollar sign ($) in front of the
column letter and row number.

2.2 Statistical Functions

Figure 2.15 #DIV/0 Error from Relative Referencing

IF

- X v f =D4/D13

A B C D E F

Expense Plan
1 (Does not include mortgage and car)
Percent of Monthly Annual Percent
2 Category Total Spend Spend LY Spend Change
3 Household Utilities 16.7%| $ 250 |$ 3,000 % 3,000 0.0%
4 Food |=D4/D13 |$ 208|$% 2,500 2,250 11.1%
5 Gasoline '%V/O! 3 12513 1,500 |3 1,200 25.0%
6 Clothes #DIVI’O! $ 100|% 1200|% 1,000 20.0%
7 Insurance /{#DIV/O! 3 125|3% 1,500 | $ 1,500 0.0%
8 Taxes /#DIV/O! 292 |% 3500|% 3,500 0.0%
9 Entertainment 4 #DIV/0! 3 $ 2000|3% 2250 -11.1%
10 Vacation / #DIV/O! | $ 125 1,500 | $ 2,000 -25.0%
11 Miscellaneous / #DIV/O! | $ 104 |$ 1.250]$ 1,558 -19.8%
12 Totals $ 1,496 | $ 17,950 | $ 18,258 -1.7%
13 Number of Categories 4
error code.
14 Average Spend
15 Min Spend
4 M Bud,det Summary | Budget Detail /~ Mortgage Paymenfs .~ Car Lease Payments /<[ 4|
Relative Referencing changed\]
this cell reference to D13, but

|

cell D13 is blank.

To eliminate the divide-by-zero error shown in Figure 2.15 "#DIV/0 Error from
Relative Referencing", we must add an absolute reference to cell D12 in the formula.

An absolute reference® prevents relative referencing from changing a cell
reference in a formula. This is also referred to as locking a cell. The following
explains how this is accomplished:

® N

Double click cell B3.

Place the mouse pointer in front of D12 and click. The blinking cursor
should be in front of the D in the cell reference D12.

Press the F4 key. You will see a dollar sign ($) added in front of the
column letter D and the row number 12. You can also type the dollar
signs in front of the column letter and row number.

Press the ENTER key.

Click cell B3.

Click the Copy button in the Home tab of the Ribbon.

Highlight the range B4:B11.

Click the Paste button in the Home tab of the Ribbon.

Figure 2.16 "Adding an Absolute Reference to a Cell Reference in a Formula" shows
the percent of total formula with an absolute reference added to D12. Notice that in

cell B4, the cell reference remains D12 instead of changing to D13 as shown in
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Figure 2.15 "#DIV/0 Error from Relative Referencing". Also, you will see that the

percentages are being calculated in the rest of the cells in the column, and the
divide-by-zero error is now eliminated.

Figure 2.16
IF v X v f | =D4/sDs12
A B | C D E F
Expense Plan
1 (Does not include mortgage and car)
Percent of |Monthly |Annual Percent

2 Category Total Spend Spend LY Spend [Change
3 Household Utilities 16.7%| $ 250 % 3,000|% 3,000 0.0%
4 \Food =D4!$D$12| $ 208 |3 2500/% 2250 11.1%
5 Gasoline 4 84%| 3 125|% 1500|% 1,200 25.0%
6 Clothes / 6.7%| $ 100%$ 1,200($% 1,000 20.0%
7 Insurance / 8.4%| % 125|% 1500(% 1,500 0.0%
8 Taxes / 19.5%| $ 292 |3% 3500|% 3,500 0.0%
9 Entertainment 11.1%| $ 167 |% 2,000(% 2250 -11.1%
10 Vacation / 84%| % 125|9% 1,500 | $ 2,000 -25.0%
11 Miscellaneous  / 7.0%| $ 104 |% 1250(% 1,558 -19.8%
12 Totals $ 1,496 | $ 17,950 | $ 18,258 -1.7%
13 Number of Categories
14 Average Spend
15 Min Spend
Mo ] Budget'iummary | Budget Detail /~ Mortgage Payments ~ Car Lease Payments /3 1E

The dollar signs indicate that
an absolute reference was

added to this cell.

|

Skill Refresher: Absolute References

(click to see video)

2.2 Statistical Functions

1. Click in front of the column letter of a cell reference in a formula
or function that you do not want altered when the formula or
function is pasted into a new cell location.

2. Press the F4 key or type a dollar sign ($) in front of the column

letter and row number of the cell reference.

141


http://www.youtube.com/v/Kry_8RPeR7E?rel=0

Chapter 2 Mathematical Computations

The COUNT Function

Follow-along file: Continue with Excel Objective 2.00. (Use file Excel Objective 2.05 if
starting here.)

Lesson Video: COUNT Function

(click to see video)

The next function that we will add to the Budget Detail worksheet is the COUNT
function. The COUNT function is used to determine how many cells in a range
contain a numeric entry. For the Budget Detail worksheet, we will use the COUNT
function to count the number of items that are planned in the Annual Spend
column (Column D). The following explains how the COUNT function is added to the
worksheet by using the function list:

Click cell D13 in the Budget Detail worksheet.

Type an equal sign (=).

Type the letter C.

Click the down arrow on the scroll bar of the function list (see Figure
2.17 "Using the Function List to Add the COUNT Function") and find
the word COUNT.

Double click the word COUNT from the function list.

Highlight the range D3:D11.

Type a closing parenthesis ().

Press the ENTER key. The function produces an output of 9 since there
are 9 items planned on the worksheet.

= WoN e

® N9

Figure 2.17 "Using the Function List to Add the COUNT Function" shows the
function list box that appears after completing steps 2 and 3 for the COUNT
function. The function list provides an alternative method for adding a function to a
worksheet.
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Figure 2.17 Using the Function List to Add the COUNT Function

AVERAGE v X & =
A B C D E F G
Percent of |Monthly Annual Percent
2 Category Total Spend Spend LY Spend |Change
3 Household Utilities 16.7%| $ 250 |$ 3,000 | $ 3,000 0.0%
4 Food 13.9%| $ 208 |$ 2500|% 2250 11.1%
5 Gasoline 84%| % 125|/% 1500 |% 1,200 25.0%
6 Clothes 6.7%| $ 100/$ 1,200 % 1,000 20.0%
7 Insurance 84%| $ 125/$ 1500 [$ 1,500 0.0%
8 Taxes 19.5%| $ 292|$ 3500 |$% 3,500 0.0%| Function list
9 Entertainment 11.1%| $ 167 |$ 2000 |9% 2250 -11.1%]
10 Vacation 84%| $ 125|$ 1,500 | $ 2,000 —2.%%
11 Miscellaneous 7.0%| $ 104 |$ 1250 |% 1,558 //1 9.8%
12 Totals $ 1,496 | $ 17,950 | convexr K - ;[ Double click the function name ]
D to add it to the worksheet.
13 | This definition appears Number of Categories =c| j‘cosu
14 m Counts the number of cells in a range that contain numbers " w
function name once. ) =
15 Min Spend ®
16 Max Spend

W 4« » M| Budget Summary | Budget Detail < Mortgage Payments Car Lease Payments _/¥J G

Enter

Click here to scroll through
the list to find a function.

Figure 2.18 "Completed COUNT Function in the Budget Detail Worksheet" shows the

output of the COUNT function after pressing the ENTER key. The function counts
the number of cells in the range D3:D11 that contain a numeric value. The result of
9 indicates that there are 9 categories planned for this budget.

Figure 2.18 Completed COUNT Function in the Budget Detail Worksheet

£ | =counT(D3:011) ¢

( The COUNT function as it

)

L appears in cell D13.
A B C D E F T
Percent of |Monthly |Annual Percent
2 Category Total Spend Spend LY Spend |Change
3 Household Utilities 16.7%| $ 250|$ 3,000(% 3,000 0.0%
4 Food 13.9%| $ 208 |$ 2500(% 2250 11.1%
5 Gasoline 8.4%| $ 1251% 1,500 |$ 1,200 25.0%
6 Clothes 6.7%| $ 100]$ 1,200|% 1,000 20.0%
7 |Insurance 8.4%| $ 125]1% 1500|% 1,500 0.0%
8 Taxes 19.5%| $ 202 |$ 3,500|% 3,500 0.0%
9 |Entertainment 11.1%| $ 167 |$ 2,000 | $ 2,250 -11.1%
10 Vacation 8.4%| $ 125|% 1,500 % 2,000 -25.0%
11 Miscellaneous 7.0%| $ 104 |$ 1250 |$ 1,558 -19.8%
12 Totals $ 1,496 | 8§ 17,950 | $ 18,258 -1.7%
ﬂ Number of Categories 9
14 Average Spend COUNT function
output
15 Min Spend
16 Max Spend
17

4 < » M [ Budget Summary | Budget Detail ~~ Mortgage Payments . Car Lease Payments /%[ 4[
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Follow-along file: Continue with Excel Objective 2.00. (Use file Excel Objective 2.06 if
starting here.)

Lesson Video: AVERAGE Function

(click to see video)

The next function we will add to the Budget Detail worksheet is the AVERAGE
function. This function is used to calculate the arithmetic mean for a group of
numbers. For the Budget Detail worksheet, we will use the function to calculate the
average of the values in the Annual Spend column. We will add this to the
worksheet by using the Function Library. The following steps explain how this is
accomplished:

1. Click cell D14 in the Budget Detail worksheet.

2. Click the Formulas tab on the Ribbon.

3. Click the More Functions button in the Function Library group of
commands.

4. Place the mouse pointer over the Statistical option from the drop-
down list of options.

5. Click the AVERAGE function name from the list of functions that
appear in the menu (see Figure 2.19 "Selecting the AVERAGE Function
from the Function Library"). This opens the Function Arguments dialog
box.

6. Click the Collapse Dialog button in the Function Arguments dialog box
(see Figure 2.20 "Function Arguments Dialog Box").

7. Highlight the range D3:D11.

8. Click the Expand Dialog button in the Function Arguments dialog box
(see Figure 2.21 "Selecting a Range from the Function Arguments
Dialog Box"). You can also press the ENTER key to get the same result.

9. Click the OK button on the Function Arguments dialog box. This adds
the AVERAGE function to the worksheet.

Figure 2.19 "Selecting the AVERAGE Function from the Function Library" illustrates
how a function is selected from the Function Library in the Formulas tab of the
Ribbon.
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Figure 2.19 Selecting the AVERAGE Function from the Function Library
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Figure 2.20 "Function Arguments Dialog Box" shows the Function Arguments dialog
box. This appears after a function is selected from the Function Library. The
Collapse Dialog button is used to hide the dialog box so a range of cells can be
highlighted on the worksheet and then added to the function.

Figure 2.20 Function Arguments Dialog Box

- = 1 1 | Collapse Dialog
Function Arguments | |
. e button
AVERAGE

Number1l D13

Number2 = number

The definition of the
function appears here.

=9
Returns the average (arithmetic mean) of its arguments, which can be numbers or names, arrays, or references that contain numbers.

Numberl: numberl,number2,... are 1 to 255 numeric arguments for which you want the average.

Formula result = $ 9

Help on this function [ oK J [ Cancel

Figure 2.21 "Selecting a Range from the Function Arguments Dialog Box" shows how
a range of cells can be selected from the Function Arguments dialog box once it has
been collapsed.
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Figure 2.21 Selecting a Range from the Function Arguments Dialog Box
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Figure 2.22 "Function Arguments Dialog Box after a Cell Range Is Defined for a
Function" shows the Function Arguments dialog box after the cell range is defined
for the AVERAGE function. The dialog box shows the result of the function before it
is added to the cell location. This allows you to assess the function output to
determine whether it makes sense before adding it to the worksheet.

Figure 2.22 Function Arguments Dialog Box after a Cell Range Is Defined for a Function

Function Arguments ‘i“ﬂ‘

AVERAGE The first few values that are

= {3000;250U;1500;1200;1500;3500;2000;1...4_ entered into the cell range
er appear here.

Number1 |D3:D11

Number2

The output of the ]

= 1994.444444 function appears here.
Returns the average (arithmetic mean) of its arqguments, which can be numbers or names, arrays, or references that contain numbers.

Number1: numberl,number2,... are 1 to 255 numeric arguments for which you want the average.

Formula result = §

Figure 2.23 "Completed AVERAGE Function" shows the completed AVERAGE
function in the Budget Detail worksheet. The output of the function shows that on
average we expect to spend $1,994 for each of the categories listed in Column A of
the budget. This average spend calculation per category can be used as an indicator
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to determine which categories are costing more or less than the average budgeted

spend dollars.
Figure 2.23
D14 - fe | =AVERAGE(D3:D11) < azﬁf:!::aégﬁ\fsgllcgﬁz
A B C D E :]
Percent of |Monthly |Annual Percent
2 Category Total Spend Spend LY Spend |Change
3 Household Utilities 16.7%| $ 250 |$ 3,000 | $ 3,000 0.0%
4 Food 13.9%| 3 208 |$ 2,500 | $ 2,250 11.1%
5 Gasoline 8.4%| $ 125|$ 1,500 | $ 1,200 25.0%
6 |Clothes 6.7%| % 100($ 1,200]$ 1,000 20.0%
7 |Insurance 8.4%| 3 125|$ 1,500 | $ 1,500 0.0%
8 Taxes 19.5%| $ 292 |$ 3,500 | $ 3,500 0.0%
9 |Entertainment 11.1%| $ 167 |$ 2,000 | $ 2,250 -11.1%
10 Vacation 8.4%| $ 125|$ 1,500 | $ 2,000 -25.0%
11 Miscellaneous 7.0%| $ 104 |$ 1250 |3 1,558 -19.8%
12 Totals $ 1,496 | § 17,950 | $ 18,258 -1.7%
13 Number of Categories 9
E Average Spend| $ 1,994 AVERﬁf;ﬂ:C“(’"
15 Min Spend
16 Max Spend
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4 4 » | Budget Summary | Budget Detail /~ Mortgage Payments
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The MAX and MIN Functions

Lesson Video: MAX and MIN Functions

(click to see video)

Ll

Follow-along file: Continue with Excel Objective 2.00. (Use file Excel Objective 2.07 if
starting here.)

The final two statistical functions that we will add to the Budget Detail worksheet
are the MAX and MIN functions. These functions identify the highest and lowest

values in a range of cells. The following steps explain how to add these functions to
the Budget Detail worksheet:

Click cell D15 in the Budget Detail worksheet.
Type an equal sign (=).
Type the word MIN.

Type an open parenthesis (().
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5. Highlight the range D3:D11.
. Type a closing parenthesis ()).
7. Press the ENTER key. The MIN function produces an output of $1,200,
which is the lowest value in the Annual Spend column (see Figure 2.24
"MIN Function Added to the Budget Detail Worksheet").

8. Click cell D16.

9. Type an equal sign (=).
10. Type the word MAX.
11. Type an open parenthesis (().
12. Highlight the range D3:D11.
13. Type a closing parenthesis ()).
14. Press the ENTER key. The MAX function produces an output of $3,500.

This is the highest value in the Annual Spend column (see Figure 2.25
"MAX Function Added to the Budget Detail Worksheet").

Figure 2.24
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Figure 2.25
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Skill Refresher: Statistical Functions

(click to see video)

1. Type an equal sign (=).
Type the function name followed by an open parenthesis (() or
double click the function name from the function list.

3. Highlight a range on a worksheet or click individual cell locations

followed by commas.
. Type a closing parenthesis ().
5. Press the ENTER key.

Copy and Paste Formulas (Pasting without Formats)

The MAX function as it
appears in cell D15.
F

Follow-along file: Continue with Excel Objective 2.00. (Use file Excel Objective 2.08 if
starting here.)
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(click to see video)

As shown in Figure 2.25 "MAX Function Added to the Budget Detail Worksheet", the
COUNT, AVERAGE, MIN, and MAX functions are summarizing the data in the Annual
Spend column. You will also notice that there is space to copy and paste these
functions under the LY Spend column. This allows us to compare what we spent last
year and what we are planning to spend this year. Normally, we would simply copy
and paste these functions into the range E13:E16. However, you may have noticed
the double-line style border that was used around the perimeter of the range
B13:E16. If we used the regular Paste command, the double line on the right side of
the range E13:E16 would be replaced with a single line. Therefore, we are going to
use one of the Paste Special commands to paste only the functions without any of
the formatting treatments. This is accomplished through the following steps:

1. Highlight the range D13:D16 in the Budget Detail worksheet.

2. Click the Copy button in the Home tab of the Ribbon.

3. Click cell E13.

4, Click the down arrow below the Paste button in the Home tab of the
Ribbon.

5. Click the Formulas option from the drop-down list of buttons (see
Figure 2.26 "Paste Formulas Option").

Figure 2.26 "Paste Formulas Option" shows the list of buttons that appear when you
click the down arrow below the Paste button in the Home tab of the Ribbon. One
thing to note about these options is that you can preview them before you make a
selection by dragging the mouse pointer over the options. As shown in the figure,
when the mouse pointer is placed over the Formulas button, you can see how the
functions will appear before making a selection. Notice that the double-line border
does not change when this option is previewed. That is why this selection is made
instead of the regular Paste option.
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Figure 2.26 Paste Formulas Option
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Skill Refresher: Paste Formulas

(click to see video)

Click a cell location containing a formula or function.

Click the Copy button in the Home tab of the Ribbon.

Click the cell location or cell range where the formula or function
will be pasted.

Click the down arrow below the Paste button in the Home tab of
the Ribbon.

Click the Formulas button under the Paste group of buttons.

Sorting Data (Multiple Levels)

Follow-along file: Continue with Excel Objective 2.00. (Use file Excel Objective 2.09 if

starting here.)
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(click to see video)

The Budget Detail worksheet shown in Figure 2.26 "Paste Formulas Option" is now
producing several mathematical outputs through formulas and functions. The
outputs allow you to analyze the details and identify trends as to how money is
being budgeted and spent. Before we draw some conclusions from this worksheet,
we will sort the data based on the Percent of Total column. As mentioned in Chapter
1 "Fundamental Skills", sorting is a powerful tool that enables you to analyze key

trends in any data set. We demonstrated the process of executing a single-level sort
in Chapter 1 "Fundamental Skills". For the purposes of the Budget Detail

worksheet, we need to set multiple levels for the sort order. This is accomplished
through the following steps:

2.2 Statistical Functions

Highlight the range A2:F11 in the Budget Detail worksheet.

2. Click the Data tab in the Ribbon.

3. Click the Sort button in the Sort & Filter group of commands. This

opens the Sort dialog box, as shown

Figure 2.27 Sort Dialog Box

in Figure 2.27 "Sort Dialog Box".
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4. Click the down arrow next to the “Sort by” box.
5. Click the Percent of Total option from the drop-down list.
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6. Click the down arrow next to the sort Order box.
7. Click the Largest to Smallest option.
8. Click the Add Level button. This allows you to set a second level for any
duplicate values in the Percent of Total column.

9. Click the down arrow next to the “Then by” box.
10. Select the LY Spend option.
11. Click the OK button at the bottom of the Sort dialog box.

Figure 2.28 Budget Detail Worksheet after Sorting

Figure 2.28 "Budget Detail Worksheet after Sorting" shows the Budget Detail
worksheet after it has been sorted. Notice that there are three identical values in
the Percent of Total column. This is why a second sort level had to be created for
this worksheet. The second sort level arranges the values of 8.4% based on the
values in the LY Spend column in ascending order. Excel gives you the option to set
as many sort levels as necessary for the data contained in a worksheet.
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Skill Refresher: Sorting Data (Multiple Levels)

(click to see video)

Highlight a range of cells to be sorted.

Click the Data tab of the Ribbon.

Click the Sort button in the Sort & Filter group.

Select a column from the “Sort by” drop-down list in the Sort

dialog box.

5. Select a sort order from the Order drop-down list in the Sort dialog
box.

6. Click the Add button in the Sort dialog box.

7. Repeat Steps 4 and 5.

8. Click the OK button on the Sort dialog box.

B W N =

Now that the Budget Detail worksheet is sorted, a few key trends can be easily
identified. The worksheet clearly shows that the top three categories as a
percentage of total budgeted spending for the year are Taxes, Household Utilities,
and Food. All three categories are necessities (or realities) of life and typically
require a significant amount of income for most households. Looking at the Percent
Change column, we can see how our planned spending is expected to change from
last year. This is perhaps the most import column on the worksheet because it
allows you to assess whether your plan is realistic. You will see that there are no
changes planned for Taxes and Household Utilities. While Taxes can change from
year to year, it is not too difficult to predict what they will be. In this case, we are
assuming that there are no changes to the tax costs for our budget. We are also
planning no change in Household Utilities. These costs can fluctuate from year to
year as well. However, you can take measures to reduce costs, such as using less
electricity, turning off heat when no one is in the house, keeping track of your
wireless minutes so you do not go over the maximum allowed in your plan, and so
on. As a result, there is no change in planned spending for Household Utilities
because we will assume that any rate increases will be offset with a decrease in
usage. The third item that is planned not to change is Insurance. Insurance policies
for cars and homes can change, but as is true for taxes, the changes are predictable.
Therefore, we are assuming no changes in our insurance policy.

The first big change that is noticeable in the worksheet is the Food and
Entertainment categories in rows 5 and 6 (see definitions in Table 2.1 "Spend
Category Definitions"). The Percent Change column indicates that there is an 11.1%
decrease in Entertainment spending and an 11.1% increase in Food spending. This is
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2.2 Statistical Functions

logical because if you plan to eat in restaurants less frequently, you will be eating at
home more frequently. Although this makes sense in theory, it may be hard to do in
practice. Dinners and parties with friends may be tough to turn down. However, the
entire process of maintaining a budget is based on discipline, and it certainly takes
a significant amount of discipline to plan targets for yourself and stick to them.

A few other points to note are the changes in the Gasoline and Vacation categories.
If you commute to school or work, the price of gas can have a significant impact on
your budget. It is important to be realistic if gas prices are increasing, and you
should reflect these increases in your budget. To compensate for the increased
spending for gas, the spending plan for vacations has been reduced by 25%.
Budgeting often requires a certain degree of creativity. Although the Vacation
budget has been reduced, there is still money you can set aside to make plans for
spring break or winter break.

Finally, the budget shows a decrease in Miscellaneous spending of 19.8%. This was
defined as a group containing several expenses, such as textbooks, school supplies,
software updates, and so on (see Table 2.1 "Spend Category Definitions"). You may
be able to reduce your spending in this category if you can use items such as online
textbooks. This reduction in spending can free up funds for Clothes, a spend
category that has increased by 20%. We will continue to develop the Personal
Budget workbook further in Section 2.3 "Functions for Personal Finance".
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KEY TAKEAWAYS

2.2 Statistical Functions

Statistical functions are used when a mathematical process is required
for a range of cells, such as summing the values in several cell locations.
For these computations, functions are preferable to formulas because
adding many cell locations one at a time to a formula can be very time-
consuming.

Statistical functions can be created using cell ranges or selected cell
locations separated by commas. Make sure you use a cell range (two cell
locations separated by a colon) when applying a statistical function to a
contiguous range of cells.

To prevent Excel from changing the cell references in a formula or
function when they are pasted to a new cell location, you must use an
absolute reference. You can do this by placing a dollar sign ($) in front
of the column letter and row number of a cell reference.

The #DIV/0 error appears if you create a formula that attempts to divide
a constant or the value in a cell reference by zero.

The Paste Formulas option is used when you need to paste formulas
without any formatting treatments into cell locations that have already
been formatted.

You need to set multiple levels, or columns, in the Sort dialog box when
sorting data that contains several duplicate values.
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EXERCISES

1. In the formula =C2/$C$24, the dollar signs used in the C24 cell
reference indicate:

a. Relative referencing has been turned off for this cell
reference.

b. Any value entered into cell C24 will be formatted with US
currency.

c. The output of the formula will be formatted with US
currency.

d. The value currently in C24 cannot be changed.

2. Which statement best explains how the following function will
produce a result =AVERAGE(B1,B10)?

a. The function will calculate the average for the values in B1
and B10.

b. The function will calculate the average for the values in all
cell locations in the range B1 through and including B10.

c. Commas cannot be used in statistical functions. The function
cannot produce an output and will display the #DIV/0 error
code.

d. The function will take the average of cell B1 based on the
value that is entered into cell B10.

3. Which of the following best explains the purpose of the Paste
Formulas command?

a. You cannot use the regular Paste command for formulas and
functions. You need to use the Paste Formulas command
when you copy and paste a formula or function to additional
cell locations on a worksheet.

b. You would use the Paste Formulas command when you want
to show the formula or function in a cell location and not the
calculated output.

c. You would use the Paste Formulas command when you want
to paste only the formula or function to a new cell location
without the formatting treatments that were applied to the
copied cell location.
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d. The Paste Formulas command is required if you want to
paste a formula into multiple cell locations on a worksheet.

4. Which of the following explains how data in a worksheet can be

sorted if the primary column of data contains several duplicate
values?

a. You can only sort data based on the values in one column.
Excel will take the duplicate values and sort them in the
order in which they were entered into the worksheet.

b. Excel will sort any duplicate values in the primary column
based on the values one column to the right in ascending
order.

c. You can click the Add button in the Sort dialog box and
designate which column Excel should use to sort any
duplicate values in the primary column.

d. You would sort each column in the worksheet one at a time.
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2.3 Functions for Personal Finance

LEARNING OBJECTIVES

Understand the fundamentals of loans and leases.

. Use the PMT function to calculate monthly mortgage payments on a

house.

Use the PMT function to calculate monthly lease payments for an
automobile.

Learn how to summarize data in a workbook by using worksheet links to
create a summary worksheet.

Understand the concept of the time value of money.

Use the FV function to calculate the future value of personal
investments.

Use Goal Seek to conduct what-if scenarios.

In this section, we continue to develop the Personal Budget workbook. Notable
items that are missing from the Budget Detail worksheet are the payments you
might make for a car or a home. In addition, you may want to set and track a
savings goal. This section demonstrates Excel functions used to calculate lease
payments for a car, to calculate mortgage payments for a house, and to project
future savings based on regular contributions and an average rate of return. This
section also discusses the scenario capabilities of Excel once the Personal Budget
workbook is complete.

The Fundamentals of Loans and Leases

Follow-along file: Continue with Excel Objective 2.00. (Use file Excel Objective 2.10 if
starting here.)

Lesson Video: Loan and Lease Fundamentals

(click to see video)

One of the functions we will add to the Personal Budget workbook is the PMT
function. This function calculates the payments required for a loan or a lease.
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7. A contractual agreement in
which money is borrowed from
a lender and paid back over a
specific period of time.

8. The amount of money
borrowed from a lender.

9. A loan used to purchase a home
or property.

10. A schedule of payments broken
down by interest and principal
for a loan. By law, a lender is
required to provide an
amortization table to a
borrower.

However, before demonstrating this function, it is important to cover a few
fundamental concepts on loans and leases.

A loan’ is a contractual agreement in which money is borrowed from a lender and
paid back over a specific period of time. The amount of money that is borrowed
from the lender is called the principal® of the loan. The borrower is usually
required to pay the principal of the loan plus interest. When you borrow money to
buy a house, the loan is referred to as a mortgage’. This is because the house being
purchased also serves as collateral to ensure payment. In other words, the bank can
take possession of your house if you fail to make loan payments. As shown in Table
2.5 "Key Terms for Loans and Leases", there are several key terms related to loans
and leases.

Table 2.5 Key Terms for Loans and Leases

Any item of value that is used to secure a loan to ensure payments to the
Collateral
lender
Down The amount of cash paid toward the purchase of a house. If you are paying 20%
down, you are paying 20% of the cost of the house in cash and are borrowing
Payment
the rest from a lender.
Interest . . ;
Rate The interest that is charged to the borrower as a cost for borrowing money
Mortgage | A loan where property is put up for collateral
Principal | The amount of money that has been borrowed
Residual
V:j:leua The estimated selling price of a vehicle at a future point in time
Terms The amount of time you have to repay a loan

Figure 2.29 "Example of an Amortization Table" shows an example of an
amortization table' for a loan. A lender is required by law to provide borrowers
with an amortization table when a loan contract is offered. The table in the figure
shows how the payments of a loan would work if you borrowed $100,000 from a
lender and agreed to pay it back over 10 years at an interest rate of 5%. You will
notice that each time you make a payment, you are paying the bank an interest fee
plus some of the loan principal. Each year the amount of interest paid to the bank
decreases and the amount of money used to pay off the principal increases. This is
because the bank is charging you interest on the amount of principal that has not
been paid. As you pay off the principal, the interest rate is applied to a lower
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11. A contract in which the lessee
uses an asset such as acarora
piece of equipment and agrees
to make regular payments to
the owner or the lessor. The
lessee is often required to
return the leased asset to the
lessor at the conclusion of the
lease contract.

number, which reduces your interest charges. Finally, the figure shows that the
sum of the values in the Interest Payment column is $29,505. This is how much it
costs you to borrow this money over 10 years. Indeed, borrowing money is not free.
It is important to note that to simplify this example, the payments were calculated
on an annual basis. However, most loan payments are made on a monthly basis.

Figure 2.29 Example of an Amortization Table

A B © D
) Loan Details
2 |Annual Interest Rate 5.0%
3 Terms in Years 10
4 Loan Principal| $ 100,000

$12,950

plus the Principle Payment is
$12,950.

Annual Payments

For each year, the Interest Payment ]

Amortization Table for Loan

Interest Principal |Beginning

8 Year |Payment | Payment |Principal Balance
9 1 $5000|% 7950 % 100,000
10 2 $4602 |3 8348 |3 92,050
11 3 $4185|3% 8,765 S 83,702
12 4 $ 3747 |3 9204 |3 74,936
13 5 $3287|3% 96643 65,733
14 6 $2803|% 10,147 |$ 56,069
15 7 $ 229 |$ 10654 9% 45,922
16 8 $ 1763 |% 11,187 |9 35,267
17 9 $ 1204 |3 117463 24,080
18 10 $ AG17 | 12334 |53

12,334 1_|
Total for this column At the end of year 10, the
is $29,505. loan is paid in full.

Alease'! is a contract in which you, the lessee, use an asset such as a car or a piece
of equipment and you agree to make regular payments to the owner or the lessor.
When you lease a car, the manufacturer or a leasing company retains ownership of
the vehicle and you agree to make regular payments for a specific period of time.
The amount of money you pay depends on the price of the car, the terms of the
lease contract, and the car’s expected residual value at the end of the lease. The
calculation of lease payments is similar to the calculation of loan payments.
However, when you lease a car, you pay only the value of the car that is used. For
example, suppose you are leasing a car that is priced at $25,000. The lease contract
is for 4 years at an interest rate of 5%. The residual value of the car is $10,000. This
means the car will lose $15,000 of its value over 4 years. Another way to state this is
that the car will depreciate $15,000. A lease will be structured so that you pay this
$15,000 in depreciation. However, the interest charges will be based on the
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purchase price of $25,000. We will look at a demonstration of leasing a car as well as
buying a home in the next section.

The PMT (Payment) Function for Loans

Follow-along file: Continue with Excel Objective 2.00. (Use file Excel Objective 2.10 if
starting here.)

Lesson Video: PMT Function for Loans

(click to see video)

If you own a home, your mortgage payments are a major component of your
household budget. If you are planning to buy a home, having a clear understanding
of your monthly payments is critical for maintaining strong financial health. In
Excel, mortgage payments are conveniently calculated through the PMT (payment)
function. This function is more complex than the statistical functions covered in
Section 2.2 "Statistical Functions". With statistical functions, you are required to
add only a range of cells or selected cells within the parentheses of the function.
With the PMT function, you must accurately define a series of arguments in order
for the function to produce a reliable output. Table 2.6 "Arguments for the PMT
Function" lists the arguments for the PMT function. It is helpful to review the key
loan and lease terms in Table 2.5 "Key Terms for Loans and Leases" before
reviewing the PMT function arguments.

Table 2.6 Arguments for the PMT Function

This is the interest rate the lender is charging the borrower. The interest rate
Rate is usually quoted in annual terms, so you have to divide this rate by 12 if you
are calculating monthly payments.

The argument letters stand for number of periods. This is the term of the loan,
which is the amount of time you have to repay the bank. This is usually quoted

N
per in years, so you have to multiply the years by 12 if you are calculating
monthly payments.
The argument letters stand for present value. This is the principal of the loan or
Py the amount of money that is borrowed. When defining this argument, a minus

sign must precede the cell location or value. For leases, this argument is used
for the price of the item being leased.
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The argument letters stand for future value. The brackets around the argument
indicate that it is not always necessary to define it. It is used if there is a lump-
[Fv] sum payment that will be made at the end of the loan terms. This is also used
for the residual value of a lease. If it is not defined, Excel will assume that it is
zero.

This argument can be defined with either a 1 or a 0. The number 1 is used if
payments are made at the beginning of each period. A 0 is used if payments
[Typel are made at the end of each period. The argument is in brackets because it
does not have to be defined if payments are made at the end of each period.
Excel assumes that this argument is 0 if it is not defined.

We will use the PMT function in the Personal Budget workbook to calculate the
monthly mortgage payments for a house. These calculations will be made in the
Mortgage Payments worksheet and then displayed in the Budget Summary
worksheet through a cell reference link. So far we have demonstrated several
methods for adding functions to a worksheet. The following steps explain a new
method using the Insert Function command for adding the PMT function:

Click the Mortgage Payments worksheet tab.
Click cell B5.
Click the Formulas tab on the Ribbon.

L

Click the Insert Function button (see Figure 2.30 "Mortgage Payments
Worksheet"). This opens the Insert Function dialog box, which can be
used for searching all functions in Excel.
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Figure 2.30 Mortgage Payments Worksheet

, —_ Formulas tab
X - - |- ¢ Excel Objective 2.00[:
Home Insert Page Layout Formulas Data Review View

AFIPBE@BAPRED S

Insert AutoSum Recently Financial Loglcal Text Date & Lookup & Math&  More Name
Function Used ¥ v - Time » Reference ¥ Trig ¥ Functions ¥ | Manage

\ Function Library "
= Insert Function button
B5 h I’
A B = D E

. Mortgage Payment Analysis

2 Loan Principal 3 165,000

3 |Interest Rate 5.0%

4 Terms of Loan 30|Years

5 |Monthly Payment

6

7/ The PMT function will be

8 added here to calculate the

monthly mortgage payments.

Z

10

11

19

13

= Mortgage Payments
15 worksheet tab
16
17

4 4 » » [ Budget Summary / Budget Detail | Mortgage Payments / Car Lease P;

In the “Search for a function:” input box at the top of the Insert
Function dialog box, type mortgage payments (see Figure 2.31 "Insert
Function Dialog Box"). Note that the current description in the “Search
for a function:” input box will already be highlighted. You can begin
typing and the description will be replaced with your entry.

Click the Go button in the upper right side of the Insert Function dialog
box. This adds all the Excel functions that match your description in
the “Select a function:” box in the lower half of the Insert Function
dialog box (see Figure 2.31 "Insert Function Dialog Box").

Click the PMT option in the “Select a function:” box in the lower half of
the Insert Function dialog box.

Click the OK button at the lower right side of the Insert Function dialog
box. This will open the Function Arguments dialog box.
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10.

11.

12.

13.

14.

15.

16.

Figure 2.31 Insert Function Dialog Box

‘Q‘

Insert Function

-
Type a description of what
you need to calculate here.

-

Search for a function:

mortgage payments

o celoct o cat . e E Click here after typing a description
I select a category: ecommendael . .
category to retrieve recommended functions

Select a function:

PV
Fv

PMT

PPMT

NPER

[
:::(Erate'nper pv.funtype) hd Click here to scroll through the
St list and search for a function.

Calculates the payment for a loan based on constant payments and a constant interest rate.

[l »

A list of recommended
functions will appear here.

( A description of the
selected function is

Help on this function [A oK %J [ Gt l L displayed here.

Click here to begin building
the selected function.

Mouseless Commands

Insert Function

o Hold the SHIFT key while pressing the F3 key.

Click the Collapse Dialog button next to the Rate argument in the
Function Arguments dialog box. This will be the first argument defined
for the function.

Click cell B3 on the worksheet. This is the rate being charged on the
loan.

Type a forward slash (/) for division.

Type the number 12. Since our goal is to calculate the monthly
payments for the loan, we need to divide the rate, which is stated in
annual terms, by 12. This converts the annual rate to a monthly rate.
Press the ENTER key on your keyboard. This returns the Function
Arguments dialog box to its expanded form. You will also see that the
Rate argument is now defined.

Click the Collapse Dialog button next to the Nper argument in the
Function Arguments dialog box. This is the second argument we define
in the function.

Click cell B4 on the worksheet. This is the term or the amount of time
we have to repay the loan.

Type an asterisk (*) for multiplication.
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17.

18.

19.

20.

21.

22.

23.

Type the number 12. Since our goal is to calculate the monthly
payments for the loan, we need to multiply the terms of the loan by 12.
This converts the terms of the loan from years to months.

Press the ENTER key on your keyboard. This returns the Function
Arguments dialog box to its expanded form. You will also see that the
Nper argument is now defined.

Click the Collapse Dialog button next to the Pv argument in the
Function Arguments dialog box. This is the third argument we will
define in the function.

Type a minus sign (-). When defining the Pv argument of the PMT
function, any cell location or value must be preceded with a minus
sign.

Click cell B2 on the worksheet. This is the principal of the loan.

Press the ENTER key on your keyboard. You will now see the Rate,
Nper, and Pv arguments defined for the function.

Click the OK button at the bottom of the Function Arguments dialog
box. The function will now be placed into the worksheet. Since we are
not paying any lump sums of money at the end of the loan, there is no
need to define the Fv argument. Also, we will assume that the monthly
mortgage payments will be made at the end of each month. Therefore,
there is no need to define the Type argument.

Mouseless Commands

Function Arguments Dialog Box

« After the equal sign (=) and function name are typed into cell a
location, hold down the CTRL key and press the letter A on your
keyboard.

Figure 2.32 "Function Arguments Dialog Box for the PMT Function" shows the

completed Function Arguments dialog box for the PMT function. Notice that the
dialog box shows the values for the Rate and Nper arguments. The Rate is divided
by 12 to convert the annual interest rate to a monthly interest rate. The Nper
argument is multiplied by 12 to convert the terms of the loan from years to months.
Finally, the dialog box provides you with a definition for each argument. The
definition appears when you click in the input box for the argument.

2.3 Functions for Personal Finance
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Figure 2.32 Function Arguments Dialog Box for the PMT Function

Function Arguments r 2 lcell
s L Collapse Dialog box button ]
I
Rate B3/12 = 0.004166667
The computed values for
Nper B4*12 360
each argument appear here.
Pv -B2
Fv
e eabos The function output
& appears here.
= B885.755678
Calculates the payment for a loan based on constant payments and a constant interest rate. .
Definition of the selected
Rate is the interest rate per period for the loan. For example, use 6%/4 for quarterly 4—
payments at 6% APR. argument appears here.
Formula result = $885.76 4

Click here to get more
information about this function.

Integrity Check
Comparable Arguments for PMT and FV Functions

When using functions such as PMT or FV, make sure the arguments are defined
in comparable terms. For example, if you are calculating the monthly payments
of a loan, make sure both the Rate and Nper argument are expressed in terms of
months. The function will produce an erroneous result if one argument is
expressed in years while the other is expressed in months.

Figure 2.33 "Mortgage Payments Worksheet with the PMT Function" shows the final
appearance of the Mortgage Payments worksheet after the PMT function is added.
The result of the function in cell B5 will be displayed in the Budget Summary
worksheet.
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Figure 2.33 Mortgage Payments Worksheet with the PMT Function

- The PMT function as it
B5 v Jx | =PMT(B3/12,B4%12,-B2) uncti : J

appears in cell B5.

. Mortgage Payment Analysis

2 Loan Principal $ 165,000
3 Interest Rate 5.0%

4 Terms of Loan 30|Years
PMT function

5 Monthly Payment $885.76 | < output
6

7

8

9

10

11

12

13

14

15

16

17
M4 4 » » [ Budget Summary . Budget Detail | Mortgage Payments /"~

The PMT (Payment) Function for Leases

Follow-along file: Continue with Excel Objective 2.00. (Use file Excel Objective 2.11 if
starting here.)

Lesson Video: PMT Function for Leases

(click to see video)

In addition to calculating the mortgage payments for a home, the PMT function will
be used in the Personal Budget workbook to calculate the lease payments for a car.
The details for the lease payments are found in the Car Lease Payments worksheet.
Similar to the statistical functions, we can type the PMT function directly into a
cell. However, you must know the definitions for each argument of the function and
understand how these arguments need to be defined based on your objective. The
terms for loans and leases are in Table 2.5 "Key Terms for Loans and Leases", and
the definitions for the arguments of the PMT function are in Table 2.6 "Arguments

2.3 Functions for Personal Finance 168


http://www.gone.2012books.lardbucket.org/sites/all/files/ManzoExcel_1.0_Excel_Objective_2.11.xlsx
http://www.youtube.com/v/1qztokXmndc?rel=0

Chapter 2 Mathematical Computations

for the PMT Function". The following steps explain how the PMT function is added

to the Personal Budget workbook to calculate the lease payments for a car:

e e

o

10.
11.

12.
13.
14.

15.

16.

17.
18.

Click cell B6 in the Car Lease Payments worksheet.

Type an equal sign (=).

Type the letters PMT.

Type an open parenthesis (().Excel then provides a tip box showing the
arguments of the function.

Click cell B4. This is the interest rate being charged for the lease.

Type the forward slash (/) for division.

Type the number 12. Since our goal is to calculate the monthly lease
payments, we divide the interest rate by 12 to convert the annual rate
to a monthly rate.

Type a comma. When you type a function containing arguments, you
must separate each argument with a comma. This signals to Excel that
one argument has been defined and you are ready to define the next
argument in the function.

Click cell B5. This is the term or the length of time for the lease
contract. Since the term is already expressed in months, we can just
reference cell B5 and move to the next argument.

Type a comma. This advances the function to the Pv argument.

Type a minus sign (-). Remember that cell locations or values used to
define the Pv argument must be preceded with a minus sign.

Click cell B2 on the worksheet, which is the price of the car.

Type a comma. This advances the function to the [Fv] argument.

Click cell B3 on the worksheet. This is the residual value of the car.
Note that cell location and values used to define the [Fv] argument are
NOT preceded by a minus sign.

Type a comma. This advances the function to the [Type] argument.
Type the number 1. We will assume that the lease payments will be due
at the beginning of each month.

Type a closing parenthesis ().

Press the ENTER key.

Figure 2.34 "PMT Function Constructed to Calculate Lease Payments" shows how

the PMT function should appear before pressing the ENTER key. Notice the commas
that separate each argument of the function. Also, the tip box will show the current
argument being defined in bold font.

2.3 Functions for Personal Finance
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Figure 2.34 PMT Function Constructed to Calculate Lease Payments

IF v X v fe| =PMT(B4/12,85,-82,83,1)

A B C D E F

1 Car Lease Payments
Annual interest rate
2 Price of Car $ 20,000 charged for this lease.
3 Residual Value $ 12,000
4 Interest Rate 3.0% 44—
5 Terms of Loan 48 Months ‘
6 Monthly Payment |=PMT(B4/12,B5,-82,B3,1)
7 | PMT(rate, nper, pv, [fv], [type]) |————
8
2
10 The bold font indicates The tip box will appear after typing the open
11 this argument is parenthesis after the function name or double
= currently activated. clicking the function name from the function list.
13
14
15
16
17

M 4> N[ Budget Summary ~ Budget Detail -~ Mortgage Payments lCar Lease Paymentsgg

Figure 2.35 "Results of the PMT Function in the Car Lease Payments Worksheet"
shows the result of the PMT function. The monthly payments for this lease are
$206.56. This monthly payment will be displayed in the Budget Summary
worksheet.
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Figure 2.35 Results of the PMT Function in the Car Lease Payments Worksheet

B6 - Jx | =PMT(B4/12,B5,-82,83,1) ( The PMT fu.nction asit
L appears in cell B6.

A B C D E -
1 Car Lease Payments
2 |Price of Car $ 20,000
3 Residual Value 3 12,000
4 Interest Rate 3.0%
5 Terms of Loan 48 Months

PMT functi

6 Monthly Payment $206.56 | ¢——
7
8
9
10
11
12
13
14
15
16
17 |

4 4 » M| Budget Summary . Budget Detail -~ Mortgage Payments | Car Lease Payments .
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Skill Refresher: PMT Function

(click to see video)

. Type an equal sign (=).
2. Type the letters PMT followed by an open parenthesis, or double

click the function name from the function list.

. Define the Rate argument with a cell location that contains the

rate being charged by the lender for the loan or lease.

. Define the Nper argument with a cell location that contains the

amount of time to repay the loan or lease.

. Define the Pv argument with a cell location that contains the

principal of the loan or the price of the item being leased. Cell
locations or values used for this argument must be preceded by a
minus sign.

. Define the [Fv] argument with a cell location that contains the

residual value of the item being leased or the lump sum payment
for a loan.

. Define the [Type] argument with a 1 if payments are made at the

beginning of each period or 0 if payments are made at the end of
each period.

. Type a closing parenthesis ()).
. Press the ENTER key.

Linking Worksheets (Creating a Summary Worksheet)

Follow-along file: Continue with Excel Objective 2.00. (Use file Excel Objective 2.12 if

starting here.)

Lesson Video: Linking Worksheets

(click to see video)

So far we have used cell references in formulas and functions, which allow Excel to
produce new outputs when the values in the cell references are changed. Cell
references can also be used to display values or the outputs of formulas and
functions in cell locations on other worksheets. This is how data will be displayed
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on the Budget Summary worksheet in the Personal Budget workbook. Outputs
from the formulas and functions that were entered into the Budget Detail,
Mortgage Payments, and Car Lease Payments worksheets will be displayed on the
Budget Summary worksheet through the use of cell references. The following steps
explain how this is accomplished:

Click cell C3 in the Budget Summary worksheet.

Type an equal sign (=).

Click the Budget Detail worksheet tab.

Click cell D12 on the Budget Detail worksheet.

Press the ENTER key on your keyboard. The output of the SUM
function in cell D12 on the Budget Detail worksheet will be displayed
in cell C3 on the Budget Summary worksheet.

A .

Figure 2.36 "Cell Reference Showing the Total Expenses in the Budget Summary
Worksheet" shows how the cell reference appears in the Budget Summary

worksheet. Notice that the cell reference D12 is preceded by the Budget Detail
worksheet name enclosed in apostrophes followed by an exclamation point (‘Budget
Detail’!) This indicates that the value displayed in the cell is referencing a cell
location in the Budget Detail worksheet.

Figure 2.36 Cell Reference Showing the Total Expenses in the Budget Summary Worksheet

This indicates that the D12

c3 - S | ='Budget Detail'lD12 < cell reference is from the ]

L Budget Detail worksheet.

Personal Cash Budget

1

2 NetIncome $ 33,000

3 |Expenses $ 17,950

4 Mortgage Payments

5 Car Lease Payments This is the Total Annual

6 Total Plan Spend Spend value in cell D12 from
the Budget Detail worksheet.

7 Net Change in Cash

8

9 Savings Plan| $ 25,000

10 Savings Projection

11 Plan vs Projection

12 Years of Saving 10

13 Rate of Return 3.5%

14 Current Balance| $ 2,000

15

4 4 » » | Budget Summary / Budget Detail .~ Mortgage Payments . Car Lease Payments
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As shown in Figure 2.36 "Cell Reference Showing the Total Expenses in the Budget
Summary Worksheet", the Budget Summary worksheet is designed to show the
expense budget for the mortgage payments and the auto lease payments. However,
you will recall that we used the PMT function to calculate the monthly payments. In
the Budget Summary worksheet, we need to show the total annual payments. As a
result, we will create a formula that references cell locations in the Mortgage
Payments and Car Lease Payments worksheets. The following steps explain how
this is accomplished:

AN S o e

10.
11.
12.
13.

14.

Click cell C4 in the Budget Summary worksheet.

Type an equal sign (=).

Click the Mortgage Payments worksheet tab.

Click cell B5 in the Mortgage Payments worksheet.

Type an asterisk (*) for multiplication.

Type the number 12. This multiplies the monthly payments by 12 to
calculate the total payments required for the year.

Press the ENTER key on your keyboard. The value of multiplying the
monthly mortgage payments by 12 is now displayed on the Budget
Summary worksheet.

Click cell C5 on the Budget Summary worksheet.

Type an equal sign (=).

Click the Car Lease Payments worksheet tab.

Click cell B6 in the Car Lease Payments worksheet.

Type an asterisk (*) for multiplication.

Type the number 12. This multiplies the monthly lease payments by 12
to calculate the total payments required for the year.

Press the ENTER key on your keyboard. The value of multiplying the
monthly lease payments by 12 is now displayed on the Budget
Summary worksheet.

Figure 2.37 "Formulas Referencing Cells in Mortgage Payments and Car Lease

Payments Worksheets" shows the results of creating formulas that reference cell

locations in the Mortgage Payments and Car Lease Payments worksheets.
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Figure 2.37 Formulas Referencing Cells in Mortgage Payments and Car Lease Payments Worksheets

5

reference is from the Car
L Lease Payments worksheet.

Jfe | ='CarLease Payments'|B6%12
B

This indicates that the B6 cell]

1 Personal Cash Budget
2 NetIncome $ 33,000
3 Expenses $ 17,950
4 Mortgage Payments $ 10,629 <
5 Car Lease Payments $ 2479 |>
pn)
6 Total Plan Spend
Outputs for formulas that

7 Net Change in Cash reference cells in the

Mortgage Payments and Car
8 L Lease Payments worksheets
9 Savings Plan| $ 25,000
10 Savings Projection
11 Plan vs Projection
12 Years of Saving 10
iz Rate of Return 3.5%
14 Current Balance| 2,000
15

4 4 » » | Budget Summary / Budget Detail / Mortgage Payments ~ Car Lease Payments .

We can now add other formulas and functions to the Budget Summary worksheet
that can calculate the difference between the total spend dollars vs. the total net
income in cell D2. The following steps explain how this is accomplished:

A .

© x® N

10.

Click cell D6 in the Budget Summary worksheet.

Type an equal sign (=).

Type the function name SUM followed by an open parenthesis (().
Highlight the range C3:C5.

Type a closing parenthesis ()) and press the ENTER key on your
keyboard. The total for all annual expenses now appears on the
worksheet.

Click cell D7 on the Budget Summary worksheet.

Type an equal sign (=).

Click cell D2.

Type a minus sign (-) and then click cell Dé.

Press the ENTER key on your keyboard. This formula produces an
output of $1,942, indicating our income is greater than our total
expenses.

Figure 2.38 "Formulas Added to Show Income Is Greater Than Expenses" shows the

results of the formulas that were added to the Budget Summary worksheet. The
output for the formula in cell D7 shows that the net income exceeds total planned
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expenses by $1,942. Overall, having your income exceed your total expenses is a
good thing because it allows you to save money for future spending needs or
unexpected events.

Figure 2.38 Formulas Added to Show Income Is Greater Than Expenses

D6 - f =suw|(c3:c5}4

A B C D E F

- Personal Cash Budget
This SUM function is
2 NetIncome $ 33,000 L entered into cell D6.
3 Expenses $ 17,950
4 Mortgage Payments $ 10,629
5 Car Lease Payments $ 2479
6 |Total Plan Spend $ 31,058
7 Net Change in Cash $§ 1,942 4
8
9 Savings Plan| $ 25,000
10 Savings Projection The formula in this cell is
11 Plan vs Projection subtracting cell D6 from D2.
12 Years of Saving 10
13 Rate of Return 3.5%
14 Current Balance| $ 2,000
15

4 4 » M| Budget Summary / Budget Detail ~ Mortgage Payments .~ Car Lease Payments

We can now add a few formulas that calculate both the spending rate and the
savings rate as a percentage of net income. These formulas require the use of

absolute references, which we covered earlier in this chapter. The following steps
explain how to add these formulas:

2.3 Functions for Personal Finance

Click cell E6 in the Budget Summary worksheet.

Type an equal sign (=).

Click cell Dé.

Type a forward slash (/) for division and then click D2.

A

cell D2.

6. Press the ENTER key. The result of the formula shows that total

expenses consume 94.1% of our net income.
7. Click cell Ee.
8. Place the mouse pointer over the Auto Fill Handle.

Press the F4 key on your keyboard. This adds an absolute reference to

9. When the mouse pointer turns to a black plus sign, left click and drag

down to cell E7. This copies and pastes the formula into cell E7.
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Figure 2.39 "Calculating the Savings Rate" shows the output of the formulas
calculating the spending rate and savings rate as a percentage of net income. The
absolute reference shown for cell D2 prevents the cell from changing when the
formula is copied from cell E6 and pasted into cell E7. The results of the formula
show that our current budget allows for a savings rate of 5.9%. This is a fairly good
savings rate. In the next section we will discuss how these savings can grow over
time by exploring the time value of money concepts.

Figure 2.39 Calculating the Savings Rate

The dollar signs indicate
£7 - 5 :D7f’SD52< an absolute reference has
A B c D E L been added to cell D2.
- Personal Cash Budget
2 NetIncome $ 33,000
3 |[Expenses $ 17,950
4 |Mortgage Payments $ 10,629
5 |Car Lease Payments $ 2479
6 Total Plan Spend $ 31,058 94 1%
7 |Net Change in Cash $ 1,942 5.9%| €
8
9 Savings Plan| $ 25,000
10 Savings Projection
11 Plan vs Projection This plan is showing that
the savings rate is 5.9% of
12 Years of Saving 10 netincome.
13 Rate of Return 3.5%
14 Current Balance| $ 2,000
15

4 4 » ¥ | Budget Summary / Budget Detail .~ Mortgage Payments ~ Car Lease Payments -

Time Value of Money Concepts

Follow-along file: Continue with Excel Objective 2.00. (Use file Excel Objective 2.13 if
starting here.)

Lesson Video: Time Value of Money Concepts

(click to see video)

In reviewing the Budget Summary worksheet in Figure 2.39 "Calculating the
Savings Rate", you will notice that the range B9:D14 contains data that can be used
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12. The opportunity to increase
the value of money over time
through investments that
provide a constant or average
positive rate of return.

to assess a savings plan. We can project how much money can be saved over a
specific period of time given set contributions and a rate of return. This calculation
is accomplished through the future value, or FV, function. We will use the FV
function in cell D10 of the Budget Summary worksheet to calculate our savings
plan projection. However, before we use the FV function, it is important to review a
few basic concepts regarding the time value of money, as shown in Table 2.7 "Key
Terms for Time Value of Money Concepts".

Table 2.7 Key Terms for Time Value of Money Concepts

An investment that is made in regular payments over a period of time. For
Annuity | example, depositing $100 a month into an interest-bearing bank account or
mutual fund is considered an annuity.

An investment in which you lend money to a company or government entity.
The borrower agrees to pay you interest over a specific period time. At the
Bonds end of the bond agreement, the amount of money that was borrowed, or your
initial investment, is returned to you. Most bonds are considered a lower risk
investment but offer a lower rate of return than stocks offer.

A collection of similar investments managed by a financial professional called
a fund manager. Mutual funds allow you to invest in several stocks or bonds
without having to make many individual investments. They also allow you to
reduce your risk and take advantage of the investment expertise of a
professional.

Mutual
Funds

The percentage gained or lost on an investment. Investments that offer a high
Rate of predicted rate of return often carry a higher risk of losing money.

Return Investments that offer a lower predicted rate of return often carry a lower
risk of losing money.

An investment in which you own a portion of a company. The value of this
investment increases as the company produces higher profits. Most stocks are
Stocks expected to generate a higher rate of return than bonds generate. However,
the risk of losing money on a stock investment is much greater than the risk
for bonds.

Table 2.7 "Key Terms for Time Value of Money Concepts" provides definitions for
several terms used when addressing the time value of money concepts. The time
value of money'” is the opportunity to grow your money over time given a
constant or average rate of return. For example, consider the data shown in Figure
2.40 "Time Value of Money Example for a One-Time Investment". This data assumes
that a person makes a one-time investment of $100 in a bond mutual fund that
returns 5% interest per year. Notice that the interest paid in Column E increases
every year. This is because the interest is reinvested in the mutual fund, which
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13. An investment made in regular
payments over a period of
time.

increases the total value of the investment. For example, the interest earned in year
1is based on a $100 investment. Therefore, the interest paid is $5.00, or 5% of $100.
However, in year 2, when the $5.00 interest payment is reinvested, the total
investment increases to $105. Therefore, in year 2 the interest paid increases to
$5.25, or 5% of $105. The value of the investment at the end of 5 years is $127.63.
This is the value that can be calculated using the FV function.

Figure 2.40
A B C D E F
Time Value of Money Example [ Aone-time investment
g of $100 is made at the
. One-'lllme Investment L beginning of year 1.
Beginning Interest |Interest |Ending
2 Year |Balance Investment |Rate Paid Balance
3 1 3 = $ 100.00 5.00%| $ 5.00 | $105.00
4 2 $ 10500 % - 5.00%| % 5.25|3%110.25 The future value
function can be used to
5 3 $ 11025|% - 5.00%| 3% 551 |3%115.76 calculate this number.
6 4 $ 11576 |3 - 5.00%| $ 5.79 $121.55ﬂJ
7 5 $ 12155 % - 5.00%| % 6.08 | %127.63

The interest paid The total interest earned on
increases every year. this investment is $127.63.

Figure 2.41 "Time Value of Money Example for an Annuity Investment" shows
another example demonstrating the time value of money concept. Instead of
making a one-time investment, we will assume that a person invests $100 at the
beginning of every year in the same bond mutual fund. This is referred to as an
annuity'’ because the person is making reoccurring investments over a specific
period of time. Notice that the value of this investment after 5 years is $580.19. Also,
the total interest earned on this investment is $80.19 as opposed to the $27.63
earned on the one-time investment in Figure 2.40 "Time Value of Money Example
for a One-Time Investment".
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Figure 2.41 Time Value of Money Example for an Annuity Investment

A B C D E F
Time Value of Money Example
Annuity Investment ( Reoccurring investments of $100
192 I are made at the beginning of
Beginning v Interest |Interest |Ending L SYEryyear:
13 Year |Balance Investment |Rate Paid Balance
14 1 3 - $ 100.00 5.00%|$ 5.00 | $105.00
15 2 $ 105.00|$ 100.00 5.00%| $ 10.25 | $215.25
16 3 $ 21525|$% 100.00 5.00%| $ 15.76 | $331.01
17 4 $ 331.01|$ 100.00 5.00%| $ 21.55 | $452.56
18 5 $ 45256 |$ 100.00 5.00%| $ 27.63 | $580.19

The total interest earned on
this investment is $580.19.

The FV (Future Value) Function

Follow-along file: Continue with Excel Objective 2.00. (Use file Excel Objective 2.13 if
starting here.)

Lesson Video: FV Function

(click to see video)

Establishing a personal savings plan is one of the most important financial exercises
you can do. For example, a savings plan is critical for establishing financial security
for your retirement years. Many people mistakenly believe that saving for
retirement is something you do when you get older. However, the greatest financial
gains for your retirement can be achieved if you start saving in the earliest years of
your career. Now that you have an understanding of the time value of money, you
can see that the more years you can earn interest on your investments and reinvest
those earnings, the more money you will have when you retire. Savings plans are
also important for other key life events, such as going to college or buying a home.
The FV function is a convenient tool that can help you establish savings goals and
project the value of your investments over time. Similar to the PMT function, the
FV function requires you to accurately define specific arguments in order to
produce a reliable result. Table 2.8 "Arguments for the FV Function" provides
definitions for each of the arguments in the FV function. It is helpful to review the
time value of money terms in Table 2.7 "Key Terms for Time Value of Money
Concepts" before using the FV function.
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Table 2.8 Arguments for the FV Function

Rate

This is the rate of return you expect to earn on an investment over time. This
rate is usually quoted in annual terms, so you have to divide by 12 if you are
calculating the value of an annuity making investments on a monthly basis.

Nper

The argument letters stand for number of periods. This is the amount of time
you are using to measure the value of an investment. The amount of time used
to define this argument must be comparable to the Rate argument. For
example, if the rate is stated in terms of months, the amount of time used to
define this argument must be in months.

Pmt

The argument letters stand for payment. This argument is used if you are
measuring the value of an annuity investment. The argument is defined with
the value of the investment that is made for each measure of time used to
define the Nper argument. For example, if the Nper argument is expressed in
terms of months, you must define this argument with the investment value
that is made every month.

[Pv]

The argument letters stand for present value. The brackets around the
argument indicate that it is not always necessary to define it. Excel assumes
zero if the argument is not defined. The argument is used when measuring the
value of a one-time investment. Both this argument and the Pmt argument
will be defined if an annuity investment has a beginning balance or includes a
beginning one-time lump-sum investment.

[Typel

This argument can be defined with either a 1 or a 0. The number 1 is used if
investments are made at the beginning of each period used to define the Nper
argument. A 0 is used if the investments are made at the end of each period.
The argument is in brackets because it does not have to be defined if your
investments are made at the end of each period. Excel assumes that this
argument is 0 if it is not defined.

With respect to the Personal Budget workbook, we will use the FV function to
project the value of the savings plan in 10 years. We will type the function directly
into the Personal Budget worksheet for this demonstration. However, you can use
any of the methods demonstrated in this chapter for future use. The following steps
explain how this function is added to the worksheet:

2.3 Functions for Personal Finance

A

Click cell D10 in the Budget Summary worksheet.

Type an equal sign (=).

Type the letters FV followed by an open parenthesis (().

Click cell D13. This is the expected rate of return for the investments.
Type a comma.
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10.
11.

12.

13.

14.
15.
16.

Click cell D12. This is the amount of time the investments are expected
to grow.

Type a comma.

Type a minus sign (-). All values or cell locations used to define the Pmt
argument must be preceded by a minus sign.

Click cell D7. This is the change in cash that was calculated by
subtracting the total expenses from the net income. We are expecting
to save this amount of money for the 10-year period this investment is
being measured.

Type a comma.

Type a minus sign (-). All values and cell locations used to define the Pv
argument must be preceded by a minus sign.

Click cell D14. Since the savings plan has a current balance, we use this
to define the Pv argument of the function. This is equivalent to starting
with a lump-sum investment.

Type a closing parenthesis (). There is no need to define the last
argument of the function because we will assume that the savings in
cash achieved in our budget will be invested at the end of each year of
the savings plan.

Press the ENTER key. Check that cell D11 is activated.

Type an equal sign (=).

Click cell D10.

17. Type a minus sign (-) and then click cell D9. This subtracts the savings
plan from the current savings plan projection.
18. Press the ENTER key.
Integrity Check

PMT and FV Functions Produce Negative Results

If the results of the PMT function or FV function are negative, check the Pv or
Pmt arguments. Remember that these arguments must be preceded by a minus
sign. If the minus sign is omitted, the functions produce a negative output.

Figure 2.42 "Results of the Savings Plan Projections" shows the results of the FV

function. Notice that the current savings plan projection is $25,606. This is $606
higher than the target of $25,000 entered into cell D9, which shows that the current
budget is working to achieve the goals of this savings plan. In other words, given
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the current net income, we are saving enough money to achieve our savings plan
goals.

There are two important factors to notice with regard to this plan. The first factor is
that our spending plan allows us to save enough money so that it can be invested to
achieve our target of $25,000. The second factor is that the expected rate of return
is 3.5%. This is a relatively low expected rate of return and could be achieved by
investing in relatively low-risk investments such as bonds as opposed to stocks.
This rate can be considered good because we can achieve our savings goals without
having to make high-risk investments that could result in a significant loss of our
savings.

Figure 2.42 Results of the Savings Plan Projections

D10 v Jfe | =FV(D13,D12,-D7,-D14)

A B C D E F
: Personal Cash Budget —
The FV function as it was
2 |Net Income $ 33,000 [ entered into cell D10.
3 Expenses $ 17,950
4 Mortgage Payments $ 10,629
5 Car Lease Payments $ 2,479
6 Total Plan Spend $ 31,058 94.1%
7 |Net Change in Cash $ 1,942 5.9%
8
9 Savings Plan| $§ 25,000
E Savings Projection $ 25606 The current savings value and
11 Plan vs Projection $ 606 expected rate of return is enough to
slightly exceed the savings plan.
12 Years of Saving 10
13 Rate of Return 3.5%|¢ 1
14 Current Balance| $ 2,000 This expected rate of return requires a
15 relatively low risk investment.

4 4 » » | Budget Summary ~ Budget Detail ~ Mortgage Payments ~ Car Lease Payments
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Skill Refresher: FV Function

(click to see video)

. Type an equal sign (=).
2. Type the letters FV followed by an open parenthesis, or double

click the function name from the function list.

. Define the Rate argument with a cell location that contains the

expected rate of return for your investment.

. Define the Nper argument with a cell location that contains the

amount of time you are measuring the growth of your investment.

. Define the Pmt argument with a cell location that contains the

value of regular investments for an annuity. Cell locations or
values used for this argument must be preceded by a minus sign.

. Define the [Pv] argument with a cell location that contains the

value of a one-time lump-sum investment. Cell locations or values
used for this argument must be preceded by a minus sign.

. Define the [Type] argument with a 1 if annuity investments are

made at the beginning of each period or a 0 if investments are
made at the end of each period.

. Type a closing parenthesis ().
. Press the ENTER key.

Goal Seek (What-If Scenarios)

Follow-along file: Continue with Excel Objective 2.00. (Use file Excel Objective 2.14 if

starting here.)

Lesson Video: Goal Seek

(click to see video)

We used several formulas and functions to complete the Personal Budget workbook
shown in Figure 2.42 "Results of the Savings Plan Projections". All the formulas and
functions entered contain cell references that allow for a variety of what-if
scenarios. Goal Seek is a tool that can be used in the process of conducting these
what-if scenarios. Goal Seek maximizes the benefits of Excel’s cell-referencing
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capabilities by changing inputs to precise values to achieve specific outputs
produced by formulas or functions. We will begin by changing one of the inputs in
the Personal Budget workbook through the following steps:

1. Click the Budget Detail worksheet tab.

2. Click cell D9.

3. Type the number 2000. Instead of planning a decrease in our vacation
spending, we will see what happens to our budget if we spend the same
amount as last year, which was $2,000.

4. Press the ENTER key.

Figure 2.43 "Budget Detail Worksheet " and Figure 2.44 "Budget Detail Worksheet "
show the Budget Detail worksheet before and after the change in the annual
vacation budget. By comparing these two figures you can see that by changing just
one input, many of the outputs produced by the formulas and functions in the
worksheet changed. The following is a list of the changes that occurred in the
worksheet:

¢ The formula output in cell F12 now shows that we are planning a 1.1%
increase in our total spending as opposed to a -1.7% decrease.

« The formula output in cell F9 changes from -25% to 0%.

+ The SUM function in cell D12 changes from $17,950 to $18,450.

« The SUM function in cell C12 changes from $1,496 to $1,538.

+ The AVERAGE function in cell D14 changes from $1,994 to $2,050.
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Figure 2.43 Budget Detail Worksheet before Changing the Annual Vacation Budget

D3 - Jx | 1500
A B c D E F
Expense Plan
1 (Does not include mortgage and car)
Percent of |Monthly [Annual Percent
2 Category Total Spend Spend LY Spend |Change
3 Taxes 19.5%| $ 292|$ 3500|% 3,500 0.0%
4 Household Utilities 16.7%| $ 250|$ 3,000($% 3,000 0.0%
5 Food 13.9%| $ 208|$ 2500|% 2250 11.1%
6 Entertainment 11.1%] $ 167 |$ 2000|3% 2250 -11.1%
7 Gasoline 8.4%| % 125|% 1,500 |3% 1,200 25.0%
8 Insurance 8.4%|$ 12518 1,500 % 1,500 0.0%
9 |Vacati0n 8.4%|$ 125|8% 150008 2,000 -25.0%
10 Miscellaneous 7.0%| $ 104 |$ 1,250 1,558 -19.8%
11 |Clothes 6.7%| $ 100§ 1,200 $\1,000 20.0%
12 Totals $ 1,496 | $ 17,950 | § 18\2Q8\ -1.7%
13 Number of Categories 9 9 \{ : -
This value will be
14 Average Spend| $ 1,994 |$ 2029 changed to $2,000. ]
15 Min Spend| $ 1,200 |$ 1,000
16 Max Spend| $ 3,500 |$ 3,500
17
IR NI Budget Summary lBudget Detail /~ Mortgage Payments .~ Car Lease Payments /%[ 4]

D10

-

J | =FV(D13,D12,-D7,-D14)

Figure 2.44 Budget Detail Worksheet after Changing the Annual Vacation Budget

A B C D E F
1 Personal Cash Budget
2 NetIncome $ 33,000
3 Expenses $ 18,450
4 Mortgage Payments $ 10,629
5 Car Lease Payments $ 2479
6 Total Plan Spend $ 31,558 95.6%
7 Net Change in Cash $ 1,442 4.4%
8
9 Savings Plan| $ 25,000 ) —
- . - The savings plan projection falls
E Savings Projection| $§ 19,741 | below the target of $25,000 when the
11 Plan vs Projection $ (5 259) annual vacation budget is increased.
12 Years of Saving 10
13 Rate of Return 3.5%
14 Current Balance| $ 2,000
15
16
17
18
19

4 4 » | Budget Summary / Budget Detail ~ Mortgage Payments ~ Car Lease Payments
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In addition to the changes in the Budget Detail worksheet, outputs of formulas and
functions on the Budget Summary worksheet also change when the Annual Spend
for the Vacation category was increased. To see the changes, compare Figure 2.42
"Results of the Savings Plan Projections" to Figure 2.45 "Budget Summary
Worksheet ". There were a total of fourteen changes in the outputs of formulas and
functions on the Budget Summary worksheet. In total, there were twenty-one
outputs that changed in the Personal Budget workbook as a result of changing just
one input.

Figure 2.45 Budget Summary Worksheet after Changing the Annual Vacation Budget

D10 hd b3 =FV(D13,D12,-D7,-D14)
A B C D E F

1 Personal Cash Budget
2 NetIncome $ 33,000
3 Expenses $ 18,450
4 Mortgage Payments $ 10,629
5 Car Lease Payments $ 2479
6 Total Plan Spend $ 31,558 95.6%

Net Change in Cash $ 1,442 4. 4%

Savings Plan| $ 25,000

10 Savings Projection] $ 19,741 - —
The savings plan projection falls
11 Plan vs Projection| $ (5,259) below the target of $25,000 when the
annual vacation budget is increased.

12 Years of Saving 10
13 Rate of Return 3.5%
14 Current Balance| $ 2,000

4 4 » | Budget Summary / Budget Detail .~ Mortgage Payments .~ Car Lease Payments

One of the most notable changes on the Budget Summary worksheet is the Savings
Projection in cell D10. By spending an additional $500 a year on vacation plans, the
projected savings value in 10 years decreases by $5,865. However, what if the rate of
return were to increase? An increase in the rate of return could recover the
decrease in the future value of our savings plan. We can use a tool such as Goal Seek
to determine exactly how much the rate of return would have to increase to achieve
our savings plan target of $25,000. The following steps explain how to use Goal Seek
to accomplish this goal:

1. Click the Budget Summary worksheet tab.
2. Click the Data tab of the Ribbon.
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3.

10.

11.
12.
13.
14.

Click the What-If Analysis button in the Data Tools group of
commands.

Click Goal Seek from the list options (see Figure 2.46 "Selecting Goal
Seek from the What-If Analysis Options"). This opens the Goal Seek

dialog box.

Mouseless Commands

Goal Seek

o Press the Alt key on your keyboard and then the letters A, W,
and G one at a time.

Figure 2.46 Selecting Goal Seek from the What-If Analysis Options

- -G Excel Objective 2.00 - Microsoft Excel e
<} Data tab of Ribbon
“ Home Insert Pagelayout Formulas  Data  Review  View
|78 From Access 5 5 j [5) connections Al ? T Clear E‘ =4 Data validation ~ fwdFEI J.ZEI ‘QD
Z[A S=E
|28 From Web = | S L Properties [ o Reappl E=H [P consolidate c = o
From Other Existing Refresh Zl Sort Filter = Textto Remove — Y Group Ui brara
{fjfromText  Sources~ | Connections |~ Allv &= Edit Link = ¥ Advanced | Columns Duplicates (£} What-If Analysis v‘4—-—[What-|fAna|ysis butt
Get External Data Connections Sort & Filter Daté Scenario Manager... Outline
D10 v fe =FV(D13,012,-D7,-D14) Goal Seek |
A B C D E F G K J
Data Table... F
1 Personal Cash Budget
2 NetIncome $ 33,000 Goal Seek option
3 Expenses $ 18,450
4 Mortgage Payments $ 10,629
5 Car Lease Payments $ 2479

Click the Collapse Dialog button next to the “Set cell:” input box on the
Goal Seek dialog box.

Click cell D10 on the Budget Summary worksheet.

Press the ENTER key on your keyboard.

Place the mouse pointer over the “To value” input box in the Goal Seek
dialog box and click.

Type the number 25000 in the “To value” input box in the Goal Seek
dialog box.

Click the Collapse Dialog button next to the “By changing cell” input
box in the Goal Seek dialog box.

Click cell D13 on the Budget Summary worksheet.

Press the ENTER key on your keyboard.

Click the OK button on the Goal Seek dialog box.

Click the OK button on the Goal Seek Status dialog box (see Figure 2.48
"Solution Calculated by Goal Seek"). The status box is telling you that
Excel found a value for cell D13 that produces an output of $25,000 for
the FV function in cell D10.
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15. Figure 2.47 "Final Settings for the Goal Seek Dialog Box" shows the
final settings for the Goal Seek dialog box before clicking the OK
button.

Figure 2.47 Final Settings for the Goal Seek Dialog Box

Goal Seek | % | =]

Set cell: $D$10 i i
Collapse Dialog

To value: 25000

box buttons

il

By changing cell: |$D$13
0K | | Cance\
\

Click in this box to type a
value Excel will use for the
“Set cell” location

Figure 2.48 "Solution Calculated by Goal Seek" shows the solution Goal Seek
calculated for the rate of return. Notice that in order to achieve the target savings
plan of $25,000, the rate of return must increase to 7.8%. Initially, it appears that we
can spend the additional $500 a year on vacations and still achieve our savings goal
of $25,000. However, achieving a 7.8% annual rate of return will require us to make
riskier investments with our savings. Thus, there is a greater possibility that we
could lose a substantial amount of our savings. This is the downside of decreasing
your overall savings rate. If you save less money, it forces you to take higher risks
with the money you have in order to achieve higher rates of return. Unfortunately,
many people end up on the losing end of these risks, which severely compromises
their ability to reach their savings goals.
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Figure 2.48 Solution Calculated by Goal Seek

Excel Objective 2.00.xIsx - Microsoft Excel

.@{fﬂnvm & |+
e |

Home Insert Page Layout Formulas Data Review View

i) From Access o (3 connections s | _)‘ T
5 From \ ' Propertie

From Other Refresh Al ort Iter _ Text t
£ From Text Sources ons | Al =2 Edit Links 7 Advanced | colym

Get External Data | Connections | Sort & Filter
D10 - fc | =FV(D13,012,-D7,-D14)
A B © Goal Seek Status EHE‘
VY0 s E ] MO 14 Goal Seeking with Cell D10
1 found a solution.
2 Net Income Target value: 25000
3 Expenses $ 18,450 Current value:  $25,000 ‘
2 Mortgage Payments $ 10,629 [ o \’] [ concel |
5. (Car Lease Payments 3 247 - This dialog box indicates that Excel
6 |Total Plan Spend $ 31,568 95.6% Lfound a solution for the value that was ]
7 Net Change in Cash $ 1,442 4.4% typed into the To value input box.
8
9 Savings Plan| $ 25,000
10 Savings Projection| $ 25,000 < oo 1 T :
o gr oal Seek changed the rate o
11 Plan vs Projection | § L. L return so the ou.?tput of the FV ]
12 Years of Saving 10 function would equal $25,000.
13 Rate of Return 7.8% 4 J
14 Current Balance| $ 2,000
15
|« » | Budget Summary / Budget Detal ./ Mortgage Payments  Car Lease Payrl| | 4|

Skill Refresher: Goal Seek

(click to see video)

Click the What-If Analysis button in the Data tab of the Ribbon.
Click the Goal Seek option.

Define the “Set cell” input box in the Goal Seek dialog box with a
cell location that contains a formula or function.

Type a number in the “To value” input box in the Goal Seek dialog
box. This is the number you want the formula or function to
produce, which you defined for the “Set cell” input box.

Define the “By changing cell” input box in the Goal Seek dialog box
with a cell location that is referenced in the formula or function
used to define the “Set cell” input box.

Click the OK button on the Goal Seek dialog box.

Click the OK button on the Goal Seek Status dialog box.
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KEY TAKEAWAYS

+ The PMT function can be used to calculate the monthly mortgage
payments for a house or the monthly lease payments for a car.

+ When using the PMT or FV functions, each argument must be separated
by a comma.

« When using the PMT or FV functions, the arguments must be defined in
comparable terms. For example, when using the FV function, if the Pmt
argument is defined using monthly payments, the Rate and Nper
arguments must be defined in terms of months.

« The FV function is used to calculate the value an investment at a future
point in time given a constant rate of return.

« The PMT and FV functions produce a negative output if the Pmt or Pv
arguments are not preceded by a minus sign.

¢ Goal Seek is a valuable tool for creating what-if scenarios by changing
the value in a cell location referenced in either a formula or a function.
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EXERCISES

1. Which statement best explains the setup of the following
payment function: =PMT(.06,30,-200000,50000,0)? Note that the
6% annual interest rate is expressed in decimal terms as .06.

a. The function is calculating the monthly payments of a
$200,000 loan, 6% interest rate, over 30 years, with a lump-
sum payment of $50,000 at the end of the loan. Payments are
due at the end of every month.

b. The function is calculating the annual payments of a
$200,000 loan, 6% interest rate, over 30 years, with a lump-
sum payment of $50,000 at the end of the loan. Payments are
due at the end of every year.

c. The function is calculating the monthly payments of a
$200,000 loan, 6% interest rate, over 30 years, with a lump-
sum payment of $50,000 at the end of the loan. Payments are
due at the beginning of every month.

d. The function is calculating the annual payments of a
$200,000 loan, 6% interest rate, over 30 years, with a lump-
sum payment of $50,000 at the end of the loan. Payments are
due at the beginning of every year.

2. When leasing a car, the residual value will be used to define
which of the following?

the Pv argument in the FV function

the Pv argument in the PMT function
the Pmt argument in the FV function
the Fv argument in the PMT function

fo op

3. The recurring investments in an annuity investment would be
used to define which of the following?

the Pmt argument in the FV function
the Pv argument in the FV function

the Fv argument in the PMT function
the Pv argument in the PMT function

o op

4. Which of the following PMT functions will accurately calculate
the monthly payments on a mortgage if the price of the house is

2.3 Functions for Personal Finance 192



Chapter 2 Mathematical Computations

2.3 Functions for Personal Finance

$300,000, a down payment of $60,000 is made, the interest rate is
5%, the term of the loan is 30 years, and payments are due at the
end of every month?

=PMT(.05/12,30%12,-300000,60000,0)
=PMT(.05,30*12,-300000,60000,0)
=PMT(.05/12,30%12,-240000)
=PMT(.05/12,30,-240000,0)

o op
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2.4 Chapter Assignments and Tests

To assess your understanding of the material covered in the chapter, please
complete the following assignments.
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Careers in Practice (Skills Review)
Financial Plan for a Lawn Care Business (Comprehensive Review)

Starter File: Chapter 2 CiP Exercise 1

Difficulty: Level 1 Easy

Running your own lawn care business can be an excellent way to make money
over the summer while on break from college. It can also be a way to
supplement your existing income for the purpose of saving money for
retirement or for a college fund. However, managing the costs of the business
will be critical in order for it to be a profitable venture. In this exercise you will
create a simple financial plan for a lawn care business by using the skills
covered in this chapter. Begin this exercise by opening the file named Chapter 2
CiP Exercise 1.

1. Click cell C5 in the Annual Plan worksheet.

2. Enter a formula that calculates the average price per lawn cut.
Type an equal sign (=), then click cell B3. Type the asterisk symbol
(*) for multiplication, then click cell B4. Press the ENTER key.

3. Click cell C8 in the Annual Plan worksheet.

4. Enter a formula that calculates the total number of lawns that will
be cut during the year. Type an equal sign (=), then click cell Bé.
Type the asterisk symbol (*) for multiplication, then click cell B7.
Press the ENTER key.

5. Click cell D9 in the Annual Plan worksheet.

6. Enter a formula that calculates the total sales for the plan. Type an
equal sign (=), then click cell C5. Type the asterisk symbol (*) for
multiplication, then click cell C8. Press the ENTER key.

7. Click cell F3 in the Leases worksheet. The PMT function will be
used to calculate the monthly lease payment for the first item. For
many businesses, leasing (or renting) equipment is a more
favorable option than purchasing equipment because it requires
far less cash. This enables you to begin a business such as a lawn
care business without having to put up a lot of money to buy
equipment.
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8. Type an equal sign (=) followed by the function name PMT and an
open parenthesis ((). Define the arguments of the function as
follows:

o Rate: Click cell B3, type a forward slash (/) for division, type the
number 12, and type a comma. Since we are calculating
monthly payments, the annual interest rate must be converted
to a monthly interest rate.

o Nper: Click cell C3, type an asterisk (*) for multiplication, type
the number 12, and type a comma. Similar to the Rate
argument, the terms of the lease must be converted to months
since we are calculating monthly payments.

o Pv: Type a minus sign (-), click cell D3, and type a comma.
Remember that this argument must always be preceded by a
minus sign.

o Fv: Click cell E3 and type a comma.

o Type: Type the number 1, type a closing parenthesis ()), and
press the ENTER key. We will assume the lease payments will
be made at the beginning of each month, which requires that
this argument be defined with a value of 1.

9. Copy the PMT function in cell F3 and paste it into the range F4:F6.

10. Click cell F10 in the Leases worksheet. A SUM function will be
added to calculate the total for the monthly lease payments.

11. Type an equal sign (=) followed by the word SUM and an open
parenthesis ((). Highlight the range F3:F9, type a closing
parenthesis ()), and press the ENTER key. You will notice that
blank rows were included in this range for the SUM function. If
other items are added to the worksheet, they will be included in
the output of the SUM function.

12. Highlight the range A2:F6 on the Leases worksheet. The data in
this range will be sorted.

13. Click the Sort button in the Data tab of the Ribbon. In the Sort
dialog box, select the Interest Rate option in the “Sort by” drop-
down box. Select Largest to Smallest for the sort order. Then, click
the Add Level button on the Sort dialog box. Select the Price option
in the “Then by” drop-down box. Select Largest to Smallest for the
sort order. Click the OK button in the Sort dialog box.

14. Click cell B11 on the Annual Plan worksheet. The monthly lease
payments that are calculated in the Lease worksheet will be
displayed in this cell.
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15. Type an equal sign (=). Click the Leases worksheet tab, click cell
F10, and press the ENTER key.

16. Click cell C12 on the Annual Plan worksheet.

17. Type an equal sign (=) and click cell B11. Type an asterisk (*), type
the number 12, and press the ENTER key. This formula calculates
the annual lease payments.

18. Format the output of the formula in cell C12 so the decimal places
are reduced to zero.

19. Click cell C14 on the Annual Plan worksheet.

20. Type an equal sign (=) and click cell B13. Type an asterisk (*), click
cell C8, and press the ENTER key.

21. Click cell D16 on the Annual Plan worksheet.

22. Type an equal sign (=) followed by the word SUM and an open
parenthesis ((). Highlight the range C11:C15, type a closing
parenthesis ()), and press the ENTER key. This SUM function adds
the total expenses for the business.

23. Click cell D17 on the Annual Plan worksheet.

24. Type an equal sign (=). Click cell D9, type a minus sign (-), click cell
D16, and press the ENTER key. This formula calculates the annual
profit for the business.

25. Click cell B10 on the Investments worksheet.

26. Type an equal sign (=) followed by the word COUNT and an open
parenthesis ((). Highlight the range B3:B8, type a closing
parenthesis ()), and press the ENTER key. This function counts the
number of investments that currently have a balance. Notice that
additional blank rows were included in the range for this function.
The function output will automatically change if any new
investments are added to the worksheet.

27. Click cell D3 on the Investments worksheet.

28. Type an equal sign (=). Click the Annual Plan worksheet tab. Click
cell D17 and type a forward slash (/) for division. Click the
Investments worksheet tab. Click cell B10 and press the ENTER
key. This formula divides the profit calculated on the Annual Plan
worksheet by the number of investments in the Investments
worksheet. We will assume that the profits from this business will
be invested evenly among the funds listed in Column A of the
Investments worksheet.

29. Before copying and pasting the formula created in step 28,
absolute references must be added to the cell locations in the
formula. Double click cell D3 on the Investments worksheet. Place
the mouse pointer in front of D17 in the formula and click. Press
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30.
31.

32.

33.
34.
35.

the F4 key on your keyboard. Place the mouse pointer in front of
cell B10 in the formula and click. Press the F4 key on your
keyboard. Press the ENTER key.

Copy cell D3 and paste it into cells D4 and D5.

Click cell E3 on the Investments worksheet. The future value
function will be added to project the total growth of the
investments listed in Column A. We will assume that the business
will be able to consistently generate the profit, which will be
invested evenly in the funds every year.

Type an equal sign (=) followed by the function name FV and an
open parenthesis ((). Define the arguments of the function as
follows:

o Rate: Click cell C3 and type a comma. This is the expected
growth rate of the first fund.

o Nper: Type the number 10 and then type a comma. We will
project the growth of these investments in 10 years.

o Pmt: Type a minus sign (-), click cell D3, and type a comma.
Remember that this argument must always be preceded by a
minus sign. We are assuming that the business will
consistently generate the profits calculated in the Annual
Plan worksheet and that these profits will be invested evenly
into each fund.

o Pv: Type a minus sign () and click cell B3. Since each fund
currently has a balance, we need to add this to the Pv
argument of the function. Similar to the Pmt argument,
remember that this argument must also be preceded by a
minus sign.

o Type: Type a closing parenthesis ()) and press the ENTER key.
We will assume the investments will be made at the end of
each year. Therefore, it is not necessary to define this
argument since Excel will assume zero, or end of the period, if
it is not defined.

Copy the FV function in cell E3 and paste it into cells E4 and E5.
Click cell B9 on the Investments worksheet.

Type an equal sign (=) followed by the word SUM and an open
parenthesis ((). Highlight the range B3:B8, type a closing
parenthesis ()), and press the ENTER key. This SUM function adds
the current balance for all investments. Blank rows are added to
the range for the function so additional investments will
automatically be included in the function output.
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36. Copy the SUM function in cell B9 and paste it into cells D9 and E9.

37. We will use Goal Seek to determine how many customers we need
to service in order to reach a savings goal of $250,000. Click cell E9
on the Investments worksheet. Click the What-If Analysis button
in the Data tab of the Ribbon and select Goal Seek. Click in the “To
value” input box on the Goal Seek dialog box. Type the number
250000. Click the Collapse Dialog button next to the “By changing
cell” input box on the Goal Seek dialog box. Click the Annual Plan
worksheet tab and click cell B6. Press the ENTER key, and click the
OK button on the Goal Seek dialog box. Click the OK button on the
Goal Seek Status dialog box. View the number of customers

showing in cell B6 in the Annual Plan worksheet.

38. Save the workbook by adding your name in front of the current
workbook name (i.e., “your name Chapter 2 CiP Exercise 1”).
39. Close the workbook and Excel.

Figure 2.49
Completed CiP Exercise 1 Annual Plan Worksheet
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A

B

C

j Lawn Care Annual Financial Plan

2 Sales Plan:

Price per Acre

Average Acreage per Customer
Average Price per Cut

Number of Customers

Frequency of Lawn Cuts per Custome|
Total Lawn Cuts

0N O s W

9 Total Sales

10 Expenses:

11 Monthly Lease Payments

12 Annual Lease Payments

13 Lawn & Equipment Expenses Per Cut
14 Total Lawn & Equipment Expenses
15  Office and Other Expenses

16 Total Expenses

17 Operating Income

$ 50.00
0.50
$ 25.00
32.697433
22
719
$122
$1,461
$ 5.00
$ 3,597
$ 1.500

6,558

17,984

11,426

18

- T — ) i
4 4 » » | Annual Plan / Investments “Leases /%3 ~

T
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Figure 2.50

Completed CiP Exercise 1 Investments Worksheet

2
3 |Treasury Bond $
4 |Domestic Stock Fund 20,000 8.0% 3,809 | $ 98,353
5 |Emerging Markets 10,000 10.5% 3,809 |93 89,316
6
7
8
9 |Total 40,000 11,426 | $ 250,000
10 (Number of Investments 3
11|
12|
13|
14
15 |
Ac |
4 4 » ¥ [ Annual Plan | Investments /Leases /% T

Figure 2.51

Completed CiP Exercise 1 Leases Worksheet

2
3 Blower 3
4 Commercial Lawn Mower 5.5% 4/$ 6,000|3% 3,000 $83.14
5 |Edger 4.0% 2|8 400 | $ 150 $11.32
6 Trimmer 4.0% 2[$ 3508 100 $11.15
7
8
2
10 Total $121.74
11
12
13|
14|
15/
16
4 <« » »| Annual Plan / Investments | Leases /%J ﬁ

Hotel Management Cost Analysis

Starter File: Chapter 2 CiP Exercise 2

Difficulty: Level 2 Moderate

The hotel management industry presents a wide variety of career

opportunities. These range from running your own bed and breakfast to a
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management position at a large hotel corporation. No matter what hotel
management career you choose to pursue, understanding the costs for any
hotel operation is critical to running a successful operation. This exercise
examines the relationship between cleaning expenses and the occupancy rate
of a small hotel. Cleaning expenses are obviously influenced by the occupancy
rate of the hotel. As more rooms need to be cleaned, the amount of overall
cleaning expenses increases. However, to accurately estimate these expenses,
you need to know whether there is a baseline, or fixed portion, of these
expenses that does not change no matter how many rooms need to be cleaned.
In other words, if you pay a cleaning staff a fixed salary, it does not matter if
they clean 1 room or 100 rooms; their salary will remain the same. However,
you may need more cleaning supplies as the number of rooms that need to be
cleaned increases. In addition, the replacement of guest necessities such as
soap, shampoo, lotions, and so on will also increase as the number of rooms to
be cleaned increases. This exercise will demonstrate how these costs can be
estimated through a technique called the high-low method. Begin this exercise by
opening the file named Chapter 2 CiP Exercise 2.

1. Enter a formula in cell C5 on the Historical Costs worksheet to
calculate the January capacity for the hotel. The capacity is
calculated by multiplying the occupants per room (cell C3) by the
number of rooms in the hotel (cell C2). This result is then
multiplied by the number of days in the month (cell C5). Construct
this formula so that relative referencing does not change cells C3
and C2 when the formula is pasted into other cell locations in
Column C.

2. Copy the formula in cell C5 and paste it into the range C6:C16. Use
a paste method that does not remove the border at the bottom of
cell C1e6.

3. Enter a formula in cell E5 on the Historical Costs worksheet to
calculate the occupancy capacity of the hotel. Your formula should
divide the Hotel Capacity into the Actual Capacity. Format your
result to a percentage with two decimal places. Then copy and
paste the formula into the range E6:E16. Use a paste method that
does not remove the border at the bottom of cell E16.

4. Enter a function in cell C17 on the Historical Costs worksheet that
sums the values in the range C5:C16. Copy the function and paste it
into cells D17 and F17. Use a paste method that does not change
the border on the right side of cell F17.

5. Copy the formula in cell E16 and paste it into cell E17. Use a paste
method that does not change the border at the bottom of cell E17.
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10.

11.

12.

13.

14.

Sort the data in the Historical Costs worksheet based on the
values in the Actual Occupancy column in descending order
(largest to smallest). For any duplicate values in the Actual
Occupancy column, sort using the values in the Cleaning Expenses
column in descending order.

On the Cost Analysis worksheet, enter a function into cell B3 that
shows the highest value in the range D5:D16 in the Actual
Occupancy column on the Historical Costs worksheet.

On the Cost Analysis worksheet, enter a function into cell B4 that
shows the lowest value in the range D5:D16 in the Actual
Occupancy column on the Historical Costs worksheet.

On the Cost Analysis worksheet, enter a function into cell C3 that
shows the highest value in the range F5:F16 in the Actual
Occupancy column on the Historical Costs worksheet.

On the Cost Analysis worksheet, enter a function into cell C4 that
shows the lowest value in the range F5:F16 in the Actual
Occupancy column on the Historical Costs worksheet.

On the Cost Analysis worksheet, format cells B3 and B4 with a
comma and zero decimal places. Format cells C3 and C4 with US
dollars with zero decimal places.

On the Cost Analysis worksheet, enter a formula in cell B5 that
subtracts the lowest actual occupancy value from the highest
actual occupancy value. Copy this formula and paste it into cell C5.
Enter a formula in cell C6 on the Cost Analysis worksheet that
calculates that variable cost portion for the cleaning expenses per
month. As mentioned in the introduction to this exercise, the
cleaning expense contains costs that increase with each room that
is cleaned. This is known as a variable expense and can be estimated
by dividing the Actual Occupancy High Low Difference (cell B5)
into the Cleaning Expenses High Low Difference (cell C5). Format
the output of this formula to US dollars with two decimal places.
Enter a formula in cell C7 on the Cost Analysis worksheet that
calculates the fixed cost portion for the cleaning expenses per
month. This is the amount of money that will be spent on cleaning
expenses no matter how many rooms are cleaned. Since we have
calculated the variable cost portion of the cleaning expense, we
can now use it to calculate the fixed expense. To do this, subtract
from the High Cleaning Expense (cell C3) the result of multiplying
the variable expense (cell C6) by the High Actual Occupancy (cell
B3). Format the result of the formula to US dollars with zero
decimal places.
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ons

15.

16.

17.

18.

19.

Figure 2.52

Enter the number 3500 in cell C2 on the Cleaning Cost Estimates
worksheet. Format the number with commas and zero decimal
places.

Apply a yellow fill color to cell C2 on the Cleaning Cost Estimates
worksheet. This is being formatted to indicate to the user of this
worksheet that a number is to be entered into the cell.

On the Cleaning Cost Estimates worksheet, enter a formula in cell
C3 that calculates the estimated cleaning expenses given the
number that was entered into cell C2. Now that we have calculated
the variable and fixed expenses on the Cost Analysis worksheet,
we can use the results to estimate the cleaning expenses. The
formula is a + bX, where a is the fixed cost, b is the variable cost,
and X is the activity level that is typed into cell C2. The fixed cost is
added to the result of multiplying the variable cost by the activity
level in cell C2. Format the output of the formula to US dollars with
zero decimal places.

Save the workbook by adding your name in front of the current
workbook name (i.e., “your name Chapter 2 CiP Exercise 2”).

Close the workbook and Excel.

Completed CiP Exercise 2 Historical Costs Worksheet

A B C D E F

§ Hotel Occupancy and Cleaning Costs for Last Year

17
18

Number of Rooms 45
Occupants per Room 4

Days in |Hotel Actual Cleaning
Month Month |Capacity |Occupancy |Capacity Expenses
June 30 5,400 5,413 100.24%| $ 5,986
December 31 5,580 5,142 92.15%| $ 5,877
August 31 5,580 4,640 83.15%| $ 5,542
January 31 5,580 4,371 78.33%| $ 5,595
July 31 5,580 4,219 75.60%| $ 5,259
May 31 5,580 4,124 73.91%| $ 5,413
September 30 5,400 3,866 71.60%| $ 4,426
February 28 5,040 3,715 73.71%| $ 4,246
April 30 5,400 3,351 62.05%| $ 4,566
October 31 5,580 2,513 45.04%| $ 4,267
November 30 5,400 2,513 46.54%| $ 4,104
March 31 5,580 2,062 36.95%| $ 4,053
Total 65,700 45,928 69.91% 59,333

1Lz
4 4 » ¥ | Historical Costs / Cost Analysis

Cleaning Cost Estimates /%2
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Figure 2.53
A B C
, Hotel Cost Analysis
Actual Cleaning
2 Occupancy Expenses
3 High 5413 | $ 5,986
4 Low 2,062 | 3 4,053
5 High Low Difference 3,351 1,933
6 Variable Cost per Stay 3 0.58
7 Fixed Cost 3 2,863
8
9
10
11
12
13
14
15
16
17
18
19
2N
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4 4 » » [ Historical Costs | Cost Analysis ~

Cleaning Cost Estimates

204



Chapter 2 Mathematical Computations

Integrity Check

Starter File: Chapter 2 IC Exercise 3

Difficulty: Level 3 Difficult

The purpose of this exercise is to analyze a worksheet to determine whether
there are any integrity flaws. Read the scenario below, then open the Excel
workbook related to this exercise. You will find a worksheet in the workbook
named AnswerSheet. This worksheet is to be used for any written responses
required for this exercise.

Scenario

You are the manager of a large do-it-yourself hardware store that is part of a
national retail chain. Your assistant manager has constructed a sales and profit
budget for the upcoming year. The Budget worksheet contains several
formulas used to calculate the expected sales and profit dollars for the store by
product category. The following is a list of key elements and calculations used
on this worksheet:

¢ Cells shaded in yellow are intended for data entry values. For
example, last year sales results in Column B are typed into the
cells. Also, the expected growth rates in Column D and profit
percentages in Column E are also typed into the cells. These values
fluctuate from year to year, and the assistant manager intends to
create a few scenarios for the budget by changing the growth rates
and expected profit percentages for each product category.

« Table 2.9 "Formulas Used on the Budget Worksheet" contains a list
of the formulas that are used to produce the outputs on the
Budget worksheet.

Table 2.9 Formulas Used on the Budget Worksheet

Purpose Formula Location
Budgeted Profit .
& Budgeted Sales x Profit Percent F4:F7
Dollars
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Budgeted Sales Sales Last Year x (1 + Sales Growth) C4:C7
Total Profit
otal Tron (Total Budgeted Profit Dollars + Total Budgeted Sales) | E8
Growth
Total Sales (Total Budgeted Sales - Total Sales Last Year) + Total -
Growth Sales Last Year
Assignment

1. Asnoted in Table 2.9 "Formulas Used on the Budget Worksheet",
the Sales Last Year is used in the formula calculating the Budgeted
Sales dollars. Use the Trace Dependents command to locate the
formula referencing any value in the Sales Last Year column on the
Budget worksheet. Document your observation in the
AnswerSheet worksheet.

2. The assistant manager intends to use the Budget worksheet to
create a few scenarios for the budgeted sales and profit dollars.
Change a few values in the Profit Percent column and document
your observations in the AnswerSheet worksheet.

3. Look at each value in the Totals row (row 8) on the Budget
worksheet. Are there any values that do not make sense? Type
your answer on the AnswerSheet worksheet.

4. Using Table 2.9 "Formulas Used on the Budget Worksheet" as a
guide, evaluate all formulas that were entered into the Budget
worksheet. Make any necessary corrections to the worksheet so
when any value is changed in Columns B, D, and E, new outputs are
created.

5. Save the workbook by adding your name in front of the current
workbook name.

Starter File: Chapter 2 IC Exercise 4

Difficulty: Level 3 Difficult

The purpose of this exercise is to analyze a worksheet to determine whether
there are any integrity flaws. Read the scenario below, then open the Excel
workbook related to this exercise. You will find a worksheet in the workbook
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named AnswerSheet. This worksheet is to be used for any written responses
required for this exercise.

Scenario

Your friend is working on a few financial calculations in Excel and is asking for
your assistance. The workbook that was given to you contains calculations for
estimating the future value of investments and monthly mortgage calculations
for purchasing a home. Your friend explained the following in an e-mail that
was sent with the workbook:

* You will see in the Investment Plan worksheet that I have
estimated the value of my investments in 5 years. My company is
taking money out of my paycheck at the end of every month and
investing it in the funds I have listed in Column A. I am pretty sure
I did this right, but all my results in Column E are negative. [ am
not sure why this is happening.

« In the Mortgage Payments worksheet, I am trying to calculate the
monthly payments for a house I am thinking about buying.
However, the output of the function in cell B6 seems really high.
There is no way I would be paying over $9,000 a month in
mortgage payments. Something must be wrong.

+ Idon’t want to spend more than $775 a month for a mortgage. I
thought I would be able to use Excel to determine what my target
price for the house should be. My agent said that the current
owners were probably willing to negotiate on the asking price for
the house.

Assignment

1. Look at the FV function that was entered into cell E3 on the
Investment Plan worksheet. Why is the output for this function
negative?

2. Assume that the output of the FV function in cell E3 was a positive
$17,385 instead of negative. Does it make sense that given a 4.5%
annual rate of return, starting balance of $10,000, and an ongoing
investment of $900 per month that the value of the investment
would be $17,385 after 5 years?
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3. Look at the PMT function in cell B6 on the Mortgage Payments
worksheet. Is the function set up to calculate monthly payments?

4. You friend states that the target monthly mortgage payment is
$775. What Excel tool could you use to change the price in cell B2
on the Mortgage Payments worksheet so the mortgage payment
is equal to $7757

5. Based on your friend’s comments, make any necessary corrections
to all the functions in the Investment Plan and Mortgage
Payments worksheets. Set the price of the home in cell B2 on the
Mortgage Payments worksheet so the monthly payment equals
$775.

6. Save the workbook by adding your name in front of the current
workbook name.
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Applying Excel Skills
Lease vs. Buy

Starter File: None

Difficulty: Level 2 Moderate

You are in the process of getting a new car but are not sure if you should buy or
lease. The price of the car you want is $18,000, but you do not want to spend
more than $250 a month on car payments. If you lease the car, the terms of the
lease will be 48 months at an annual interest rate of 5%. The residual value of
the car will be set at $9,000. If you buy the car, your bank will offer you a 7-year
loan at an annual interest rate of 6%. You are not required to make a down
payment with either the lease or loan options, and payments are made at the
end of the month for both options.

Should you lease or buy the car given your budget limit of $250 a month?
Create a new workbook and design a worksheet that shows the difference
between leasing and buying the car in terms of monthly payments. Use proper
formatting so your worksheet is easy to read. Remember to use column and row
headings, add a title to your worksheet, and rename the worksheet tab with an
appropriate label. Include your name in the file name of the workbook.

Amortization Table for a Home Loan
Starter File: None
Difficulty: Level 3 Difficult

You are considering the purchase of a new home offered at a price of $225,000.
Create an amortization table in a new workbook that shows how much interest
and principal you will pay each month for the duration of the loan. The
following is a list of assumptions and requirements you need to consider for
this assignment:
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1. You will be making a down payment of 20% on the home (refer to
Table 2.5 "Key Terms for Loans and Leases" for loan and lease
terms).

2. The bank will offer you a loan at an annual interest rate of 5.5% for
30 years.

3. Your mortgage payments will be made at the end of each month.

4. You must construct the amortization table so that any change in
the loan variables, down payment percent, length of loan, interest
rate, and so on will automatically produce new outputs for each
month of the amortization table.

5. The amortization table must show the interest payment, principal
payment, and balance remaining to be paid on the loan for every
month of the loan duration. The beginning balance for the last
month of the loan should be equal to the principal payment in the
last month. Refer to Figure 2.29 "Example of an Amortization
Table" for establishing the format for the table.

6. Remember to use column and/or row headings, add a title to your
worksheet, and rename the worksheet tab with an appropriate
label.

7. Include your name in the file name of the workbook.
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CHAPTER SKILLS TEST

Starter File: Chapter 2 Skills Test

Difficulty: Level 2 Moderate

Answer the following questions by executing the skills on the starter file
required for this test. Answer each question in the order in which it appears.
If you do not know the answer, skip to the next question. Open the starter
file listed above before you begin this test.

1. Enter a function in cell B9 on the Investments worksheet that calculates
the total of the values in the range B3:B8.

2. Copy the function in cell B9 and paste it into cells C9 and G9.

3. Enter a formula in cell E3 on the Investments worksheet that calculates
the growth rate for the investments. Your formula should first subtract
the value in the Invested Principal column from the value in the Current
Balance column. Then, divide this result by the value in the Invested
Principal column.

4. Copy the formula in cell E3 and paste it into the range E4:E8.

5. Copy the formula in cell E3 and paste it into cell E9 using the Paste
Formulas option.

6. Enter a formula in cell D3 on the Investments worksheet that divides
the Current Balance by the total in cell C9. Add an absolute reference to
C9 in this formula.

7. Copy the formula in cell D3 and paste it into the range D4:D8.

8. In cell G3 on the Investments worksheet, use the Future Value function
to calculate the future value of the investment in 2 years. Use the Target
Growth Rate to define the Rate argument. This is not an annuity so there
are no periodic investments. Use the Current Balance to define the Pv
argument. Assume that the investment is made at the beginning of the
period.

9. Copy the function in cell G3 and paste it into the range G4:G8.

10. Enter a function in cell B10 on the Investments worksheet that
calculates the average of the values in the range B3:B8.

11. Copy the function in cell B10 and paste it into cells C10 and G10.

12. On the Mortgage worksheet, use the data provided to enter a formula in
cell B6 to calculate the principal of the loan that will be required to
purchase the house.

13. On the Mortgage worksheet, use the PMT function in cell B7 to calculate
the monthly payments of the mortgage. Use cell locations from this
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14.

15.

16.

17.

18.

19.

20.

21.

28

23.

24.

worksheet to define each argument of the function. Assume that
payments are made at the end of each month.

On the Auto Lease worksheet, use the PMT function in cell B6 to
calculate the monthly lease payments. Use cell locations from this
worksheet to define each argument of the function. Assume that the
lease payments are due at the beginning of each month.

On the Auto Lease worksheet, use Goal Seek to change the Annual
Interest rate in cell B2 so the monthly payments are exactly $200.

In cell E2 on the Summary worksheet, use a cell reference to display the
value in cell B9 in the Investments worksheet.

In cell E3 on the Summary worksheet, use a cell reference to display the
value in cell G9 in the Investments worksheet.

Enter a formula in cell F4 on the Summary worksheet that subtracts the
Principal of Investments from the 2 Year Future Value of Investments.
Enter a formula in cell F5 on the Summary worksheet that calculates
the amount of mortgage payments that will be made over 2 years. Your
formula should multiply the value in B7 on the Mortgage worksheet by
24,

Enter a formula in cell F6 on the Summary worksheet that calculates
the amount of lease payments that will be made over 2 years. Your
formula should multiply the value in B6 on the Auto Lease worksheet by
24.

Enter a formula in cell F7 on the Summary worksheet that subtracts the
sum of the values in the range F5:F6 from the value in cell F4.

Sort the data in the range A2:G8 on the Investments worksheet. Sort the
data based on the values in the Invested Principal column in ascending
order (smallest to largest). For duplicate values in this column, sort
using the values in the Target Growth Rate column in descending order
(largest to smallest).

Save the workbook by adding your name in front of the current
workbook name (i.e., “your name Chapter 2 Skills Test”).

Close the workbook and Excel.

212



Chapter 3

Logical and Lookup Functions

Going beyond the basic computational tools of Excel unlocks unlimited potential for
processing and analyzing data. This chapter takes you beyond basic Excel
computations by introducing logical functions and lookup functions. Logical functions
are used to assess the contents within cell locations and produce custom outputs or
mathematical computations. We will look at two types of logical functions in this
chapter. The first is the IF function, which uses a logical test to evaluate the
contents in a cell location. The OR and AND functions also use logical tests to
evaluate the contents in a cell location and are often used within the IF function.
The second type of logical function that we will look at are statistical IF functions.
These functions combine the logical test feature of the IF function with the
mathematical computation features of statistical functions (which were reviewed in
Chapter 2 "Mathematical Computations"). The last section of this chapter
demonstrates the use of two lookup functions. These functions are used to find data
in one worksheet and display it in another. We will demonstrate the skills for this
chapter through the construction of a personal investment portfolio. This theme
builds on the personal budget project introduced in Chapter 2 "Mathematical
Computations". In the personal budget project, we analyzed the impact of investing
money in an account that provides a continuous rate of return. In this chapter we
look at how you can decide where to invest your money and how to analyze the
performance of those investments.
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3.1 Logical Functions

1. Employee retirement savings
plans offered by businesses and
by public and private
institutions. These plans allow
you to deduct money from
your paycheck every month,
tax-free, and invest it.

LEARNING OBJECTIVES

1. Learn how to use the Freeze Panes command to lock specific columns
and rows in place while scrolling through large worksheets.

2. Understand the construction and use of formulas, basic statistical
functions, and financial functions.

3. Learn how to construct a logical test to evaluate the contents of a cell
location.

4. Learn how to use the IF function to evaluate the data in a cell location
using a logical test.

5. Learn how to use the OR function within an IF function to evaluate the
data in a cell location using multiple logical tests.

6. Learn how to use the AND function within an IF function to evaluate the
data in a cell location using multiple logical tests.

7. Review the construction of nested IF functions for evaluating data using
more than one logical test.

8. Learn how to set a conditional format rule so formatting commands are
automatically applied based on the value in a cell location.

This section reviews the use of logical functions in Excel through the construction
of an investment portfolio. Although it may seem that managing investments is a
specialized career choice, the reality is that almost everyone will become an
investor at some point in their lives. Many companies offer employees retirement
savings benefits through 401(k) or 403(b)" plans. These plans allow you to deduct
money from your paycheck every month, tax-free, and invest it. In addition to the
tax benefits afforded by such plans, many employers match a percentage of your
monthly savings or deposit money into your retirement account as an added form
of compensation. When you sign up for these savings plans, your company will give
you a list of options as to how your money can be invested, and you choose the type
of investments you would like the company to make on your behalf. As a result of
this process, you become an investor. Excel can be an extremely valuable tool to
help you make these investment decisions and analyze the performance of the
money you have invested.

Figure 3.1 "Completed Personal Investment Portfolio Workbook" shows the
completed investment portfolio workbook that we will complete in this chapter.
Similar to the personal budget example in Chapter 2 "Mathematical Computations",
the Portfolio Summary worksheet contains a summary of the data entered or
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calculated in other worksheets in the workbook. This project begins by building on
the Investment Detail worksheet.

Figure 3.1 Completed Personal Investment Portfolio Workbook

e e RER-=18 Personal Investment Portfolio - Microsoft Excel e
The Ri ni
Home et Pagelajow Formuias Data  Review View <= E ' _0 S <
Al - | personal Investment summary minimized.

A B [— D E F G H

i I Personal Investment Summary
Portfolio Summar
2 Total Summary ,I o Y
Average |Total X poTKehee
Number of Months Purchase Current Annual Benchmark 5
3 Investments |Owned |Cost Value Growth |Year Growth |Benchmark
4 Bond Fund 4 36| $ 23,773 | % 27,274 4.9% 6.0%|Barclays
s Domestic Stock Fund 3 34/$ 22110 | $ 22,903 1.3% 2.5%|S&P 500
6 International Stock Fund 3 27| $ 18,983 | $ 22,578 8.5% 1.3%|MSCI EAFE
7 Individual Stock 5 63| $ 31,763 | $ 45,101 8.0% 5.4%|Dow Jones
8 TOTAL 15 40/ $ 96,628 | $117,857 6.6% 3.8%
s Poor Performing Invest ts

Average |Total
Numberof |Months |Purchase |Current Annual
10 Investments |Owned |Cost Value Growth

11 Bond Fund 1 10{$ 5500|$ 5626 2.8%

12 Domestic Stock Fund 3 34| $ 22,110 | $ 22,903 1.3%

13 International Stock Fund 1 42/$ 7340 |$ 50958 -5.4%

14 Individual Stock 2 69| $ 10,097 | $ 13,990 6.8%

15 TOTAL 7 39|s 45047 |5 48478 | 2.4%

16

K4 » | Portfolio Summary /" Investment Detail . Investment List /" Benchmarks ./ Price Data| 4| W

This worksheet is summarizing
the data that is entered or
calculated in this worksheet.

Freeze Panes

Follow-along file: Excel Objective 3.00

Lesson Video: Freeze Panes

(click to see video)

The Investment Detail worksheet shown in Figure 3.2 "Investment Detail
Worksheet" contains the majority of the information used to create the Portfolio
Summary worksheet shown in Figure 3.1 "Completed Personal Investment Portfolio
Workbook". When you first open the worksheet, you will notice it is not possible to
view all twenty-four columns on your computer screen. As you scroll to the right to
view the rest of the columns, you will lose site of the row headings in Columns A
and B. The headings in these columns show the investment that pertains to the data
in Columns C through X. To solve this problem of viewing the row headings while
scrolling through the remaining columns in the worksheet, we will use the Freeze
Panes command.
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2. An Excel command that allows
you to lock specific columns
and rows in place while
scrolling through a large
worksheet.

3.1 Logical Functions

Figure 3.2 Investment Detail Worksheet

1
2

® <o |0 |s|w

©

10
11
12
13
14
15
16
17
18

el I R =T Excel Objective 3.00 - Microsoft Excel o @
n Home Insert Pagelayout Formulas Data  Review  View o @ o e
| a1 - e Personal Investment Portfolio
A B & D E_| F G Ho |
Descriptive Information Purchase Curr
Purchase Current
Dividend / |Shares  |Price per |Cost of Current  |Purchase
Investment Type Symbol | Description Yield Share Price Value
Bond Fund VFICX 4.60%)| 750 |$ 9.49 $ 984
Bond Fund VFSTX 3.20%) 750 | $ 10.68 $ 10.73
Bond Fund VWEHX 7.20%) 500 |$ 6.29 $ 582
Bond Fund VUSTX 4.00%) 500 |$ 11.00 $ 10.88
International Stock Fund |VDMIX 2.60%) 500 | $ 14.68 $ 10.52
Domestic Stock Fund __ |[VEIPX 2.50%) 500 |$ 23.35 $ 2151
Domestic Stock Fund  [VISGX 0.30%)| 250 | $ 19.33 $ 2367
Domestic Stock Fund VIMSX 1.00%) 250 | $ 22.41 $ 21.70
International Stock Fund [VTRIX 2.00%) 250 | $ 22.83 $ 33.30
International Stock Fund [VEIEX 1.40%)| 250 | $ 23.74 $ 31.80
Individual Stock TRV 2.40%)| 150 | $ 38.14 $ 55.54
Individual Stock JNJ 3.60%) 150 | $ 53.30 S 61.94
Individual Stock KO 2.80%) 150 | $ 62.46 $ 65.50
Individual Stock MSFT 2.50%| 75|$ 28.02 $ 27.85
Individual Stock 1BM 1.60%) 75|$ 87.68 $ 146.67
Total

19

X 4% [ Portfolio Summary | Investment Detail / Tnvestment List

The Freeze Panes” command allows you to scroll across the Investment Detail

The rest of the columns in this
worksheet (J through X) are not
visible on one screen.

]

Benchmarks

Price Dat [ W]

Formulas and statistical functions

will be used to create the totals
in this row.

worksheet while keeping the row headings in Columns A and B locked in place. The
following steps explain how to do this:

activated cell as well as the rows above the activated cell.
2. Click the View tab on the Ribbon.

Command").

Figure 3.3 Freeze Panes Command

o)

= I

File Home

=1

Insert

Page Layout

Formulas  Data

Review

Excel Objective 3.00 - Microsoft Excel
<&

Click the Freeze Panes button (see Figure 3.3 "Freeze Panes

View [N

Click the Freeze Panes option from the drop-down list of options.

View tab

Click cell C4 on the Investment Detail worksheet. We select this cell
because the Freeze Panes option locks the columns to the left of the

s P s g 5 f —
IEE (L page Break preview ruler [ rormuiasar | @ j_ g 1 E jij Fsplit | (v -
\H ‘%‘ 15 custom views = A ;‘i" l : _Nfi‘ p ‘F e 1 synct Freeze Panes
ormal | Page 0om oomto | New Arrange | Freeze
| Laygu( 23 Full Screen ) Griclines [] Headings sclection | window I [PAREER [~ unhide | 3 Reset Window Position | Workspace button
_ Warkbook Views e _ show | zom iy Freeze Panes
@ - 73 ij Keep rows and columns visible while the rest of | ———
A T - = the worksheet scrolls (based on current selection) k
o Freeze Top Row
E Keep the top row visible while scrolling t{ Freeze Sheet panes
1 the rest of the worksheet.
= " Freeze First Column
5 Descriptive Information D] Keep the first column visible while scrolling
through the rest of the worksheet —F
Dividend / [Shares Price per |Cost of |Current P
3 Investment Type Symbol Description Yield Purchased |Share Purchase (Click here to lock in place the rows
4 [Bond Fund VFICX 4.60% 750 |S 9.49 above the activated cell and the
5 Bond Fund VESTX 3.20% 750 | $ 10.68 columns to the left of the
6 Bond Fund VWEHX 7.20% 500 |$ 6.29 activated cell.
7 Bond Fund VUSTX 4.00% 500 | $ 11.00 51088
8 |International Stock Fund |VDMIX 2.60% 500 | $ 14.68 $ 10.52
9 Domestic Stock Fund  |VEIPX 2.50% 500 | $ 23.35 $ 21.51
10 Domestic Stock Fund  |VISGX 0.30% 250 | $ 19.33 $ 2367

CellC4is
activated.
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Once you click the Freeze Panes option shown in Figure 3.3 "Freeze Panes
Command", Columns A and B are locked in place as you scroll through the columns
in the worksheet. Since this is a large worksheet, you may find it easier to navigate
the columns by using the arrow keys on your keyboard. However, since rows 1 and
2 contain merged cells, make sure a cell location is activated below Row 2 before you begin
using the arrow keys. Figure 3.4 "Freeze Panes Command Activated on the Investment
Detail Worksheet" shows the appearance of the Investment Detail worksheet after
the Freeze Panes command has been activated. To deactivate the Freeze Panes
command, click the Freeze Panes button again and select the Unfreeze Panes
option.

Figure 3.4 Freeze Panes Command Activated on the Investment Detail Worksheet

View

[T I, R -1 Excel Objective 3.00 - Microsoft Excel To deactivate Freeze Panes command,
Panes option.

Home Insert  Pagelayout Formulas  Data  Review & click here and select the Unfreeze

=5 | ol Page Break preview : © 5 B L1 + 3 split ew Side by Side
(8 e [ rormianer ¢ L@ = g E :Hme - ‘ o =

15| custom views 9
Normal | Page ) Gridines [7] Headings | Z00m 100% Zoomto = New Amange Freeze Save  Switch | M

Selection | Window Al Panes~ [~ Unhide | 3j4Reset Window Position | Workspace Windows ~

Layout |3 Full Screen

G — Eii) Zn v e Formulas and functions will be
L X used to complete the blank columns
A G H 1 l J K
L shown here.
1 [ |
5 Descriptive Information f Purchase Current Value
Purchase Current [Estimated |Current Current Target
Price per Cost of Current Purchase Dividend Investment |Percent of |Percent of
3 Investment Type jymbol Share Purchase Price Value Payments |Value Portfolio Portfolio
"4 [Bond Fund VFICX [$ 9.49 $ 984 10.0%
5 Bond Fund / [VFsTX [s 10.68 $ 10.73 10.0%
6 Bond Fund / [VWEHX[S 6.29 $ 582 10.0%
7 Bond Fund F VUSTX |$ 11.00 $ 10.88 10.0%
8 |International Stoc) Fund [VDMIX | $ 14.68 $ 10.52 7.0%
9 D ic Stack Find — |VEID $ 23.35 $ 21.51 5.0%
19 This line indicates that Columns A || $ 19.33 $ 2367 The arrow keys on your keyboard |5.0%
and B are locked in place from the can be used to navigate the
Freeze Panes command. ) L worksheet from here.

Formula and Functions Review

Follow-along file: Continue with Excel Objective 3.00. (Use file Excel Objective 3.01 if
starting here.)

Lesson Video: Formulas and Functions Review

(click to see video)

We will begin developing the personal investment portfolio workbook by adding
several formulas and functions. The formulas and functions we will add were
illustrated in detail in Chapter 2 "Mathematical Computations". Therefore, the
steps provided in this chapter will be brief. After the formulas and functions are
added to the Investment Detail worksheet, we can add the logical and lookup
functions. However, before proceeding, let’s review the investment type definitions

217


http://www.gone.2012books.lardbucket.org/sites/all/files/ManzoExcel_1.0_Excel_Objective_3.01.xlsx
http://www.youtube.com/v/T0IvgtAbIo0?rel=0

Chapter 3 Logical and Lookup Functions

3.1 Logical Functions

in Table 3.1 "Investment Types in Column A of the Investment Detail Worksheet".
Table 3.1 "Investment Types in Column A of the Investment Detail Worksheet"

provides a definition for each of the investment types listed in Column A of the
Investment Detail worksheet. This project assumes that the personal investment
portfolio comprises four types of investments. The reason we include a variety of
investment types in any portfolio is to manage our total risk, or potential of losing
money. When building an investment portfolio, it is important to keep in mind that
investments of all types can dramatically increase or decrease in value over a short
period of time. Managing risk requires that your money is not concentrated in one
type of investment.

Table 3.1 Investment Types in Column A of the Investment Detail Worksheet

A mutual fund consisting of a variety of bonds. The benefit of buying
shares of a fund as opposed to a specific bond is that doing so allows you to

Bond Fund ) . .
spread your investment over several bonds instead of concentrating your
investment in just one bond.

Domestic A mutual fund consisting of several domestic stocks. Buying shares of a
stock mutual fund provides the benefit of investing your money over

Stock Fund

several stocks.

International | Same as a domestic stock fund but contains a variety of non-US or foreign
Stock Fund | stocks.

The stock for one specific company. In addition to mutual funds, this
Individual chapter’s portfolio will include a few individual stocks for public

Stock companies. When you purchase shares of a specific company, such as IBM,
you become a partial owner of that company.

We will begin adding formulas and functions to the Investment Detail worksheet
in sections. If you scroll across all the columns in the worksheet, you will notice the
worksheet includes five distinct sections. Four of the five sections contain columns
that need to be completed with formulas and functions before we can add the

logical and lookup functions. Table 3.2 "Definitions for Columns A through G of the
Investment Detail Worksheet" contains definitions for each of the columns in the

Descriptive Information section (Columns A through D) and the Purchase section
(Columns E through G). 1t will be helpful to understand the purpose of these
columns as we complete this worksheet.
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3.1 Logical Functions

Table 3.2 Definitions for Columns A through G of the Investment Detail Worksheet

The type of investment with regard to bonds and stocks. A definition for
Investment . . . . .
Tvoe each of the investment types used in this portfolio can be found in Table 3.1
P "Investment Types in Column A of the Investment Detail Worksheet".
The symbol that represents a mutual fund or stock. This symbol can be used
Symbol to research the profile or current trading price on any website that provides
stock quotes.
. The company name for an individual stock or a description of the type of
Description | .
investments made by a mutual fund.
Dividend/ | The amount of interest earned on a bond or bond fund or the amount of
Yield earnings distributed per share for an individual stock or stock fund.
Shares T
The amount of shares purchased for a mutual fund or individual stock.
Purchased
Purchase . . T
Price ver The price paid for the shares purchased for the mutual funds and individual
Sharep stocks in the portfolio.
Cost of The number of shares purchased multiplied by the purchase price per share.
This represents your base investment and is used to determine how much
Purchase .
money has been gained or lost.

The Descriptive Information section of the Investment Detail worksheet (Columns
A through D) contains only one blank column, which will be completed using a
lookup function. Therefore, we will proceed to the Purchase section (Columns E
through G) where the Cost of Purchase column is blank. The following steps explain
how to enter the formula into this column:

Click cell G4 on the Investment Detail worksheet.

2. Type an equal sign (=).

Enter a formula that multiplies the Shares Purchased (cell E4) by the
Purchase Price per Share (cell F4).

Copy the formula in cell G4.

Highlight the range G5:G18.

Click the down arrow on the Paste button in the Home tab of the
Ribbon.

Click the Formulas button from the list of options. This is the Paste
Formulas command, which pastes only the formula without any
associated formats for the copied cell location.

Click cell E19 on the Investment Detail worksheet.

219




Chapter 3 Logical and Lookup Functions

9. Press and hold the ALT key on your keyboard, then press the equal sign
(=). This is the shortcut for the Auto Sum feature.
10. Press the ENTER key on your keyboard.
11. Click cell G19 on the Investment Detail worksheet.
12. Repeat step 9.
13. Press the ENTER key on your keyboard.

Figure 3.5 "Completed Formula in the Cost of Purchase Column" shows the formula
that was entered into cell G4 in the Purchase section of the Investment Detail
worksheet. You can also see the results of the formula after it is pasted into the
range G5:G18. The Paste Formulas option was used to paste the formula into this
range so the borders would not be altered.

Figure 3.5 Completed Formula in the Cost of Purchase Column

‘E‘ D= Excel Objective 3.00 - Microsoft Excel
- This line along with the change in
column letter sequence indicates that

= ; X floern = = = 5 T L Columns A and B have been locked
through the Freeze Panes command.
i
, Descriptive Information Purchase
Purchase ICy
Dividend / |Shares Price per |Cost of Curre
3 Investment Type Symbol Yield Purchased |Share Purchase ' Cost of Purchase formula. J
4 |Bond Fund VFICX 4.60% 750 | $ 9.49|=E4'F4 |S 9.84
5 Bond Fund VFSTX 3.20% 750 |$ 1068 |$ 8,010 []$ 10.73
6 Bond Fund VWEHX | 7.20% 500|$ 6.29|$% 3,145(|S 5.82
7 Bond Fund VUSTX 4.00% 500 |$ 11.00|$ 5500(fS 10.88
8 International Stock Fund |VDMIX 2.60%)| 500 |$ 1468 |$ 7,340 (S 10.52
9 Domestic Stock Fund  |VEIPX 2.50% 500|$ 23.35|8$11,675(|$ 21.51
10 Domestic Stock Fund VISGX 0.30% 250 |9 19.33|$ 4833]||S 23.67
11 Domestic Stock Fund _ [VIMSX 1.00% 250 [$ 22.41[3 5603([s 2170 ]| Results after pasting the
12 International Stock Fund |VTRIX 2.00% 250 | $ 2283 |$ 5,708 |[S 3330 || Costof Purchase formula.
13 International Stock Fund |VEIEX 1.40%| 250 |$ 23.74|$ 5935||S 31.80 ™
14 Individual Stock TRV 2.40% 150 |$ 38.14|$ 5721 (|$ 5554
15 Individual Stock JNJ 3.60% 150 | $ 53.30 |$ 7,995||S 61.94
16 |Individual Stock KO 2.80% 150 | $ 62.46 |$ 9,369 ||$ 65.50
17 Individual Stock MSFT 2.50% 75|19 28.02|3% 2,102 ||$ 27.85
18 Individual Stock IBM 1.60%; 75|89 87.68 |3 6,576 |JS 146.67
19 Total 5,100 $ 96,628

o0 . i . . 1 - N
4 < » [ Portfolio Summary | Investment Detail / InvestmentfList Benchmarks . Prife Dati| 4 dSUM function outputs.]

Table 3.3 "Definitions for Columns H through K of the Investment Detail
Worksheet" shows the definitions for the Current Value section (Columns H

through K) of the Investment Detail worksheet.

Table 3.3 Definitions for Columns H through K of the Investment Detail Worksheet

Category Definition
Current The current price of an individual stock or the current net asset value of a
Price mutual fund.
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Current
Purchase
Value

The number of shares purchased multiplied by the current price.

Estimated
Dividend
Payments

The estimated amount of money paid for the interest on a bond fund or the
dividends paid on a stock or stock fund. The future value function is used to
estimate these payments. For an actual portfolio, real monetary distributions
can be added to the current purchase value of the investment to calculate
the total value of an investment.

Current
Investment
Value

The current purchase value plus the estimated dividend payments. The
current investment value is compared with the cost of purchase to
determine how much money is gained or lost.

We will add a basic formula to the Current Purchase Value and Current Investment
Value columns. For the Estimated Dividend Payments column, we will use the FV
(future value) function to estimate the dividend payments. The following explains
how we add the FV function to the Estimated Dividend Payments column:

10.
11.

3.1 Logical Functions

Click cell J4 and type an equal sign (=).

. Type the function name FV followed by an open parenthesis (().

Click cell D4, type a forward slash (/) for division, and then type 12.
This divides the rate in the Dividend/Yield column by 12. The length of
ownership of an investment is expressed in terms of months in Column
Q. Therefore, the rate for the FV function must be expressed in terms
of months by dividing the annual rate by 12.

Type a comma.

Click cell Q4, which contains the number of months owned or the term
of the future value calculation.

Type a comma followed by a zero (,0). We are not calculating an
annuity or periodic investment in this example, so the PMT argument
will be defined with a zero. Type a comma to advance the function to
the Pv argument.

Type a minus sign (-) and click cell G4. This is the cost of the
investment purchase previously calculated.

Type a closing parenthesis ().

Type a minus sign (-) and click cell G4. By itself, the FV function is
calculating the total value of the investment with dividends or interest
earned. To show only the amount of dividends or interest earned, we
subtract the cost of the investment purchase in G4 from the result of
the FV function.

Press the ENTER key on your keyboard.

Adjust the decimal places for the output of the FV function to zero.
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12.

Copy the FV function in cell J4 and paste it into the range J5:J18 using
the Paste Formulas command.

Figure 3.6 "Completed FV Function in the Estimated Dividend Payments Column"
shows the completed FV function in cell J4 of the Estimated Dividend Payments
column. It is important to reduce the decimal places to zero after you enter the
function into cell J4. Excel does not display the result of the function until the

decimal places are removed because of the column width.

Figure 3.6 Completed FV Function in the Estimated Dividend Payments Column

| HLOOKUP v (* X ¥ fe| =FV(D4/12,04,0,-G4)-G4
A B D E F G H I J
| RV function calculating the estimated
) [ dividend or interest payments. ]
, Descriptive Information Purchase Current Value
Purchase Current Estimated  |Current Current

Dividend / | Shares Price per |Cost of Current Purchase Dividend Investment |Percent
3 Investment Type Symbol Yield Purchased |Share Purchase |Price Value |Payments  |Value Portfoli
4 |Bond Fund VFICX 4.60%, 750|$ 9493 7118|838 9.84 =FV(b4/12.Q4,0,-G4)-G4
5 Bond Fund VFSTX 3.20% 750 |$ 1068 |$ 8010|S 10.73 FV(rate, nper, pmt, [pv], [type]) L
6 Bond Fund VWEHX | 7.20% 500 |$ 6.29|8$ 3145[S 582 TS T.086 [ —
7 Bond Fund VUSTX 4.00%; 500 |$ 11.00[$ 5500[$ 10.88 $ 186
8 International Stock Fund |VDMIX 2.60%)| 500 |$ 1468 |$ 7.340[S 10.52 $ 698
9 Domestic Stock Fund VEIPX 2.50%) 500 |$ 23.35|311675[$ 21.51 $ 547
10 Domestic Stock Fund VISGX 0.30% 250 |$ 19.33|$ 4833|8 23.67 $ 40 ( Results of the FV function
11 Domestic Stock Fund  |VIMSX 1.00% 250 |9 2241 |% 5603|8 21.70 $ 219 . afteritis pasted into the
12 International Stock Fund |VTRIX 2.00%; 250 |$ 2283 |% 5708|S 33.30 $ 282 L [EERED
13 International Stock Fund |VEIEX 1.40% 250 |$ 23.74|% 5935|% 31.80 $ 63
14 Individual Stock TRV 2.40%) 150 | $ 38.14|$ 5,721 |S 55.54 $ 885
15 Individual Stock JNJ 3.60% 150 | $ 53.30|S 7,995|S 61.94 $ 2,380
16 Individual Stock KO | 2.80% 1$ 624618 9.369 1S F_ﬁ.ﬁi $ 132 | —
M 4 » ¥|| Investment Detail / Investment List .~ Benchmarks . Price Data /%3 4 u >

Use these arrows to navigate the
worksheet while building the
FV function.

The following steps explain how to add the formulas for the Current Purchase Value
and Current Investment Value columns:

3.1 Logical Functions

Click cell 14 on the Investment Detail worksheet.

Enter a formula that multiplies the Current Price in cell H4 by the
Shares Purchased in cell E4.

Copy the formula in cell 14 and paste it into the range 15:118 using the
Paste Formulas command.

Click cell K4 on the Investment Detail worksheet.

Enter a formula that adds the Current Purchase Value in cell 14 to the
Estimated Dividend Payments in cell J4.

Copy the formula in cell K4 and paste it into the range K5:K18 using the
Paste Formulas command.

Click cell K19 on the Investment Detail worksheet.

Enter a SUM function that adds the values in the range K4:K18.
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Figure 3.7 "Completed Current Value Section of the Investment Detail Worksheet"
shows the completed columns of the Current Value section in the Investment
Detail worksheet. The formula used to calculate the Current Investment Value
illustrates why we used the FV function to calculate the estimated dividend or
interest payments for an investment. Investments that earn interest or dividends
can achieve growth in two ways. The first way is through interest or dividend
payments. The second way is through changes in the price paid for the investment.
The formula used to calculate the Current Purchase Value is taking the number of
shares purchased for each investment and multiplying it by the current market
price. Therefore, the Current Investment Value takes into account any changes in
the investment price by adding the purchase value at the current market price to
any dividends or interest payments earned.

Figure 3.7 Completed Current Value Section of the Investment Detail Worksheet

K19 - £ | =sum(ka:is) <€ SUM function entered in cell K19.
A

B E F G H | J K L
1
, Descriptive Information Purchase Current Value
Purchase Current [Estimated [Current Current
Shares Price per Cost of Current Purchase Dividend Investment |Percent of
3 Investment Type Symbol Purchased |Share Purchase Price Value Payments |Value & _|Portfolio
4 Bond Fund VFICX 750|$ 949|S% 7.118[$ 984 |3 7380 1435|% 8815 —
5 Bond Fund VFSTX 750 [$ 1068 [S 8010[S 1073[S 80485 829|$ 8.877| ™Mefesitsinthiscoumn
6 Bond Fund VWEHX 500 |$ 6.29|$ 3145|3 582|3% 2910|$ 1046 |$ 3.956| ; pu?chasep,ice
7 Bond Fund VUSTX 500 |$ 11.00|$ 5500|$ 10.88|$ 5440 |$ 186 |$ 5626  andanydividendsor
& International Stock Fund [VDMIX 500 |$ 1468 |$ 7.340|S$ 1052 |$ 5260[S 698[S 5,958 interest paid.
9 Domestic Stock Fund  |VEIPX 500 |$ 23.35[$11675|9 2151|$ 10,755 |$ 547 |$ 11.302
10 Domestic Stock Fund  |VISGX 250 |$ 19.33|$ 4833[$ 2367 |3 5918 |9 40|$ 5958
11 Domestic Stock Fund  [VIMSX 250 |$ 2241|$ 5603[$ 2170 |3 5425|S 219|$ 5644
12 International Stock Fund |VTRIX 250 |$ 2283 |% 5708|% 3330|3 8325|$ 282|3 8607
13 International Stock Fund |VEIEX 250 |$ 23.74|% 5935|S 31808 79508 63|S 8013
14 Individual Stock TRV 150 |$ 38.14|$ 5721|9% 5554 |$ 8331|S 885|S 9216
15 Individual Stock JINJ 150 |$ 5330 |$ 7995|$ 6194 |$ 9291 |$ 2380 |$ 11,671
16 Individual Stock KO 150 |$ 6246 |$ 9369 |$ 6550 |$ 9825|$ 132|$ 9957
17 Individual Stock MSFT 75|% 2802|% 2102|$ 2785|% 2089|S 230|$ 2319
18 Individual Stock IBM 75|95 8768 |$ 6,576[$146.67 [S 11,000 |$ 937 |$ 11,938
19 Total 5,100 $ 96,628 $117,857

20 . . . .
M < » n| Portfolio Summary | Investment Detail / Investment List ~ Benchmarks . Price Dati|4 w

Table 3.4 "Definitions for Columns L through R of the Investment Detail Worksheet"
provides definitions for the Percent of Portfolio section of the Investment Detail
worksheet (Columns L through R).

Table 3.4 Definitions for Columns L through R of the Investment Detail Worksheet

Category Definition
Current
Percent | The current investment value divided by the total current value of the
of investment portfolio.
Portfolio
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3.1 Logical Functions

Target

Percent | The planned percentage each investment is intended to have for the entire

of portfolio.

Portfolio

Current | The difference between the Current Percent of Portfolio column and the

vs. Target | Target Percent of Portfolio column.

Shows which investments do not match the target percentage of the portfolio.
For example, as one investment increases in value due to an increase in
market price, it will comprise a greater percentage of the portfolio. This may

Rebalance ) ) . :

Indicator | FeUIre that some sh?res of this :flss.et be sold and 1nvesjced in other areas th.at
may have decreased in value. This is known as rebalancing the portfolio, and it
helps you sell investments when prices are high and buy investments when
prices are low.

Buy/Sell | Based on the results of the Rebalance Indicator, a logical function is used to

Indicator | indicate whether an investment should be purchased or sold.

Months Shows how many months an investment is owned. The length of ownership is
expressed in terms of months since dividend payments on stock funds and

Owned . s
interest payments on bond funds are distributed monthly.

Shows whether an investment has been owned long enough to qualify as a

Long/ long-term investment, which is greater than twelve months. The amount of

Short taxes paid on the amount of money gained for a short-term investment is

Indicator | greater than a long-term investment. Therefore, there is a tax incentive to
hold investments for more than twelve months.

The Percent of Portfolio section of the Investment Detail worksheet (Columns L
through R) requires two formulas and one function. The following steps explain
how we add them to the worksheet:

Click cell L4 in the Investment Detail worksheet.

Enter a formula that divides the Current Investment Value in cell K4 by
the total in cell K19.

Place an absolute reference on cell K19 in the formula by placing the
cursor in front of the column letter and pressing the F4 key on your
keyboard.

Copy the formula and paste it into the range L5:L18 using the Paste
Formulas command.

Click cell N4 in the Investment Detail worksheet.

Enter a formula that subtracts the Target Percent of Portfolio (cell M4)
from the Current Percent of Portfolio (cell L4): L4-M4.

Copy the formula and paste it into the range N5:N18 using the Paste
Formulas command.
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3.1 Logical Functions

8. Click cell Q19 in the Investment Detail worksheet.
9. Enter an AVERAGE function that calculates the average of the values in
the range Q4:Q18.

Figure 3.8 "Percent of Portfolio Section of the Investment Detail Worksheet" shows

the results of adding two formulas and a function to the Percent of Portfolio section
of the Investment Detail worksheet. Notice the absolute reference added to the cell
reference for K19 in the formula in the Current Percent of Portfolio column.

Figure 3.8
AVERAGE v X V fe| =K4/SkS19
A B K L M N (0] P Q R
1
> Descriptive Information Percent - colute reference is added |
Current Current Target to this cell.

Percent of Per(g:ent of W;&ﬁww onths |Long/Short  |Uni
3 Investment Type Symbol Value Portfolio Po[tfgllo/ Target i i Owned i Gai
4 |Bond Fund VFICX S 8,815 =K4/SK$19 -2.5% 48
5 Bond Fund VESTX |$ 8877 7.5% 10.0% -2.5% 37
6 Bond Fund VWEHX | $ 3,956 3.4% 10.0% -6.6% 48
7 Bond Fund VUSTX |$ 5,626 4.8% 10.0% -5.2% 10
8 International Stock Fund [VDMIX |$ 5,958 5.1% 7.0% -1.9% 42
9 Domestic Stock Fund VEIPX $ 11,302 9.6% 5.0% 4.6% 22
10 Domestic Stock Fund VISGX |$ 5958 5.1% 5.0% 0.1% 33
11 Domestic Stock Fund VIMSX |$ 5,644 4.8% 5.0% -0.2% 46
12 International Stock Fund |[VTRIX | $ 8,607 7.3% 7.0% 0.3% 29
13 International Stock Fund |[VEIEX |$ 8,013 6.8% 6.0% 0.8% 9
14 Individual Stock TRV $ 9216 7.8% 5.0% 2.8% 72
15 Individual Stock JNJ $ 11,671 9.9% 5.0% 4.9% 87
16 Individual Stock KO $ 9,957 8.4% 5.0% 3.4% 6
17 Individual Stock MSFT $ 2319 2.0% 5.0% -3.0% 50
18 Individual Stock IBM $ 11,938 10.1% 5.0% 5.1% 100

AVERAGE

19 Total $117,857 42.6 H function output.
‘Zn‘ » | Portfolio Summary | Investment Detail “Investment List ~Benchmarks _ Price Dati |4 L w ]

Table 3.5 "Definitions for Columns S through X of the Investment Detail Worksheet"

provides definitions for the columns in the Performance Analysis section of the
Investment Detail worksheet.

Table 3.5 Definitions for Columns S through X of the Investment Detail Worksheet

Category Definition
. The amount of money gained or lost on an investment. It is considered
Unrealized ) . .
. unrealized because the loss or gain does not actually occur until the
Gain/Loss . .
investment is sold.
Percent The percentage increase or decrease based on the unrealized gain/loss and
Gain/Loss the purchase value of an investment.
Target . .
Annual The expected annual growth rate for an investment. All investments are
expected to grow over time. The rate of growth depends on the amount of
Growth Rate
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Category Definition

risk taken. Investments that are a higher risk are expected to pay a higher
rate of return.

Actual . .. . . .

Annual The percentage gain/loss divided by the amount of time an investment is
owned expressed in terms of years.

Growth Rate

Target vs. .

Actual The difference between the actual annual growth rate and the target
annual growth rate.

Growth Rate &

Performance | A logical function will be used to indicate which investments are

Indicator underperforming with respect to the target vs. actual growth rate.

Most of the columns in the Performance Analysis section of the Investment Detail
worksheet will be completed with formulas and functions. The following steps
explain how we add them to the worksheet:

3.1 Logical Functions

1. Click cell S4 on the Investment Detail worksheet.
. Enter a formula that subtracts the value in the Cost of Purchase

column (cell G4) from the value in the Current Investment Value
column (cell K4): K4-G4.

. Copy the formula and paste it into the range S5:519 using the Paste

Formulas command. Note that this formula will be used to calculate the
output for the Total row in this column. The results of the formula are
showing how much money has been earned or lost for each
investment. It is important to note that these gains or losses do not
actually happen unless the investment is sold.

. Click cell T4 on the Investment Detail worksheet.
. Enter a formula that divides the Unrealized Gain/Loss (cell S4) by the

Cost of Purchase (cell G4): S4/G4.

. Copy the formula in cell T4 and paste it into the range T5:T19 using the

Paste Formulas command.

. Click cell V4 on the Investment Detail worksheet.
. Enter a formula that divides the Percent Gain/Loss (cell T4) by the

result of dividing the Months Owned (cell Q4) by 12: T4/(Q4/12).
Dividing the Months Owned value by 12 expresses the amount of time
an investment has been owned in terms of years. The benchmark
growth rates for most investments are expressed in terms of annual
return rates. Therefore, this formula must first express the amount of
time an investment has been owned in terms of years. Then the total
percentage gain or loss for each investment is divided by the length of
ownership in years to calculate the actual annual rate of return.
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3.1 Logical Functions

9. Copy the formula in cell V4 and paste it into the range V5:V19 using
the Paste Formulas command.
10. Click cell W4 on the Investment Detail worksheet.
11. Enter a formula that subtracts the Target Annual Growth Rate (cell U4)
from the Actual Annual Growth Rate (cell V4): V4-U4.
12. Copy the formula in cell W4 and paste it into the range W5:W18 using
the Paste Formulas command.

Figure 3.9 "Performance Analysis Section of the Investment Detail Worksheet"

shows the results of the formulas added to the Performance Analysis section of the
Investment Detail worksheet. This completes the required formulas and functions
necessary to add before moving on to the logical and lookup functions of the

chapter.

Figure 3.9 Performance Analysis Section of the Investment Detail Worksheet

[ AVERAGE v (5 X v f| =T4/(Q8/12)
A B Q R S| T U Vv \
The Months Owned is
1 V| dividinlgnby: ) o
, Descriptive Information Performance Analysis
v
Months |Long/Short |Unrealized |Percent Target Annual |Actual Annual | TarGet vs Actual|Performance
3 Investment Type Symbol Owned [Indicator Gain/Loss |Gain/Loss |Growth Rate |Growth Ratej Rate i
4 |Bond Fund VFICX 48 $ 1697 | 23.85%, 4.60%|=T4/(Q4/12) 1.36%
5 Bond Fund VESTX 37 $ 867 10.82% 3.20% 3.51% 0.31%
6 Bond Fund VWEHX 48 $ 811 25.79% 7.20% 6.45% -0.75%
7 Bond Fund VUSTX 10 $ 126 2.29% 4.00% 2.75% -1.25%
8 |International Stock Fund [VDMIX 42 $ (1.382)| -18.82% 8.00% -5.38% -13.38%
9 Domestic Stock Fund VEIPX 22 $ (373)] -3.20% 8.00% -1.74% -9.74%
10 Domestic Stock Fund VISGX 33 $ 1.125| 23.28% 10.00% 8.47% -1.53%
11 Domestic Stock Fund  [VIMSX 46 $ 41 0.74% 10.00% 0.19% -9.81%
12 International Stock Fund |VTRIX 29 $ 2900 | 50.81% 10.00% 21.02% 11.02%
13 International Stock Fund |VEIEX 9 $ 2078 35.01% 12.00% 46.67% 34.67%
14 Individual Stock TRV 72 $ 3495| 61.09% 8.00% 10.18% 2.18%
15 Individual Stock JNJ 87 $ 3,676 | 45.98% 8.00% 6.34% -1.66%
16 Individual Stock KO 6 $ 588 6.28% 8.00% 12.55% 4.55%
17 Individual Stock MSFT 50 $ 218 10.36% 10.00% 2.49% -7.51%
18 Individual Stock IBM 100 $ 5362 | 81.53% 10.00% 9.78% -0.22%
19 Total 426 $21,220 | 21.97% 6.19%) €| oamentannua
a0 i ' - - the portfolio.
4 4 » | Portfolio Summary | Investment Detail /~ Investment List Benchmarks _ Price Dati| 4 u

The Logical Test

Follow-along file: Continue with Excel Objective 3.00. (Use file Excel Objective 3.02 if
starting here.)

Lesson Video: The Logical Test

(click to see video)
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A key component for the logical functions that will be demonstrated in this section
is the logical test’. A logical test is used in logical functions to evaluate the
contents of a cell location. The results of the logical test can be either true or false.
For example, the logical test C7 = 25 (read as “if the value in cell C7 is equal to 25”)
can be either true or false depending on the value that is entered into cell C7. A
logical test can be constructed with a variety of comparison operators, as shown in
Table 3.6 "Comparison Operator Symbols and Definitions". These comparison
operators will be used in the logical test arguments for the logical functions
demonstrated in this chapter.

Table 3.6 Comparison Operator Symbols and Definitions

Symbol Definition

= Equal To

> Greater Than

> Less Than

<> Not Equal To

>= Greater Than or Equal To
<= Less Than or Equal To

A logical test will be used to evaluate the contents of a cell location in the
Investment Detail worksheet. We will first demonstrate how the logical test is used
to evaluate the contents of a cell location. Then we will use this logical test in the IF
function, which will be demonstrated next. The following steps explain how the
logical test is constructed:

1. Click cell R4 on the Investment Detail worksheet.

2. Type an equal sign (=).

3. Click cell Q4.

4. Type the greater than sign (>) followed by an equal sign (=).

3. An expression used to evaluate . . L .
the contents of a cell location. 5. Type the number 12. This completes the logical test, which is shown in
The logical test typically Figure 3.10 "Logical Test Entered into the Investment Detail
contains comparison operators Worksheet". The logical test would be stated as: “If the value in cell Q4

such as equal to (=), greater
than (>), less than (<), and so
on. The results of the logical
test can be either true or false.
An example of a logical test is
B8 >= 25, which is read as “if
the value in cell B8 is greater
than or equal to 25.”

is greater than or equal to 12.”
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Figure 3.10 Logical Test Entered into the Investment Detail Worksheet

E’” ™ R B cRt=-lE Excel Objective 3.00 - Microsoft Excel
Home Insert Page Layout Formulas Data Review View
& e AN S=o e B i
Paste Al B 7 U e A === $ - €. Conditic
/; = i — = - Formattit
Clipboard Font Alignment Number
INDEX - X v f | =Q4>=12
B 0 P Q R
1
, Descriptive Information nt of Portfolio
Rebalance Buy/Sell |Months |[Long/Short |Unre
3 Investment Type Symbol Indicator Indicator [Owned |Indicator Gain
4 Bond Fund VFICX 48]=Q4>=12 |$
5 Bond Fund VFSTX 37 A 3
6 Bond Fund VWEHX 48 3
7 Bond Fund VUSTX 10 s
8 International Stock Fund [VDMIX 42 Tlhis'PgiC_?';eS“T
9 Domestic Stock Fund __|VEIPX 22| Lo s amter
10 Domestic Stock Fund VISGX 33 than or equal to 12.
11 |Domestic Stock Fund VIMSX 46 IS

6. Press the ENTER key on your keyboard. Notice that the output of the
logical test is the word TRUE. This is because the value in cell Q4 is 48,
which is greater than 12 (see Figure 3.11 "Output of the Logical Test").

7. Copy the logical test in cell R4 and paste it into the range R5:R18 using

the Paste Formulas command.

Figure 3.11 "Output of the Logical Test" shows the results of the logical test after it

is pasted into the range R5:R18. Notice that for any values that are less than 12 in

the range Q4:Q18, the logical test produces an output of FALSE.
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Figure 3.11
@’ =, R = |= Excel Objective 3.00
Home Insert Page Layout Formulas Data Review View
R4 - B | =Q4>=12
A B P Q R
1
5 Descriptive Information lio
Buy/Sell |Months (Long/Short

3 |Investment Type Symbol Indicator |Owned |Indicator

4 |Bond Fund VFICX 48| TRUE

5 Bond Fund VFSTX 37| TRUE

6 Bond Fund VWEHX 48| TRUE

7 Bond Fund VUSTX » 10| FALSE

8 International Stock Fund |[VDMIX 42| TRUE

9 Domestic Stock Fund VEIPX 22| TRUE

10 | Domestic Stock Fund  |VISGX 33] TRUE The output of the
11 |Domestic Stock Fund VIMSX 46| TRUE > logical test is either
12 |International Stock Fund |VTRIX 29| TRUE [ RYEerIFALSE J
13 International Stock Fund |VEIEX 9| FALSE

14 Individual Stock TRV 72| TRUE

15 Individual Stock The output of this 87| TRUE

16 |Individual Stock e~ 6] FALSE

17 Individual Stock less than 12. 50| TRUE

18 Individual Stock BV 100{ TRUE

19 Total 42.6

4 4 » || Investment Detail ~* Investment List .~ Benchmarks . Price Data /%3

IF Function

Follow-along file: Continue with Excel Objective 3.00. (Use file Excel Objective 3.03 if

starting here.)

Lesson Video: IF Function

(click to see video)

The IF function is used to produce a custom output based on the results of a logical
test. If the results of the logical test are TRUE, the IF function can display a specific
number or text, or perform a calculation. If the results of the logical test are FALSE,
the IF function can display a different number or text, or perform a different
calculation. The arguments of the IF function are defined in Table 3.7 "Arguments

for the IF Function".
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Table 3.7 Arguments for the IF Function

Logical_test

A test used to evaluate the contents of a cell location. This argument
typically utilizes comparison operators, which are defined in Table 3.6
"Comparison Operator Symbols and Definitions". The results of the test
can be either true or false. For example, the test C7>25 would be read as if
C7 is greater than 25. If the number 30 is entered into cell C7, the logical
test is true. If you are evaluating a cell that contains text data, the text

in the logical test must be placed inside quotation marks. For example, if
you wanted to test if the word Long is in cell C7, the logical test would be
C7 =“Long”.

[Value_if_true]

The output that will be displayed by the function or the calculation that
will be performed by the function if the results of the logical test are
true. This argument can be defined with a formula, function, number, or
text. However, when defining this argument with a text output such as
the word Long, it must be placed inside quotation marks (“Long”).

[Value_if_false]

The output that will be displayed by the function or the calculation that
will be performed by the function if the results of the logical test are
false. This argument can be defined with a formula, function, number, or
text. However, when defining this argument with a text output such as
the word Long, it must be placed inside quotation marks (“Long”).

We will use the IF function in the Percent of Portfolio section of the Investment
Detail worksheet. We will use the logical test that was previously demonstrated
within the IF function to determine if an investment has been held for a short or
long period of time. For tax purposes, an investment is considered short-term if it is
held less than twelve months. This requires the investor to pay a higher tax
percentage for any profit earned on the investment. An investment held twelve
months or longer is considered a long-term investment. The following explains how
the IF function is used to identify which investments are long term or short term:

1. Highlight the range R4:R18 on the Investment Detail worksheet and
press the DELETE key on your keyboard. This will remove the logical
test and allow us to replace it with an IF function.

R

Click cell R4 on the Investment Detail worksheet.
Click the Formulas tab on the Ribbon.
Click the Logical button in the Function Library group of commands.

Click the IF function from the list of functions (see Figure 3.12

"Selecting the IF Function from the Function Library"). This opens the
Function Arguments dialog box.
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Figure 3.12 Selecting the IF Function from the Function Library
- o8- Excel Objective 3.00 - Microsoft Excel

Click here to select from a
list of logical functions.

Home Insert Page Layout Formulas Data Review View
.fr @ @ ﬁ ’—/iA' - =H =5 Define Name ¥ i‘}l Trace Precedents @ Show Fori
E -] —tg

Insert | AutoSum Recently Financial | Logical ext Date & Lookup & Math&  More Name -
Function v Usedv v v v Time~ Reference~ Trigv Functions v Manager B Create from Selection | 7, Remo

a
£P use in Formula =3 Trace

Click here to open the argumen
dialog box for the IF function.

Defined

AND
R4 -

FALSE

F

IFERROR [k I
1 E—— IF(logical_test,value_if true,value_if false)
, Descriptive Informa "7 Checks whether a condition is met, and  fOFtfolio

| OR returns one value if TRUE, and another

TRUE AL RIS ce Buy/Sell |Months |[Long/Short |Unrealize
3 Investment Type e Press F1 for more help. r Indicator [Owned |Indicator Gain/Loss
4 Bond Fund o reentncion T T10.0%] -2.5% 48 $ 169
5 Bond Fund VESTX 10.0% -2.5% 37 $ 86
6 Bond Fund VWEHX 10.0% -6.6% 48 $ 81
7 Bond Fund VUSTX 10.0% -5.2% 10 $ 12
8 International Stock Fund [VDMIX 7.0% -1.9% 42 $ (1,38
9 Domestic Stock Fund VEIPX 5.0% 4.6% 22 $ (37
10 Domestic Stock Fund VISGX 5.0% 0.1% 33 $ 1,12
11 Domestic Stock Fund  |VIMSX 5.0% -0.2% 46 $ 4
19 lntarnatianal Cianls Cund N/TDIV 7 NoL n 20L LeTe] e N an

6. Click the Collapse Dialog button next to the Logical_test argument (see
Figure 3.13 "Logical Test Argument Defined").

7. Click cell Q4 and press the ENTER key on your keyboard.

8. Type the greater than sign (>) followed by an equal sign (=).

9. Type the number 12.

Figure 3.13 "Logical Test Argument Defined" shows the appearance of
the IF Function Arguments dialog box after defining the Logical_test
argument. Notice that next to the Logical_test input box, Excel shows
that the results of the test are true. This makes sense given that the
value in cell Q4 is 48, which is greater than 12.
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Figure 3.13 Logical_Test Argument Defined

X | - & |- Excel Objective 3.00.xIsx - Microsoft Exce
File! ‘ Home Insert Pagelayout = Formulas | Data  Review  View
X The results of the B Shom Formul
@ - “ = . s 24 Sho ormulas
j.\‘ 2 ‘\ 2) ?) A H\ ‘M €} ] logical test appear here. =
I8 i o = it & Err Checking
:l:wff Function Arguments ‘i“i‘_ Remove Arrows - &) Evaluate Formula
E Formula Auditing
Logical_test | Q4>=12 = TRUE
Value_if_true =
Value_if_false =] = any Click here to define the
1 B Value_if_true argument.
2 Checks whether a condition is met, and returns one value if TRUE, and another value if FALSE.
Logical_test is any value or expression that can be evaluated to TRUE or FALSE.
nths |Long/Short |Unrealized
B ned |Indicator Gain/Loss
& Formula result = 48 Q4>=12)A $ 1’69_’
5 37 Nls 86
6 || Help on this function oK Cancel 48 \[s 81
7 [olyfepaiilas T TR TU.U% -2.2% 10 $ 12¢
3 Inter] A definition of the argument | 7.0% -1.9% 42 $ (1,38:
o Dom{ being defined appears here. 5.0% 4.6% 22 v @
10 Domestic Stock Fund VISGX 5.0% 0.1% 33 § 112
11 Domestic Stock Fund VIMSX 5.0% -0.2% ( The function appears in the cell
i iea—me—a hreiw = Aas Y]

as it is being constructed.

10. Press the TAB key on your keyboard to advance to the next argument,
which is Value_if_true.

11. Type the word Long in quotation marks. If you forget to put words or
text in quotation marks using the Function Arguments dialog box,
Excel will insert the quotation marks for you.

12. Press the TAB key on your keyboard to advance to the next argument,
which is Value_if false.

13. Type the word Short in quotation marks.

14. Click the OK button on the Function Arguments dialog box to complete
the function.

15. Copy the IF function in cell R4 and paste it into the range R5:R18 using
the Paste Formulas command.

Integrity Check

Placing Text in Quotation Marks for Logical Functions

If you are using a logical function to evaluate text data in a cell location, or if
you are using a logical function to output text data, the text must be placed
inside quotation marks. For example, if you are using a logical function to
evaluate whether the word Long is entered into cell B5, the logical test must
appear as follows: B5= “Long”. If you omit the quotation marks, the function may
produce an erroneous false result for the test.

3.1 Logical Functions
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Figure 3.14 "Completed Function Arguments Dialog Box for the IF Function" shows
the completed Function Arguments dialog box for the IF function. Notice that the
results of the function are displayed in the dialog box. Since the value in cell Q4 is
greater than 12, the word Long will be displayed in cell R4.

Figure 3.14 Completed Function Arguments Dialog Box for the IF Function

\z” H 9 0 ‘ =4 Excel Objective 3.00.xIsx - Microsoft Excel
File: Home Insert Page Layout Formulas Data Review View
£ < = < D i3 Define Name
f T 8 8@ A8 A @ y !
—— eckin
Inse| Function Arguments ? H 23 ‘
Funct| L £9 Evaluate Forrr
o= Formula Auditing
Logical test |Q4>=12 = TRUE
Value_if true |"Long" = "Long" Q R S
Value_if_false |"Short" = "Short"
1 = "Long"
2 Checks whether a condition is met, and returns one value if TRUE, and another value if FALSE. I |
Value_if_false is the value that is returned if Logical_test is FALSE. If omitted, FALSE is returned. The results of the
function are shown here.
3 <
"o "
& Formula result = Long 48' 2 Short ) $ 1’
5 3 $
6 || Help on this function oK [ el [ 48]\ 3
7 Bond rFund VUSTX TU.U% -9.2% 10 \ $
8 |International Stock Fund |VDMIX 7.0% -1.9% / 42 \ $ (1
o Domestic Stock Fund __|VEIPX 5.0% 4.6%)/ 22 N\ s ¢

an NAamaantia Céanls Cund \vienv E n[

Click here to complete
the function.

The value in Q4 is
greater than 12.

Figure 3.15 "IF Function Output" shows the completed Long/Short Indicator column

on the Investment Detail worksheet. Notice the word Short is displayed for any
investment held less than twelve months.

Figure 3.15 II Function Output

R4 v £ | =IF(Q4>=12,"Long","Short")
A B M N o P Q R S

1
, Descriptive Information Percent of Portfolio

Target

Percent of |Current vs. y Long/Short |Unrealiz¢
3 Investment Type Symbol Portfolio Target i i Owned i Gain/Los
4 |Bond Fund VFICX 10.0% -2.5% 48|Long $ 1.6
5 Bond Fund VESTX 10.0% -2.5% 37|Long S 8
6 Bond Fund VWEHX 10.0% -6.6% 48|Long $ 8
7 Bond Fund VUSTX 10.0% -5.2% 10[Short $ 1
8 International Stock Fund |VDMIX 7.0% -1.9% 42|Long $ (1.3
9 Domestic Stock Fund VEIPX 5.0% 4.6% 22|Long $ 3
10 Domestic Stock Fund  |VISGX 5.0% 0.1% 33|Long $ 1.1 T';E'Ffu"Cfie"i;!’mdlud"g
11 Domestic Stock Fund _|VIMSX 50%| _ -0.2% 46[Long s B e o
12 International Stock Fund |VTRIX 7.0% 0.3% 29|Long $ column Q.
13 International Stock Fund [VEIEX 6.0% 0.8% 9|Short $ 20
14 Individual Stock TRV 5.0% 2.8% 72|Long $ 3.4
15 Individual Stock JNJ 5.0% 4.9% 87|Long $ 36
16 Individual Stock KO 5.0% 3.4% 6|Short $ &
17 Individual Stock MSFT 5.0% -3.0% 50|Long $ 2
18 Individual Stock IBM 5.0% 5.1% 100|Long $ 53¢
19 Total 42.6 $21,2
‘zn‘ » M| Portfolio Summary | Investment Detail / Investment List Benchmarks " Price Dati| 4
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Skill Refresher: IF and Nested IF Function

(click to see video)

1. Type an equal sign (=).

2. Type the function name IF followed by an open parenthesis (().

3. Define the logical_test argument to evaluate the contents of a cell
location such that the result of the test is either true or false.

4, Define the value_if_true argument, which will be the output of the
function if the results of the logical test are true.

5. Define the value_if_false argument, which will be the output of
the function if the results of the logical test are false. This
argument can also be defined by starting another IF function if you
are nesting IF functions.

6. Type a closing parenthesis ()). In the case of nested IF functions,
type a closing parenthesis for every IF function that was started.

7. Press the ENTER key on your keyboard.

The OR Function

Follow-along file: Continue with Excel Objective 3.00. (Use file Excel Objective 3.04 if
starting here.)

Lesson Video: OR Function

(click to see video)

The OR function is similar to the IF function in that it uses a logical test to evaluate
the contents of a cell location. However, the OR function allows you to define
several logical tests as opposed to just one. If one of the logical tests is true, the
output of the function will be the word TRUE. If all the logical tests are false, the
output of the function will be the word FALSE. This differs from the IF function
because the output of the function is only the word TRUE or the word FALSE. As a
result, the OR function is commonly used within the IF function to enable specific
outputs to be defined.
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We will use the OR function in the Performance Indicator column on the
Investment Detail worksheet. The purpose of this column is to identify any
investment where either the Unrealized Gain/Loss is less than zero or the Target vs.
Actual Growth Rate is less than -1%. We will use the function in the logical test of
an IF function so we can define a specific output based on the results of the OR
function. However, we will first demonstrate how the OR function works by itself,
which is outlined in the following steps:

10.

Click cell X4 on the Investment Detail worksheet.

Type an equal sign (=).

Type the function name OR followed by an open parenthesis (().
Click cell S4 on the Investment Detail worksheet.

Type the less than symbol (<) followed by a zero. This completes the
first logical test, which is evaluating if the value in cell S4 is less than
zero.

Type a comma. This advances the function to a second logical test.
Click cell W4 on the Investment Detail worksheet.

Type the less than symbol (<) followed by -1%. Be sure to include the
minus sign and percent symbol. This completes the second logical test,
which is evaluating if the value in cell W4 is less than -1%.

Type a closing parenthesis ()) and press the ENTER key on your
keyboard.

Copy the OR function in cell X4 and paste it into the range X5:X18
using the Paste Formulas command.

Figure 3.16 Completed OR Function by Itself

1

5 Descriptive Information Performance Analysis

OR -

X ¥ fe| =OR(S4<0,W4<-1%)
B S T U Vv W X Y

Two logical tests are
defined for the

OR function.

Unrealized |Percent Target Annual |Actual Annual |Target vs Actual|Performance
3 Investment Type Symbol Gain/Loss |Gain/Loss |Growth Rate |Growth Rate /th Rate i
4 |Bond Fund VFICX |$ 1697 23.85% 4.60% 5.96% 1.36%]=0R(S4<0,W4<-1%)
5 Bond Fund VFSTX |$ 867 | 10.82% 3.20% 3.51% 0.31%| FALSE
6 Bond Fund VWEHX |$ 811 | 25.79% 7.20% 6.45% -0.75%| FALSE
7 |Bond Fund VUSTX |$ 126 2.29% 4.00% 2.75% -1.25% TRUE
8 International Stock Fund |[VDMIX | $ (1.382)] -18.82% 8.00% -5.38% -13.38% TRUE
9 Domestic Stock Fund VEIPX |$ (373)] -3.20% 8.00% -1.74% -9.74% TRUE
10 Domestic Stock Fund VISGX |$ 1,125 23.28% 10.00% 8.47% -1.53% TRUE
11 Domestic Stock Fund VIMSX | $ 41 0.74% 10.00% 0.19% -9.81% TRUE
12 International Stock Fund [VTRIX |$ 2900 | 50.81% 10.00% 21.02% 11.02%| FALSE
13 International Stock Fund [VEIEX |$ 2,078 | 35.01% 12.00% 46.67% 34.67%| FALSE The output of the
14 Individual Stock TRV $ 3,495 61.09% 8.00% 10.18% 2.18% FALSE OR function is either the
15 | Individual Stock JNJ $ 3,676 45.98% 8.00% 6.34% -1.66% TRUE word TRUE or FALSE.
16 Individual Stock KO $ 588 6.28% 8.00% 12.55% 4.55% FALSE
17 Individual Stock MSFT $ 218 10.36% 10.00% 2.49% -7.51% TRUE
18 Individual Stock IBM $ 5,362 81.53% 10.00% 9.78% -0.22% FALSE
19 Total $21,229 21.97% 6.19%
\304 » [ Portfolio Summary | Investment Detail / Investment List ~ Benchmarks _/ Price Dati| 4 w
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Figure 3.16 "Completed OR Function by Itself" shows the construction and result of

the OR function by itself. Notice that the only output of the function is the word
TRUE or the word FALSE. If either the Unrealized Gain/Loss is less than zero or the
Target vs. Actual Growth Rate is less than -1%, the function shows the word TRUE.
However, these descriptions will not be helpful for the person using this worksheet.
Displaying the words OK or Warning would be far more helpful in identifying
investments that need to be evaluated. We can do this if we use the OR function in
the logical test argument of the IF function. The following steps explain how to
accomplish this:

Dk B

© x® N

10.
11.
12.
13.
14.

15.

16.

17.
18.

19.

Highlight the range X4:X18 on the Investment Detail worksheet and
press the DELETE key on your keyboard. We are going to start over by
creating an IF function.

Click cell X4 on the Investment Detail worksheet.

Type an equal sign (=).

Type the function name IF followed by an open parenthesis (().

Type the function name OR followed by an open parenthesis ((). The
OR function is being placed into the logical_test argument of this IF
function.

Click cell S4 on the Investment Detail worksheet.

Type the less than symbol (<) followed by a zero.

Type a comma. This advances the function to a second logical test.
Click cell W4 on the Investment Detail worksheet.

Type the less than symbol (<) followed by -1%.

Type a closing parenthesis ().

Type an equal sign (=).

Type the word TRUE. Do not put the word inside quotation marks.
Type a comma. This completes the logical_test argument of the IF
function. We can now go on to define the value_if_true and the
value_if_false arguments. This will allow us to specify what the output
of the function should be instead, using the OR function outputs of
either TRUE or FALSE.

Type the word Warning. Be sure to enclose the word in quotation
marks.

Type a comma. This will advance the function to the value_if_false
argument.

Type the word OK. Be sure to enclose the word in quotation marks.
Type a closing parenthesis ())and press the ENTER key on your
keyboard.

Copy the IF function in cell X4 and paste it into the range X5:X18 using
the Paste Formulas command.
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Figure 3.17 "OR Function in the Logical Test of the IF Function" shows the OR

function within the logical_test argument of the IF function. The logical test of the
IF function is now evaluating if the results of the OR function are true.

Figure 3.17 OR Function in the Logical Test of the IF Function

1

, Descriptive Information

OR -
A

XV £

B

S

=IF(OR($4<0,W4<-1%)=TRUE,"Warning","OK")

T

Performance Analysis

The OR function is used
in the logical test of

Unrealized |Percent Target Annual |Actual Annual |Target vs Actual|Performance the I function.
3 Investment Type Symbol Gain/Loss |Gain/Loss |Growth Rate |Growth Rate |Growth Rate Indicator
4 |Bond Fund VFICX |$ 1,697 23.85% 4.60% 5.96% 1.36%, =|IF(OR(S4<0,W4<-1%)=TRUE,
5 Bond Fund VFSTX |$ 867 10.82% 3.20% 3.51% 0.31%|"Warning","OK")
6 Bond Fund VWEHX | $ 811 25.79% 7.20% 6.45% -0.75%|0K
7 Bond Fund VUSTX |$ 126 2.29% 4.00% 2.75% -1.25%|Warning The word TRUE, which is 2
8 International Stock Fund [VDMIX | $ (1,382)] -18.82% 8.00% -5.38% -13.38%|Warning possimeompu;omeoa
9 Domestic Stock Fund VEIPX |$ (373) -3.20% 8.00% -1.74% -9.74%|Warning function, is not enclosed in
10 Domestic Stock Fund __|[VISGX | $ 1,125 23.28% 10.00% 8.47% -1.53%|Warning Quotes
11 Domestic Stock Fund VIMSX |$ 41 0.74% 10.00% 0.19% -9.81%|Warning
12 International Stock Fund |VTRIX $ 2,900 50.81% 10.00% 21.02% 11.02%|OK
13 International Stock Fund |[VEIEX | $ 2,078 35.01% 12.00% 46.67% 34.67%|0K
14 Individual Stock TRV $ 3.495| 61.09% 8.00% 10.18% 2.18%|0K
15 Individual Stock JNJ $ 3,676 | 45.98% 8.00% 6.34% -1.66%|Warning
16 Individual Stock KO $ 588 6.28% 8.00% 12.55% 4.55%|0K
17 Individual Stock MSFT $ 218 10.36% 10.00% 2.49% -7.51%|Warning
18 Individual Stock IBM $ 5,362 81.53% 10.00% 9.78% -0.22%|0K
19 Total $21,229 21.97% 6.19%
\3“4 » ¥ Portfolio Summary | Investment Detail / Investment List Benchmarks _/ Price Dati [ 4 u »

Skill Refresher: OR Function

(click to see video)

1. Type an equal sign (=).

2. Type the function name OR followed by an open parenthesis (().

3. Define the logical_test argument to evaluate the contents of a cell
location such that the result of the test is either true or false.

4. Define additional logical test arguments as needed. The output of
the function will be TRUE if any of the logical tests are true.

5. Type a closing parenthesis ().

6. Press the ENTER key on your keyboard.

The AND Function

Follow-along file: Continue with Excel Objective 3.00. (Use file Excel Objective 3.05 if
starting here.)
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Lesson Video: AND Function

(click to see video)

The AND function is almost identical to the OR function in that it is composed of
only logical tests and produces one of two possible outputs: TRUE or FALSE.
However, all logical tests defined for the AND function must be true in order to
produce a TRUE output. If one logical test is false, the function will produce a FALSE
output. We will use the AND function to complete the Buy/Sell Indicator column on
the Investment Detail worksheet. This column will show either the word Buy or the
words Hold or Sell based on the results of the logical test argument of an IF function.
We will use the AND function to define the logical test argument of the IF function.
The following steps explain how to accomplish this:

B wN e

10.
11.

Click cell P4 on the Investment Detail worksheet.

Type an equal sign (=).

Type the function name IF followed by an open parenthesis (().

Type the function name AND followed by an open parenthesis ((). The
AND function is being placed into the logical_test argument of this IF
function.

Click cell N4 and then type the less than symbol (<</b>).

Type a minus sign (-) followed by the number 1 and a percent symbol:
(-1%).

Type a comma. This advances the AND function to the second logical
test.

Click cell S4.

Type a greater than symbol (>) followed by an equal sign (=). These
symbols are used to evaluate if the value in a cell location is greater
than or equal to a target value.

Type a zero followed by a closing parenthesis ().

Type an equal sign (=) followed by the word TRUE. Do not enclose the
word in quotation marks.

Figure 3.18 "AND Function Placed in the Logical Test of an IF Function"
shows the appearance of the AND function that has been added to the
logical test of the IF function. The AND function will produce a true
output if the value in cell N4 is <-1% and the value in cell S4 is greater
than or equal to 0.
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12.

13.

14.
15.

16.

17.

18.

Figure 3.18 AND Function Placed in the Logical Test of an IF Function

AVERAGE v X V' fe| =IF(AND(N4<-1%,54>=0)=TRUE,"Buy",IF(AND(N4>1%,54>=0,Q4>=12)=TRUE,"sell","Hold"))

B N (o) P Q R S T

i
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4 |Bond Fund VFICX -2.5%|Rebalance =‘IF(AND(N4<-1%,S4>=0)=TRUE,”Buy".IF(AND(N4>1%,S4>=0,Q4>=1
5 Bond Fund VFSTX -2.5%|Rebalance |=TRUE,"Sell","Hold")) |
6 Bond Fund VWEHX | -6.6%|Rebalance l [s 811]2579% 20%
= Dand Cind \nieTv E n0.[DAkalanan [ I'e 1na | n noorl A nnor|

Type a comma. This advances the IF function to the value_if_true
argument.

Type the word Buy enclosed in quotation marks as shown in Figure
3.19 "Results of the AND Function in the Logical Test Argument of an IF
Function". If the Current vs. Target value is less than -1% and the
Unrealized Gain/Loss is greater than or equal to zero, the function will
show the word Buy. In other words, if the investment is less than the
desired percentage for the total portfolio and it is currently not losing
money, we will buy more of that investment so it is in line with the
target percentage of the portfolio.

Type a comma.

Type the words Hold or Sell enclosed in quotation marks as shown in
Figure 3.19 "Results of the AND Function in the Logical Test Argument
of an IF Function". For all other investments that are not designated
with a Buy indicator, the function will show the words Hold or Sell. This
indicates that an investment could either be held or sold.

Type a closing parenthesis ()) and press the ENTER key on your
keyboard.

Copy the IF function in cell P4 and paste it into the range P5:P18 using
the Paste Formulas command.

Increase the width of Column P to 12 points.

Figure 3.19 "Results of the AND Function in the Logical Test Arsument of an IF

Function" shows the results of the completed AND function within an IF function

after it is copied and pasted into the range P5:P18.
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Figure 3.19 Results of the AND Function in the Logical Test Argument of an IF Function

P4 - e | =IF(AND(N4<-1%,54>=0)=TRUE, "Buy","Hold or sell") < { AND function used within
the IF function
A B N (0] P Q R

1
, Descriptive Information Percent of Portfolio
Current vs. [Rebalance Buy/Sell Months |Long/Short
3 Investment Type Symbol Target Indicator Indicator Owned |Indicator
4 Bond Fund VFICX -2.5% Buy 48|Long
5 Bond Fund VFSTX -2.5% Buy 37|Long
6 Bond Fund VWEHX -6.6% Buy 48|Long
7 Bond Fund VUSTX -5.2% Buy 10[Short
8 International Stock Fund [VDMIX -1.9% Hold or Sell 42|Long
9 Domestic Stock Fund VEIPX 4.6% Hold or Sell 22|Long
10 Domestic Stock Fund VISGX 0.1% Hold or Sell 33|Long
11 Domestic Stock Fund VIMSX -0.2% Hold or Sell| >4461tony
12 International Stock Fund [VTRIX 0.3% Hold or Sell 29|Long
13 International Stock Fund |VEIEX 0.8% Hold or Sell 9[Short
14 Individual Stock TRV 2.8% Hold or Sell 72|Long
15 Individual Stock JNJ 4.9% Hold or Sell 87|Long | TheoutputoftheIF function is
16 Individual Stock KO 3.4% Hold or Sell BIShort | ™encron e ool teet
17 Individual Stock MSFT -3.0% Buy 50|Long argument.
18 Individual Stock IBM 5.1% Hold or Sell 100|Long
19 Total 42.6
%ﬂm Investment Detail / Investment List Benchmarks . Price Data /%3 4

Skill Refresher: AND Function

(click to see video)

1. Type an equal sign (=).

2. Type the function name AND followed by an open parenthesis (().

3. Define the logical_test argument to evaluate the contents of a cell
location such that the result of the test is either true or false.

4. Define additional logical test arguments as needed. The output of
the function will be TRUE if ALL of the logical tests are true.

5. Type a closing parenthesis ().

6. Press the ENTER key on your keyboard.

Nested IF Functions

Follow-along file: Continue with Excel Objective 3.00. (Use file Excel Objective 3.06 if
starting here.)
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4, Used when more than two tests
and two outputs are required
when using the IF function. A
nested IF function is when the
value_if_true or
value_if_false arguments of an
IF function are defined with
another IF function.

3.1 Logical Functions

Lesson Video: Nested IF Functions

(click to see video)

When constructing the IF function, the logical test can produce only two potential
outcomes when evaluating the data in a cell. In addition, the function can produce
only two possible outputs, which are defined in the value_if_true and
value_if_false arguments. However, there may be situations when you need to test
for several possible outcomes, which may require more than two possible outputs.
To accomplish this, you need to create a nested IF function®. A nested IF function is
when either the value_if_true or value_if_false arguments are defined with
another IF function.

For the Personal Investment workbook, a nested IF function is required to complete
the Rebalance Indicator column (Column O) on the Investment Detail worksheet
(see Figure 3.19 "Results of the AND Function in the Logical Test Argument of an IF
Function"). The purpose of this column is to indicate where the portfolio needs to
be rebalanced. Looking at the Current vs. Target column (Column N) shown in
Figure 3.19 "Results of the AND Function in the Logical Test Argument of an IF
Function", you can see that several investments have a significant negative number
where the investment value has fallen below the target percentage for the portfolio.
Other investments have a significant positive number where the investment has
exceeded the target percentage for the portfolio. For this portfolio, a number
greater than 1% or less than -1% will be considered significant. Therefore, we will
need to assess three possible outcomes when creating a logical test that evaluates
the values in Column N. The first test will be if the value is greater than 1%. The
second test will be if the value is less than -1%. The third test will be if both the first
test and the second test are false. This is why we need to construct a nested IF
function to produce the outputs in the Rebalance Indicator column. The following
steps explain how to accomplish this:

Click cell 04 on the Investment Detail worksheet.

Type an equal sign (=).

Type the function name IF followed by an open parenthesis (().

Click cell N4.

Type the greater than symbol (>) followed by the number 1%. It is
important to use the percent symbol (%) after the number 1. If you
omit the percent symbol, Excel will test if the value in cell N4 is greater
than 100%.

6. Type a comma.

A o S .
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Type the word Rebalance inside quotation marks. When using text
data to define any of the arguments for the IF function, the text must
be placed inside quotation marks.

8. Type a comma.
9. Start another IF function by typing the function name IF followed by
an open parenthesis (().

10. Click cell N4.

11. Type the less than symbol (<) followed by -1%.

12. Type a comma.

13. Type the word Rebalance inside quotation marks.

14. Type a comma.

15. Type the word OK inside quotation marks.

16. Type two closing parentheses ())). Since two IF functions were started,
there are two open parentheses in the function. As a result, we need to
add two closing parentheses; otherwise, Excel will produce an error
message stating that a closing parenthesis is missing.

17. Press the ENTER key on your keyboard.

18. Copy the nested IF function in cell 04 and paste it into the range
05:018 using the Paste Formulas command.

Integrity Check

Using Logical Functions to Evaluate Percentages

If you are using a logical function to evaluate percentages in a cell location, be
sure to use the percent symbol when defining the logical test. For example, if
you are testing cell location B5 to determine if the value is greater than 10%,
the logical test should appear as follows: B5>10%. If you omit the percent sign,
the logical test will evaluate cell B5 to see if the value is greater than 1000%.
This may erroneously force the function to produce the value_if false output.
You can also convert the percentage to a decimal in the logical test. For
example, in decimal form, the logical test can be constructed as follows: B5>.10.

Figure 3.20 "Completed Nested IF Function" shows how the completed nested IF
function should appear in cell 04 of the Investment Detail worksheet. In addition,
we see the results of the function after it was pasted into the range 05:018. Notice
that for any investment where the Current vs. Target value is between plus or
minus 1%, the word OK appears.
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Figure 3.20 Completed Nested IF Function

INDEX » X « fe | =IF(N4>1%,"Rebalance”,IF(N4<-1%,"Rebalance","OK"))
B L M N 0o P Q R S
1 Asecond IF function is
5 Descriptive Information Percent of Portfolio ( snedhere.
Current Target
Percent of |Percent of |Currentvs. |Rebalance Buy/Sell Months |Long/Short |Unrealized |P¢
3 Investment Type Symbol Portfolio Portfolio Target Indicator Indicator ned |Indicator Gain/Loss |G
4 |Bond Fund VFICX 7.5% 10.0% -2.5%)|=IF(N4>1%,"Rebalance",IF(N4<-1%,"Rebalance","OK"))
5 Bond Fund VFSTX 7.5% 10.0% -2.5%|R IF(logical_test, [value_if_true], [value_if false]) | $ 867
6 Bond Fund VWEHX 3.4% 10.0% -6.6%|Rébalance Buy 48[Cong $ 811
7 Bond Fund VUSTX 4.8% 10.0% -5.2%|Rebalance |Buy 10|Short $ 126
8 International Stock Fund |VDMIX 5.1% 7.0% -1.9%|Rebalance |Hold or Sell 42|Long $ (1.382)
9 Domestic Stock Fund VEIPX 9.6% 5.0% 4.6%|Rebalance |Hold or Sell 22|Long $ (373)
10 Domestic Stock Fund VISGX 5.1% 5.0% 0.1%|0OK Hold or Sell 33|Long $ 1,125
11 Domestic Stock Fund VIMSX 4.8% 5.0% -0.2%|0OK Hold or Sell 46|Long $ 41
12 International Stock Fund [VTRIX 7.3% 7.0% 0.3%|0K Hold or Sell 29|Long $ 2,900 (Nested IF
13 International Stock Fund |VEIEX 6.8% 6.0% 0.8%|0K Hold or Sell 9[Short $ 2,078 | function
14 Individual Stock TRV 7.8% 5.0% 2.8%|Rebalance |Hold or Sell 72|Long $ 3,495
15 Individual Stock JNJ 9.9% 5.0% 4.9%|Rebalance |Hold or Sell 87|Long $ 3,676
16 Individual Stock KO 8.4% 5.0% 3.4%|Rebalance |Hold or Sell 6[Short $ 588
17 Individual Stock MSFT 2.0% 5.0% -3.0%|Rebalance [Buy 50|Long $ 218
18 Individual Stock IBM 10.1% 5.0% 5.1%|Rebalance |Hold or Sell 100|Long $ 5,362
19 Total 42.6 $21,229
4« » ¥ || Investment Detail / Investment List ~ Benchmarks / Price Data /%3 4 (T

Why?
Use AND or OR functions within IF functions

The benefit of using the AND or OR functions within the IF function is that
doing so reduces the need to construct lengthy nested IF functions. It becomes
increasingly difficult to manage the accuracy of lengthy nested IF functions.
The AND and OR functions allow you to test for a variety of conditions in a cell
location, which can reduce the need to nest multiple IF functions. Examine the
nested if function in cell 04 on the Investment Detail worksheet. Can you
recreate this without nesting the IF function?

Basic Conditional Formats

Follow-along file: Continue with Excel Objective 3.00. (Use file Excel Objective 3.07 if

starting here.)

Lesson Video: Basic Conditional Formats

(click to see video)
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5. An Excel feature that applies
formatting commands to cell
locations based on the cell
contents. A basic conditional
formatting rule will utilize a
logical test to evaluate the
contents of a cell location. If
the results of the logical test
are true, Excel will apply the
designated formatting

commands to the cell location.
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A feature related to the skills used to create logical functions is conditional
formatting. Conditional formats® allow you to apply a variety of formatting
treatments based on the contents of a cell location. A logical test similar to the ones
used in the IF, AND, and OR functions is used to evaluate the contents of a cell and
apply a designated formatting treatment. For example, looking at Figure 3.20
"Completed Nested IF Function", you will notice that the Unrealized Gain/Loss
column is formatted using the accounting number format. Negative numbers are
enclosed in parentheses. However, to make these numbers stand out, we can use
conditional formatting to change the font color to red. We will do this for the
Unrealized Gain/Loss and Percent Gain/Loss columns. The following steps explain
how conditional formats are applied to the cell locations in these columns:

1. Highlight the range S4:T18 on the Investment Detail worksheet.
2. Click the Conditional Formatting button in the Styles group of
commands on the Home tab of the Ribbon.

3. Click the New Rule command from the list of options (see Figure 3.21
"Conditional Formatting Options List"). This will open the New
Formatting Rule dialog box.

Figure 3.21 Conditional Formatting Options List

@‘ ™ I R G}‘ - Excel Objective 3.00 - Microsoft Excel Conditional Formatting
= . button
File Home Insert Page Layout Formulas Data Review View
\ q =,
& [arial ez AT = e S ||custom - *:‘ ﬁlu A
B2 Ari A A == ¥ = u ) 4 =4 ax
Paste B I U~|i| & . === =EiE . . 9 4 | =0 .00 | Conditional |Formatas Cell 41
f = = A = = - = = ég $ o et Formatting ¥| Table v Styles v L:—l
—

Clipboard Font Alignment Number

s4 v Je | =K4-Ga
A B R S T
1

q—cc - = Preset condition
5 Descriptive Informat}‘n Py l:l Data Bars > H rm—

Long/Short |Unred Click here to setanew rule, gt/
3 Investment Type Symbol |Indicator Gain/| ortest, for formatting cell  yth E_, Color Scales »
locations.
4 BondFund / VFICX RN )

Long

J] Highlight Cells Rules » |
E=e S

U
Lﬂl_dl Top/Bottom Rules »

=TT

5 Bond Fund / VFSTX |Long S 867 10.82% ] §§|;¢°..Sm ,
6 VWEHX |Long $ 811| 25.79% ] -
7 [§ Clickheretoopenthe | JySTX |Short S 126| 2.29%| P:[E Newue

Format Cells dialog box. — r
8 |l d [VDMIX |Long $ (1,382)| -18.82% {[E) Clear Rules (N
9 Domestic Stock Fund VEIPX |Long $ (373) -3.20% {[H] Manage Rules... L
10 |Domestic Stock Fund VISGX |Long $ 1,125 23.28% 10.00%] 8.47%]|

4. At the top of the New Formatting Rule dialog box, you will find a list of
options under the Select a Rule Type heading. Click the second option
that states “Format only cells that contain.”

5. Inthe lower portions of the New Formatting Rule dialog box, you will
see several drop-down boxes under the heading Edit the Rule
Description. Make sure the first drop-down box is set to Cell Value.

6. Click the second drop-down box in the Edit the Rule Description
section of the New Formatting Rule dialog box and select the “less
than” option.

245



Chapter 3 Logical and Lookup Functions

10.
11.

Click in the input box, which is next to the drop-down box that was set
in the previous step, and type a zero. This completes the logical test of
the conditional format, which is going to evaluate if the value in any of
the cells in the range S4:T18 is less than zero.

Click the Format button, which is near the bottom of the New
Formatting Rule dialog box. This will open the Format Cells dialog box.
Click the drop-down box in the Color section of the Format Cells dialog
box and select the red square from the color palette (see Figure 3.22
"Format Cells Dialog Box").

Click the OK button at the bottom of the Format Cells dialog box.

Click the OK button at the bottom of the New Formatting Rule dialog
box. This completes the Conditional Formatting rule that will be
applied to cells in the range S4:T18.

Figure 3.22 "Format Cells Dialog Box" shows the Format Cells dialog box. This opens

when the Format button is clicked on the New Formatting Rule dialog box. Notice
the tabs running across the top of the dialog box. All formatting features in Excel
are grouped by category, which can be accessed by clicking the related tab on the
Format Cells dialog box. You will see some of the formatting commands in light
grey. This indicates that these commands cannot be used with the Conditional
Formatting feature. You can use the Format Cells dialog box to apply any
formatting features by clicking the Format Cells dialog button on the Home tab of
the Ribbon (see Figure 3.21 "Conditional Formatting Options List").

3.1 Logical Functions

246



Chapter 3 Logical and Lookup Functions

3.1 Logical Functions

Figure 3.22 Format Cells Dialog Box

~
All formatting commands in Excel ]

Commands in grey are not
available for use with the
Conditional Formatting feature.

F,C’"“at ol N\ . _can be accessed through these tabs.
1 Number | Font \ Border | Fill P
Font: '\ Font style: Size:
Hp Cambria (Headings) - Regular - 8 ‘ Nl
T Calibri (Body) Ttalic 9
85140em Bold 10
Ty Agency FB Bold Ttalic 11
I Aharoni 12
I Algerian Font tab s | |14
Underline: Color:
EI Automatic B
Effects -‘ Automatic
Strikethrough Theme Colors
Superscript O HEN HE
Subscript .
il Click here to
5 I I select a color.
For Conditional Formatting you can set Font Style, U [ I I I I I I
Standard Colors
L EEEEE
® Colors...

0K

| |

Cancel

Mouseless Commands

Open the Format Cells Dialog Box

« Hold down the CTRL key while pressing the SHIFT key and the
letter F key on your keyboard.

Figure 3.23 "New Formatting Rule Dialog Box" shows the final settings for the New

Formatting Rule dialog box. It is important to note that the “Format only cells that
contain” option was selected in the New Formatting Rule dialog box to set a basic
logical test that can be used to apply formatting commands automatically based on

the values in cell locations.
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Figure 3.23 New Formatting Rule Dialog Box

9 -c-&|

Excel Objective 3.00.xIsx - Microsoft Excel

Select this option to establish a

Home | Insert  Pagelayout  Formulas _ Data _ Review  View

basic logical test for applying

formatting commands based

* New Formatting Rule
]
L2 Select a Rule Type:
paste B A
J » Format all cells based on their values

on the values in cell locations.
T

Clipboard 1 » Format only cells that contain &

» Format only top or bottom ranked values

» Format only values that are above or below average
» Format only unique or duplicate values

» Use a formula to determine which cells to format

s4

Click here to select a
LL="| comparison operator.
S

1 Edit the Rule Description:
Descrip Format only cells with: _ _ (Values that go with the comparison
2 | | [cel valee [=] [fessthan N e 1 operator are typed here.
palized |Percent
3 Investme AaBbCcYyzz ‘ /Loss |Gain/Loss
4 Bond FU/ 1,697 23.85%
[ oy ] :
5 Bond p( : ‘ : , 867 | 10:82%
7 f ; f i = —
This drop-down box must Click here to open the The conditional format will be
be set to Cell Value when setting Format Cells dialog box. applied to the highlighted cells.

a conditional format based
on the value in a cell location.

Figure 3.24 "Conditional Format Applied to the Range S4:T18" shows the results of

the conditional formatting rule that was applied to the range S4:T18. Notice the
font color is automatically changed to red for negative numbers.

Figure 3.24 Conditional Format Applied to the Range S4:T18

s4 - fe | =K4-G4
A B Q R 5 T
i
> Descriptive Information F
Months |Long/Short |Unrealized |Percent Target
3 Investment Type Symbol Owned |Indicator Gain/Loss |Gain/Loss |Growtl
4 |Bond Fund VFICX 48|Long $ 1697 ] 23.85%
5 Bond Fund VFSTX 37|Long $ 867 10.82%
6 |Bond Fund VWEHX 48|Long $ 811 25.79%
7 |Bond Fund VUSTX 10|Short $ 126 2.29% The conditional format
8 International Stock Fund [VDMIX 42|Long $ (1,382)| -18.82% automatically changes the
9 Domestic Stock Fund VEIPX 22|Long $ (373)] -3.20% font color to red because
10 Domestic Stock Fund VISGX 33|Long $ 1,125 23.28% 1 these values are less than zero.
11 Domestic Stock Fund  [VIMSX 46|Long $ 41 0.74% 1
12 International Stock Fund [VTRIX 29|Long $ 2,900 50.81% 1
13 International Stock Fund |VEIEX 9|Short $ 2,078 | 35.01% 1
14 Individual Stock TRV 72|Long $ 3495| 61.09%
15 Individual Stock JNJ 87|Long $ 3,676 | 45.98%
16 Individual Stock KO 6|Short $ 588 6.28%
17 Individual Stock MSFT 50|Long $ 218 10.36% 1
18 Individual Stock IBM 100|Long $ 5362 | 81.53% 1
19 Total 42.6 $21,229 | 21.97%

20 p
4 4 » ¥ [ Portfolio Summary | Investment Detail / Investment List

"Benchmarks . Price Dat{| 4
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Skill Refresher: Conditional Formats (Cell Values)

(click to see video)

1. Click a cell or highlight a range of cells where the conditional
format will be applied.
Click the Home tab of the Ribbon.
Click the Conditional Formatting button.
Click the New Rule option from the drop-down list.
Click the “Format only cells that contain” rule type from the list at
the top of the New Formatting Rule dialog box.
6. Select the type of contents you are evaluating in the first drop-
down box near the bottom of the New Formatting Rule dialog box.
7. Select a comparison operator description in the second drop-down
box near the bottom of the New Formatting Rule dialog box.
8. Enter a value in the input box next to the comparison operator
box.
9. Click the Format button to set the format that will be applied to
the selected cell locations.
10. Click the OK button at the bottom of the New Formatting Rule
dialog box.

Qg b W DN
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KEY TAKEAWAYS

¢ The Freeze Panes command should be used to lock column and row
headings in place while scrolling through large worksheets.

+ The IF function is used to evaluate the contents of a cell location using a
logical test. Based on the results of the logical test, you designate a
custom output or calculation to be performed by the function.

« When using text, or nonnumeric data, to define any argument of the IF
function, it must be placed inside quotation marks.

* A nested IF function is used when more than one logical test and more
than two outputs are required for a project. Either the Value_if_true or
the Value_if_false arguments can be defined with an IF function.

« When using percentages in any logical test or formula, you must use the
percent symbol (%) or convert the percentage to a decimal. For example,
10% can also be expressed as .10.

« The OR function is used when many logical tests are required to evaluate
the contents of a cell location. The OR function will produce a TRUE
output if one of the logical tests is true.

« The AND function is used when many logical tests are required to
evaluate the contents of a cell location. The AND function will produce a
TRUE output if all of the logical tests are true.

+ To minimize the complexity of nested IF functions, the OR and AND
functions should be used when possible to define the logical_test
argument of the IF function.
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EXERCISES

1. Assume the value in cell B12 is 25. Any value greater than or
equal to 25 is OK, and any value below 25 is too low. Which of the
following IF functions will provide an accurate result?

=IF(B12>25,0K,TOO LOW)

=IF(B12>25, “TOO LOW”, “OK”)
=IF(B12=25 OR B12>25, “OK”, “TOO LOW”)
=IF(B12>=25, “OK”, “TOO LOW”)

o op

2. Assume the value in cell C4 is 5 and the value in D4 is 2. If the
value in C4 is greater than 10, or if the value in D4 is greater than
or equal to 2, the output should read OK. Otherwise, the output
should read LOW. Which of the following IF functions will
provide an accurate result?

=IF(C4>10 or D4>2 or D4=2, “OK”, “LOW”")
=IF(OR(C4>10,D4>2,=2)=TRUE, “OK”, “LOW”)
=IF(OR(D4>=2,C4>10)=TRUE, “OK”, “LOW”)
=IF(C4>10, D4>=2, “OK”, “LOW”)

g0 op

3. Assume the value in cell A2 is 0 and the value in B2 is 1%. If the
value in A2 is equal to 0 and the value in B2 is greater than 1%,
then the output of the function should be OK. Otherwise, the
output of the function should be REBAL. Which of the following
IF functions will provide an accurate result?

=IF(A2=0, “OK”,IF(B2>1%, “OK”, “REBAL”))
=IF(AND(A2=0,B2>1)=TRUE, “OK”, “REBAL”)
=IF(AND(A2=0,B2>.01)=TRUE, “OK”, “REBAL”)
Both a and c are correct.

o op

4, Assume the value in cell E3 is 5. If the value in cell E3 is less than
0, the font color of the text should be red. If the value in cell E3 is
greater than or equal to 0, the font color should remain black.
When establishing a conditional format for cell E3, which rule
type should be selected in the New Formatting Rule dialog box?

a. Format all cells based on their values
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b. Format only cells that contain
c. Format only top or bottom ranked values
d. Use a formula to determine which cells to format
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3.2 Statistical IF Functions

LEARNING OBJECTIVES

1. Use the COUNTIF function to count selected nonblank cells in a range
based on one criteria argument.

2. Use the AVERAGEIF function to calculate the average of selected cells in
a range based on the values in an alternate range of cells and one
criteria argument.

3. Use the SUMIF function to calculate the sum of selected cells in a range
based on the values in an alternate range of cells and one criteria
argument.

4. Use the COUNTIFS function to count selected nonblank cells in a range
based on more than one criteria argument that utilizes a logical test.

5. Use the AVERAGEIFS function to calculate the average of selected cells
in a range based on the values in an alternate range of cells using more
than one criteria argument that utilizes a logical test.

6. Use the SUMIFS function to calculate the sum of selected cells in a range
based on the values in an alternate range of cells using more than one
criteria argument that utilizes a logical test.

This section will demonstrate the use of statistical IF functions. Statistical IF
functions® provide you with the ability to evaluate the contents in a cell location
before including them in a mathematical calculation. This allows you to selectively
include targeted cell locations when executing statistical calculations such as sum,
average, count, and so on. We will use several statistical IF functions to construct
the Portfolio Summary worksheet shown in Figure 3.1 "Completed Personal
Investment Portfolio Workbook", which contains two main sections. The Total
Summary section (Rows 2 through 8) shows an overview for all investments in the
portfolio by investment type. This will allow us to compare the growth performance
among the Bond Funds, Domestic Stock Funds, and others. The Poor Performing
Investments section (Rows 9 through 15) will provide an overview of poor
performing investments by investment type. For the purposes of this exercise, we
will define a poor performing investment as one where the growth rate is below the
6. Statistical functions that target growth rate by more than 1% (see Column W on the Investment Detail
provide the ability to evaluate | worksheet). The statistical IF functions will allow us to establish criteria to select
;tioiznifgiﬁg i(f[eilrllfcatlon targeted investments that can be included in the calculations for each section of the
mathematical calculation. Cell Portfolio Summary worksheet.
locations can be selected from

a range based on specific
criteria or a logical test.
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The COUNTIF Function

Follow-along file: Continue with Excel Objective 3.00. (Use file Excel Objective 3.08 if
starting here.)

Lesson Video: COUNTIF Function

(click to see video)

The COUNTIF function differs from the regular COUNT function in two ways. First,
the regular COUNT function counts only the number of cells in a range that contain
numeric data. The COUNTIF function counts the number of cells in a range that
contain numeric or text data. Second, the COUNTIF function allows you to
selectively count the cells in a range based on specific criteria.

The COUNTIF function contains two arguments: range and criteria. The range
argument is defined with the range of cells that will be counted. The criteria
argument is defined with the criteria that will be used to decide if a cell in the range
should be included in the output of the function. The following steps explain how
we can use the COUNTIF function to calculate the number of investments by
investment type on the Portfolio Summary worksheet:

1. Click cell B4 on the Portfolio Summary worksheet.

2. Click the Formulas tab of the Ribbon.

3. Click the More Functions button in the Function Library group of
commands.

4. Place the mouse pointer over the Statistical option from the drop-
down list.

5. Click the scroll down arrow on the second drop-down list to find the
COUNTIF function (see Figure 3.25 "Selecting the COUNTIF Function
from the Function Library").

6. Click the COUNTIF function. This will open the Function Arguments
dialog box.
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3.2 Statistical IF Functions

10.

11.

12.

Figure 3.25 Selecting the COUNTIF Function from the Function Library

tz” -~ ﬂ & Excel Objective 3.00 - Microsoft Excel
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Click the Collapse Dialog button next to the Range argument on the
Function Arguments dialog box (see Figure 3.26 "Completed Function
Arguments Dialog Box for the COUNTIF Function").

Click the Investment Detail worksheet tab.

Highlight the range A4:A18 on the Investment Detail worksheet and
press the ENTER key on your keyboard.

Click in the Range argument input box and place an absolute reference
on the range A4:A18. This is done by typing a dollar sign ($) in front of
the column letter and row number for both cells in the range.
Alternatively, place the insertion point after the 4 in cell reference A4
and press the F4 key on your keyboard. Then place the insertion point
after the 8 in cell reference A18 and press the F4 key. This will add the
$ to the appropriate positions automatically.

Press the TAB key on your keyboard to advance to the next argument,
which is the Criteria argument. Then type the cell location A4. The
criteria for the function will be the investment type entered into cell
A4 on the Portfolio Summary worksheet.

Click the OK button at the bottom of the Function Arguments dialog
box. Figure 3.26 "Completed Function Arguments Dialog Box for the
COUNTIF Function" shows the completed Function Arguments dialog
box for the COUNTIF function. Notice the absolute references that were
placed on each cell location in the range that was used to define the
Range argument. The Criteria argument is defined with the cell A4,
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which means the function will only count cell locations in the range
A4:A18 where the contents in the cell match the contents in cell A4.

Figure 3.26 Completed Function Arguments Dialog Box for the COUNTIF Function

Function Arguments Absolute References are placed

COUNTIF '_/\_l on each cell location in this range

Range | 'Investment Detail"!$A%4:5A$18 = {"Bond Fund";"Bond Fund";"Bond Fund";"Bon

Criteria | A4

Collapse Dialog button

Counts the number of cells within a range that meet the given condition. for the Range argument

Criteria is the condition in the form of a number, expression, or text that defines which cells
will be counted.

Formula result = 4

Help on this function oK N ] i Cancel

13. Copy the function in cell B4 and paste it into the range B5:B7 using the
Paste Formulas command.

14. Enter a SUM function in cell B8 that sums the values in the range
B4:B7.

Figure 3.27 "COUNTIF Function Output in the Portfolio Summary Worksheet" shows
the results of the COUNTIF function after it is pasted into the range B5:B7. Because
of relative referencing, the cell location used in the criteria argument is changed
after the function is pasted into the range B5:B7. For example, in cell B6, the
function is counting the cell locations in the range A4:A18 where the contents
match the contents of cell A6. This allows you to use the function to count the
number of investments per investment type. As shown in the figure, the range
B4:B7 now shows the number of investments in this portfolio by investment type.
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Figure 3.27
B6 - Je | =COUNTIF('Investment Detail'|SAS4:5A518,A6)
A B C D E
+ /Cell location in the Criteria
L Personal Investment Sum argument changes from
relative referencing.
2 Total Summary
Average |Total
Number of |[Months (Purchase |Current
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8 TOTAL 15| «¢ lrSUMfunctionadded here]
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Average |Total
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Skill Refresher: COUNTIF Function

(click to see video)

Type an equal sign (=).
Type the function name COUNTIF followed by an open parenthesis

(0.

3. Define the range argument with a range of cells that will be

counted.

4. Type a comma.
5. Define the criteria argument with a cell location, number, text, or
logical test. Text and logical tests must be enclosed in quotation

marks.

6. Type a closing parenthesis ().
7. Press the ENTER key on your keyboard.
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The AVERAGEIF Function

Follow-along file: Continue with Excel Objective 3.00. (Use file Excel Objective 3.09 if
starting here.)

Lesson Video: AVERAGEIF Function

(click to see video)

The AVERAGEIF function performs the identical mathematical calculation as the
regular AVERAGE function. However, similar to the COUNTIF function, it allows you
to define criteria that will select cells in a range that will be used in the function
output. The AVERAGEIF function differs from the COUNTIF function in that it allows
you to define two cell ranges instead of one. The first range pertains to the criteria
that will be used to select cells for the function output. The second range contains
the values that will be used to calculate the arithmetic mean. Table 3.8 "Arguments
for the AVERAGEIF and SUMIF Functions" provides definitions for the arguments
contained in the AVERAGEIF and SUMIF functions.

Table 3.8 Arguments for the AVERAGEIF and SUMIF Functions

Range Range of cells that will be evaluated by the criteria argument.

Criteria that will be used to evaluate the range of cells that is used to
define the Range argument. This argument can be defined with a cell
location, formula, number, text, or logical test. Note that text and
logical tests must be enclosed in quotation marks.

Criteria

Range of cells that will be used to calculate the average when using the
AVERAGEIF function, or the sum when using the SUMIF function. This
argument is enclosed in brackets because it does not always need to be
defined. If this argument is omitted, the function will use the range of
cells in the Range argument to calculate the output.

[Average_range]
or [Sum_range]

The AVERAGEIF function will be used in the Portfolio Summary worksheet to
calculate the average length of time that investments for each investment type are
held. The following steps explain how to add this function to the worksheet:

1. Click cell C4 on the Portfolio Summary worksheet.
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2. Click the Formulas tab on the Ribbon.

10.

11.

12.

13.

14.

15.

Click the More Functions button in the Function Library group of
commands.

Place the mouse pointer over the Statistical option from the drop-
down list (see Figure 3.25 "Selecting the COUNTIF Function from the
Function Library").

Click the AVERAGEIF function, which will be near the top of the list of
functions. This opens the Function Arguments dialog box.

Click the Collapse Dialog button next to the Range argument on the
Function Arguments dialog box (see Figure 3.28 "Defined Arguments
for the AVERAGEIF Function").

Click the Investment Detail worksheet tab.

Highlight the range A4:A18 on the Investment Detail worksheet and
press the ENTER key on your keyboard.

Click in the Range argument input box and place an absolute reference
on the range A4:A18. This is done by typing a dollar sign ($) in front of
the column letter and row number for both cells in the range.

Press the TAB key on your keyboard to advance to the Criteria
argument and type the cell location A4. The criteria for the function
will be the investment type entered into cell A4 on the Portfolio
Summary worksheet.

Click the Collapse Dialog button next to the Average_range argument
on the Function Arguments dialog box (see Figure 3.28 "Defined
Arguments for the AVERAGEIF Function").

Click the Investment Detail worksheet tab.

Highlight the range Q4:Q18 on the Investment Detail worksheet and
press the ENTER key on your keyboard.

Click in the Average_range argument input box and place an absolute
reference on the range Q4:Q18. This is done by typing a dollar sign ($)
in front of the column letter and row number for both cells in the
range.

Click the OK button at the bottom of the Function Arguments dialog
box.

Figure 3.28 "Defined Arguments for the AVERAGEIF Function" shows
the Function Arguments dialog box for the AVERAGEIF function that
will be input into cell C4. Notice that absolute references are placed on
the cell locations used to define the Range and Average_range
arguments. The function will evaluate the cells in the range A4:A18
using the value that exists in cell A4 on the Portfolio Summary
worksheet. When a cell in the range A4:A18 meets the criteria, the
function will pull the cell location in the same row from the range
Q4:Q18 and include it in the average calculation.

259



Chapter 3 Logical and Lookup Functions

16.

17.
18.

Figure 3.28 Defined Arguments for the AVERAGEIF Function

Function Arguments \I”Fﬂ
AVERAGEIF { Absolute references have
Range | 'Investment Detail!$A$4:5A518 £%| = {"Bond Fund";"Bond Fund";"Bond Fund";"B.L been added to these
Criteria | A4 - "Bond Fund" ranges.
Average_range | 'Investment Detail{$Q$4:$Q$18 = {48;37;48;10;42;22;33;46;29;9;72;87;6;50;

=33.79

Finds average(arithmetic mean) for the cells specified by a given condition or criteria.
Range is the range of cells you want evaluate: Definition for the
Average_range argument

Help on this function [ oK k" [ Cancel l

Formula result = 36

Copy the function in cell C4 and paste it into the range C5:C7 using the
Paste Formulas option.

Type an equal sign (=) in cell C8.

Click the Investment Detail worksheet tab. Then click cell Q19 and
press the ENTER key on your keyboard.

Figure 3.29 "AVERAGEIF Function Output on the Portfolio Summary Worksheet"
shows the output of the AVERAGEIF function in the Average Months Owned column

on the Portfolio Summary worksheet. The function calculates the average months
owned in Column Q on the Investment Detail worksheet where the investment
type is equal to the description entered in the range A4:A7 on the Portfolio
Summary worksheet.

Figure 3.29 AVERAGEIF Function Output on the Portfolio Summary Worksheet
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Integrity Check

Matching Row Numbers for the Range and Average_range (or Sum_range)
Arguments

When defining the Average_range argument for the AVERAGEIF function or
the Sum_range argument for the SUMIF function, it is good practice to make
sure the row numbers match the row numbers used in the Range argument.
For example, if the Range argument is defined with the range A4:A12, the range
used to define the Average_range or Sum_range argument should begin with
Row 4 and end with Row 12. If the row numbers in these two arguments do not
match, Excel will include the values only in the rows used to define the Range
argument. For example, if the Range argument is defined with the range
A4:A12 and the Average_range (or Sum_range) argument is defined with the
range D4:D20, only the values in cells D4:D12 will be included in the function
output.

Skill Refresher: AVERAGEIF Function

(click to see video)

1. Type an equal sign (=).

2. Type the function name AVERAGEIF followed by an open
parenthesis (().

3. Define the range argument with a range of cells that will be
evaluated using the criteria argument.

4. Type a comma.

5. Define the criteria argument with a cell location, number, text, or
logical test. Text and logical tests must be enclosed in quotation
marks.

6. Type a comma.

7. Define the Average_range argument with a range that contains
values to be averaged. Excel will use the range argument to
calculate the average if this argument is omitted.

8. Type a closing parenthesis ().

9. Press the ENTER key on your keyboard.
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The SUMIF Function

Follow-along file: Continue with Excel Objective 3.00. (Use file Excel Objective 3.10 if
starting here.)

Lesson Video: SUMIF Function

(click to see video)

The SUMIF function performs the same mathematical calculation as the regular
SUM function. However, similar to the AVERAGEIF function, this function allows
you to select specific cells from a range that will be used in the output. The
arguments for the SUMIF function are identical to the AVERAGEIF function (see
Table 3.8 "Arguments for the AVERAGEIF and SUMIF Functions"). We will use the
SUMIF function in two columns on the Portfolio Summary worksheet. The first
column will show the total investment cost for each investment type. The second
column will show the total current value for each investment type. This will allow
us to calculate the total annual growth rate for each investment type. The following
steps explain how we will use this function to complete the first column:

1. Click cell D4 on the Portfolio Summary worksheet.

2. Click the Formulas tab on the Ribbon.

3. Click the Math & Trig button in the Function Library group of
commands (see Figure 3.25 "Selecting the COUNTIF Function from the
Function Library").

4. Select the SUMIF function from the drop-down list. Use the scroll bar
to scroll down to find the SUMIF function.

5. Click the Collapse Dialog button next to the Range argument on the
Function Arguments dialog box (see Figure 3.30 "Defined Arguments
for the First SUMIF Function on the Portfolio Summary Worksheet").

6. Click the Investment Detail worksheet tab.

7. Highlight the range A4:A18 on the Investment Detail worksheet and
press the ENTER key on your keyboard.

8. Click in the Range argument input box and place an absolute reference
on the range A4:A18. This is done by typing a dollar sign ($) in front of
the column letter and row number for both cells in the range.

9. Press the TAB key on your keyboard to advance to the Criteria
argument and type the cell location A4. The criteria for the function
will be the investment type entered into cell A4 on the Portfolio
Summary worksheet.

262


http://www.gone.2012books.lardbucket.org/sites/all/files/ManzoExcel_1.0_Excel_Objective_3.10.xlsx
http://www.youtube.com/v/rmv-SRMj-h0?rel=0

Chapter 3 Logical and Lookup Functions

3.2 Statistical IF Functions

10.

11.
12.

13.

14.

15.

16.

Click the Collapse Dialog button next to the Sum_range argument on
the Function Arguments dialog box (see Figure 3.30 "Defined

Arguments for the First SUMIF Function on the Portfolio Summary
Worksheet").

Figure 3.30 Defined Arguments for the First SUMIF Function on the Portfolio Summary
Worksheet

Function Arguments (2 =]
SUMIF
Range |'nvestment Detaill$A$4:$A518 = {"Bond Fund";"Bond Fund";"Bond Fund";8an
L ==l The row numbers used ir
Criteria | A4 = 4 5
4—M both ranges are identica
Sum_range |'Investment Detail1$G$4:$G$18 B8] = (7117.5;8010;3145;5500;7340;11675;

= 237725
Adds the cells specified by a given condition or criteria.

Sum_range are the actual cells to glim. If omitted, the cells in range are used.

Formula result =  § 23,773

Help on this function OK I}I l Cancel

Sum-range Collapse
Dialog button

Click the Investment Detail worksheet tab.

Highlight the range G4:G18 on the Investment Detail worksheet and
press the ENTER key on your keyboard.

Click in the Sum_range argument input box and place an absolute
reference on the range G4:G18. This is done by typing a dollar sign ($)
in front of the column letter and row number for both cells in the
range.

Click the OK button at the bottom of the Function Arguments dialog
box.

Copy the function in cell D4 and paste it into the range D5:D7 using the
Paste Formulas option.

Enter a regular SUM function into cell D8 on the Portfolio Summary
worksheet to calculate the sum of the values in the range D4:D7.

Figure 3.30 "Defined Arguments for the First SUMIF Function on the Portfolio

Summary Worksheet" shows how the SUMIF arguments were defined for the Total
Purchase Cost column on the Portfolio Summary worksheet. Notice that the row
numbers are identical in the range used to define the Range argument and the
Sum_range argument.

The following steps explain how to add the SUMIF function to the second column on
the Portfolio Summary worksheet:

1.

Click cell E4 on the Portfolio Summary worksheet.
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2. Click the Formulas tab on the Ribbon.

Click the Math & Trig button in the Function Library group of
commands (see Figure 3.25 "Selecting the COUNTIF Function from the
Function Library").

Select the SUMIF function from the drop-down list. Use the scroll bar
to scroll down to find the SUMIF function.

Click the Collapse Dialog button next to the Range argument on the
Function Arguments dialog box (see Figure 3.30 "Defined Arguments

for the First SUMIF Function on the Portfolio Summary Worksheet").

6. Click the Investment Detail worksheet tab.

10.

11.
12.

13.

14.

15.

16.

Highlight the range A4:A18 on the Investment Detail worksheet and
press the ENTER key on your keyboard.

Click in the Range argument input box and place an absolute reference
on the range A4:A18. This is done by typing a dollar sign ($) in front of
the column letter and row number for both cells in the range.

Press the TAB key on your keyboard to advance to the Criteria
argument and type the cell location A4.

Click the Collapse Dialog button next to the Sum_range argument on
the Function Arguments dialog box (see Figure 3.30 "Defined
Arguments for the First SUMIF Function on the Portfolio Summary
Worksheet").

Click the Investment Detail worksheet tab.

Highlight the range K4:K18 on the Investment Detail worksheet and
press the ENTER key on your keyboard.

Click in the Sum_range argument input box and place an absolute
reference on the range K4:K18. This is done by typing a dollar sign ($)
in front of the column letter and row number for both cells in the
range.

Click the OK button at the bottom of the Function Arguments dialog
box.

Copy the function in cell E4 and paste it into the range E5:E7 using the
Paste Formulas option.

Enter a regular SUM function into cell E8 on the Portfolio Summary
worksheet to calculate the sum of the values in the range E4:E7.

Figure 3.31 "SUMIF Function Outputs in the Portfolio Summary Worksheet" shows
the results of the SUMIF function in the Total Purchase Cost and Current Value

columns in the Portfolio Summary worksheet.

3.2 Statistical IF Functions
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Figure 3.31 SUMIF Function Outputs in the Portfolio Summary Worksheet

E4

v J | =SUMIF('Investment Detail'!|SAS4:5AS$18,A4, Investment Detail'|SK$4:5K$18) ¢
A B C D E F
Personal Investment Summary The SUMIF function in
cell E4 appears here.

2 Total Summary

Average |Total
Number of |Months |Purchase |[Current Annual |Benc
Investments |Owned |[Cost Value Growth |Year

3

4 ‘Bond Fund 4 36|$ 23,773 |$ 27,274
5 Domestic Stock Fund 3 34| 22,110 | $ 22,903
6 International Stock Fund 3 27|$ 18,983 | $ 22,578
7 Individual Stock 5 63| $ 31,763 | $ 45,101
8 TOTAL 15 43| $ 96,628 | $117,857

9 Poor Performing Investments t t The current value of the
Average Total portfolio exceeds the cost.
Number of Months Purchase Current Annual

A formula can now be added to show the annual growth for each investment
category. The following steps explain how to add this formula to the Portfolio
Summary worksheet:

A o e

10.

11.

Click cell F4 on the Portfolio Summary worksheet.

Type an equal sign (=) followed by two open parenthesis ((().

Click cell E4 and type a minus sign (-).

Click cell D4 and type a closing parenthesis ()).

Type a slash (/) for division and click cell D4.

Type a closing parenthesis ()). This completes the first part of the
formula, which is calculating the growth rate between the Total
Purchase Cost (cell D4) and the Current Value (cell E4).

Type a slash (/) for division followed by an open parenthesis (().

Click cell C4, which is the Average Months Owned.

Type a slash (/) for division and the number 12. This part of the
formula converts the number of months owned to years by dividing it
by 12. This result is being divided into the growth rate, which will then
show the average growth per year.

Type a closing parenthesis ()) and press the ENTER key on your
keyboard.

Copy the formula in cell F4 and paste it into the range F5:F8 using the
Paste Formulas command.

Figure 3.32 "Completed Annual Growth Column in the Portfolio Summary
Worksheet" shows the results of the statistical IF functions that were added to the
Total Summary section of the Portfolio Summary worksheet. The statistical IF
functions used on this worksheet allowed us to group the details in the Investment
Detail worksheet by investment type. Once this was accomplished, we added a

formula to show the annual growth rate by investment type.
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Figure 3.32 Completed Annual Growth Column in the Portfolio Summary Worksheet
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4 Bond Fund 4 36| $ 23,773 |$ 27,274 4.9% Barclays
5 Domestic Stock Fund 3 34|$ 22,110 | $ 22,903 1.3% S&P 500
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Skill Refresher: SUMIF Function

(click to see video)

3.2 Statistical IF Functions

. Type an equal sign (=).
2. Type the function name SUMIF followed by an open parenthesis

(0.

3. Define the range argument with a range of cells that will be
evaluated using the criteria argument.

Type a comma.
Define the criteria argument with a cell location, number, text, or

logical test. Text and logical tests must be enclosed in quotation

marks.

Type a comma.

7. Define the Sum_range argument with a range that contains values
to be summed. Excel will use the range argument to calculate the
sum if this argument is omitted.

Type a closing parenthesis ()).

9. Press the ENTER key on your keyboard.
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The COUNTIFS Function

Follow-along file: Continue with Excel Objective 3.00. (Use file Excel Objective 3.11 if
starting here.)

Lesson Video: COUNTIFS Function

(click to see video)

Up to this point, the statistical IF functions that were demonstrated provided the
ability to define one criteria or logical test used to select cells from a targeted
range. The next set of statistical functions that will be demonstrated provides the
ability to define multiple sets of criteria for selecting cells from a targeted range.
We will begin with the COUNTIFS function.

It is easy to distinguish the difference between a statistical IF function that allows
one criteria argument to be defined and one that allows multiple criteria
arguments. If the IF at the end of the function name is plural, you can define
multiple sets of criteria arguments. Therefore, the COUNTIFS function provides the
option of defining multiple sets of criteria for selecting cells from a targeted range
that will be used in the function output. The arguments for the COUNTIFS function
are established in pairs. For example, the first arguments for the function are
Criteria_rangel and Criterial. The function will use the Criterial argument to
select cells in the Criteria_rangel argument. A second pair of arguments,
Criteria_range2 and Criteria2, can be defined to select a subset of cell locations
that were selected in the Criteria_rangel and Criterial arguments. This process
can be repeated for several pairs of criteria arguments. We will continue to work on
the Portfolio Summary worksheet by adding the COUNTIFS function to count the
number of poor performing investments by investment type. The following steps
explain how to add this function to the worksheet:

1. Click cell B11 on the Portfolio Summary worksheet.

2. Click the Formulas tab of the Ribbon.

3. Click the More Functions button in the Function Library group of
commands.

4. Place the mouse pointer over the Statistical option from the drop-
down list.

5. Click the scroll down arrow on the second drop-down list to find the
COUNTIFS function (see Figure 3.25 "Selecting the COUNTIF Function
from the Function Library").
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10.

11.

12.

13.

14.

15.

16.

17.

18.

19.

20.

Click the COUNTIFS function. This will open the Function Arguments
dialog box.

Click the Collapse Dialog button next to the Criteria_rangel argument
on the Function Arguments dialog box (see Figure 3.33 "Defined
Arguments for the COUNTIFS Function").

Click the Investment Detail worksheet tab.

Highlight the range A4:A18 on the Investment Detail worksheet and
press the ENTER key on your keyboard.

Click in the Criteria_rangel argument input box and place an absolute
reference on the range A4:A18. This is done by typing a dollar sign ($)
in front of the column letter and row number for both cells in the
range.

Press the TAB key on your keyboard to advance to the Criterial
argument and type the cell location A11. The criteria for the function
will be the investment type that is entered into cell A11 on the
Portfolio Summary worksheet. You will notice that when you define
this argument, the Criteria_range2 argument will appear on the
Function Arguments dialog box.

Click the Collapse Dialog button next to the Criteria_range2 argument
on the Function Arguments dialog box (see Figure 3.33 "Defined
Arguments for the COUNTIFS Function").

Click the Investment Detail worksheet tab.

Highlight the range W4:W18 on the Investment Detail worksheet and
press the ENTER key on your keyboard.

Click in the Criteria_range2 argument input box and place an absolute
reference on the range W4:W18. This is done by typing a dollar sign ($)
in front of the column letter and row number for both cells in the
range.

Press the TAB key on your keyboard to advance to the Criteria2
argument.

Type an open quotation mark followed by the logical test <-1% and
then type a closing quotation mark (“<-1%”). The second criterion for
this function is a logical test that will identify cell locations where the
value is less than -1%. For the purposes of this exercise, a poor
performing investment is one that is below the target growth rate by
more than 1%.

Click the OK button at the bottom of the Function Arguments dialog
box.

Copy the function in cell B11 and paste it into the range B12:B14 using
the Paste Formulas command.

Enter a SUM function in cell B15 on the Portfolio Summary worksheet
that sums the values in the range B11:B14.
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Why?
Use Statistical IF Functions for a Summary Worksheet

When creating a summary worksheet that summarizes detailed data from other
worksheets, such as the Portfolio Summary worksheet in Figure 3.32
"Completed Annual Growth Column in the Portfolio Summary Worksheet", it is
best to use statistical IF functions. If data is added to the detailed worksheet
that is being summarized, the statistical IF functions will automatically include
the new data in the summary worksheet. For example, suppose a row is added
below Row 7 on the Investment Detail worksheet (see Figure 3.24 "Conditional
Format Applied to the Range S4:T18") and another bond investment is added.
The statistical IF functions will automatically pick up the new investment and
include it in the Portfolio Summary worksheet. If regular statistical functions
or formulas are used, the summary worksheet can easily become inaccurate if
new data is added to the detailed worksheet or if the sort order is changed.

Figure 3.33 "Defined Arguments for the COUNTIFS Function" shows the completed
arguments for the COUNTIFS function in the Function Arguments dialog box. Notice
the scroll bar that appears on the right side of the Function Arguments dialog box.
This allows you to scroll through and define multiple pairs of criteria arguments for
the function.

Figure 3.33
Function Arguments __2 | Collapse Dialog
COUNTIFS ;bUttons
Criteria_rangel | 'Tnvestment Detail'!$A$4:5A$18 = {"Bond Fund";"Bond Fund";"Bond Fund";"B... =4
Criterial | All = "Bond Fund" Elk
Criteria_range2 | 'Investment Detail'!$W$4:5W$18 = {0.0136184985144624;0.0031032614740556
Criteria2 | "<-1%" = "<-1%"
Criteria_range3 = reference b
=1
Counts the number of cells specified by & given set of conditions or criteria. T Y T
Criteria2: jz'flhgecggsrizg.in the form of a number, expression, or text that defines which cells additional criteria
arguments need to
be defined.
Formula result = 1
The logical test for this
Help on this function argument is enclosed [ oK I\ ] [ Cancel

L in quotations. )
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Figure 3.34 "Outputs for the COUNTIFS Functions" shows the output of the

COUNTIFS function on the Portfolio Summary worksheet. The criteria established

for the COUNTIFS function shows that there are a total of seven investments that

are underperforming in the portfolio.

Figure 3.34
B11 - fe | =COUNTIFS('Investment Detail|SAS4:34518,A11, Investment Detail |SW$4:3W318,"<-1%") €——
A B C D E F
4 Bond Fund 4 36| $ 23,773 | $ 27,274 4.9%
5 Domestic Stock Fund 3 34| 22110 | % 22,903 1.3%
6 International Stock Fund 3 27|$ 18,983 | $ 22,578 8.5%
7 |Individual Stock 5 63| $ 31,763 |$ 45,101 8.0%
8 TOTAL 15 43| $ 96,628 | $117,857 6.2%
95 Poor Performing Investments
Average |Total
Number of |Months |[Purchase |Current Annual

10 Investments (Owned |Cost Value

11 |Bond Fund 1] <

12 Domestic Stock Fund 3

13 International Stock Fund 1

14 Individual Stock 2

15 TOTAL 7

16

17

L

SUM function is

entered into cell B15.

18
4 < » M| Portfolio Summary ~ Investment Detail . Investment List 7 Benchmarks ~ Price Dat{| 4|

Growtp
COUNTIFS function
incell B11.

270



Chapter 3 Logical and Lookup Functions

Skill Refresher: COUNTIFS Function

(click to see video)

1. Type an equal sign (=).

2. Type the function name COUNTIFS followed by an open
parenthesis (().

3. Define the Criteria_rangel argument with a range of cells that
will be counted.

4. Type a comma.

5. Define the Criterial argument with a cell location, number, text,
or logical test. Text and logical tests must be enclosed in quotation
marks. This argument will be used to select cells from the
Criteria_rangel argument.

6. Type a comma and then repeat steps 3, 4, and 5 to define as many
pairs of arguments as needed.

7. Type a closing parenthesis ().

8. Press the ENTER key on your keyboard.

The AVERAGEIFS Function

Follow-along file: Continue with Excel Objective 3.00. (Use file Excel Objective 3.12 if
starting here.)

Lesson Video: AVERAGEIFS Function

(click to see video)

The AVERAGEIFS function is similar to the COUNTIFS function in that multiple sets
of criteria can be defined instead of one. However, the arguments for the
AVERAGEIFS function are slightly different from those for the COUNTIFS function.
Table 3.9 "Arguments for the AVERAGEIFS and SUMIFS Functions" provides
definitions for the arguments of the AVERAGEIFS and the SUMIFS functions.
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Table 3.9 Arguments for the AVERAGEIFS and SUMIFS Functions

Average_range
or Sum_range

Range of cells that contain values to be averaged when using the
AVERAGEIFS function or summed when using the SUMIFS function.
Note that the AVERAGEIFS or SUMIFS functions will only select values
from the range used to define this argument if all criteria pairs are true.

Criteria_rangel

Range of cells that will be evaluated based on the Criterial argument to
determine which cells in the Average_range or Sum_range arguments
will be included in the output of the function.

Criterial

Criteria that will be used to evaluate the range of cells used to define the
Criteria_rangel argument. This argument can be defined with a cell
location, formula, number, text, or logical test. Note that text and
logical tests must be enclosed in quotation marks.

Criteria_range2

Optional argument that defines a second range of cells that will be
evaluated based on the Criteria2 argument to determine which cells in
the Average_range or Sum_range arguments will be included in the
output of the function. Additional Criteria_rangeN arguments can be
defined as needed.

Criteria2

Criteria that will be used to evaluate the range of cells used to define the
Criteria_range2 argument. This argument can be defined with a cell
location, formula, number, text, or logical test. Note that text and
logical tests must be enclosed in quotation marks. Additional CriteriaN
arguments can be defined as needed.

The AVERAGEIFS function will be used to calculate the average months of
ownership for poor performing investments in the portfolio. The following steps
explain how to add this function to the Portfolio Summary worksheet:

1. Click cell C11 on the Portfolio Summary worksheet.
Click the Formulas tab on the Ribbon.

3. Click the More Functions button in the Function Library group of
commands.

4. Place the mouse pointer over the Statistical option from the drop-
down list (see Figure 3.25 "Selecting the COUNTIF Function from the
Function Library").

5. Click the AVERAGEIFS function near the top of the list of functions.
This will open the Function Arguments dialog box.

6. Click the Collapse Dialog button next to the Average_range argument
on the Function Arguments dialog box (see Figure 3.35 "Completed
Arguments for the AVERAGEIFS Function").

7. Click the Investment Detail worksheet tab.
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10.

11.
12.

13.

14.

15.

16.
17.

18.

19.

20.

Highlight the range Q4:Q18 on the Investment Detail worksheet and
press the ENTER key on your keyboard. Selected cells from this range
will be averaged by the function based on the defined criteria in
ensuing arguments.

Click in the Average_range argument input box and place an absolute
reference on the range Q4:Q18. This is done by typing a dollar sign ($)
in front of the column letter and row number for both cells in the
range.

Click the Collapse Dialog button next to the Criteria_rangel argument
on the Function Arguments dialog box (see Figure 3.35 "Completed
Arguments for the AVERAGEIFS Function").

Click the Investment Detail worksheet tab.

Highlight the range A4:A18 on the Investment Detail worksheet and
press the ENTER key on your keyboard. Once the Criteria_rangel
argument is defined, the Criterial argument will appear in the
Function Arguments dialog box.

Click in the Criteria_rangel argument input box and place an absolute
reference on the range A4:A18. This is done by typing a dollar sign ($)
in front of the column letter and row number for both cells in the

range.
Press the TAB key on your keyboard to advance to the Criterial
argument and type the cell location A11. The criteria for the function
will be the investment type entered into cell A11 on the Portfolio
Summary worksheet. You will notice that as you define this argument,
the Criteria_range2 argument will appear on the Function Arguments
dialog box.

Click the Collapse Dialog button next to the Criteria_range2 argument
on the Function Arguments dialog box (see Figure 3.35 "Completed
Arguments for the AVERAGEIFS Function").

Click the Investment Detail worksheet tab.

Highlight the range W4:W18 on the Investment Detail worksheet and
the press the ENTER key on your keyboard.

Click in the Criteria_range2 argument input box and place an absolute
reference on the range W4:W18. This is done by typing a dollar sign ($)
in front of the column letter and row number for both cells in the
range.

Press the TAB key on your keyboard to advance to the Criteria2
argument.

Type an open quotation mark followed by the logical test <-1% and
then type a closing quotation mark (“<-1%”). The second criterion for
this function is a logical test that will identify cell locations where the
value is less than -1%. For the purposes of this exercise, a poor
performing investment is one that is below the target growth rate by
more than 1%.
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21.

22.

23.

24.

25.

26.

Click the OK button at the bottom of the Function Arguments dialog
box.

Copy the function in cell C11 and paste it into the range C12:C14 using
the Paste Formulas command.

Figure 3.35 "Completed Arguments for the AVERAGEIFS Function"
shows the defined arguments for the AVERAGEIFS function. Notice that
two sets of criteria arguments are defined. Values that meet all criteria
defined in the function will be selected from the range Q4:Q18.

Figure 3.35 Completed Arguments for the AVERAGEIFS Function

Function Arguments (2 =]

AVERAGEIFS The values in this range
Average_range  'Investment Detal\'.’$Q$4:$Q$18l = {48;37;48;10;42;22;33;46,29;9;72;87;6;50; 4 will be averaged based
on the Criteria_range anc
Criteria arguments.

Criteria_rangel | 'Investment Detail!$A$4:$A518 = {"Bond Fund";"Bond Fund";"Bond Fund";"Bon
Criterial  All = "Bond Fund"

Criteria_range2 | 'Investment Detail''$W$4:$W$18 = {0.0136184985144624;0.0031032614740556

Criteria2 | "<-1%" = "<-1%"
Collapse Dialog
Finds average(arithmetic mean) for the cells specified by a given set of conditions or criteria. buttons

Criteria2: is the condition or criteria in the form of a number, expression, or text that defines
which cells will be used to find the average.

Formula result = 10

Help on this function 0K IX] [ Cancel

Enter an AVERAGEIF function in cell C15 by typing an equal sign (=)
followed by the function name AVERAGEIF followed by an open
parenthesis (().

Click the Investment Detail worksheet tab and highlight the range
W4:W18 to define the Range argument. Type a comma.

Type the following to define the criteria argument: “<-1%”. Type a
comma.

Highlight the range Q4:Q18 to define the [Average_range] argument.
Then type a closing parenthesis ()) and press the ENTER key on your
keyboard.

Figure 3.36 "Results of the AVERAGEIFS Function" shows the results of the

AVERAGEIFS function in the Portfolio Summary worksheet. The function shows
the average months of ownership for the poor performing investments by
investment type.

3.2 Statistical IF Functions
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Figure 3.36
C15 v Jx | =AVERAGEIF('Investment Detail'!W4:W18,"<-1%", 'Investment Detail'!Q4:Q18) —
A B C D E F
4 Bond Fund 4 36|$ 23,773 | % 27,274 4.9%
5 Domestic Stock Fund 3 34/$ 22110 | % 22,903 1.3%
6 International Stock Fund 3 27|$ 18,983 | $ 22,578 8.5%
7 |Individual Stock 5 63| $ 31,763 | 3% 45,101 8.0%
8 TOTAL 15 43| $ 96,628 | $117,857 6.2%

5 Poor Performing Investments

Average |Total
Number of |Months |Purchase |Current Annual
10 Investments |[Owned |Cost Value Growth

11 Bond Fund 1 10
12 Domestic Stock Fund 3 34
13 International Stock Fund 1 42
14 Individual Stock 2 69 P
| The AVERAGEIF function
3 ‘TOTAL 7 41| <

| was entered here.

16
17

18
4 4 » | Portfolio Summary / Investment Detail . Investment List . Benchmarks /" Price Dati| 4

Skill Refresher: AVERAGEIFS Function

(click to see video)

1. Type an equal sign (=).

Type the function name AVERAGEIFS followed by an open
parenthesis (().

3. Define the Average_range argument with a range of cells that
contain values to be averaged.

Type a comma.

5. Define the Criteria_rangel argument with a range of cells that
will be evaluated based on the criteria used to define the Criterial
argument.

6. Type a comma.

7. Define the Criterial argument with a cell location, number, text,
or logical test. Text and logical tests must be enclosed in quotation
marks.

8. Repeat steps 4, 5, 6, and 7 to define as many pairs of criteria
arguments as needed.

9. Type a closing parenthesis ().

10. Press the ENTER key on your keyboard.
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The SUMIFS Function

Follow-along file: Continue with Excel Objective 3.00. (Use file Excel Objective 3.13 if
starting here.)

Lesson Video: SUMIFS Function

(click to see video)

The SUMIFS function is similar to the AVERAGEIFS function in that multiple criteria
arguments can be defined to select cells from a targeted range (see Table 3.9
"Arguments for the AVERAGEIFS and SUMIFS Functions"). The function will use the

selected cells from this targeted range to calculate a total or sum. The SUMIFS
function will be used to complete the Total Purchase Cost and Current Value
columns in the Poor Performing Investments section of the Portfolio Summary
worksheet. The following steps explain how to construct this function for the Total
Purchase Cost column:

Click cell D11 on the Portfolio Summary worksheet.

2. Click the Formulas tab on the Ribbon.

10.

3.2 Statistical IF Functions

Click the Math & Trig button in the Function Library group of
commands (see Figure 3.25 "Selecting the COUNTIF Function from the
Function Library").

Select the SUMIFS function from the drop-down list. Use the scroll bar
to scroll down to find the SUMIFS function. This will open the Function
Arguments dialog box.

Click the Collapse Dialog button next to the Sum_range argument on
the Function Arguments dialog box (see Figure 3.37 "Completed
Arguments for the SUMIFS Function").

Click the Investment Detail worksheet tab.

Highlight the range G4:G18 on the Investment Detail worksheet and
press the ENTER key on your keyboard. Selected cells from this range
will be summed based on the defined criteria in ensuing arguments.
Click in the Sum_range argument input box and place an absolute
reference on the range G4:G18. This is done by typing a dollar sign ($)
in front of the column letter and row number for both cells in the

range.
Click the Collapse Dialog button next to the Criteria_rangel argument
on the Function Arguments dialog box (see Figure 3.37 "Completed
Arguments for the SUMIFS Function").

Click the Investment Detail worksheet tab.
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11.

12.

13.

14.

15.

16.

17.

18.

19.

20.

21.

22.

Highlight the range A4:A18 on the Investment Detail worksheet and
press the ENTER key on your keyboard. Once the Criteria_rangel
argument is defined, the Criterial argument will appear in the
Function Arguments dialog box.

Click in the Criteria_rangel argument input box and place an absolute
reference on the range A4:A18. This is done by typing a dollar sign ($)
in front of the column letter and row number for both cells in the
range.

Press the TAB key on your keyboard to advance to the Criterial
argument and type the cell location A11. The criteria for the function
will be the investment type that is entered into cell A11 on the
Portfolio Summary worksheet. You will notice that as soon as you
define this argument, the Criteria_range2 argument will appear on
the Function Arguments dialog box.

Click the Collapse Dialog button next to the Criteria_range2 argument
on the Function Arguments dialog box (see Figure 3.37 "Completed
Arguments for the SUMIFS Function").

Click the Investment Detail worksheet tab.

Highlight the range W4:W18 on the Investment Detail worksheet and
press the ENTER key on your keyboard.

Click in the Criteria_range2 argument input box and place an absolute
reference on the range W4:W18. This is done by typing a dollar sign ($)
in front of the column letter and row number for both cells in the
range.

Press the TAB key on your keyboard to advance to the Criteria2
argument.

Type an open quotation mark followed by the logical test <-1% and
then type a closing quotation mark (“<-1%”). The second criterion for
this function is a logical test that will identify cell locations where the
value is less than -1%. For the purposes of this exercise, a poor
performing investment is one that is below the target growth rate by
more than 1%.

Click the OK button at the bottom of the Function Arguments dialog
box.

Copy the function in cell D11 and paste it into the range D12:D14 using
the Paste Formulas command.

Enter a regular SUM function in cell D15 on the Portfolio Summary
worksheet that sums the values in the range D11:D14.

Figure 3.37 "Completed Arguments for the SUMIFS Function" shows the defined

arguments for the SUMIFS function. Values that meet all criteria defined in the
function will be selected from the range G4:G18. Notice that the results for each
argument of the function are shown along the right side of the Collapse Dialog

buttons.
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Figure 3.37

SUMIFS

Adds the cells specified by a given set of conditions or criteria.

Formula result = $

Function Arguments

[ =]

'Investment DetaiJ'I$G$4 : $G$1BI

'Investment Detail'!$A$4:5A518

Sum_range
Criteria_rangel
Criterial | All

Criteria_range2 | 'Investment Detail'!$W$4:5W$18

Criteria2 | "<-1%"

Criteria2: is the condition or critgria i

= "Bond Fund"

=717117.5;8010;3145;5500;7340;11675;4832.>

Efz/ = {"Bond Fund";"Bond Fund";"Bond Fund";"B...

= {0.0136184985144624;0.00310326147405...

= "<-1%"

in the form of a number, expression, or text that defines

Selected cells in this
range will be summed.

Results for each
argument appear here.

Collapse Function

which cells will be added-

5,500

Help on this function

Arguments dialog
box buttons

[

OK Q { Cancel

Figure 3.38 "SUMIFS Function Out

ut for the Total Purchase Cost Column" shows
the results of the SUMIFS function used to complete the Total Purchase Cost
column. In total, over $45,000 was invested in funds and stocks that are not meeting
the performance goals of the portfolio.

Figure 3.38
D15 hd fx | =5UM({D11:D14) ¢ SUM function entered
A B C D E in cell D15.

4 Bond Fund 4 36| $ 23,773 | % 27,274 4.9%

5 Domestic Stock Fund 3 34| $ 22,110 % 22,903 1.3%

6 International Stock Fund 3 27|$ 18,983 | $ 22,578 8.5%

7 Individual Stock 5 63| $ 31,763 | 3% 45,101 8.0%

8 TOTAL 15 43| $ 96,628 | $117,857 6.2%

9 Poor Performing Investments

Average |Total
Number of |Months |Purchase |Current Annual

10 Investments |Owned Cost Value Growth

11 Bond Fund 1 10($ 55007

12 Domestic Stock Fund 3 34/ 3 22,110 L Output of the

13 International Stock Fund 1 42| 7,340 SUMIFS function.

14 Individual Stock 2 69| $ 10,097

15 ‘TOTAL 7 41| $ 45,047

16

17

18
4 4 » | Portfolio Summary / Investment Detail . Investment List  Benchmarks " Price Dat{| 4

In addition to the Total Purchase Cost column, the SUMIFS function will also be
used to complete the Current Value column for the Poor Performing Investments
section on the Portfolio Summary worksheet. The following steps explain how to

add the function to the worksheet to complete this column:
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1. Click cell E11 on the Portfolio Summary worksheet.
2. Click the Formulas tab on the Ribbon.

10.
11.

12.

13.

14.

15.
16.

17.

Click the Math & Trig button in the Function Library group of
commands (see Figure 3.25 "Selecting the COUNTIF Function from the
Function Library").

Select the SUMIFS function from the drop-down list. Use the scroll bar
to scroll down to find the SUMIFS function. This will open the Function
Arguments dialog box.

Click the Collapse Dialog button next to the Sum_range argument on
the Function Arguments dialog box (see Figure 3.39 "Completed
Function Arguments Dialog Box for the Second SUMIFS Function").
Click the Investment Detail worksheet tab.

Highlight the range K4:K18 on the Investment Detail worksheet and
press the ENTER key on your keyboard. Selected cells from this range
will be summed based on the defined criteria in ensuing arguments.
Click in the Sum_range argument input box and place an absolute
reference on the range K4:K18. This is done by typing a dollar sign ($)
in front of the column letter and row number for both cells in the
range.

Click the Collapse Dialog button next to the Criteria_rangel argument
on the Function Arguments dialog box (see Figure 3.39 "Completed
Function Arguments Dialog Box for the Second SUMIFS Function").
Click the Investment Detail worksheet tab.

Highlight the range A4:A18 on the Investment Detail worksheet and
press the ENTER key on your keyboard. Once the Criteria_rangel
argument is defined, the Criterial argument will appear in the
Function Arguments dialog box.

Click in the Criteria_rangel argument input box and place an absolute
reference on the range A4:A18. This is done by typing a dollar sign ($)
in front of the column letter and row number for both cells in the
range.

Press the TAB key on your keyboard to advance to the Criterial
argument and type the cell location A11. The criteria for the function
will be the investment type entered into cell A11 on the Portfolio
Summary worksheet.

Click the Collapse Dialog button next to the Criteria_range2 argument
on the Function Arguments dialog box (see Figure 3.39 "Completed
Function Arguments Dialog Box for the Second SUMIFS Function").
Click the Investment Detail worksheet tab.

Highlight the range W4:W18 on the Investment Detail worksheet and
press the ENTER key on your keyboard.

Click in the Criteria_range2 argument input box and place an absolute
reference on the range W4:W18. This is done by typing a dollar sign ($)
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18.

19.

20.

21.

22.

in front of the column letter and row number for both cells in the
range.

Press the TAB key on your keyboard to advance to the Criteria2
argument.

Type an open quotation mark followed by the logical test <-1% and
then type a closing quotation mark (“<-1%”). The second criterion for
this function is a logical test that will identify cell locations where the
value is less than -1%. For the purposes of this exercise, a poor
performing investment is one that is below the target growth rate by
more than 1%.

Click the OK button at the bottom of the Function Arguments dialog
box.

Copy the function in cell E11 and paste it into the range E12:E14 using
the Paste Formulas command.

Enter a regular SUM function in cell E15 on the Portfolio Summary
worksheet that sums the values in the range E11:E14 (see Figure 3.40
"SUMIFS Function Output for the Current Value Column").

Figure 3.39 Completed Function Arguments Dialog Box for the Second SUMIFS Function

Criterial | All = "Bond Fund"
Criteria_range2 | 'Investment Detail!$W$4:5W$18

Adds the cells specified by a given set of conditions or criteria.

Formula result =

Help on this function

Criteria2 | "<-1%"

Function Arguments ’THF”
SUMIFS Selected cells in this
Sum_range | 'Investment Detail'l$K$4:$K$18 Fis| = {8814.83865270675;8876.96280025549;395 ~ [ fange will be summed.
Criteria_rangel | 'Investment Detail'$A$4:$A$18 = {"Bond Fund";"Bond Fund";"Bond Fund";"Bon ‘E |

= {0.0136184985144624;0.0031032614740556

E| = "<1%" -
Collapse Function
= 5626.107921 .
Arguments dialog
box buttons

Criteria2: is the condition or criteria in the form of a number, expression, or text that defines
which cells will be added.

5,626

0K b ] [ Cancel

3.2 Statistical IF Functions
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Figure 3.40 SUMIFS Function Output for the Current Value Column

E11 - Je | =SUMIFS('Investment Detail'!$K$4:3K$18, 'Investment Detail'!|SAS4:5A$18,A11, 'Investment Detail |SWS4:SWS$18,"<-1%") 4—
A B C D E F G
4 Bond Fund 4 36| $ 23,773 | $ 27,274 4.9% B
5 Domestic Stock Fund 3 34| $ 22,110 | $ 22,903 1.3% S
6 International Stock Fund 3 27|$ 18,983 | $ 22,578 8.5% 1%
7 Individual Stock 5 63| $ 31,763 | $ 45,101 8.0% D
8 TOTAL 15 43| $ 96,628 | $117,857 6.2%
5 Poor Performing Investments
Average |[Total
Number of |Months |Purchase |Current Annual
10 Investments |Owned Cost Value Growth
11 |Bond Fund 1 10]S_ 5500 [S_ 5626 |« SUMIFS function
12 Domestic Stock Fund 3 34/$ 22,110 | $ 22,903
13 International Stock Fund 1 42|$ 7,340 |$ 5,958
14 Individual Stock 2 69| $ 10,097 | $ 13,990
15 TOTAL 7 41| $ 45,047 | $ 48,478
16
17
18 A SUM function
R | Portfolio y / Investment Detail "Investment List . Benchm{ " addedhere i

Now that the Total Purchase Cost and Current Value columns are completed for the
Poor Performing Investments section on the Portfolio Summary worksheet, we
can add a formula to show the annual growth rate by investment type. Since this is
the same formula that was used in the Total Summary section of the Portfolio

Summary worksheet, we can just copy and paste it. The following steps explain
how to do this:

1. Copy the formula in cell F4 on the Portfolio Summary worksheet.
2. Highlight the range F11:F15 on the Portfolio Summary worksheet.
3. Paste the formula using the Paste Formulas command.

Integrity Check

Error Message for Statistical IF Functions

If you receive an error message when attempting to enter a statistical IF

function into a cell location, check to make sure any criteria using a

comparison operator is enclosed in quotation marks. For example, if you are
assessing a range of cells to see if the values are greater than or equal to zero,
you must define the Criteria argument as follows: “>=0”. If you do not use the
quotation marks, Excel will not accept the function in the cell location and will
display an error message.
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Figure 3.41 "Completed Poor Performing Investments Section of the Portfolio
Summary Worksheet" shows the completed Poor Performing Investments section

on the Portfolio Summary worksheet. Notice that even though an investment is
considered “poor performing” it does not mean that money is lost on the
investment. As shown in the figure, only one investment in the International Stock
Fund category is losing money, with an annual growth rate of -5.4%. However, the
total annual growth rate for all investments in the Poor Performing section is 2.2%
(see cell F15). This is less than half the growth rate for the overall portfolio, which is
6.2% (see cell F8). A final observation is that all the investments in the Domestic
Stock Fund category are “poor performing.” The same number of investments in
the Total Summary section appears in the Poor Performing Investments section.
This completes the Portfolio Summary worksheet with the exception of one
column. We will complete this column in the next section with a lookup function.

Figure 3.41 Completed Poor Performing Investments Section of the Portfolio Summary Worksheet

F11 v J | =((E11-D11)/D11)/(C11/12) 1 | Formula entered
A B G D E ® incell F11 H

2 Personal Investment Summary
2 Total Summary
Average |Total

Number of [Months |Purchase |Current Annual (Benchmark 5
8 Investments (Owned |Cost Value Growth |Year Growth |Benchmark
4 Bond Fund 4 36| $ 23773 |$ 27,274 4.9% Barclays
5 Domestic Stock Fund 3 34/$ 22,110 | $ 22,903 1.3% |4 S&P 500
6 International Stock Fund 3 27|$ 18,983 | $ 22,578 8.5% MSCI EAFE
7 Individual Stock 5 63| $ 31,763 | $ 45,101 8.0% Dow Jones
8 TOTAL 15 43| $ 96,628 | $117,857 6.2%

This column will be

9 Poor Performing Investments

C witha
Average |Total lookup function.
Number of [Months |Purchase |Current Annual
10 Investments |Owned |Cost Value Growth
11 Bond Fund 1 10/$ 5500|$ 5626 2.8%
12 Domestic Stock Fund 3 34/$ 22,110 | $ 22,903 1.3%|€¢—
13 International Stock Fund 1 42|$ 7,340 |$ 5,958 -5.4%
14 Individual Stock 2 69/ $ 10,097 | $ 13,990 6.8%
All of the investments in the Domestic
15 TOTAL 7 41|$ 45,047 | $ 48,478 2.2% LStockFundcategoryare”poorperforming."]
16
4 4 » | Portfolio Summary / Investment Detail Investment List Benchmarks _/ Price Dati| 4] M
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Skill Refresher: SUMIFS Function

(click to see video)

1. Type an equal sign (=).

2. Type the function name SUMIFS followed by an open parenthesis
(.

3. Define the Sum_range argument with a range of cells that contain
values to be summed.

4. Type a comma.

5. Define the Criteria_rangel argument with a range of cells that
will be evaluated based on the criteria used to define the Criterial
argument.

6. Type a comma.

7. Define the Criterial argument with a cell location, number, text,
or logical test. Text and logical tests must be enclosed in quotation
marks.

8. Repeat steps 4, 5, 6, and 7 to define as many pairs of criteria
arguments as needed.

9. Type a closing parenthesis ().

10. Press the ENTER key on your keyboard.

KEY TAKEAWAYS

+ The COUNTIF, SUMIF, and AVERAGEIF functions can select specific cell
locations from a range to compute an output using one criteria
argument.

+ The COUNTIFS, SUMIFS, and AVERAGEIFS functions can select specific
cell locations from a range to compute an output using multiple sets of
criteria arguments.

¢« When using the AVERAGEIF and SUMIF functions, the row numbers used
in the ranges to define the Range argument and the Average_range or
Sum_range arguments must be identical.

« The benefit of using statistical functions when creating a summary
worksheet is that if rows of data are added to the detail worksheet, the
new data will automatically be included in the function output.

+ When using statistical IF functions, the logical test used to define a
criteria argument must be enclosed in quotation marks.
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EXERCISES

3.2 Statistical IF Functions

. Consider the following SUMIF function:

=SUMIF(B2:B10,A1,E2:E20). What cell range will be used to
compute the output for the function?

E2:E10
B2:B10
E2:E20
B2:B20

o op

. Which of the following is true with respect to the COUNTIF

function?

a. It can only be used to sum selected cells from a range using
one set of defined criteria.

b. It can be used to count both numeric and nonnumeric values
in selected cells from a range using one set of defined
criteria.

c. It can be used to count only numeric values in selected cells
from a range given one set of defined criteria.

d. It can be used to count only numeric values in selected cells
from a range using multiple sets of defined criteria.

. If you wanted to calculate the average of the values contained in

the range B5:B20 based on any values in the range E5:E20 with a
value greater than 5, which of the following functions would
provide an accurate result?

a. =COUNTIF(B5:B20,>5,E5:E20)

b. =AVERAGEIF(B5:B20,>5,E5:E20)
c. =AVERAGEIF(E5:E20,>5,B5:B20)
d. =AVERAGEIF(E5:E20,”>5" ,B5:B20)

Suppose you wanted to sum the values in the range C3:C15 where
the values in B3:B15 are equal to the word Bond and where the
values in the range D3:D15 are greater than 3%. Which of the

following functions would provide an accurate result?

a. =SUMIFS(C3:C15,B3:B15,“Bond”,D3:D15,“>3%")
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b. =SUMIFS(B3:B15,“Bond”,D3:D15,“>.03”,C3:C15)
c. =SUMIFS($C$3:$C$15,$B$3:$B$15,“Bond”,$D$3:$D$15,>3%)
d. =SUMIFS($B$3:$B$15,=Bond,$D$3:$D$15,>.03,$C$3:$C$1)
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3.3 Lookup Functions

7. Functions that are used to
search for and display data
located in an existing
worksheet or in other
worksheets or workbooks.

LEARNING OBJECTIVES

1. Use the VLOOKUP function to search and display the contents of a cell
location for data that is organized in columns.

2. Use the HLOOKUP function to search and display the contents of a cell
location for data that is organized in rows.

3. Create a web query that imports stock price data into a worksheet from
a website.

The final section of this chapter addresses lookup functions. Lookup functions’ are
typically used to search for and display data located in other worksheets or
workbooks. The two lookup functions we will use in our example of the personal
investment portfolio are the VLOOKUP and HLOOKUP functions. In addition to
demonstrating these functions, we will also show how we can enhance the personal
investment portfolio workbook with a web query. Web queries are used to bring live
or current data into a worksheet from a website.

The VLOOKUP Function

Follow-along file: Continue with Excel Objective 3.00. (Use file Excel Objective 3.14 if
starting here.)

Lesson Video: VLOOKUP Function

(click to see video)

The VLOOKUP function is typically used to access and display data located in
another worksheet or workbook. The function can also be used to access and
display data located in the same worksheet. This is a very powerful and versatile
function because it eliminates the need to copy or recreate data that exists in other
worksheets or workbooks. It is called a VLOOKUP function because the function will
search vertically down the first column of a range of cells to find what is called a
lookup value. This process is very similar to the statistical IF functions in Section 3.2
"Statistical IF Functions". You will recall that these functions used criteria to select

cells from a range that was used in the mathematical output. The VLOOKUP
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3.3 Lookup Functions

function is essentially performing the same process; however, instead of selecting
multiple cells from a range, the function is only looking for one specific cell
location. Once the function finds the specific cell location, it will display the
contents of that cell location or another cell location in the range. Before using the
VLOOKUP function in the personal investment portfolio workbook, it is strongly
recommended that you carefully read the definitions for the function arguments
listed in Table 3.10 "Arguments for the VLOOKUP Function".

Table 3.10 Arguments for the VLOOKUP Function

Lookup_value

This argument is typically defined with a cell location, number, or text.
Text data must be enclosed in quotation marks for this argument. The
function will search for the criteria entered into this argument in the
first column of the range used to define the Table_array argument. For
example, if the word Hat is used to define this argument, the function
will search for the word Hat in the first column of the range used to
define the Table_array argument.

Table_array

Range of cells that contain data you wish the VLOOKUP function to
search though (Lookup_value) and display. This cell range must contain
the criteria used to define the Lookup_value in the first column. For
example, if the range A2:D15 is used to define this argument, the criteria
used to define the Lookup_value argument must exist in Column A.

Col_index_num

This is the column index number argument. It is defined with the
number of columns to the right of the first column in the range used to
define the Table_array argument that contains the data you wish to
display. For example, suppose the data you wish the function to display
is contained in Column C. If the range used to define the Table_array
argument is A2:D15, then the column index number will be 3. Counting
the columns to the right of the first column in this range, Column A
would be 1, Column B would be 2, and Column C would be 3. It is
important to remember to count the first column in the table array
range as 1.

[Range_lookup]

This argument is defined with either the word TRUE or the word FALSE.
When this argument is defined with the word FALSE, the function will
look for an exact match to the criteria used to define the Lookup_value
argument in the first column of the table array range. It is important to
note the function will search the entire range to find a match. If this
argument is defined with the word TRUE, the function will look for a
value that is an exact match or the closest match that is less than the
lookup value. For example, if the lookup value is 80 and the highest
value in the first column of the table array range is a 78, the function
will consider 78 a match for the number 80. However, if the lookup value
is 80 and the lowest number in the first column of the table array range
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is 85, the function will produce an error. This is because the number 80
and any value less than 80 do not exist in the first column of the table
array range. It is important to note that if you define this argument with the
word TRUE, the data in the table array range must be sorted in ascending order.
This is because the function will stop searching for a match once the
value in the first column exceeds the lookup value. If the data in the
table array range is not sorted, the function can either produce an error
code or display an erroneous result. This argument is in brackets
because if it is not defined it will automatically be defined with the word
TRUE.

Integrity Check

Using a TRUE Range Lookup for VLOOKUP and HLOOKUP

If you are defining the Range_lookup argument with the word TRUE for either
the VLOOKUP or HLOOKUP function, the range used to define the Table_array
argument must be sorted in ascending order. For the VLOOKUP function, the
table array range must be sorted from smallest to largest or from A to Z based
on the values in the first column. For the HLOOKUP function, the table array
range must be sorted from left to right based on the values in the first row,
from smallest to largest or A to Z.

You may have noticed that on the Investment Detail worksheet, the Description
column is blank (see Figure 3.2 "Investment Detail Worksheet"). Descriptions for
several investments are included in the workbook in the Investment List
worksheet as shown in Figure 3.42 "Investment List Worksheet". The VLOOKUP
function will be used to search for a specific symbol in Column A of the Investment
List worksheet and display the description for that symbol located in Column B. The
following steps explain how to accomplish this:
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Figure 3.42 Investment List Worksheet

Ve
a3 - £ vmmixx To display the data in this column, the
A B C D E ; Col_index_num argument must be defined
A Investment List with the number 2.
Growth Last |5 Year
2 Symbol |D Investment Type Risk Level |Year Growth
3 [VMMXX _[Prime Money Market Money Market 1 0.07% 2.45%
4 VUSTX Long Term Treasury Bond Fund 3 0.68% 3.51%
5 VFSTX Short Term Investment Grade Bond Fund 1 3.79% 4.92%
6 VWEHX |[High Yield Corporate \Bond Fund B 12.37%! 6.74%
7 VFICX Intermediate Investment Grade Bond Fund 2 7.88% 6.63%
8 VFISX Short Term Treasury Bond Fund 1 1.74% 4.39%
9 VBISX Short Term Bond Index Bond Fund 1 2.85% 4.98%
10 VEIPX Equity Income Domestic Stock Fund 4 17.10% 3.59%
11 VIMSX Mid Cap Domestic Stock Fund 5 24.94% 4.39%
12 VISGX Small Cap Growth Domestic Stock Fund 5 32.55% 5.92%
13 VFINX S&P 500 Index Domestic Stock Fund 4 15.49% 2.54%
14 VEIEX Emerging Markets International Stock Fund 5 17.18% 10.01%
15 VDMIX Developed Markets International Stock Fund 5 10.49% 1.41%
16 VTRIX International Value International Stock Fund 5 7.69% 1.93%
17 MSFT Microsoft Corporation Individual Stock 5 -10.05% 3.49%
18 AAPL Apple Inc. Individual Stock 5! 50.97% 324.19%
19 I1BM International Business Machine Individual Stock 5 12.09% 72.65%!
20 GOOG Google Inc. Individual Stock 5 -4.03% 28.60%
21 INJ Johnson and Johnson Individual Stock 5 -3.11% -1.05%
D7 ﬁ P (o TP — - = 42 na0 Zo 470
W« » W[ Poltfolio Summary _ Investment Detall | List ./ Price Dati[ 4] u

[T

his column contains the data that will be
matched to the lookup value of the
VLOOKUP function.

10.

11.

Click cell C4 on the Investment Detail worksheet.

Click the Formulas tab on the Ribbon.

Click the Lookup & Reference button in the Function Library group of
commands.

Select the VLOOKUP function from the list of functions. Use the scroll
bar to scroll down to the bottom of the list. This will open the Function
Arguments dialog box for the VLOOKUP function.

Click the Collapse Dialog button next to the Lookup_value argument
on the Function Arguments dialog box.

Click cell B4 and press the ENTER key on your keyboard. The symbol in
cell B4 is the lookup value that will be searched in the first column of
the range defined for the Table_array argument.

Click the Collapse Dialog button next to the Table_array argument on
the Function Arguments dialog box.

Click the Investment List worksheet tab.

Highlight the range A3:F23 on the Investment List worksheet and
press the ENTER key on your keyboard. The function will look in
Column A of this range for the lookup value.

Click in the input box for the Table_array argument and place an
absolute reference on the range A3:F23. This is done by typing a dollar
sign ($) in front of the column letter and row number of each cell
location in the range.

Press the TAB key on your keyboard to advance to the Col_index_num
argument and type the number 2. Once the function finds the lookup
value in Column A of the range A3:F23, it will display the description
that is in Column B of the same row.
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12. Press the TAB key on your keyboard to advance to the Range_lookup
argument and type the word FALSE. This will direct the function to
search for only exact matches to lookup value.

13. Click the OK button at the bottom of the Function Arguments dialog
box.

14. Copy the VLOOKUP function in cell C4 and paste it into the range
C5:C18 using the Paste Formulas command.

Figure 3.43 "Completed Function Arguments Dialog Box for the VLOOKUP Function"
shows the completed Function Arguments dialog box for the VLOOKUP function.
Notice that the Range_lookup argument is defined with the word FALSE. This will
direct the function to search for an exact match to the lookup value and will also
direct the function to search the entire first column of the table array range.
Finally, it is important to note the absolute reference on the table array range. This
will prevent the table array range from changing when the function is pasted into
other cell locations.

Figure 3.43 Completed Function Arguments Dialog Box for the VLOOKUP Function

Function Arguments 2 @]
VLOOKUP ( An absolute reference is
Lookup_value |B4 ﬂ e prlaced on the table array range.
Table_array |'Investment Listl!$A$3:5F52 = {"VMMXX","Prime Money Market ","Money M
Col_index_num |2 -3 The W9rd FALSE indicates that the
i | eaLsE function will search for an exact
ange_looky E| = S
e ’ match to the lookup value in the
= "Intermediate Investment Grade” first column of the table array range.
Looks for a value in the leftmost column of a table, and then returns a value in the same row from a column you specify. By
default, the table must be sorted in an ascending order.
Range_lookup is a logical value: to find the closest match in the first column (sorted in ascending
order) = TRUE or omitted; find an exact match = FALSE.
Formula result = Intermediate Investment Grade

Figure 3.44 "Results of the VLOOKUP Function in the Investment Detail Worksheet"
shows the results of the VLOOKUP function in the Investment Detail worksheet.
The function is searching for each symbol in Column B of the Investment Detail
worksheet in Column A of the Investment List worksheet. When the function finds
a match, it will display whatever is in the cell location two columns to the right, or
Column B, in the Investment List worksheet. For example, the symbol VDMIX,
which is in cell B8 on the Investment Detail worksheet (see Figure 3.44 "Results of
the VLOOKUP Function in the Investment Detail Worksheet"), is also in cell A15 on
the Investment List worksheet (see Figure 3.42 "Investment List Worksheet"). As a
result, the function is displaying whatever is in cell B15 on the Investment List
worksheet, which is the description “Developed Markets.”
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Figure 3.44 Results of the VLOOKUP Function in the Investment Detail Worksheet

ca v Jx | =VLOOKUP(B4, Investment List'ISAS3:5F$23,2,FALSE) <

A B C D E F 4
1 VLOOKUP function as it
, Descriptive Information Purchase | PpearsincellCa.

Purchase
Dividend / | Shares Price per [Costo

3 Investment Type Symbol Description Yield Purchased |Share Purch:
4 |Bond Fund VFICX |Intermediate Investment Grade | 4.60% 75018 9498 7
5 Bond Fund VFSTX |Short Term Investment Grade 3.20% 750 |$ 1068 |S 8
6 Bond Fund VWEHX [High Yield Corporate 7.20% 500|$ 6.29|S% 3
7 Bond Fund VUSTX |Long Term Treasury 4.00% 5008 11.00(S$ 5
8 International Stock Fund |[VDMIX |Developed Markets < 2-60% 5061514685+
9 Domestic Stock Fund  |VEIPX |Equity Income 2.50% 500 |$ 23.35|S$ 11
10 Domestic Stock Fund  |VISGX |Small Cap Growth 0.30% 250 % 1933 | 4
11 Domestic Stock Fund VIMSX [Mid Cap 1.00% 250 | $ 22.41 [ This description is in cell B15
12 International Stock Fund [VTRIX _|International Value 2.00% 250 [ $ 22.83 L"""'e'"V“‘"‘e"‘“s‘w""“““‘-]
13 International Stock Fund |[VEIEX |Emerging Markets 1.40% 250 | % 2374|% 5
14 Individual Stock TRV The Travelers Companies, Inc. 2.40% 150 |$ 38.14 |8 5
15 Individual Stock JINJ Johnson and Johnson 3.60% 150 |$ 5330 |S 7
16 Individual Stock KO Coca Cola 2.80% 150 | $ 6246 |$ 9
17 Individual Stock MSFT _ [Microsoft Corporation 2.50% 75]% 2802 |3 2
18 Individual Stock IBM International Business Machine| 1.60% 75|3 8768 |3 6
19 Total 5,100 $ 96
'Zn‘ﬁim‘ Investment Detail / Investment List Benchmarks " Price Dati | 4] ul ]

Integrity Check

Absolute References on the Table Array Range for the VLOOKUP and HLOOKUP
Functions

If you are copying and pasting a VLOOKUP or HLOOKUP function, you will most
likely need to place an absolute reference on the range used to define the
Table_array argument. The table array range will change because of relative
referencing once the function is pasted to new cell locations. This may result in
an error output for either the VLOOKUP or HLOOKUP function. This is because
the function will not be able to find the lookup value since the range has been
adjusted. If you are defining the Range_lookup argument with the word TRUE,
an adjustment in the table array range may result in an erroneous output.
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Skill Refresher: VLOOKUP Function

(click to see video)

1. Type an equal sign (=).

2. Type the function name VLOOKUP followed by an open
parenthesis (().

3. Define the Lookup_value argument with a cell location, number,
or text that will be searched in another workbook or worksheet.
Text must be placed in quotation marks.

4. Type a comma.

5. Define the Table_array argument with a range of cells that
contain the lookup value in the first column along with data that is
to be displayed or used by the function.

6. Type a comma.

7. Define the Col_index_num argument with a number that
designates the columns to the right in the table array range that
will be displayed by the function. Count the first column of the
table array range as 1.

8. Type a comma.

9. Define the Range_lookup argument with either the word FALSE or
the word TRUE. The word FALSE will search for exact matches to
the lookup value. The word TRUE will search for an exact or closest
match less than the lookup value. Excel will define this argument
as TRUE if it is omitted.

10. Type a closing parenthesis ().
11. Press the ENTER key on your keyboard.

The HLOOKUP Function

Follow-along file: Continue with Excel Objective 3.00. (Use file Excel Objective 3.15 if
starting here.)

Lesson Video: HLOOKUP Function

(click to see video)
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The HLOOKUP function serves the same purpose as the VLOOKUP function. The
HLOOKUP function can be used to display data from another worksheet or
workbook. However, instead of searching for the lookup value vertically down the
first column of the table array range, the HLOOKUP function searches horizontally
across the first row of the table array range. When the function finds a match for the
lookup value, it will display the contents in a cell location based on a row index
number. This number designates how many rows below the first row of the table
array range the function should display. Table 3.11 "Arguments for the HLOOKUP
Function" provides a definition for each argument of the HLOOKUP function. It is
best to review the definitions of these arguments carefully before using the
function.

Table 3.11 Arguments for the HLOOKUP Function

This argument is typically defined with a cell location, number, or text.
Text data must be enclosed in quotation marks for this argument. The
function will search for the criteria entered into this argument in the
Lookup_value first row of the range used to define the Table_array argument. For
example, if the word Hat is used to define this argument, the function
will search for the word Hat in the first row of the range used to define
the Table_array argument.

Range of cells that contain data you wish the HLOOKUP function to
search though (Lookup_value) and display. This cell range must contain
the criteria used to define the Lookup_value in the first row. For
example, if the range A2:D15 is used to define this argument, the
criteria used to define the Lookup_value argument must exist in Row
2.

Table_array

This is the row index number argument. It is defined with the number
of rows below the first row in the range used to define the Table_array
argument that contains the data you wish to display. For example,
suppose the data you wish the function to display is contained in Row 5.
Row_index_num | If the range used to define the Table_array argument is A2:D15, then
the column index number will be 4. Counting the rows below the first
row in this range, Row 2 would be 1, Row 3 would be 2, Row 4 would be
3, and Row 5 would be 4. It is important to remember to count the first
row in the table array range as 1.

This argument is defined with either the word TRUE or the word FALSE.
When this argument is defined with the word FALSE, the function will
look for an exact match to the criteria used to define the Lookup_value
[Range_lookup] | argument in the first row of the table array range. It is important to
note the function will search the entire range to find a match. If this
argument is defined with the word TRUE, the function will look for a
value that is an exact match or the closest match that is less than the
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8. A value or qualitative example
that can be used as a standard
point of comparison. Results
that are higher or better than a
benchmark are typically
considered positive, whereas
results that are lower or worse
than the benchmark are
typically considered negative.

3.3 Lookup Functions

lookup value. For example, if the lookup value is 80 and the highest
value in the first row of the table array range is a 78, the function will
consider 78 a match for the number 80. However, if the lookup value is
80 and the lowest number in the first row of the table array range is 85,
the function will produce an error. This is because the number 80 and
any value less than 80 do not exist in the first row of the table array
range. It is important to note that if you define this argument with the word
TRUE, the data in the table array range must be sorted based on the values in
the first row in ascending order from left to right. This is because the
function will stop searching for a match once the value in the first row
exceeds the lookup value. If the data in the table array range is not
sorted, the function can either produce an error code or display an
erroneous result. This argument is in brackets because if it is not
defined it will automatically be defined with the word TRUE.

The HLOOKUP function will be used on the Portfolio Summary worksheet to
display the benchmark growth rates in the range G4:G7. A benchmark® is a value
that can be used as a standard point of comparison. The Benchmarks worksheet
contains growth rates at different year intervals for the benchmarks that will be
used to compare the performance for each investment type (see Figure 3.45
"Benchmarks Worksheet"). For the purposes of this workbook, we will be
comparing the growth rates for each investment type to the 5-year average growth
rate for the benchmarks categories listed in the range H4:H7. The following steps
explain how to construct the HLOOKUP function to display the 5-year benchmark

values in the Portfolio Summary worksheet:

Figure 3.45
e - J | 6.03%
A B i C \ D E
1 Financial Benchmarks
2 S&P 500 Barclays Dow Jones |MSCI EAFE
3 |1 Year Growth 15.65% 5.14% 16.53% 10.42%
4 3 Year Growth 2.35% 5.31% 3.21% -3.01%
5 |5 Year Growth 2.54% 6.03%| €+  5.35% 1.30%
6 10 Year Growth 3.29% 5.57% 5.92% 5.39%
7

If the table array range is set to
B2:E6, to display this value for the
Barclays benchmark the row index

number must be set to 4.
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1. Click cell G4 in the Portfolio Summary worksheet.
2. Click the Formulas tab on the Ribbon.

10.

11.

12.

13.

14.

Click the Lookup & Reference button in the Function Library group of
commands.

Select the HLOOKUP function from the list of functions. This will open
the Function Arguments dialog box for the HLOOKUP function.

Click the Collapse Dialog button next to the Lookup_value argument
on the Function Arguments dialog box.

Click cell H4 and press the ENTER key on your keyboard. The
description in cell H4 will be the lookup value that will be searched in
the first row of the range defined for the Table_array argument.
Click the Collapse Dialog button next to the Table_array argument on
the Function Arguments dialog box.

Click the Benchmarks worksheet tab.

Highlight the range B2:E6 on the Benchmarks worksheet and press the
ENTER key on your keyboard. The function will look in Row 2 of this
range for the lookup value.

Click in the input box for the Table_array argument and place an
absolute reference on the range B2:E6. This is done by typing a dollar
sign ($) in front of the column letter and row number of each cell
location in the range.

Press the TAB key on your keyboard to advance to the
Row_index_num argument and type the number 4. Once the function
finds the lookup value in Row 2 of the range B2:E6, it will display the
value that is in Row 5 of the same column. Remember that Row 2 is
counted as Row 1 for the row index number in this example.

Press the TAB key on your keyboard to advance to the Range_lookup
argument on the Function Arguments dialog box and type the word
FALSE. This will direct the function to search for only exact matches of
the lookup value.

Click the OK button at the bottom of the Function Arguments dialog
box.

Copy the HLOOKUP function in cell G4 and paste it into the range G5:G7
using the Paste Formulas command.

Figure 3.46 "Completed Function Arguments Dialog Box for the HLOOKUP Function"

shows the completed Function Arguments dialog box for the HLOOKUP function.
The row index number 4 indicates that the function will display the contents of the
cell location in the fourth row of the table array range.

3.3 Lookup Functions

295



Chapter 3 Logical and Lookup Functions

3.3 Lookup Functions

Figure 3.46 Completed Function Arguments Dialog Box for the HLOOKUP Function

Function Arguments
HLOOKUP

I

Lookup_value H4 ’\
Table_array |Benchmarkd!$B$2:$E$6

Row_index_num 4

Range_lookup |FALSE|

Formula result = 6.0% 4

= -

= "Barclays"
= {"sp ,"Barclays","Dow Jones","MSCI EAF

4

-

An absolute reference is
placed on the table array range.

FALSE

0.0603

Looks for a value in the top row of a table or array of values and returns the value in the same column from a row you specify.

Range_lookup s a logical value: to find the closest match in the top row (sorted in ascending order) =
TRUE or omitted; find an exact match = FALSE.

Help on this function

DKI}

This is the output

( Contents of the lookup value
Lcell reference are shown here.

of the function.

Figure 3.47 "Completed Portfolio Summary Worksheet" shows the output of the
HLOOKUP function. Notice that the output of the function in cell G4 is 6.0%. This is

because the lookup value was defined with the entry in cell H4, which is the
Barclays index. Looking at Figure 3.45 "Benchmarks Worksheet", if you count the
first row of the table array range as Row 1, the value 6.03% is the fourth row in the
Barclays column. Since the values in Column G on the Portfolio Summary
worksheet are set to 1 decimal place, the value is displayed as 6.0%.

Figure 3.47 Completed Portfolio Summary Worksheet

G4 bl Jx | =HLOOKUP(H4,Benchmart

1$BS2:5E96,4,FALSE) <

A B

<
C

D E E

Personal Investment Summary

G H

HLOOKUP function
entered into cell G4

N

Total Summary

Average |Total
Numberof |Months |Purchase |[Current Annual |Benchmark 5
3 Investments [Owned |Cost Value Growth |Year Growth |Benchmark
4 \Bond Fund 4 36| $ 23,773 |$ 27,274 4.9% 6.0%|Barclays
5 Domestic Stock Fund 3 34/$ 22,110 | $ 22,903 1.3% 2.5%|S&P 500
6 International Stock Fund 3 27|$ 18,983 | $ 22,578 8.5% 1.3%|MSCI EAFE
7 Individual Stock 5 63| $ 31,763 | $ 45,101 8.0% 5.4%|Dow Jones
8 TOTAL 15 43| $ 96,628 | $117,857 6.2% 4
9 Poor Performing Investments
Average |Total The output of the HLOOKUP functions
Number of |Months |Purchase |Current Annual e @R e N s
10 Investments ([Owned Cost Value Growth 4" row of the range B2:E6 on the
11 Bond Fund 1 10[S_ 5500[$ 5626 2.8% Benchmarks worksheet.
12 Domestic Stock Fund 3 34/$ 22,110 | $ 22,903 1.3%
13 International Stock Fund 1 42|$ 7,340 |S$ 5,958 -5.4%
14 Individual Stock 2 69| $ 10,097 | $ 13,990 6.8%
15 TOTAL 7 41| $ 45,047 | $ 48,478 2.2%
16

< » | Portfolio Summary / Investment Detail

y: "Investment List yi

"Benchmarks ./ Price Dati| 4]
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Integrity Check

#N/A and #REF! Errors with Lookup Functions

If you receive the #N/A error code when using the VLOOKUP or HLOOKUP
function, it indicates that Excel cannot find the lookup value in the table array
range. Check that the lookup value exists in the first column for the VLOOKUP,
or the first row for the HLOOKUP, in the range used to define the Table_array
argument. You may also see this error code if you copy and paste the function
and forget to put an absolute reference on the range used to define the
Table_array argument. The #REF! error code indicates that the column index
number or row index number exceeds the number of columns or rows in the
range used to define the Table_array argument.

3.3 Lookup Functions 297



Chapter 3 Logical and Lookup Functions

Skill Refresher: HLOOKUP Function

(click to see video)

Type an equal sign (=).

2. Type the function name HLOOKUP followed by an open

parenthesis (().

3. Define the Lookup_value argument with a cell location, number,
or text that will be searched in another workbook or worksheet.
Text must be placed in quotation marks.

4. Type a comma.

5. Define the Table_array argument with a range of cells that
contain the lookup value in the first row along with data that is to
be displayed or used by the function.

6. Type a comma.

7. Define the Row_index_num argument with a number that
designates the rows from the top of the table array range that will
be displayed by the function. Count the first row of the table array
range as 1.

8. Type a comma.

9. Define the Range_lookup argument with either the word FALSE or
the word TRUE. The word FALSE will search for exact matches to
the lookup value. The word TRUE will search for an exact or closest
match less than the lookup value. Excel will define this argument
as TRUE if it is omitted.

10. Type a closing parenthesis ().
11. Press the ENTER key on your keyboard.
Web Queries

Follow-along file: Continue with Excel Objective 3.00. (Use file Excel Objective 3.16 if

starting here.)

Lesson Video: Web Queries

(click to see video)

3.3 Lookup Functions
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The final skill we will demonstrate in this chapter is the creation of a web query.
Web queries allow you to import external data from a website into an Excel
worksheet. We can enhance the personal investment portfolio demonstrated in this
chapter through the use of web queries to import current stock prices from a
website. Once a stock price is imported into the workbook, a cell reference can be
added to the Investment Detail worksheet to reflect the most current price for an
investment. It is important to note that you must establish an Internet connection
before proceeding with this exercise. The following steps explain how to retrieve
the current stock price for Microsoft from the Yahoo! Finance website and import it
into the Price Data worksheet:

3.3 Lookup Functions

1. Click cell A2 on the Price Data worksheet.

Click the Data tab of the Ribbon.

commands. This will open the New Web Query dialog box.

(see Figure 3.48 "New Web Query Dialog Box"):

Click the From Web button located in the Get External Data group of

Type the following Internet address (URL) in the Address input box

http://www.yahoo.com. Press the ENTER key on your keyboard after

entering the URL.

Use the scroll bar on the right side of the New Web Query dialog box to

locate the Finance link on the left navigation pane of the website. Click
the Finance link (see Figure 3.48 "New Web Query Dialog Box").

Figure 3.48 New Web Query Dialog Box

New Web Query %
Address: | http://www.yahoo.com/ ( E @ ® Rr @ B Options...
Click E] next to the tables you want to select, then click Import.
YaHoO! Signin  New here? Sign Up St
YAHOO! SITES £ Eqit stops passing cars with his amazing * Malaysian pet outrage
— appendages. Their total length > * Fighting toxic toads
Mail
Autos 3
@ Dating | = I
S g
D e oo ionees, e Bl O EEE
Fashion rules fo 0Q'S recor Kobe's Twitter Cool new
[e¢] Flickr break ear length accountgone  Android phones
B Games
37 -400f 44 L
Health
(o - Up to 5 million hit by massive power outage
anEapes California, Arizona and Mexico suffer through a blackout that
@ Jobs

causes big problems for residents and transit systems.
—a Employee removing equipment likely caused outage ’
NS
e

Web address
input box

}-
Use the scroll bar arrows
| to navigate the website.

[ ttp://vvew.yahoo.com)/_ylt=AOWTferVpGIOSbIA9jmbvzxd/SIG=11dnfeih3/EXP=1315632725/*http | |

)

Click and drag here to chang
the size of the dialog box.

6. Locate the Get Quotes input box by using the scroll bar to scroll to the
top of the website (see Figure 3.49 "Get Quotes Input Box on Yahoo!

Finance").
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7. Click in the Get Quotes input box, type the stock symbol MSFT, and
press the ENTER key on your keyboard (see Figure 3.49 "Get Quotes
Input Box on Yahoo! Finance").

Figure 3.49 Get Quotes Input Box on Yahoo! Finance

New Web Query
[=] @ ® R’ @ Options...

Address: | http://finance.yahoo.com/

Click [#] next to the tables you want to select, then click Import.

L lew User? Register Sign In Help Upgrade to Safer IES

YAaHOO!, FINANCE [searan

1] »

| PERSONAL FINANCE ‘ MY PORTFOLIOS Type a stoc

|
INVESTING | NEWS

k symbol here

MSFT] RSP - 2nce Search to view stock price data.
MSFT Microsoft Corporation Equity
"MSFSY {t') NASDAQ OMX Alpha MSFT vs. SPY
"MVSPY NASDAQ OMX Alpha MSFT vs. SPY
MSFT.BA Microsoft Corporation E -B
MSFT.MX Microsoft Corporation Eq
MSFT11BF.SA MICROSOFT -DRN MB Equ
Show all results for msft
Tin: llee romma () tn senarate multinle anuntes | earn mare i

< 1 |

‘Waiting for | | ‘

8. When viewing the stock price data for MSFT, you will see several
yellow boxes or tags with arrows (see Figure 3.50 "Selecting a Tag to
Import Data from a Website"). These tags indicate blocks or tables of
data that can be imported into a worksheet from a website. Click the

yellow tag next to the Last Trade price. The yellow tag will turn green
with a check mark inside of it.
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Figure 3.50 Selecting a Tag to Import Data from a Website

selected for importing. )

New Web Query
Address: | http://finance.yahoo.com/q?s=MSFT&ql=0 Izl @ ® R & B Options...
click [#] next to the tables you want to select, then click Import. P
More On MSFT |nd WHA OIN I 08 1 \
. |ON WITH MSFT; ‘ Mu?‘laglig?Q - :e!fcf;r‘ ..... of
¢ LLLDT optionshouse icss” Scottrade
» summary | ‘
Order Book Microsoft Corporation (NasdagGs: MSFT) & Ad 1= These yellow tags indicate
Options After Hours: 26.19 ¥ 0.03 (0.11%) 7:59PM EDT = blocks or tables of data
mMSFT that can be imported.
Historical Prices ks 26,22 Y Range: 2595 . 2666 p
CHARTS
sy I — Seps  S2wkRange  23.65-29.46 Vr/‘/
Interactive
g Change: 10.22 (0.85%) Volume: 65,818,212
Basic Tech. Analysis Prev Close: 26.00 Avg Vol (3m): 65,925,500 © Yahoo!
NEWIS & INFO Open: 2598 Market Cap: 219.68B  j0am
Headlines Bid: 24.73 x 100 P/E (ttm): 9.75
) 1d
Financial Blogs Ask: 26.20 x 4000 EPS (ttm): 269
i 1y Target Est: 3208 Div&Yield  0.64(2.50%) -
< \ 1L J ] 3
7 - - N l Import \] [ Cancel I
" The green tag indicates the =
) | |
highlighted area has been Y

9. Click the Import button at the bottom of the New Web Query dialog

box. This will open the Import Data dialog box, as shown in Figure 3.51

"Import Data Dialog Box".

Figure 3.51 Import Data Dialog Box

IE‘ H9-¢0-& ‘7 Excel Objective 3.00.xIsx - Microsoft Exce!
Home Insert Page Layout Formulas Data Review View
) 3 1 1 1 1] Co Z| — i

a @ O 8 3 =0 ==
From From From Frc her ! ort Filter Textto Rem Data Consol
5 = & . =2 Edit Links 5 % Advanced | columns Dub ST don
A Web  Text Sour ons All LlenE 7 Advanced | columns Dupli validation

Get External Data ‘ Connections Sort & Filter | Data Tools
A2 - £
A B C D E B G

1 MSFT IBM KO
2 Import Data (B ==
3 Where do you want to put the data?
4 (@) Existing worksheet:
= 2 =
6 (©) New worksheet
7
8 [ Properties... ] [ OK ] [ Cancel ]
=
10

The first column of data
retrieved by the web query
will be entered here.

~
Click here to open the External
Data Range Properties dialog box.
.

10. Click the Properties button at the bottom of the Import Data dialog box
(see Figure 3.51 "Import Data Dialog Box"). This will open the External

Data Range Properties dialog box.
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11.

12.

13.

14.

15.
16.

17.

Click in the Name input box on the External Data Range Properties
dialog box and delete the query name that is provided. Type the new
query name Microsoft Stock Price.

Click the box next to the “Refresh every” property. Change the refresh
minutes to 5. This means the query will automatically search the
website every 5 minutes to retrieve an updated stock price for

Microsoft (see Figure 3.52 "Final Settings for the External Data Range
Properties Dialog Box").

Figure 3.52 Final Settings for the External Data Range Properties Dialog Box
r )

External Data Range Properties | % H :
- ctode < Click here to change the
Name: |Mi Stock Pri
Name ICrosol OCK Frice L name Of the query,
Query definition ’
Save guery definition
Save password Click here to have the query
. automatically refresh data
efresh, confra . df he |
nable background refresh Importe rom the Internet.

Befresh every |5 2 minutes

[] Refresh data when opening t

Remove external data from worksie{before closing

Data formatting and layout Click here to change how often

the query will refresh data
imported from the Internet.

Include field names Preserve column sort/filter/layod
Include row numbers Preserve cell formatting
Adjust column width

If the number of rows in the data range changes upon refresh:
( ) Insert cells for new data, delete unused cells

(7) Insert entire rows for new data, clear unused cells

Eifl down formulas in columns adjacent to data This option has been selected so
the query does not delete rows or cells
| oK QJ I Cancel ] L\when data is refreshed from the Internet.

(@) Overwrite existing cells with new data, clear unused cells
I

Click the option at the bottom of the External Data Range Properties
dialog box that reads “Overwrite existing cells with new data, clear
unused cells” (see Figure 3.52 "Final Settings for the External Data
Range Properties Dialog Box"). It is important to select this option if
you intend to add more than one web query to a worksheet or if you
are using formulas in adjacent columns to a web query. This option will
prevent the web query from deleting entire rows of data from the
worksheet.

Click the OK button at the bottom of the External Data Range
Properties dialog box.

Click the OK button at the bottom of the Import Data dialog box.
After the data is imported, click cell H17 on the Investment Detail
worksheet and type an equal sign (=).

Click the Price Data worksheet tab.
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18. Click cell B2 on the Price Data worksheet and press the ENTER key on
your keyboard. This will display the price that is imported from the
web query on the Investment Detail worksheet.

19. Figure 3.53 "Stock Price for Microsoft Imported into the Price Data
Worksheet" shows the results of importing the Microsoft stock price
from the Yahoo! Finance website. It is important to note that the data
you retrieve from the website will be different from what is shown in
this figure.

Figure 3.53 Stock Price for Microsoft Imported into the Price Data Worksheet

B2 - £ 26.22
A B C D E F

1 MSFT IBM KO
2 Last Trade: 26.22 7
3 Trade Time: 8-Sep
4 Change: Up 0.22 (0.85%)
5 Prev Close: 26 || This data is being imported
6 Open: 25.98 >{ from the internet. ]
7 Bid: 24.73 x 100
8 Ask: 26.20 x 4000
9 1y Target Est: 32.08
10 -
11
12
13
14
15
16
17
18

19
M < » W[ Portfolio Summary  Investment Detal . Investment List  Benchmarks | Price Data /%7 ][4
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Skill Refresher: Web Queries

(click to see video)

Click a cell location on a worksheet where the first column of the
data being imported should appear.

2. Click the Data tab of the Ribbon.

10.

11.

Click the From Web button in the Get External Data group of
commands.

Enter a website address in the Address input box on the New Web
Query dialog box and press the ENTER key on your keyboard.

Use the scroll bars and website links to navigate the website.
Select one or more yellow tags that contain the block or blocks of
data you wish to import.

Click the Import button at the bottom of the New Web Query
dialog box.

Click the Properties button at the bottom of the Import Data dialog

box.

Make any necessary changes on the External Data Range
Properties dialog box.

Click the OK button at the bottom of the External Data Range
Properties dialog box.

Click the OK button at the bottom of the Import Data dialog box.
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KEY TAKEAWAYS

Lookup functions are powerful and versatile tools because they
eliminate the need to copy or recreate data that exists in other
worksheets or workbooks.

The VLOOKUP function will look vertically down the first column of the
table array range to find the lookup value. The lookup value must exist
in the first column of the table array range when using the VLOOKUP
function.

The HLOOKUP function will look horizontally across the first row of the
table array range to find the lookup value. The lookup value must exist
in the first row of the table array range when using the HLOOKUP
function.

If the Range_lookup argument for the VLOOKUP function is defined
with the word TRUE, the data in the table array range must be sorted in
ascending order (smallest to largest) based on the values in the first
column.

If the Range_lookup argument for the HLOOKUP function is defined
with the word TRUE, the data in the table array range must be sorted in
ascending order (smallest to largest), left to right, based on the values in
the first row.

If you are copying and pasting a VLOOKUP or HLOOKUP function to
other cell locations on a worksheet, make sure there is an absolute
reference placed on the table array range.

Web queries are used to import external data from a website into an
Excel worksheet.
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EXERCISES

1. Which of the following is true with respect to the range of cells
used to define the Table_array argument when using the
VLOOKUP function?

a. The lookup value must exist in the first row of this range.

b. The lookup value must exist in the first column of this range.

c. This range must be sorted in ascending order if the
Range_lookup argument is defined with the word FALSE.

d. The range used to define the Table_array argument is the
lookup value.

2. Assume that the range B3:E23 is used to define the Table_array
argument for an HLOOKUP function. How should the
Row_index_num argument be defined if the output of the
function should be the contents of the cell location in Row 15 in
the same column as the lookup value?

with the number 15
with the range B3:B15
with cell location B15
with the number 13

o op

3. Column A contains values that will be used to define the
Lookup_value argument of a VLOOKUP function. The function
will search for an exact match to the lookup value in the range
A2:D15 in the Description List worksheet. The output of the
function should be the contents in the cell location in Column C
of the same row as the lookup value. Once the function is
created, it will be copied and pasted to other cell locations in the
same column. Which of the following VLOOKUP functions will
provide an accurate result based on these criteria?

=VLOOKUP(A4, Description List’!A2:D15,2,FALSE)
=VLOOKUP($A$4, Description List’'I$A$2:$D$15,2,FALSE)
=VLOOKUP(A4, Description List’!$A$2:$D$15,3, TRUE)
=VLOOKUP(A4, Description List’!$A$2:$D$15,3,FALSE)

o op
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4. When using a web query, what is the appropriate setting to make
if you want Excel to search the website for new information
every minute?

a.

b.

Click the “Refresh every” option and change the minutes to 1
in the Import Data dialog box.

Click the “Refresh every” option and change the minutes to 1
in the External Data Range Properties dialog box.

Click the “Refresh every” option and change the minutes to 1
in the